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P

Preface

This guide describes how to use the Compound Discoverer™ application to qualitatively 
process RAW data files with a targeted or untargeted workflow. A targeted workflow evaluates 
the mass spectral data for the presence of specific compounds. An untargeted workflow 
evaluates the mass spectral data, predicts the elemental composition of unknown compounds, 
and searches mass spectral databases to identify these compounds.

To familiarize yourself with the Compound Discoverer application, follow the tutorials that 
are available from the application Help menu or see Chapter 2, “Getting Started.” 

Related Documentation
The Compound Discoverer application includes these manuals as PDF files:

• Compound Discoverer User Guide

• Compound Discoverer E & L Tutorial

• Compound Discoverer Metabolism Tutorial

• Compound Discoverer Metabolomics Tutorial

• Compound Discoverer Stable Isotope Labeling Tutorial

• Compound Discoverer Reporting Quick Start 

The Compound Discoverer application also includes a Help system.

Contents

• Related Documentation

• System Requirements

• Installation Instructions

• Special Notices

• Contacting Us
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 To view the Compound Discoverer manuals

From the application window, choose Help > Manuals.

–or–

From the Microsoft™ Windows™ taskbar, choose Start > All Programs (or Programs) > 
Thermo Compound Discoverer 3.1 > Manual.

 To download user documentation from the Thermo Scientific™ website

1. Go to thermofisher.com.

2. Point to Support, and then click Manuals under Product Documentation on the left.

3. In the Refine Your Search box, search by the product name.

4. From the results list, click the title to open the document in your web browser, save it, or 
print it. 

To return to the document list, click the browser Back button.

https://www.thermofisher.com
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System Requirements
The Compound Discoverer 3.1 application can process data files produced by high-resolution 
accurate-mass (HRAM) Thermo Scientific™ mass spectrometers, such as the Orbitrap 
Fusion™, Q Exactive™, and Exactive™.

Table 1 lists the hardware and software requirements for the processing computer.

Table 1. Hardware and software requirements for the processing computer

System Minimum requirements

Hardware • 3.4 GHz dual-core processor

• 16 GB RAM

• 500 GB hard drive

• DVD-ROM and USB drive

• Display monitor resolution of 1920  1080 with 96 dpi setting

Software • Microsoft Windows 7 Pro SP1 (64-bit) or Windows 10 64-bit 
operating system

• Microsoft .NET Framework 4.7.2

• Microsoft Office 2010

• Adobe™ Reader™ 11

• Adobe Flash™ Player 15

System settings • To run processing workflows with online mass spectral database 
searches, the computer must have unblocked access to the mass 
spectral databases on the Internet. 

• The computer must have the correct time and date settings and be 
synchronized with Internet time. 

• The Region and Language setting for the operating system must 
be set to English (United States).
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Table 2 lists the recommended hardware configurations for enhanced performance using the 
Compound Discoverer application.

To check the access to the mass spectral databases, the time and date settings, and the Internet 
time, see Chapter 17, “Testing Communication to the Online Databases.” 

To verify that the system meets the minimum requirements, follow these procedures:

• To check the computer specifications

• To check the font DPI for a Windows 7 system

• To check the format setting for Region and Language

 To check the computer specifications

1. From the Windows Explorer directory, right-click OSDisk (Drive:) (the directory for the 
hard drive where the operating system is installed) and choose Properties.

The OSDisk (Drive:) Properties dialog box opens. This dialog box lists the file system 
(NTFS or FAT) and the free disk drive space.

2. From the Windows Desktop, choose Start > Control Panel > System and Security > 
System.

The System page opens. This page lists the operating system; the processor type, speed, 
and number of cores; the installed RAM; and the system type (32-bit or 64-bit).

 To check the font DPI for a Windows 7 system

1. From the Windows taskbar, choose Start > Control Panel.

2. On the Adjust Your Computer’s Settings page, do the following:

a. For View By, select Category.

Table 2. Recommended hardware configurations for enhanced performance

System Recommended configurations

Hardware • Dual 8-core processor (for example, 2x Intel™ Xeon™ Gold 6134 CPU @ 
3.20 GHz)

• 64 GB RAM

• 1 TB SSD (solid-state disk) hard drive for OS

• 2nd 3 TB (conventional disk) hard drive for data storage

• DVD-ROM and USB drive

• Two 27 in. UHD monitors: Display monitor resolution of 
3840 2160
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b. Under Appearance and Personalization, click Adjust Screen Resolution.

The Screen Resolution page opens.

3. Click Make Text and Other Items Larger or Smaller.

4. On the left panel, click Set Custom Text Size (DPI).

The Custom DPI Setting dialog box opens (Figure 1).

Figure 1. Custom DPI Setting dialog box

5. Make sure that the DPI setting is 96 pixels per inch.

 To check the format setting for Region and Language

1. From the Windows taskbar, choose Start > Control Panel.

2. On the Adjust Your Computer’s Settings page, do the following:

a. For View By, select Category.

b. Select Clock, Language, and Region.

3. Select Region and Language.

4. On the Formats page of the Region and Language dialog box, select English (United 
States) from the Format list.
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Installation Instructions
Thermo Compound Discoverer is a licensed application. After you install the application, you 
can use it for up to 60 days without activating the software license. 

After you order the Compound Discoverer 3.1 application, you will receive a software media 
kit that includes a key-shaped USB flash drive with the installation executable. In addition, 
you will receive an email from Thermo MS Licensing providing you with the information 
that you need to activate the software license.

If you are upgrading the software from a previous version of the application, you can find the 
software installer and a license on the LSMS Software Download and Licensing Portal.

The installation executable includes three installers. The Thermo Compound Discoverer 3.1 
installer installs the Compound Discoverer application. The Thermo mzVault Library 
installer installs two mzVault libraries that are May 2019 snapshots of the online mzCloud 
mass spectral database, and the Thermo mzVault installer installs the mzVault application. 

To install the applications and the libraries, see these topics:

• Installing the Compound Discoverer Application and the mzVault Libraries

• Installing the mzVault 2.2 Application

Installing the Compound Discoverer Application and the mzVault Libraries

 To install the Compound Discoverer application and the mzVault libraries

1. Do one of the following:

a. Insert the Compound Discoverer USB flash drive into a USB port on your computer.

b. Open Windows Explorer and select the USB drive to view its contents.

IMPORTANT   Read the following:

• The installation requires the Windows 7 SP1 64-bit or Windows 10 64-bit operating 
system. See “System Requirements” on page xix for the recommended hardware 
requirements and system settings.

• The Compound Discoverer 3.1 licensing process requires an Internet connection to 
validate the software license. You can install the application on a computer without 
Internet access and complete the activation process on a computer with Internet 
access.

• The Compound Discoverer application is supported for US-English Only locale.

Note  The following versions of the Compound Discoverer application can coexist on the 
same computer: 1.0, 2.0, 2.1, 3.0, and 3.1
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c. Locate the executable: XStart_Compound Discoverer.exe.

–or–

a. Go to the following website address:

https://thermo.flexnetoperations.com 

b. Log in to your account. If you do not have an account, click Register and create one.

c. On the left side of the Life Sciences Mass Spectrometry Software Download and 
Licensing Portal, click Product List under Software and Services.

d. On the Product List page, click the Demo hyperlink.

e. On the Product Information page, click the Compound Discoverer 3.1 hyperlink.

f. On the Product Download page, in the File Name column, click the down arrow to 
the left of Compound Discoverer 3.1.zip, click Save As, and then save the 
compressed zipped folder to your computer.

g. Extract the contents of the zipped folder, and locate the executable: 
XStart_Compound Discoverer.exe.

2. Double-click XStart_Compound Discoverer.exe.

The installation wizard starts.

Figure 2. Compound Discoverer installation wizard

3. Click Compound Discoverer 3.1.

Note  If you are upgrading from the Compound Discoverer 3.0 software, which is 
a free upgrade, you can also find your software license on the Product Download 
web page. 

https://thermo.flexnetoperations.com
https://thermo.flexnetoperations.com
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4. When the installer opens, click Next and follow the instructions.

The Minimum Product Requirements screen appears with a product requirements scan 
summary. If the computer meets the system requirements, the summary states the 
following: 

All the system minimum requirements checks passed.

5. At the Installation Qualification prompt, click Yes if you want to view the Installation 
Qualification report. Otherwise, click No.

6. When the installation is complete, select whether you want the installer to restart your 
computer, and then click Finish.

7. To install the mzVault libraries, do the following:

a. If the installer restarted your computer, double-click XStart_Compound 
Discoverer.exe to restart the installer.

b. Click mzVault Library Installer to install the mzVault libraries:

8. If you have not already restarted your computer, restart it now.

Installing the mzVault 2.2 Application

To create mass spectral libraries from your own data acquired with a high-resolution 
accurate-mass (HRAM) Thermo Scientific mass spectrometer, install the mzVault 2.2 
application. The Compound Discover installer includes an installer for the mzVault 
application.

 To install the mzVault application

1. If the Compound Discoverer installer is not open, open it as follows:

a. Locate the XStart_Compound Discoverer executable. 

You can find the executable on the USB drive provided in the Compound Discoverer 
application media or in the zip folder that you downloaded from the product 
download web site. 

b. Double-click XStart_Compound Discoverer.exe. 

2. Click mzVault 2.2.

The Thermo mzVault Installshield Wizard opens.

If your computer meets the minimum requirements, the Next button becomes available.

3. Click Next to continue.

Note  If you have an earlier version of the application, follow the instructions to 
remove it, and then restart the mzVault 2.2 installer.
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4. When the installation is complete, do the following:

a. To start the mzVault application immediately after you exit the installer, select the 
Launch Thermo mzVault check box.

b. Click Finish.

c. If you want to view the Installation Qualification report, click Yes at the 
confirmation prompt. Otherwise, click No.

Special Notices
Make sure you follow the precautionary statements presented in this guide. The special 
notices appear in boxes.

Special notices include the following:

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
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Contacting Us

 For Compound Discoverer customer support questions

Send an email message to CD.support@thermofisher.com.

Contact Email Telephone QR Code

U.S. Technical Support us.techsupport.analyze@thermofisher.com (U.S.) 1 (800) 532-4752

U.S. Customer Service 
and Sales

us.customer-support.analyze@thermofisher.com (U.S.) 1 (800) 532-4752

Global support  To find global contact information or customize your request

1. Go to thermofisher.com. 

2. Click Contact Us, select the country, and then select the type of support 
you need.

3. At the prompt, type the product name. 

4. Use the phone number or complete the online form. 

 To find product support, knowledge bases, and resources

Go to thermofisher.com/us/en/home/technical-resources.

 To find product information

Go to thermofisher.com/us/en/home/brands/thermo-scientific. 

Note  To provide feedback for this document, go to surveymonkey.com/s/PQM6P62 or send an email message to 
Technical Publications (techpubs-lcms@thermofisher.com). 

mailto:us.techsupport.analyze@thermofisher.com
mailto:us.customer-support.analyze@thermofisher.com
https://www.thermofisher.com
https://www.thermofisher.com/us/en/home/technical-resources.html
mailto:CD.support@thermofisher.com
https://www.thermofisher.com/us/en/home/brands/thermo-scientific.html
http://www.surveymonkey.com/s/PQM6P62
mailto:techpubs-lcms@thermofisher.com
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Introduction

Compound Discoverer is a qualitative data-processing application that uses accurate mass 
data, isotope pattern matching, and mass spectral library searches for the structural 
identification of small molecules. It can process the accurate-mass spectra from the entire 
product line of Thermo Scientific high-resolution mass spectrometers. It can also display the 
graphical data acquired from a variety of detectors: UV-visible and photodiode array (PDA) 
detectors that are controlled by a Thermo Scientific data system and third-party analog 
detectors that are connected to the analog input channels of a Thermo Scientific MS.

To familiarize yourself with the Compound Discoverer application, see these topics. 

Contents

• New Features and Enhancements 

• Supported File Formats

• Starting the Application

• Choosing the Toolbar Icon Size

• The Application Window

• Understanding Processing Workflows

• Best Scans for Composition Prediction and Spectral Matching

• Quality Control Samples for Batch Normalization

• Stable Isotope Labeling

• FISh Scoring for Targeted Compounds and Proposed Structures

• Calculating the Mass Defect of an Elemental Composition 

• Using mzLogic to Score Candidates for Unknown Compounds

• Managing the Start Page’s Recent File Lists

• Auto-Hiding the Start Page, the Chromatograms View, and the Mass Spectrum 
View

• Working with the Tabbed Documents 

• Rearranging the Tabbed Documents and Graphical Views
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New Features and Enhancements
The application uses a study format to define the sample types, experimental study factors, 
sample groups, and group ratios. It uses a customizable node-based processing workflow to 
process Xcalibur™ RAW files and create a result file. 

Some of the workflow nodes require input from the application’s customizable lists and 
libraries, which include the structures of known compounds, mass lists, adduct ions, 
transformations, metabolic pathways, fragment lists, and spectral libraries. 

The result file includes a set of result tables and graphical views based on the processing 
workflow. The application provides graphical views for displaying chromatograms and 
spectra, and statistical views for comparing the detected compounds by sample file or sample 
group. 

These topics describe the new features and enhancements:

• New Features

• Enhancements

New Features

Compound Discoverer 3.1 has the following new features: 

• Molecular Networks (beta) to interactively explore relationships between compounds 
based on transformations and spectral similarity

• Scripting node to embed scripts in workflows—for example, Python or R scripts 

• Mass Defect Plot for Compounds and Expected Compounds

Tip  To get started with this application, follow these tutorials and guides or go to 
Chapter 2, “Getting Started.” 

• Compound Discoverer 3.1 Metabolism Tutorial

• Compound Discoverer 3.1 Metabolomics Tutorial

• Compound Discoverer 3.1Extractables and Leachables Tutorial

• Compound Discoverer 3.1 Stable Isotope Labeling Tutorial

• Compound Discoverer 3.1 Reporting Quick Start Guide

To access these tutorials from the application window, choose Help > Manuals.

Tip  For information about using the Scripting Node, go to the Resources page of the 
following web site: https://mycompounddiscoverer.com/.


https://mycompounddiscoverer.com/
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• Calculate Mass Defect node with support for up to 5 Kendrick formulas

• Peak area scaling using values from a numerical study factor that you specify as the scaling 
factor in the Normalize Areas node

• Search mzCloud node:

– Supports automatic searches of multiple spectral libraries

– Supports the new “Autoprocessed” mzCloud library

– Supports using both DIA and DDA scans as the query scans to search against the 
mzCloud library

– Highlights matching and non-matching spectral peaks in green and red, respectively

– Displays the fragment structure for matching peaks

• Apply Spectral Distance node to score the observed isotopic pattern versus the simulated 
isotopic pattern of a candidate from, for example, ChemSpider

• Manual export of detected compounds in a result file to a mass list file

• Installation of the mzVault 2.2 application for creating and editing mass spectral libraries 

Enhancements

Compound Discoverer 3.1 has the following enhancements: 

• Improved performance of ChemSpider searches

• Displays the chromatographic peak areas in units based on a time scale of seconds instead 
of minutes

• Extended retention time search window for the assignment of MSn spectra to a 
compound

• Changes in the Expected Compounds database are now immediately reflected in the 
Generate Expected Compounds node 

• New parameter for Compound Class Scoring node to use entire MSn tree

• New version of the HighChem Fragmentation Library

• New licensing mechanism

Note  The mzVault 2.2 application supports importing NIST MSP and MassBank 
MB files.
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Supported File Formats
Table 3 describes the file types that the application can recognize or create.

Table 3. Supported file formats (Sheet 1 of 2)

File format Description

Xcalibur RAW file Contains unprocessed data acquired from a high-resolution, 
accurate mass LC/MS/MS instrument with a Thermo Scientific 
data system that is layered on the Thermo Foundation™ platform.

MOL format (.mol), 
compressed structure 
(.mcs), template (.tml)

Contains a two-dimensional compound structure. You can open 
structure files by using the Structure Editor or the Custom 
Explanations Editor.

cdProcessingWF Contains the data processing instructions for the application. To 
create a processing workflow, you must start or open an analysis in 
a study.

cdAnalysis Stores the processing workflow information.

cdStudy Stores the study information, which includes the names and 
locations of the input files, the sample information, and the 
relationship between the input files. 

cdResult Contains the results produced by processing a set of raw data files 
and information about the analysis settings used to process the raw 
data.

cdResultView Contains the layout settings that the application uses to display 
the result file’s tables and graphical views. These settings also 
include the applied result filters.

Deleting this file erases all the custom layout settings and restores 
the display to the default layout settings.

cdReportTemplate Contains the layout for reports that extract data from the 
following items in a result file: selected columns in one main table, 
selected columns in the related tables, and selected graphical views 
(MS1, MS2, and Chromatograms).
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Starting the Application
You can start the application from the taskbar or the computer desktop.

 To start the application

• From the taskbar, choose Start > All Programs (or Programs) > Thermo 
Compound Discoverer.

–or–

• From the computer desktop, double-click the Compound Discoverer icon, .

The Compound Discoverer window opens with the Start Page displayed as a tabbed 
document (Figure 3). As you create studies and process data, the application creates and 
populates recent file lists to the right of the What Would You Like to Do? hyperlinks.

Filter Set (.filterset) You can use filter set files for data reduction when reviewing and 
reporting the data in Compound Discoverer result files. The 
application comes with one predefined filter set file—Example 
Filter Set.filterset. 

mgf, mzML, mzDATA Contains the mass spectral data that can be read by third-party 
mass spectrometry applications. To create any of these files types, 
use the Export Spectra Node in a processing workflow. 

XML You can export each library to an XML file, and you can import 
library entries from an XML file. 

text (.txt) You can save the data points in the graphical views to a text file. 

EMF, BMP, JPG, GIF, 
PNG, TIFF

You can save the images in the graphical views as image files of the 
following file types: enhanced metafile (.emf), bitmap (.bmp), 
Joint Photographic Group (.jpg), graphic interchange format 
(.gif ), portable network graphics (.png), and tagged image file 
format (.tiff ).

You can open EMF files in a raster image editor or a vector image 
editor. 

CSV You can import the contents of a CSV file into a Mass List file.

CLIB You can import the contents of a CLIB file as a Compound Class 
list.

DB You can import mzVault libraries into the Spectral Libraries list.

Table 3. Supported file formats (Sheet 2 of 2)

File format Description
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Figure 3. Application window with the initial Start Page and large toolbar icons

Choosing the Toolbar Icon Size
You can choose between large or small icons for the application toolbar. By default, the 
application toolbar displays large icons.

 To change the size of the toolbar icons

Do one of the following:

• To display small icons in the toolbar, right-click the application toolbar 
and choose  Show Large Icons. 

• To display large icons in the toolbar, right-click the application toolbar 
and choose Show Large Icons.

Note  The check mark to the left of Show Large Icons indicates that the application is 
set to display large toolbar icons.
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The Application Window
The application window contains a title bar, a menu bar, and a toolbar. From the application 
window, you can open all the other application views and pages by choosing a menu 
command or by clicking a toolbar icon.

These topics describe the menu bar and the toolbar:

• Application Menu Bar

• Application Toolbar

Application Menu Bar

Table 4 describes the menu commands in the menu bar at the top of the application window.

Note  This user guide uses the following terms to describe the user interface: 

• View—A dockable window that you can move to a second monitor.

• Page—A tabbed document. You can have many pages open simultaneously; however, 
only one of these pages is the active page.

• Dialog box—A graphical element that accepts user input. Only one dialog box can be 
open at a time. When it is open, a dialog box blocks you from working in other parts 
of the application. 

• Pane—A defined area of an application view, page, or dialog box.

• Prompt—A pop-up message box that you must dismiss to continue.

Table 4. Application menu bar (Sheet 1 of 6)

Menu command Description

File menu

These commands are always available.

New Study and 
Analysis

Opens the New Study and Analysis Wizard, which takes you 
through the process of selecting the studies folder for your study 
subfolders, creating a new study, and starting a new analysis.

Open Study Opens the Open Study dialog box for selecting an existing study 
file to open.

The CD study file type has the .cdStudy file name extension.
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Open Result Opens the Open Result File dialog box for selecting an existing 
result file or result view file.

You do not need an active software license to open result files.

The CD result file type, which contains the data processing 
results, has the .cdResult file name extension. 

The CD result view file type, which contains the display layout for 
the results tables and graphical views and the filter settings, has the 
.cdResultView file name extension. 

To restore the default layout for a result file, delete its associated 
CD result view file.

Note  You do not need an active software license to open result 
files. 

Save Saves recent changes to the current active page (selected tab), for 
example, the active study page or result page.

Save All Saves recent changes to all the open pages in the application 
window.

Recent Studies Displays a list of recent studies that you can open.

Recent Studies > Clear Clears the Recent Studies list.

Recent Results Displays a list of recent results that you can open.

Recent Results > Clear Clears the Recent Results list.

Exit Closes the application.

Reporting menu

These commands are only available when a result page is active.

Create Report Opens the Open Report Design Template dialog box for selecting 
a report template to resolve specific data in the result file.

Create Report 
Template

Opens the Customize Report dialog box for setting up the main 
properties of a report template.

Edit Report Template Opens the Open Report Design Template dialog box for choosing 
an existing report template to edit.

Table 4. Application menu bar (Sheet 2 of 6)

Menu command Description
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List & Libraries menu

These commands are always available.

Expected Compounds Opens the Expected Compounds view for modifying the list of 
expected compounds. 

Note  The Generate Expected node and Create Pattern Trace 
node require compounds from the Expected Compounds 
library. The Create Pattern Trace and the Pattern Scoring nodes 
require user-specified elemental compositions.

Transformations Opens the Transformations view for modifying the list of 
transformations.

Ion Definitions Opens the Ion Definitions view for modifying the list of ion 
definitions.

Adducts Opens the Adducts view for modifying the list of adducts.

Mass Lists Opens the Mass Lists view for modifying the list of mass list files 
or editing mass list files.

Spectral Libraries Opens the Spectral Libraries view for modifying the list of 
mzVault database files.

Metabolika Pathways Opens the Metabolika Pathways view for modifying the list of 
Metabolika pathways or editing a Metabolika pathway.

Compound Classes Opens the Compound Class view for viewing or modifying the 
list of compound class libraries.

View menu

The Start Page and Job Queue commands from this menu are always available. The other 
View commands are only available when a result file is active.

Start Page Opens the Start Page, which lists the most recently opened result 
files and study files.

Job Queue Opens the Job Queue page for viewing the progress of the current 
analysis or the processing events of previous analyses.

Result Summary Opens the Summaries view.

Result Filters Opens the Result Filters view for reducing the number of rows 
displayed in selected result tables.

Chromatograms Opens the Chromatograms view for viewing chromatogram plots.

Table 4. Application menu bar (Sheet 3 of 6)

Menu command Description
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Mass Spectrum Opens the Mass Spectrum view for viewing a spectral tree and the 
spectrum scans.

Trend Chart Opens the Trend Chart view for setting up a box-and-whisker 
(Box Whisker selection) chart or a trendline chart.

Isotopologues 
Distribution Chart

Opens the Isotopologues Chart view.

Available only when the active result file includes results from the 
Analyze Labeled Compounds node.

Show Mass Defect Plot Opens the Mass Defect Plot view for examining the relationship 
between the mass defects of the detected or expected compounds 
and their molecular weights. 

Result Charts Opens the Result Charts view for setting up data graphs, such as 
scatter plots, histogram charts, bar charts, and pie charts. Use 
these views to visualize the data.

Descriptive Statistics Opens the Descriptive Statistics view for viewing a 
box-and-whisker plot of all the compounds in the Compounds or 
Expected Compounds tables for the selected sample groups.

Differential Analysis Opens the Differential Analysis view for viewing volcano plots 
and running differential analyses.

Principal Component 
Analysis

Opens the Principal Component Analysis view for evaluating 
multivariate data. 

Partial Least Squares 
Discriminant Analysis

Opens the Partial Least Squares Discriminant Analysis view.

Hierarchical Cluster 
Analysis

Opens the Hierarchical Cluster Analysis view.

Retention Time 
Corrections

Opens the Corrected Retention Times view. 

Available only when the active result file includes data from 
multiple input files. To view the retention time correction curves 
for one or more input files, select the input files of interest in the 
Input Files table.

Compound Area 
Corrections

Opens the Compound Area Corrections view. 

Available only when the active result file includes data from 
Quality Control samples.

Metabolika Pathways Opens the Metabolika Pathways view for viewing the Metabolika 
pathways that are mapped to the compounds data. 

Table 4. Application menu bar (Sheet 4 of 6)

Menu command Description
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BioCyc Pathways Opens the BioCyc Pathways view for viewing the BioCyc 
pathways that are mapped to the compounds data. 

Available only when the active result file includes mapped BioCyc 
pathways.

KEGG Pathways Opens the KEGG Pathways view for viewing the KEGG™ 
pathways that are mapped to the compounds data. 

Available only when the active result file includes mapped KEGG 
pathways.

mzLogic Analysis Opens the mzLogic Analysis view.

FISh Scoring Queue Opens the FISh Scoring Queue view.

Window menu

Use these command to apply, save, manage, or reset layouts. 

Apply Layout Displays the layouts list for selecting a layout.

Save Layout Opens the Save Layout dialog box for naming the current layout.

Manage Layouts Opens the Manage Result File Layout dialog box for renaming or 
deleting layouts.

Reset Layout Closes and reopens the active result file to reset its layout.

Help menu

These commands are always available.

Compound Discoverer 
Help

Opens the Compound Discoverer Help, which is a compiled Help 
file with Contents, Index, and Search tabs. The Help contains 
context-sensitive topics; that is, pressing F1 opens the Help topic 
that corresponds to the current area of the application.

How to Use the Help Opens the Compound Discoverer Help to the Using This Help 
topic.

Glossary Opens the Compound Discoverer Help to the table of contents 
for the glossary.

Compound Discoverer 
Support Manuals

Displays links to the Compound Discoverer User Guide, 
Compound Discoverer Reporting Quick Start, Compound 
Discoverer tutorials, and Release Notes.

License Manager Opens the License Manager page where you can activate your 
Compound Discoverer license or scan for missing application 
features. 

Table 4. Application menu bar (Sheet 5 of 6)

Menu command Description
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Application Toolbar

Figure 4 shows the application toolbar.

Figure 4. Application toolbar

Communication Tests Opens the Communication Tests dialog box where you can run 
tests to check whether your data processing computer can connect 
to the external BioCyc Pathways, KEGG Pathways, mzCloud, and 
ChemSpider databases. 

Create Bug Report Creates a report of your computer’s configuration and stores it as a 
Compound Discoverer Bug Report (timestamp).zip on your 
computer desktop.

To report software errors to Thermo Fisher Scientific, send a 
detailed error description with screen shots and attach this bug 
report to the email.

Configuration Opens the Configuration page for setting global options, such as 
the maximum number of parallel analyses, the study management 
setting for automatically saving studies, the color maps, the 
mzCloud search settings, and your user credentials for the BioCyc 
mapping feature. 

About Opens the Compound Discoverer dialog box for viewing lists of 
the installed components and processing workflow nodes.

Table 4. Application menu bar (Sheet 6 of 6)

Menu command Description

Study icons Data review icons
Reporting 
icons

Shows the Job Queue page.
Shows the Start page.

Shows the Lists and Libraries Manager.

Saves the active item.

Saves all open items.
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Table 5 describes the icons in the application toolbar from left to right.

Table 5. Toolbar icons (Sheet 1 of 3)

Icon Description

Study icons

Opens the New Study and Analysis Wizard that takes you through the process 
of specifying the studies folder for all your study subfolders, creating a new 
study, and starting a new analysis.

Opens the Open Study dialog box for selecting the current version or a 
previous version of an existing study.

Opens the Open Result File dialog box for selecting the current version or a 
previous version of a result file. 

General icons

Saves the currently active item, such as a study or result file. 

Saves all the open pages, such as the study pages and the result pages.

Opens the Start Page if it is not already open and makes it the active page.

Opens the Job Queue page if it is not already open and makes it the active 
page.

Opens the Lists and Libraries Manager where you can select to open one of the 
following lists or libraries:

• Expected Compounds—For viewing or modifying a list of compounds

• Transformations—For viewing or modifying a list of transformations

• Ion Definitions—For viewing or modifying a list of ion definitions

• Adducts—For viewing or modifying a list of adducts

• Mass Lists—For creating, editing, importing, exporting, or deleting mass 
lists

• Spectral Libraries—For creating, editing, importing, exporting, or deleting 
mzVault database files

• Metabolika Pathways—For adding, editing, importing, exporting, or 
deleting Metabolika pathways.

• Compound Classes—For creating, editing, importing, exporting, or 
deleting compound class libraries of fragment structures
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Data review icons

Available when a result file is the current page in the application window. When the 
respective view is open, brings the view to the forefront or makes the view the active view.

Opens the Summaries view as a docked view. Available when the Summaries 
view is closed.

Opens the Result Filters view as a floating window. 

Opens the Chromatograms view as a docked view. 

Opens the Mass Spectrum view as a docked view. 

Opens the Trend Chart view as a docked view. 

Opens the Isotopologues Distribution Chart view as a docked view. 

Available when the opened result file includes an analysis of labeled 
compounds.

Opens the Mass Defect Plot view as a docked view. 

Opens the Results Chart view as a floating window. 

The Results Chart view includes the following pages: Scatter Chart, Histogram 
Chart, Bar Chart, and Pie Chart.

Opens the Descriptive Statistics view as a docked view.

Opens the Differential Analysis view as a docked view.

Opens the Principal Component Analysis view as a docked view.

Opens the Partial Least Squares–Discriminant Analysis (PLS–DA) view as a 
docked view.

Opens the Hierarchical Cluster Analysis view as a docked view.

Opens the Retention Time Corrections view as a docked view. Available when 
the result file includes more than one input file.

Table 5. Toolbar icons (Sheet 2 of 3)

Icon Description
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Understanding Processing Workflows
The application uses a node-based method to create processing workflows for the analysis of 
raw data files. You can create your own custom processing workflows (cdProcessingWF), use 
one of the many defined processing workflow templates provided with the application, or 
customize one of the existing processing workflow templates.

Opens the Compounds Area Correction view as a docked view.

Opens the Metabolika Pathways view as a docked view. Available when the 
result file includes mapped BioCyc pathways.

 Opens the BioCyc Pathways view as a docked view. Available when the result 
file includes mapped BioCyc pathways.

Opens the KEGG Pathways view as a docked view. Available when the result 
file includes compounds mapped to KEGG pathways.

Selecting an item in the KEGG Pathways result table opens the reference 
pathway for the item in the KEGG Pathway view.

Opens the mzLogic Analysis view as a docked view.

Opens the FISh Annotations Queue view as a docked view.

Reporting icons

Available when a result file (not necessarily the current page) is open in the application 
window.

Opens the Open Report Design Template dialog box for selecting a report 
template (.cdReportTemplate).

Opens the Customize Report dialog box for setting up a custom report 
template.

Opens the Open Report Design Template dialog box for selecting a report 
template (.cdReportTemplate).

Table 5. Toolbar icons (Sheet 3 of 3)

Icon Description

Note  The parameter settings for the workflow nodes in the defined processing workflow 
templates are not necessarily the same as the default settings for the workflow nodes 
themselves, as Thermo Fisher Scientific has optimized the parameter settings in the 
defined processing workflow templates by the area of study (vertical market). 
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These topics describe the defined processing workflow template and how the application 
processes data to find expected compounds for a targeted analysis or detect and identify 
unknown compounds for an untargeted analysis:

• Targeted Workflows for Expected Compounds

• Untargeted Workflows for Identifying Unknown Compounds

• Marking Background Compounds in an Untargeted Analysis

• Nomenclature for the Defined Processing Workflows

• The Defined Processing Workflows

Related Topics

• Workflow Nodes

• Creating and Editing Processing Workflows

Targeted Workflows for Expected Compounds

Use the Expected Compounds workflow nodes to run an analysis that targets known 
analytes—for example, the metabolites of a specific drug.

Figure 5 shows the workflow tree in the following processing workflow file:

MetID w Stats Expected w FISh Scoring and Background Removal.cdProcessingWF

This processing workflow uses the Generate Expected Compounds and Find Expected 
Compounds nodes to find expected parent1 compounds and their dealkylation, dearylation, 
and transformation products. FISh Scoring is applied to explain the fragments in the 
fragmentation spectra based on in silico fragment prediction of the parent and 
dealkylation/dearylation products.

1 A parent compound is the initial compound in a reaction or metabolic pathway.
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Figure 5. Processing workflow for a metabolism study

During this targeted analysis, the following processes occur:

1. The Input Files Node sends the file names and location of the input files to the connected 
nodes (typically the Select Spectra node, Create Analog Trace node, or both of these 
nodes).

2. The Select Spectra Node filters the MS scan data. 

IMPORTANT  For a targeted analysis, which uses the Find Expected Compounds 
node, do not filter out all the full (MS1) scans, as this node requires the full scan data. 
When the processing workflow includes the FISh Scoring node, do not filter out the 
fragmentation scans, as this node uses them to provide a confirmation score for the 
expected precursor ions.
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3. The Align Retention Times Node chromatographically aligns features across the input 
files in a sample set by using the specified alignment algorithm.

4. The Generate Expected Compounds Node creates a list of expected compound ions by 
using the following user-specified parameter settings:

• Parent compound or compounds

• Number of dealkylation and dearylation steps

• Number and type of transformation steps

• List of possible adduct ions

The Generate Expected Compounds node passes the following information to the Find 
Expected Compounds node for each expected compound:

• Parent compound or compounds

• Elemental composition of the expected neutral compound

• Molecular weight of the expected neutral compound

• Whether the expected compound is a product of a dealkylation step

• Transformations required to produce the expected compound

• Composition change between the parent and expected compound

It also passes the following information for each expected compound ion:

• Charge

• Theoretical m/z value

IMPORTANT  The alignment algorithm looks for matching features (chromatographic 
peaks with the same m/z × RT dimensions) in the input files. The alignment 
algorithm can align input files that include polarity switching data; it cannot align 
input files that include only positive polarity scans with input files that include only 
negative polarity scans.

Note  The Generate Expected Compounds node does not send information to a result 
table. It sends information to the Find Expected Compounds node, which requires 
input from at least one Generate Expected Compounds node. The Filter By Mass 
Defect node can also process the input from one or more Generate Expected 
Compounds nodes.
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5. The Find Expected Compounds Node performs the following steps by using the full 
(MS1) scan data from the Align Retention Times node and the information from the 
Generate Expected Compounds node (or multiple Generate Expected Compounds 
nodes):

a. Creates a set of mass tolerance and intensity tolerance fit parameters for each 
expected compound ion (m/z value) by using the theoretical m/z value for the ion, the 
user-specified mass tolerance, the theoretical isotope pattern for the ion, and the 
user-specified intensity tolerance for the isotopic ions.

b. For each expected compound ion, the Find Expected Compounds node does the 
following: 

i. Checks each full (MS1) scan that passes through the connected data processing 
node for centroids that match the mass and intensity tolerance rectangles. The 
pattern search (set of rectangles) looks for the base peak (most intense centroid) 
of the pattern first. 

In most cases, the base peak is the A0 centroid for the monoisotopic ion. But in 
some cases, for example, in compounds that contain two bromine atoms or four 
chlorine atoms, the isotopic peaks have a higher intensity than the monoisotopic 
peak.

ii. Draws a filtered XIC trace by summing the centroids found for each data point. 
If a data point does not contain the user-specified number of matching isotopes 
and the theoretical intensity of the missing isotope was above the noise threshold, 
the node assigns a 0 intensity value to the data point (Figure 6).

c. For each expected compound found, the Find Expected Compounds node creates a 
summed trace by summing the XIC traces of the associated expected compound ions. 

d. Detects and integrates the chromatographic peaks in each XIC trace. Does not report 
chromatographic peaks with an apex peak height that is below the user-specified 
minimum (chromatographic) peak intensity. If the average peak width of the peaks in 
the processed retention time range is greater than the setting for the Average Peak 
Width parameter, the Find Expected Compounds node rejects all of the 
chromatographic peaks.
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Figure 6. Filtered XIC trace with a 0 intensity data point

The Find Expected Compounds node passes the following information to the Expected 
Compounds per File table for each expected compound that it finds in an input file: 

• RT (min)—Retention time of the chromatographic peak apex. 

• Best SFit [%]—Best spectral fit score between the measured and expected isotope 
patterns for the expected compound ions. When the node finds only one adduct ion, 
the best spectral score is equal to the score for the adduct ion that it found.

• Max # MI—Maximum number of matched isotopes for any of the adduct ions. 
When the node finds only one adduct ion, the maximum number of matched 
isotopes is equal to that of the adduct ion that it found.

Note  A chromatographic peak with a 0 intensity value indicates one of the following:

• The user-specified mass tolerance, intensity tolerance, or number of required 
isotopes for the Find Expected Compounds node is not suitable for this sample 
set. Modify these parameter settings and rerun the analysis.

–or–

• The chromatographic peak does not represent the presence of an expected 
compound. Ignore this chromatographic peak.

Note  If the node finds more than one adduct ion for an expected compound, the 
chromatogram is a summed trace.

Zero intensity 
data point

Filtered XIC trace (blue)Integrated 
chromatographic peak
(shaded area)
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• #Adducts—Number of adduct ions that it found.

• Area—Total area of the chromatographic peaks for the found adduct ions of the 
expected compound. Peak areas are reported in counts × seconds.

• Parent Area%—Relative area of the chromatographic peak for the expected 
compound as compared to the total area of all found peaks for the expected 
compound.

6. The Group Expected Compounds Node groups the chromatographic peaks by their 
molecular weight × retention time (MW × RT) dimensions across the input file set and 
creates the Expected Compounds table.2 

This node also selects the best hit ions for each compound across the input file set:

• Selects the best ion and related MS1 scan for each compound as the one with the 
highest resolution and the highest intensity for the preferred ion. When you open a 
result file, the mass spectrum view displays the MS1 scan for the best ion across the 
input file set.

• Selects the best fragmentation data by using the user-specified preferred precursor ion 
with the highest intensity that has data-dependent MS2 scans.

7. When the input file set includes Blank samples (Sample Type: Blank), the Mark 
Background Compounds node compares the peak areas of the compounds (same parent 
compound, molecular weight, and retention time) that are found in both the Blank 
samples and the non-blank samples, and labels these compounds as Background 
Compounds if their peak areas do not meet the specified threshold.

8. When the spectrum data in the input files includes fragmentation scans (MS2, MS3, 
MSn), the FISh Scoring node compares the best fragmentation scan for an expected 
compound across the input file set to the expected structures. The scoring process can add 
considerable processing time.

9. When the processing workflow includes both the Find Expected Compounds node and 
the Detect Compounds node, the Merge Features node consolidates the chromatographic 
peaks that these nodes find in the main Merged Features table. The consolidation is based 
on the m/z × RT dimensions of the features. 

Note  The parent area is the chromatographic peak area of the expected 
compound, rather than the area of the compound listed in the Parent Compound 
column. The compounds listed in the Parent Compound column are the library 
compounds that you selected in the Generate Expected Compounds node. 

2 For result files generated in Compound Discoverer 2.0, the Group Expected Compounds node also added the 
Best Compounds column to the Expected Compounds per File table. The Workflow page of the Result 
Summary view displays the Best Compound criteria for updated result files.

Note  You use the Preferred Ions parameter in the Group Expected Compounds node 
to specify the preferred adduct ions. 
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10. When the analysis includes group ratios, the Differential Analysis node runs the 
differential analysis.

After the analysis finishes, you can open the result file.

Figure 7 shows a schematic of the main and related result tables for the targeted workflow 
shown in Figure 5. The Structure Proposals table is empty until you populate it. For 
information about adding structure proposals or editing the compound annotations, see 
“Editing Compound Annotations” on page 259.

Note  The Merge Features node also creates the Merged Features table that is related 
to the Manual Peaks table. When you manually integrate a chromatographic peak for 
a specialized trace such as a UV trace, you can compare the selected peak in the 
Manual Peaks table to the peaks in the related Merged Features table. The application 
populates the related Merged Features table with the chromatographic peaks that fall 
within the retention time window specified in the Merge Features node—that is, the 
application populates the Merged Features table that is related to the Manual Peaks 
table with chromatographic peaks that have a similar retention time to the selected 
manual peak.
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Figure 7. Result tables for a basic targeted workflow (with the Create Analog Traces and Merge 
Features nodes)
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Untargeted Workflows for Identifying Unknown Compounds

Figure 8 shows the workflow tree for the metabolomics processing workflow that is provided 
with the application: 

Untargeted. Metabolomics with Statistics Detect Unknowns with ID using Online 
Databases and mzLogic.cdProcessingWF

This processing workflow uses the Detect Compounds node to find chromatographic peaks 
for unknown compounds (MW ×  RT) and the Predict Compositions node to determine the 
possible elemental compositions of the unknown compounds. It also determines the possible 
identity of the unknown compounds as follows: 

• The Search ChemSpider node searches selected databases of MS1 scans by using the MW 
or predicted formulas when available.

• The Search mzCloud node searches the mzCloud database of fragmentation scans by 
using the MW or predicted formulas when available.

• The Map to Metabolika Pathways searches the pathways for the detected compounds. 
When the application finds a matching compound, it maps the pathway for ease of 
viewing.

The Assign Compound Annotations node assigns the following annotations to the detected 
compounds: Name, Formula, and Structure. The Apply mzLogic node combines mzCloud 
similarity searching (MS2 and MSn) with structure similarity matching to rank putative 
database results.
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Figure 8. Processing workflow that finds and identifies unknown compounds

During this untargeted analysis, the following processes occur:

1. The Input Files node sends the file names and location of the input files to the Select 
Spectra node.

2. The Select Spectra node filters the MS scan data. 

3. The Align Retention Times node chromatographically aligns the input files in a sample 
set by using the specified alignment algorithm.

4. The Detect Compounds node detects XIC traces in the full (MS1) scans by using the 
parameter settings for the mass tolerance and intensity threshold, groups isotopes and 
adducts by using the user-specified ions and base ions lists, and reports the unknown 
compounds (MW×RT) by occurrence in the Compounds per File table.
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5. The Group Compounds node uses the specified mass and RT tolerances to group 
chromatographic peaks with the same MW×RT values in the Compounds table. It then 
sends the best fragmentation data across the input files to the Search mzCloud node and 
Predict Compositions node.

This node also selects the best hit ions for each compound across the input file set:

• Selects the best ion and related MS1 scan for each compound as the one with the 
highest resolution and the highest intensity for the preferred ion. When you open a 
result file, the mass spectrum view displays the MS1 scan for the best ion across the 
input file set.

• Selects the best fragmentation data by using the user-specified preferred precursor ion 
with the highest intensity that has data-dependent MS2 scans.

The Predict Compositions node and the search nodes use the best hit ions.

6. The Search mzCloud node searches the mzCloud database for matching and similar 
fragmentation spectra.

7. The Predict Compositions node predicts the elemental compositions of the unknown 
compounds.

8. The Map to Metabolika Pathways node searches the Metabolika pathways for matching 
compounds.

9. The Search ChemSpider node searches the ChemSpider database for matching 
compounds.

10. The Fill Gaps node fills in missing peaks or peaks below the detection threshold (specified 
in the Detect Compounds node) for subsequent statistical analysis.

11. The Mark Background Compounds node determines the background compounds in the 
Blank samples and labels these compounds as background compounds.

12. The Differential Analysis node runs a differential analysis on the defined sample ratios 
and calculates the p-values.

13. The Assign Compound Annotations node assigns and compares the annotations provided 
by the Predict Compositions, Search ChemSpider, Search mzCloud, and Search Mass 
Lists nodes.

IMPORTANT  Make sure that the Preferred Ions list for the Group Compounds node 
includes the selections in the Base Ions list for the Detect Compounds node.

Note  You use the Preferred Ions parameter in the Group Compounds node to specify 
the preferred adducts. 
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14. The Apply mzLogic node runs a forward search and a reverse search using the mzCloud 
service. For compounds that have available MS2 scans, it scores all the structure 
candidates (or the specified maximum number of candidates) from the attached input 
nodes. Adds the following columns to the result tables: #Similarity Results (Compounds 
table) and mzLogic Score (search result tables).

For information about the result tables that this processing workflow generates, see 
“Compound Detection Result Tables” on page 401.

Figure 9 shows a schematic of the main and related tables for a basic untargeted workflow. 

Figure 9. Result tables for an untargeted workflow
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Marking Background Compounds in an Untargeted Analysis

This topic describes how to make the appropriate node connections for an untargeted 
processing workflow that includes two or all three of these workflow nodes: Fill Gaps, Mark 
Background Compounds, and Normalize Areas. All three of these nodes process data across 
the input file set.

The Fill Gaps and Normalize Areas nodes automatically make the appropriate connections:

• The Fill Gaps node only takes input from the Group Compounds node. When you add 
the Fill Gaps node to a processing workflow that has a Group Compounds node, the 
Group Compounds node automatically connects to it.

• The Normalize Areas node only takes input from the Fill Gaps node. When you add the 
Normalize Areas node to a processing workflow that has a Fill Gaps node, the Fill Gaps 
node automatically connects to it. 

The Mark Background Compounds node can take input from any of these three nodes—
Group Compounds, Fill Gaps, or Normalize Areas. However, always add the Mark 
Background Compounds node to the end of the processing workflow.

When an untargeted processing workflow includes the Fill Gaps, Normalize Areas, and Mark 
Background Compounds nodes, the correct connection order is as follows: Group 
Compounds > Fill Gaps > Normalize Areas > Mark Background Compounds.

Related Topics

• Fill Gaps Node

• Normalize Areas Node

• Mark Background Compounds Node–Unknown Compounds
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Nomenclature for the Defined Processing Workflows

When you open a defined processing workflow on the Workflows page of an analysis, 
descriptive text appears in the Description box. Read and understand the description before 
you use the workflow. The Description box does not enlarge to fit the text, so you must scroll 
down to read the complete description. Or, you can click the Description box, press 
CTRL + A to copy the text to the Clipboard, and paste the text into Notepad.

The file names for the processing workflows include the following descriptive text:

• Expected—The workflow runs a targeted analysis with the Generate Expected 
Compounds and Find Expected Compounds nodes. 

• Detect Unknowns, Unknown, or Untargeted—The workflow runs an untargeted analysis 
with the Detect Compounds node. 

• Online Databases—The workflow searches the mzCloud and ChemSpider databases.

IMPORTANT  You must customize the targeted workflows by selecting the targeted 
compounds in the Generate Expected Compounds node. Before you can select the 
compounds for the node, you must add the compounds to the Expected Compounds 
library.

In the defined processing workflows for targeted analyses, the Generate Expected 
Compounds node is set up to generate a mass list for the following adduct ions: 
[M+H]+1 and [M–H]–1. For best results, make the appropriate selections for your 
analysis from the Ions list in the Generate Expected Compounds node. 

Tip  Mobile phase additives can have a significant effect on the base ions (adduct ions 
with the highest intensity) in the full scan data for an LC/MS experiment. To avoid 
misinterpreting the isotopic ion clusters, make sure that the Base Ions list in the 
Detect Compounds node includes the predominant adduct ions. For example, if the 
mobile phase contains a significant amount of ammonium acetate, consider adding 
the ammonium adduct, [M+NH4]+1, to the list.

The processing workflows in the E and L folder include [M+NH4]+1 in the Base Ions 
list.

Tip  In the Search ChemSpider node, select the appropriate databases.
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• Local Database—The workflow searches your local mzVault and mass list files. For 
metabolomics templates, the local databases include the local Metabolika pathways files.

• FISh Scoring—The workflow includes the FISh Scoring Node, a structural confidence 
scoring and annotation tool for comparing the predicted fragments of expected 
compounds to the experimental fragmentation scans. This node adds a significant 
amount of processing time.

• Stats or Statistics—The workflow includes the Differential Analysis node. If you submit 
an analysis that does not include ratios, a warning message appears. If you do not want to 
run a differential analysis, you can ignore the warning and submit the run.

• Compound Class Scoring—The workflow includes the Compound Class Scoring Node. 

• MMDF—The workflow includes the Filter By Mass Defect Node.

• Background Removal—The targeted workflow includes the Mark Background 
Compounds node for filtering out expected compounds that are also found in the blank 
samples. 

• Pattern Scoring—The workflow includes the Pattern Scoring node.

Tip  In the Search mzVault and Search Mass Lists nodes, select the appropriate files. 
The application includes four mzVault library files and four mass lists.

• mzVault libraries:

– mzVault Reference May 2019 (snapshot of the mzCloud spectral database, 
MS2 data only) 

– mzVault Autoprocessed May 2019 (snapshot of the mzCloud spectral 
database, MS2 data only)

– Bamba Lab 34 Lipid Mediators Library Stepped NCE 10 30 45

– Bamba Lab 598 Polar Metabolites Stepped NCE 10 30 45

• mass lists

– Arita Lab 6549 Flavonoid Structure Database

– EFS HRAM Compound Database

– Endogenous Metabolites Database 4400 Compounds

– Extractables and Leachables HRAM Compound Database

IMPORTANT   Before you can select the compounds classes for the node, you must 
add the fragment lists to the Compound Classes library.

Note  All the untargeted workflows include the Mark Background Compounds node 
for filtering compounds detected in the blank samples.
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The Defined Processing Workflows

The processing workflows installed with the application are as follows:

• DegradantID folder

– Degradants Related and Unknown ID w Database Searches

– Degradants Unknown ID w Pattern Trace and Pattern Scoring

– Degradants w Stats Related and Unknown ID w Database Searches

• EandL folder

– E and L Expected w FISh Scoring

– E and L Unknown ID with Online and Local Database Searches

– E and L w Stats Unknown ID w Online and Local Database Searches

• Environmental folder

– Environmental Expected w Transformation and FISh Scoring

– Environmental Unknown ID w Online and Local Database Searches

– Environmental w Stats Unknown ID w Online and Local Database Searches

• Food Research folder

– Food Research Expected w FISh Scoring

– Food Research Unknown ID w Online and Local Database Searches

– Food Research w Stats Unknown ID w Online and Local Database Searches

• Forensics folder

– Forensics Expected w FISh Scoring

– Forensics Unknown ID w Compound Class Scoring and Database Searches

– Forensics w Stats Unknown ID w Compound Class Scoring and Database Searches

• ImpurityID folder

– Impurity ID Related and Unknown

– Impurity ID w Stats Related and Unknown

Tip  To access these workflows from the Workflows page of an analysis, click Open 
Common from the command bar, open the Workflow Templates folder, open the folder 
for the applicable vertical market, and then select a template.
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• Metabolomics folder

– Max ID - Detect Unknowns with ID Using Online Database Searches Single Sample

– Untargeted Metabolomics Quick Detection Unknowns No ID

– Untargeted Metabolomics using Online Databases, mzLogic, and Molecular 
Networks

– Untargeted Metabolomics with Statistics Detect Unknowns with ID using Local 
Databases

– Untargeted Metabolomics with Statistics Detect Unknowns with ID using Online 
Databases

– Untargeted Metabolomics with Statistics Detect Unknowns with ID using Online 
Databases and mzLogic

• MetID folder

– MetID Generate Inclusion List For Acquisition Pos Mode

– MetID Generate Inclusion List For Acquisition Neg Mode

– MetID Pattern Scoring with Background Removal

– MetID w Stats Expected and Unknown w Background Removal

– MetID w Stats Expected and Unknown w MMDF and Background Removal

– MetID w Stats Expected w Background Removal

– MetID w Stats Expected w FISh Scoring and Background Removal

• NaturalProduct

– Natural Product Unknown ID w Online and Local Database Searches

– Natural Product Unknown ID w Stats Online and Local Database Searches

• PolymerID

– Unknown Polymer ID w Stats Online and Local Database Searches

– Unknown Polymer ID with Online and Local Database Searches

• Stable Isotope Labeling folder

– Stable Isotope Labeling w Metabolika Pathways and ID using Local Databases

– Stable Isotope Labeling w Metabolika Pathways and ID using Online Databases
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Best Scans for Composition Prediction and Spectral Matching
For each set of raw data files that you submit for processing, the application can select the best 
MS1 scan and the best MS2 scan for each compound from different input files. This selection 
is done within the compound consolidation nodes—that is, by the Group Compounds node 
and the Group Expected Compounds node.

For information about how the application determines and uses the best scans, see these 
topics:

• Best MS1 Scan for Isotope Pattern Matching

• Best MS2 Scan for Fragments Matching and Spectral Comparison

Best MS1 Scan for Isotope Pattern Matching

To determine the best MS1 scan to use for a compound across a set of input files, the 
consolidation nodes select the MS1 scan with the highest resolution and retention time closest 
to the compound’s peak apex.

The application sends the isotope pattern information from the best MS1 scan to the 
following workflow nodes for further processing:

• To the Predict Compositions node for isotope pattern matching

• To the Apply Spectral Distance node for calculating the spectral distance between the 
assigned elemental composition and the experimental isotope pattern

Best MS2 Scan for Fragments Matching and Spectral Comparison

To identify compounds by fragmentation data or to determine the spectral similarity between 
the fragmentation scans for two different compounds, the application uses the “best MS2 
scan” for each compound.

To determine which MSn scans to attach to a compound, the application does the following:

1. Searches for MS2 scans for the precursor ion within the RT range of the compound’s peak 
apex ± FWHM.

2. If it finds no MS2 scans for the precursor ion within this range, it searches for scans 
within the start and end points of the compound’s chromatographic peak, as determined 
by the Parameterless Peak Detection (PPD) algorithm. 

3. To determine the best MS2 scan, it does the following:

a. Selects the MS2 scan for the preferred ion.

b. If it finds multiple spectrum trees for the preferred ion, it uses the MS2 scan from the 
MS1 scan with the highest precursor intensity.
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For each compound, the Group Expected Compounds and the Group Compounds nodes 
send all the MS2 scans associated with that compound to the following nodes:

• Search mzCloud node

• Search mzVault node

For each compound, the Group Compounds node sends the best MS2 scans to the Apply 
mzLogic node.

Quality Control Samples for Batch Normalization
When acquiring raw data files for a large sample set, use pooled quality control samples to 
compensate for time-dependent batch effects. For information about batch effects, refer to the 
following article: Procedures for large-scale metabolic profiling of serum and plasma using gas 
chromatography and liquid chromatography coupled to mass spectrometry.3 

To create a pooled quality control sample, combine a small aliquot from each sample in the 
processing batch (input file set to be processed to create one result file). When setting up an 
acquisition sequence, bracket the unknown samples by injecting this pooled quality control 
sample at regular intervals. 

When the processing workflow includes the Normalize Areas Node and the input file set 
includes QC samples, the application uses the QC samples to create a regression curve of area 
versus acquisition time for each detected compound. 

The application does not create a regression curve for a particular compound and does not 
correct the areas in the non-QC samples unless all three of these conditions are met:

• It detects the compound in the user-specified minimum percentage of the QC samples.

• The relative standard deviation of the detected peak areas for the compound in the QC 
samples does not exceed the user-specified threshold. 

• The number of samples acquired between the QC samples does not exceed the 
user-specified number.

3 Dunn, W.B.; Broadhurst, D.; Begley, P.; Zelena, E.; Francis-McIntyre, S.; Anderson, N.; Brown, M.; Knowles, 
J.D.; Halsall, A.; Haselden, J.N.; Nicholls, A.W.; Wilson, I.D.; Kell, D.B.; Goodacre, R. Human Serum 
Metabolome (HUSERMET) Consortium. Nat Protoc. 2011, 6(7), 1060-83. 

Note  The application checks the RSD of the peak areas both before and after 
applying a correction for the relative acquisition time. If the RSD for the corrected 
peak areas differs by more than 75% of the user-specified threshold, the application 
does not create a corrected-area regression curve for the compound.
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You can view the results of the batch normalization process in the Compounds result table 
and the Compound Area Corrections view. The Compounds table displays the corrected 
compound areas. The Compound Area Corrections view shows the effect of the signal 
correction on the absolute compound areas. If the application excluded the selected 
compound during the QC signal correction step, the Compound Area Corrections view is 
empty.

Stable Isotope Labeling
Stable isotope labeling experiments are fundamental to understanding metabolic pathways 
and the turnover rate (flux) for the molecules in these pathways. Where traditional approaches 
are usually limited to targeted analyses, which detect and quantify known compounds and 
their labeled downstream metabolites, the Compound Discoverer application makes full use 
of high-resolution Orbitrap™ data and offers state-of-the-art analyses for unknown labeled 
compounds. 

Using an unlabeled reference sample, the application detects unknown compounds above a 
specified minimum intensity threshold, determines their elemental composition and identity, 
and then determines the labeled counterparts (isotopologues) of these compounds in the 
samples marked as labeled. 

You can use any isotopic label in your experiments; however, when you use a label other than 
carbon-13, you must specify the labeled element in the processing workflow. 

The application reports the isotopologues and the fractional label incorporation (exchange 
rate) for each compound. You can overlay the exchange rate as well as other statistical data 
onto pathways using Metabolika™, which is directly integrated into the Compound 
Discoverer application.

To acquire and process stable isotope labeled data, do the following:

1. Acquire LC/MS/MS data for a set of samples where at least one sample corresponds to the 
unlabeled state of the system.

2. Select the following sample types:

• For unlabeled samples, select Sample, Identification Only, Quality Control, or 
Blank as appropriate. You must select Sample (or Control or Standard) for at least 
one sample.

• For labeled samples, select Labeled.

3. Select one of the processing workflows in the following folder:

Common Templates > Workflow Templates > Stable Isotope Labeling

Note   Currently, the application treats Sample, Control, and Standard samples 
the same way. This functionality is subject to change in future releases.
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4. When using a label other than carbon-13, customize the parameter settings for the 
Analyze Labeled Compounds node.

During data processing, the application does the following: 

1. Detects and identifies the compounds in the unlabeled samples. 

2. Submits the compounds with assigned formulas to the Analyze Labeled Compounds 
node which does the following: 

a. Generates isotopologues for each detected compound by replacing one occurrence of 
an atom at a time by its specified isotope. The compound’s formula or the 
user-specified limit defines the number of exchangeable atoms, whichever is smaller.

b. Simulates the isotope pattern for each isotopologue by using its formula and the 
spectral resolution of the raw data.

c. Consolidates the isotopologue patterns for each compound to get the final set of 
expected masses, considering the specified mass tolerance and the spectral resolution 
of the raw data.

d. Generates an XIC trace for each expected mass and detects the chromatographic 
peaks.

e. Deconvolves the chromatographic peaks to determine the relative amount of each 
isotopologue.

f. Flags compounds containing contaminating masses in unlabeled samples, as well as 
unusual isotopologue distributions and insufficient pattern fits. 

FISh Scoring for Targeted Compounds and Proposed Structures

For targeted compounds, you can add FISh scoring to the automated analysis, and for 
unknown compounds, you can apply FISh scoring to your proposed structures. 

The FISh scoring algorithm attempts to match the fragment structures in a list of expected 
fragments to the centroids in the fragmentation scans of the precursor ions.

When a precursor ion scan is followed by only one fragmentation scan, the node calculates the 
FISh coverage score as follows:

where:
# matched centroids represents the number of matched centroids.

Note  In the current version of the application, the FISh scoring algorithm uses all the 
fragmentation scans (in the spectrum tree for a compound), compared to earlier versions 
of the application that only used MS2 scans. Therefore, if you reprocess data sets that you 
already processed with an earlier version of the application, and these data sets include 
MSn scans (where n > 2), the FISh coverage scores might be lower. 

FISh coverage score
# matched centroids

# used centroids
-------------------------------------- 100=
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# used (matched + unmatched) centroids represents the number of centroids in the 
fragmentation scan that are above the user-specified signal-to-noise threshold. The 
algorithm skips centroids below the user-specified signal-to-noise threshold.

When a precursor scan is followed by more than one fragmentation scan, the node calculates a 
composite score as follows:

The FISh scoring algorithm annotates the centroids in the fragmentation scans with the 
matching fragment structures. It also provides a FISh Coverage score for data-dependent scans 
in the Mass Spectrum view legend and a FISh Coverage score in the Expected Compounds 
table.

Calculating the Mass Defect of an Elemental Composition
In the Compound Discoverer application, you can use the mass defect of an elemental 
composition as follows:

• Filter the spectral data during processing to keep or remove expected and detected 
compounds by their mass defect.

• Calculate the mass defect of each detected compound by using multiple calculation 
methods during processing, and then sort the resulting table of detected compounds by 
their mass defect.

• View a plot of the mass defects for the detected compounds versus their molecular 
weights to visualize the similarity between the compounds.

The application uses the following formulas to calculate the mass defect of an elemental 
composition.

FISh coverage score
per all scans# matched centroids 
per all scans# used centroids 

-------------------------------------------------------------------- 100=



1 Introduction
Calculating the Mass Defect of an Elemental Composition

38 Compound Discoverer User Guide Thermo Scientific

Related Topics

• Filter By Mass Defect Node

• Calculate Mass Defect Node

• Working with the Mass Defect Plot View

Table 6. Mass defect types

Mass defect type Formula

Fractional mass exact mass – floor of the exact mass

where:

exact mass = monoisotopic mass of the elemental 
composition

Standard mass defect exact mass – nominal mass

where: 

nominal mass = integer mass of the elemental composition

The application calculates the integer mass by using the selected 
rounding function:

• Floor rounds down

• Ceiling rounds up 

• Round rounds to the nearest integer value

Relative mass defect 1e6 × (exact mass – nominal mass)/exact mass

Kendrick mass defect Kendrick mass – nominal Kendrick mass

where:

Kendrick mass = a × (b/c)

a = exact mass of the elemental composition

b = nominal mass of the Kendrick formula

c = exact mass of the Kendrick formula
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Using mzLogic to Score Candidates for Unknown Compounds
There are two ways to run the mzLogic scoring algorithm:

• Running an Untargeted Analysis that Includes the mzLogic Node

• Running an mzLogic Analysis from the mzLogic Analysis View

Running an Untargeted Analysis that Includes the mzLogic Node

Processing workflow templates that include the following terms—Database Searches or 
mzLogic—in their file names include the mzLogic node and one or more of the compound 
identification nodes and pathway mapping nodes.

When an mzCloud search yields no identity matches for an unknown compound, the 
mzLogic algorithm provides a ranking score for the compound hits from the identification 
nodes and pathway mapping nodes.

The mzLogic algorithm can provide a ranking score for the various database search results 
when an unknown compound has available data-dependent MS2 scans and similarity results 
from an mzCloud similarity search.

During data processing, the mzLogic node does the following:

1. Runs a forward search and a reverse search using the mzCloud service.

2. For compounds that have available MS2 scans, scores all the structure candidates (or the 
specified maximum number of candidates) from the attached input nodes.

3. Adds the following columns to the result tables:

• Adds the #Similarity Results column to the Compounds table. By default, this 
column is hidden.

• Adds the mzLogic Score column to the following related tables as applicable: 
ChemSpider Results, Mass List Search Results, Metabolika Results, and BioCyc 
Results.

Note  The ranking score is not a probability score. It is only a measure of how similar the 
fragmentation spectra for a putative compound are to closely matching spectra in the 
mzCloud spectral database.

Note  The following nodes can supply structures to the Apply mzLogic node: Search 
ChemSpider, Search Mass Lists, Map to BioCyc Pathways, and Map to Metabolika 
Pathways.

The mass lists that you select for the Search Mass Lists node must include structures. 
The Endogenous Metabolites database 4400 Compounds.masslist file does not 
include structures.
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Running an mzLogic Analysis from the mzLogic Analysis View

If the analysis for a result file did not include the Apply mzLogic node, or if you suspect that 
the online mzCloud spectral database now includes more spectral data, use the mzLogic 
Analysis view to rank the putative structures for your unknown compounds.

Because the mzLogic Analysis view includes a link to the ChemSpider database where you can 
select putative structures, the result file does not need to include structure results.

Related Topics

• Running an mzLogic Analysis

Managing the Start Page’s Recent File Lists
The right side of the Start Page displays lists of the most recently opened study and result files. 
You can clear the recent file lists, remove files from these lists, keep a specific file at the top of 
each list, or open the folder where a specific study file or result file resides.

See these topics: 

• Keeping a File Name at the Top of a Recent File List

• Removing Files from the Recent File Lists

• Exploring File Folders from the Recent File Lists

Keeping a File Name at the Top of a Recent File List

 To keep a study name or result file name at the top of its list on the Start page

Click the pin icon to the left of the name.

The orientation of the pin changes from  to .

Removing Files from the Recent File Lists

You can remove individual files from the recent file lists or completely clear each list.

 To remove files from the recent files lists

• To remove a single file, right-click the file and choose Remove From List.

–or–

• To clear a list, right-click any file in the list and choose Clear List. 

Note  For information about using the File menu commands to manage the recent file 
lists, see “Application Menu Bar” on page 7.
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Exploring File Folders from the Recent File Lists

You can access the file folder for a specific study or result file from the recent files list.

 To explore the contents of a folder for a study file or result file

Under the recent files list, right-click a study file or a result file and choose Explore Path.

Windows Explorer opens the folder for the selected study file or result file.

Auto-Hiding the Start Page, the Chromatograms View, and the Mass 
Spectrum View

To make more space for other views, you can auto-hide the Start Page and the 
Chromatograms and Mass Spectrum views. The auto-hide features collapses each of these 
items down to a small tab.

 To use the auto-hide feature

1. Right-click the page tab and choose Dockable.

The Auto Hide command becomes available for the Start Page and the Chromatograms 
and Mass Spectrum views. This command remains unavailable for all other dockable 
pages. 

2. Right-click the page tab and choose Auto Hide.

The tab changes to a vertical tab on the left of the application window.

3. To view the hidden page, click its tab.

4. To hide the page, click anywhere in the application window outside the page borders.

Working with the Tabbed Documents
A tabbed document is a top-level tabbed page below the toolbar in the Compound Discoverer 
window.

The following pages are tabbed documents in the application window:

• Start Page ( )

• Study files (  Study Name )

• Result files (  Result File Name )

• Lists and Libraries manager ( )

• Configuration ( )
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• Job Queue ( )

• Report Templates (  Report Template Name)

• License Manager ( )

To display, dock, or hide the tabbed documents, see these topics:

• Tabbed Documents List

• Opening a Hidden Tabbed Document

• Tab Groups

• Shortcut Menu Commands for Tabbed Documents

Tabbed Documents List

Although you can have all the tabbed documents open simultaneously, including multiple 
study files and result files, the number of tabs that the application can display is limited by the 
monitor size. As you open more files than the monitor can display, the tabs begin to disappear 
from view in the order that you opened the files. To indicate that one or more tabs are hidden, 
the Current Tabs icon changes from  to  (Figure 10).

Figure 10. List of open files and pages

Opening a Hidden Tabbed Document

 To display an open tabbed document when its tab is hidden

Click the Current Tabs icon, , to display a list of open files. Then, select the 
appropriate tabbed page from the list.

The selected page becomes active.

Note  Excluding the Start Page and Job Queue, views that open from the View menu or 
toolbar are not tabbed documents—that is, when they are open, they are not listed in the 
open files. 

List of open files and pages

Current Tab 
icon
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Tab Groups

When you have two or more tabbed documents open in the same tab group, you can create 
more tab groups. Each tab group has its own Current Tabs icon, . Figure 11 shows tab 
group examples.

Figure 11. Orientation of tab groups

Single tab group

Two 
horizontal 
tab groups

Two vertical tab groups

Current Tab icon
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Shortcut Menu Commands for Tabbed Documents

Table 7 describes the shortcut menu commands that control the tabbed document properties. 

Table 7. Shortcut menu for tabbed documents

Command Description

Dockable Available for the Start Page and the result file views. This 
command is not available for the Job Queue page.

Activates the Auto Hide command.

Tabbed Document Makes the page a tabbed document. 

Available for the Start Page, Job Queue page, License Manager 
page, library pages, study pages, result file views, and report 
template pages. 

Auto Hide Available for the Start Page and the views in the View menu when 
these pages are dockable windows. This command is not available 
for the Job Queue page.

Hides the page while leaving the tab visible. Clicking the tab 
opens the page. Clicking outside the page closes the page if more 
than one tabbed document is open. The location of the tab 
depends on the tabbed document’s position in the application 
window.

Hide Closes the tabbed document.

Move to Previous Tab 
Group

Changes the position of the tabbed document.

Available only when the application window contains two or more 
tabbed groups.

Move to Next Tab 
Group

Changes the position of the tabbed document.

This command is available only when the application window 
contains two or more tabbed groups. 

New Horizontal Tab 
Group

Moves the selected tabbed document to a new horizontal tab 
group.

Available only when there are two or more tabbed documents that 
belong to the same tab group in the application window. Each tab 
group has its own Current Tab icon.

New Vertical Tab 
Group

Moves the selected tabbed document to a new vertical tab group.

Available only when there are two or more tabbed documents that 
belong to the same tab group in the application window. Each tab 
group has its own Current Tab icon.
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Rearranging the Tabbed Documents and Graphical Views
To make the best use of your screen space, rearrange the graphical views and tabbed 
documents as follows:

• Use the mouse pointer to move the graphical views that are available when you open a 
result file from one dock position to another dock position or to a second monitor. 

• Use the mouse pointer or the shortcut menu commands to rearrange the tabbed 
documents within the application window. 

To rearrange the tabbed documents and result page views, follow these topics as needed:

• Moving a Graphical View to Another Monitor

• Using the Mouse Pointer to Rearrange Tabbed Documents and Graphical Views

• Using the Shortcut Menu Commands to Rearrange the Tabbed Documents

Moving a Graphical View to Another Monitor

The graphical views that are available for a specific result file depend on the processing 
workflow used to generate the file.

 To move a graphical view to another monitor

Use the mouse pointer to drag the view by its title bar. 

Using the Mouse Pointer to Rearrange Tabbed Documents and Graphical Views

 To move a graphical view or a tabbed document

1. Drag the view by its title bar or the document by its tab. 

As you drag a view or a tabbed page, a guide tool appears. The guide tool consists of four 
directional arrows (inner arrows) that are arranged in a diamond pattern around a central 
circle. In addition to the guide tool, a directional arrow (outer arrows) appears in the 
middle of each of the window’s four edges. 

Figure 12. Guide tool
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2. To dock a view or tabbed page in a new position, align the pointer with the appropriate 
directional arrow, and then release the mouse button.

Table 8. Rearranging the views and tabbed pages

To do this ... Do the following ...

Move the selected view above the 
second view.

Move the tabbed page to a 
horizontal group above the 
current group.

Drag the pointer to the inner up arrow, .

Move the selected view below the 
second view.

Move the tabbed page to a 
horizontal group below the 
current group.

Drag the pointer to the inner down arrow, .

Move the selected view to the left 
of the second view.

Move the tabbed page to a group 
on the left.

Drag the pointer to the inner left arrow, .

Move the selected view to the 
right of the second view.

Move the tabbed page to a group 
on the right.

Drag the pointer to inner right arrow, .

Make both views tabbed. Drag the title bar to the tabs icon.

The application displays the first view 
and creates a tab for the second view.

Move the selected view to the top 
or bottom of the window.

Move the tabbed page to the top 
or bottom of the window.

Drag the pointer to the outer top arrow or the 
outer bottom arrow.

Move the first view to the left side 
or right side of the window.

Move the tabbed page to the left 
side or right side of the window.

Drag the pointer to the outer arrow at the left of 
the window or the outer arrow at the right of the 
window.
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Using the Shortcut Menu Commands to Rearrange the Tabbed Documents

 To move a tabbed document to another group

Right-click the document and choose one of these commands:

• Move to Next Tab Group

• Move to Previous Tab Group

• New Horizontal Tab Group

• New Vertical Tab Group

Related Topics

• Shortcut Menu Commands for Tabbed Documents
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2

Getting Started

These topics summarize the application setup, data analysis, data review, and reporting 
processes for the Compound Discoverer application. To get started with the Compound 
Discoverer application, follow these topics in order.

Setting Up the Lists and Libraries and Checking Access to the Online 
Databases

To set up your lists and libraries and test your computer’s access to the online databases, follow 
these topics as needed.

• Setting Up the Expected Compounds Library for a Targeted Analyses

• Checking the Access to the Online Databases for Identifying Unknown Compounds

Related Topics

• “Using the Lists and Libraries Manager” on page 497

• “Testing Communication to the Online Databases” on page 611

Contents

1. Setting Up the Lists and Libraries and Checking Access to the Online Databases

2. Setting Up a Study and an Analysis and Processing a Data Set

3. Opening the Result File, Reviewing the Data, and Creating a Report

Note  While the application comes with a local mzVault library and several mass lists, you 
can also import your own custom spectral libraries and mass lists.
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Setting Up the Expected Compounds Library for a Targeted Analyses

To identify the reaction products for specific parent compounds, you must add these parent 
compounds to the Expected Compounds library.

 To add a compound to the Expected Compounds library

1. From the menu bar, choose Lists & Libraries > Expected Compounds.

Figure 13. Lists & Libraries menu

2. Click New.

The Compound Editor opens.

Figure 14. Compound Editor

3. At the bottom of the editor, click ChemSpider.

The ChemSpider Search window opens.
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4. Enter the name of a compound and click Search.

Figure 15. ChemSpider Search window with a result for caffeine

5. Click Select.

The ChemSpider Search window closes.

6. In the Compound Editor, click Save.

The new compound appears in the library.

Figure 16. Expected Compounds library with caffeine (new entry) and omeprazole (existing entry)

Related Topics

• “Modifying the Expected Compounds List” on page 498
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Checking the Access to the Online Databases for Identifying Unknown Compounds

Check the computer’s access to the KEGG Pathways, BioCyc Pathways, mzCloud, and 
ChemSpider databases. 

 To check the computer’s access to the online databases

1. From the menu bar, choose Help > Communication Tests.

2. Click the database’s tab.

3. Click Run Tests.

Figure 17. mzCloud communication tests

4. (Optional) To use the BioCyc database, set up a BioCyc subscription.

Related Topics

• “Running the Communication Tests” on page 612

• “Setting Up a BioCyc Account or Subscription” on page 575
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Setting Up a Study and an Analysis and Processing a Data Set
A study is where you define your samples. An analysis is where you specify how you want to 
analyze the raw data (with a selected processing workflow), the samples (raw data files) that 
you want to process, (optional) the sample groups and ratios for a differential analysis, and the 
name of the result file for storing the processed data.

Follow these topics in order:

1. Setting Up a New Study and a New Analysis by Using the Wizard

2. Troubleshooting an Analysis

3. Submitting a Run to the Job Queue

Setting Up a New Study and a New Analysis by Using the Wizard

 To set up an new study and a new analysis

1. From the menu bar, choose File > New Study and Analysis.

Figure 18. File menu

The New Study and Analysis Wizard opens. To display instructions for each page of the 
wizard, click the Show Description icon, .

2. On the Study Name and Processing Workflow page, do the following:

a. In the Study Name box, type a name for the study. 

Note  The application creates a study file and a study folder with this name. The 
application stores the study file and all the result files that you generate by 
running analyses within the study in the study folder.
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b. Click the browse icon to the right of the Studies Folder box, and then browse to the 
folder where you want to store your studies. 

c. In the Processing area, open the Workflow list, and then select a processing workflow 
template for your area of study:

d. Read the description of the processing workflow.

Figure 19 shows the selection of a processing workflow that identifies detected 
compounds by searching online databases. 

Figure 19. New Study and Analysis wizard–Study Name and Processing Workflow page

Note  You can store all your studies in this top-level folder—that is, you do not 
need to create a new top-level Studies folder each time you create a new study. 

When you create a study, the application creates a study folder with the same 
name as the study and stores this folder in the top-level Studies folder. 

• Degradant ID • Forensics • Natural Products

• Environmental • Metabolism (MetID) • Polymers

• Extractables & 
Leachables

• Metabolomics • Stable Isotope 
Labeling 
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e. Click Next.

3. On the Input File Selection page, do the following:

a. Click Add Files.

The Add Files dialog box opens.

b. Browse to and select the raw data files that you want to add to the study, and then 
click Open.

c. Click Next.

4. (Optional) On the Input File Characterization page, define and assign the study factors 
for the sample set and assign the sample types. Then, click Next.

5. (Optional) On the Sample Groups and Ratios page, set up the sample groups and ratios 
for a differential analysis. Then, click Next.

6. Click Finish to exit the wizard.

The study opens as a tabbed document at the left of the application window, and the 
Analysis pane opens to the right of the study. 

The study consists of four tabbed pages: Study Definition, Input Files, Samples, and 
Analysis Results. The two tabs (Grouping & Ratios and Workflows) to the right of the 
study pages are part of the analysis—that is, if you close the Analysis pane, these tabs also 
close.

The Analysis pane lists the selected processing workflow, the name of the result file, and 
the selected raw data files. If the analysis is valid, the Run button is green. Otherwise, the 
Run button is unavailable.

Tip  To quickly learn the basic workflow for the application—from creating a new study to 
reviewing a result file—skip step 4 and step 5, as setting up the study variables can be time 
consuming. You can set up the study factors and the sample groups for your sample set 
after you become more familiar with the application.

For a guided tutorial to setting up a study, including setting up the study factors for a 
sample set, follow the tutorial for your area of study. You can access these tutorials by 
choosing Help > Manuals from the application menu bar. 

Tip  To define the study factors and characterize the input files, follow the instructions 
in the left pane or press the F1 key, , on your computer keyboard to open the 
Help to the Characterizing New Input Files topic.

Tip  To set up the sample groups and ratios, follow the instructions in the left pane or 
click anywhere on the Sample Groups and Ratios page, and then press the F1 key, 

, on your computer keyboard to open the Help to the Setting Up the Sample 
Groups and Ratios for a New Analysis topic.
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Figure 20. Study page and Analysis pane

7. (Optional) In the Result File box of the Analysis pane, rename the result file.

Related Topics

• “Starting a New Study and Setting Up an Analysis” on page 67

Study pages Analysis pages Analysis pane

Default file name for 
the result file 
(.cdResult)

Run button

Note  By default, the application uses the name of the first input file as the result file 
name. 
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Troubleshooting an Analysis

 To troubleshoot the analysis when the Run button is unavailable

1. In the Analysis pane, point to the Caution symbol, .

A pop-up message lists the missing analysis items. 

If you are working with one of the defined processing workflows, the most common 
errors are not selecting the following items for the workflow nodes:

• Compounds for the Generate Expected Compounds and Create FISh Trace nodes

• A mass list for the Search Mass Lists node

• A spectral database for the Search mzVault node

• An isotope pattern for the Pattern Scoring node

• The isotope ratios for the Create Pattern Trace node

• A Compound Class fragment list for the Compound Class Scoring node

2. Click the Workflows tab and fix the analysis errors until the Caution symbol disappears.

To fix a missing parameter error for a node ( ), select the node in the Workflow Tree 
pane on the Workflows page. Then, on the Parameters page for the node, select the 
missing item.

For example, if you have not specified any compounds for the Generate Expected 
Compounds node, select the node in the Workflow Tree area, and then select one or more 
compounds from the Compound list.

Figure 21 shows a processing workflow template for a targeted analysis. For this template, 
you must select one or more compounds for the Generate Expected Compounds node.

Note  The Current Workflow Issues table at the bottom of the Workflows page also 
lists all the processing workflow’s issues. This table does not list other validation 
issues, such as no input files in the Files for Analysis area of the Analysis pane.

Tip  In Compound Discoverer 3.1 or later application, you can leave the analysis open 
as you update any of the lists under Lists & Libraries.
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Figure 21. MetID w Stats Expected w Background Removal workflow template

Figure 22 shows the Max ID template for Metabolomics studies. This template is only 
suitable for a single sample, as it does not include the Align Retention Times node, which 
is required for aligning the detected compounds across all the input files. Because the 
template is designed to process a single sample, it does not include the Differential 
Analysis node under Post Processing Nodes.

Parameters for the 
Generate Expected 
Compounds node
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Figure 22. Untargeted processing workflow with mzLogic and Molecular Networks
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Submitting a Run to the Job Queue

 To submit a run to the Job Queue

1. In the Analysis pane, do the following:

a. Rename the result file as appropriate.

b. Click Run.

2. If the Analysis Validation Issue prompt opens, decide whether to ignore the issue or 
cancel the run.

If there are no validation issues or you click Ignore to continue submitting the job, the 
Job Queue page opens.

Opening the Result File, Reviewing the Data, and Creating a Report

To review the processed data and create a report, follow these topics in order:

1. Opening the Result File from the Job Queue

2. Reviewing the Compounds that the Analysis Detected or Found

3. Displaying Only the Items of Interest in a Result Table

4. To create a report, follow either of these topics:

• Exporting a List of Compounds to a Spreadsheet

• Printing a Report Using a Defined Template

Note  By default, the application gives the result file the same name as the first 
input file.

Tip  Not defining the ratios on the Grouping & Ratios page when the processing 
workflow includes the Differential Analysis node is one of the most common 
validation issues. If you do not want the processing workflow to perform a differential 
analysis, click Ignore. Otherwise, click Cancel, set up the sample groups and ratios, 
and then click Run again.

Note  When a graphical view or result table is the active item, pressing the F1 key opens 
the Help topic for the specific view or table.
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Opening the Result File from the Job Queue

 To open a result file

1. If the Job Queue page is closed, choose View > Job Queue from the application toolbar.

2. On the Job Queue page, double-click the completed job.

The result file opens as a tabbed page.

Reviewing the Compounds that the Analysis Detected or Found

 To review the processed data

1. Select a compound of interest in the Compounds table or the Expected Compounds 
table. 

The respective XIC traces appear in the Chromatograms view and the best MS1 spectrum 
appears in the Mass Spectrum view.

Figure 23 shows the result page for a single sample that was processed with the following 
workflow template: Untargeted Metabolomics using Online Databases, mzLogic, and 
Molecular Networks. 

Figure 23. Example result page

2. Review the various result tables and open other views as applicable.

Related Topics

• “Reviewing the Analysis Results” on page 247
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Displaying Only the Items of Interest in a Result Table

Use the Result Filters view to display only the compounds of interest in the Compounds table 
(for an untargeted analysis) or the Expected Compounds table (for a targeted analysis).

 To display only the checked compounds in the table 

1. Open a result file and click the Compounds tab or the Expected Compounds tab.

2. In the result table that you selected, select the compounds of interest by selecting their 
respective check boxes in the Checked column.

3. From the menu bar, choose View > Result Filters.

Figure 24. View menu

The Result Filters view opens as a floating window.

4. In the Result Filters view (Figure 25), under Compounds in the right pane, click Add 
Property, and then select Checked from the drop-down properties list.
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Figure 25. Adding the Checked property for filtering the Compounds table

5. To apply the filter to the Compounds table, click Apply Filters.

6. In the Compounds table, only the checked compounds remain visible.

Exporting a List of Compounds to a Spreadsheet

 To export the compounds data to a spreadsheet 

1. Use the Result Filters view to filter the data or select the check boxes for the compounds 
of interest.

2. Right-click the Compounds table or the Expected Compounds table and choose the 
appropriate format:

a. To export all the displayed columns, choose Export > As Excel.
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Figure 26. Shortcut menu for the Compounds table

The Export to Excel dialog box opens.

b. Select the result tables of interest.

c. To export only the checked compounds, select the Checked Items Only check box.

d. In the Path box, browse to the folder where you want to store the spreadsheet.

e. Click Export.

The application exports the spreadsheet to the selected folder.
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Printing a Report Using a Defined Template

 To print a report using a defined report template

1. Open the Expected Compounds table or the Compounds table.

2. Filter the table to display only the compounds of interest. 

3. From the application menu bar, choose Reporting > Create Report.

4. In the Open Report Design Template dialog box, select one of the Compounds report 
templates or one of the Expected Compounds templates. 

Figure 27. Report templates

5. Click Open.

The report resolution page opens and the application resolves the data with the template 
(Figure 28).
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Figure 28. Resolved report

6. On the report resolution page, click the Print icon, , in the toolbar to print the 
report.

7. In the Print dialog box, do the following:

a. Select the appropriate printer and the page range that you want to print.

b. If you are not printing on A4 paper, change the printer setting.

c. Click OK to print the report.

Related Topics

• “Generating a Report with an Existing Report Template” on page 332

Note  The report templates that come with the application default to printing on 
A4 paper.
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3

Starting a New Study and Setting Up an Analysis

To create a new study and optionally to set up an analysis, see these topics.

About Studies and Analyses
In the Compound Discoverer application, you start analyses (data processing) from within the 
study environment.

For information about studies and analyses, see these topics:

• Studies

• Input Files

• Study Factors

• Sample Types

• Analyses

Contents

• About Studies and Analyses

• Data Storage Architecture

• Starting the New Study and Analysis Wizard

• Setting Up the Study Folders and Selecting a Processing Workflow

• Adding Input Files to a New Study

• Characterizing New Input Files

• Using the Regular Expression Builder to Extract the Study Factors

• Setting Up the Sample Groups and Ratios for a New Analysis

• Preparing to Submit a Run to the Job Queue

• About Accessing the Wizard Help
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Studies

A study includes a list of input files with their location, the sample information for each file, 
and a list of the analyses run within the study. The sample information includes the file name, 
the study factor values, and the sample type for each sample. 

Creating a new study automatically creates a study file (.cdStudy) for storing the study 
information and a study folder for storing the study file and any result files (.cdResult) 
generated by running analyses within the study. The study file and its folder share the same 
name (see “Data Storage Architecture” on page 70).

Input Files

Input files are the raw data files acquired from an LC/MS/MS experiment. The file format for 
raw data files acquired with a Thermo Scientific MS is RAW. 

To predict the elemental compositions of the sample components, the raw data must include 
high-resolution accurate-mass MS1 scans. To search the mass spectral libraries for matching 
fragmentation spectra, the raw data must include data-dependent MS2 or higher scans.

Study Factors

A study factor is an experimental variable that might have a statistically significant effect on 
the sample population being studied. 

There are three types of study factors: 

• Categorical Factors include non-quantifiable categories such as organism, matrix, tissue, 
gender, and so on. 

• Numerical Factors include quantifiable variables such as time, amount, concentration, 
and so on. You can assign a unit to a numeric study factor; however, the unit is only a 
label and is not used in any calculations. 

• Biological Replicate Factors include non-quantifiable categories with samples from 
different entities of the same type under the same conditions and provide a measure of the 
variability associated with these conditions. Use the biological replicate factor for nested 
experiments. See Appendix A, “Experiment Design for Comparison Statistics.”  You can 
add only one biological replicate factor to a study. 

Sample Types

Table 9 describes the sample types that the application supports and how the it uses these 
sample types.
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Related Topics

• Selecting the Sample Types

Analyses

An analysis includes the processing workflow that extracts information from the raw data for 
each sample, such as the chromatographic peak areas and mass spectra for known and 
unknown compounds. It also includes the group ratios required to run a differential analysis, 
a list of input files, and the name of the result file where the processing results reside.

Related Topics

• Creating, Running, and Reprocessing Analyses

• Understanding Processing Workflows

• Reviewing the Analysis Results

Table 9. Sample types

Sample type Application use

Samplea

a The application attributes the same functionality to the Sample, Control, and Standard sample types. You can use 
the Control and Standard sample types to label your control or standard samples; that is, you can use these sample 
types as an additional study variable for grouping.

Detects the compounds in the sample.

Controla Detects the compounds in the sample.

Blank Detects the compounds in the sample. When the processing 
workflow includes one or both Mark Background Compounds 
nodes, marks these components as background compounds.

Identification Only Does not report the chromatographic peak areas for the sample’s 
compounds. Uses the sample’s fragmentation scans for component 
identification when the processing workflow includes the Group 
Compounds node.

Quality Control Detects the compounds in the sample. Pools the QC samples to 
determine a group area for each detected compound for area 
normalization. 

Standarda Detects the compounds in the sample.

Labeled Determines the formulas for the compounds in the labeled 
samples. 
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Data Storage Architecture
Figure 29 shows the hierarchy of the application folders. The studies folder is the top-level 
folder for all your studies or a particular set of studies. Each study folder within the studies 
folder holds one study file (.cdStudy) and one or more result files (.cdResult).

Figure 29. Studies folder structure 

Note  You can create more than one top-level folder for your studies. Each time you open 
the New Study and Analysis Wizard, it opens to the last opened top-level folder.

Study 1.cdStudy

Study 2.cdStudy

Study 3.cdStudy

File B1.cdResult

File A1.cdResult

File C1.cdResult

My Studies

Study 2

Study 3

Study 1

Top-level folder

Study folders in the 
top-level folder

Files in each study folder
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This figure shows an example of the directory hierarchy for a study named Omeprazole Study 
with one result file. The individual study folder and the study file share the same name.

Starting the New Study and Analysis Wizard
You can access the wizard from the Start Page, the File menu, or the application toolbar.

 To start the New Study and Analysis Wizard

Do one of the following:

• From the menu bar, choose File > New Study and Analysis.

• In the toolbar, click the Create a New Study and Analysis icon, .

–or–

• On the Start page under What Would You Like to Do?, click New Study and 
Analysis.

The New Study and Analysis wizard opens. Unlike other areas of the application, the 
wizard has embedded “How To” instructions.

Top-level folder where the application stores the individual study folders

Contents of the 
Omeprazole Study 
folder

Individual study folder
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Figure 30. First page of the New Study and Analysis Wizard

Setting Up the Study Folders and Selecting a Processing Workflow
Use the Study Name and Processing Workflow page (step 2 of 6) of the New Study and 
Analysis Wizard to do the following:

• Name the current study and its storage folder.

• Select the top-level folder for storing all the study folders or a subset of the study folders. 

• (Optional) Select a template file for the study.

• (Optional) Select a processing workflow for the analysis.

Follow these topics as needed:

• Naming a Study and Its Folder

• Creating or Selecting the Top-Level Folder for the Study

• Selecting a Study Template

• Selecting a Processing Workflow for the Analysis

After you complete this page of the wizard, go to the next page where you select the input files 
for the analysis.

Displays the embedded Help to the left of the page

Note  A template file includes defined study factors.

Note  You can select a processing workflow after you create the study.
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Figure 31 shows page 2 of the wizard.

Figure 31. Study Name and Processing Workflow page of the wizard

Naming a Study and Its Folder

The application uses the specified name for the study file (.cdStudy) and the study folder 
where it stores the study file. In addition, the application stores the result files from analyses 
run within the study in the same study folder.

 To name the study and its folder

On page 2 of the wizard, in the Study Name box, type a name for the new study.

For more information, see “Data Storage Architecture” on page 70.

Creating or Selecting the Top-Level Folder for the Study

The studies folder is where the application stores the individual study folders.

 To specify the top-level folder where you want to store the new study folder

On page 2 of the wizard, do the following:

• Use the current folder name and location that is displayed in the Studies Folder box.

–or–

• Browse to or create a new folder.

The new folder name and location appear in the Studies Folder box.
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Selecting a Study Template

A study template is a study that includes defined study factors.

 To extract the study factors for the current study from an existing study

1. On page 2 of the wizard, click the browse icon, , next to the Study Template File box. 

2. In the Select Template Study File dialog box, locate a study file (.cdStudy) with the 
appropriate study factors, and click Open.

The name and location of the study file appear in the Study Template File box.

Selecting a Processing Workflow for the Analysis

You can select a processing workflow on page 2 of the wizard or on the Workflows page of an 
analysis.

 To select a processing workflow for the current analysis

Do either of the following:

• Select a processing workflow from the Workflow list.

The Workflow list displays the processing workflow files in the Common Templates 
folder. 

–or–

• Select a processing workflow or result file from another folder by clicking the browse 
icon, , next to the Workflow list. 

When you select a processing workflow file, the file name appears in the Workflow 
list. When you select a result file, the following text appears in the Workflow list:

Imported from: File name

where File name is the file name of the result file

If the processing workflow includes a description, the description appears in the 
Workflow Description box below the Workflow list.
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Adding Input Files to a New Study
Use the Input File Selection page (step 3 of 6) of the New Study and Analysis Wizard to select 
all the input files for the new study or only those input files that you want to process with the 
current analysis. If you click Finish before you add files to the study, the wizard saves the 
named study to the named folder and closes. 

 To add or remove raw data files

1. On page 3 of the wizard, do the following:

a. To add files, click Add Files. Then, browse to the appropriate folder, select the 
Xcalibur RAW files of interest, and click Open.

Figure 32. Input File Selection page of the wizard

The file names of the selected files appear in the Files box, the number of files that 
you selected appears below this box, and the Next button becomes available 
(Figure 33).

Note  The example Xcalibur RAW files for the tutorials are on the Compound Discoverer 
USB key in the software media kit or in the software media that you downloaded from 
Flexera. The software installation process does not install the example files on your 
processing computer.
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Figure 33. Input File Selection page with selected files

b. To remove any of the added files, select them and click Remove Files.

2. Do one of the following:

• Click Next to continue to the Input File Characterization page.

• Click Finish to create the new study and close the wizard.

Number of files field
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Characterizing New Input Files
To set up the study factors and the sample information for the study’s input files, use the 
Input File Characterization page (step 4 of 6) of the New Study and Analysis Wizard or the 
Input File Characterization dialog box that opens when you add input files to an existing 
study. 

The sample information includes the sample type and study factor values for each sample.

Figure 34 shows the functional area of the Input File Characterization page or dialog box.

Figure 34. Input File Characterization page of the wizard

Follow these topics:

1. Selecting the Delimiters for Parsing the File Names

2. To set up the study factors, follow these topics as needed:

• Adding Categorical Study Factors

• Adding Numeric Study Factors

Note  In an existing study, you can do the following:

• Use the Input File Characterization dialog box to add and edit the study factors and 
set up the sample information for additional input files.

• Add and edit the study factors on the Study Definition page.

• Manually select the sample types and study factor values on the Samples page.

Automatically assigns the defined study factor values

Opens the Extract Sample Information from Sample Names dialog box
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• Adding Biological Replicate Study Factors

• Deleting Study Factors

• Duplicating Study Factors

• Editing Study Factors

3. To select or assign the study factor values to the samples (in the Samples area), follow 
these topics:

• Automatically Assigning Study Factor Values

• Manually Selecting the Study Factor Values

• Resetting the Sample Assignments

4. To select the sample types, see Selecting the Sample Types.

Selecting the Delimiters for Parsing the File Names

You can select the delimiters for parsing a file name on the Input File Characterization page of 
the wizard or in the Input File Characterization dialog box.

 To select the delimiters that separate the factors in the file names 

1. Select the check box or check boxes of the delimiter or delimiters for the input file names.

For example, the underscore character is the delimiter that separates the study factors 
from the other parts of the file name in the following file names:

In this case, the study factors are time period (0-4hr, 4-8hr, 8-12hr, or Predose) and 
replicate (1 or 2).

2. If the delimiter is not available, select the Other check box and type the delimiter 
character in the box.

Adding Categorical Study Factors

You can add study factors when you create a study, when you add files to an existing study, 
and on the Study Definition page of an existing study. 

Urine_0-4hr_1 Urine_4-8hr_1 Urine_8-12hr_1 Urine_Predose_1

Urine_0-4hr_2 Urine_4-8hr_2 Urine_8-12hr_2 Urine_Predose_2
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 To add a categorical study factor

1. From the menu bar at the top right of the Study Factors pane, choose Add > Categorical 
Factor.

The categorical factor editor appears with [new factor] automatically selected (Figure 35). 

Figure 35. Categorical factor editor

2. Type the name of the factor, for example, Time Period.

3. For each item that you want to add to the Items list, do the following:

a. In the Items box (to the left of the Add button), begin typing a factor, for example, 
0-4hr.

If the file name contains a character delimiter and you selected the delimiter’s check 
box, the editor automatically enters the appropriate text in the Items box as you start 
typing. Otherwise, you must type all the characters for the item.

The Add button becomes available (Figure 36).

Figure 36. Entering items in the item box

b. Click Add.

The current item appears in the Items list. 

Note  The file name parsing feature is not available on the Study Definition page 
of an existing study, so you must type all the characters for the item.



3 Starting a New Study and Setting Up an Analysis
Characterizing New Input Files

80 Compound Discoverer User Guide Thermo Scientific

4. To save the study factor, click Apply.

The factor editor collapses to show only the study factor name and the Items list 
(Figure 37). The items appear in ascending order.

Figure 37. Named factor with a list of items

Adding Numeric Study Factors

You can add study factors when you create a study, when you add files to an existing study, 
and on the Study Definition page of an existing study. 

 To add a numeric factor

1. From the menu bar at the top right of the Study Factors pane, choose Add > Numeric 
Factor.

The numeric factor editor appears with [new factor] automatically selected (Figure 38).

Figure 38. Numeric factor editor

2. Type a factor name to replace [new factor], for example, Replicate.

3. Point to the right of Factor Unit and, in the box that appears, type a unit for the factor if 
applicable.

The Factor Unit is only a text label; however, it must start with a letter.

4. For each numeric value that you want to add to the Values list, do the following:

a. In the box next to the Add button, type a numeric value.

The Add button becomes available (Figure 39).
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Figure 39. Entering numeric values in the values box

b. Click Add.

The value appears in the Values list in ascending order. 

5. To save the study factor, click Apply.

The factor editor collapses to show only the study factor name and the Values list 
(Figure 40).

Figure 40. Numeric factor with a list of values

Adding Biological Replicate Study Factors

You can add study factors when you create a study, when you add files to an existing study, 
and on the Study Definition page of an existing study. 

You can add only one biological replicate factor to a study. Use the biological replicate factor 
for nested statistical models—that is, for studies that include one study factor nested within 
another study factor.

 To add a biological replicate factor

1. From the menu bar at the top right of the Study Factors pane, choose Add > Biological 
Replicate Factor.

The biological replicate factor editor appears with [new factor] automatically selected. 

Figure 41. Biological replicate factor editor

2. Type a factor name to replace [new factor], for example, Rat.
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3. For each item that you want to add to the Items list, do the following:

a. In the Items box (next to the Add button), type a study factor item, for example, 
Rat 1.

The Add button becomes available.

Figure 42. Biological replicate factor editor with added items

b. Click Add.

The current item appears in the Items list. 

4. To save the study factor, click Apply.

The factor editor collapses to show only the study factor name and the Items list. The 
items appear in alphabetical order.

Deleting Study Factors

 To delete a study factor

1. In the Study Factors pane, click  in the title bar of the factor.

2. At the prompt, click Yes to delete the study factor.

Duplicating Study Factors

 To create a new study factor by using the Copy and Paste commands

1. In the Study Factors pane, select the factor that you want to copy.

The title bar of the selected factor turns blue.

2. Click Copy.

3. Click Paste.

A copy of the selected factor appears.

Note  Because the application cannot recognize whether a study factor is in use, this 
prompt appears even when you attempt to delete an undefined study factor.
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Editing Study Factors

You can edit study factors as you create a new study with the wizard, in Study Factors area of 
the Input File Characterization dialog box when you add more files to an existing study, and 
in the Study Factors area on the Study Definition page of an existing study. 

 To edit a study factor

1. In the factor title bar, click Edit.

The text entry box and the Add and Delete buttons appear. For a numeric factor, the 
Factor Unit box also appears.

2. To change the unit for a numeric factor, select the current unit and type a new unit.

3. To add more entries to the Items or Values list, type alphanumeric text in the appropriate 
box, and then click Add.

4. To delete an entry, select the entry and click Delete. 

When an entry is in use, it is unavailable. To delete a value that is in use, you must first 
undo its assignment to any sample.

Automatically Assigning Study Factor Values

After you set up the study factors for a study, you can assign the study factor values to each 
sample. If the input file names follow a consistent pattern and the study factor values are 
completely defined, clicking Assign on the Input File Characterization page (or dialog box) 
assigns the study factor values to the samples. 

 To automatically assign the study factor values to a sample set

1. If you have not already set up the study factors, set them up.

2. In the command bar of the Input File Characterization page or dialog box, click Assign.

3. Check the study factor columns, verify the sample assignments, and manually assign the 
study factor values if necessary.

Manually Selecting the Study Factor Values

After you set up the study factors for the study, you can select the study factor values for each 
sample. If the input file names do not follow a consistent pattern or do not include the study 
factor values or you are selecting the values on the Samples page of an existing study, you have 
to manually select these values.

Note  You can only manually assign study factor values on the Samples page of an existing 
study.
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 To manually select the study factor values

On the Input File Characterization page (or dialog box) or on the Samples page of an 
existing study, do the following:

• To select the factor values for a single sample, select the appropriate value from the 
list in each factor column.

• To select the same value for a consecutive sample range, drag the pointer across the 
rows of interest. Then right-click and choose Set Factor To > Value.

• To select the same value for nonconsecutive samples, hold down the CTRL key and 
click the samples of interest. Then right-click and choose Set Factor To > Value.

Resetting the Sample Assignments

On the Input File Characterization page (or dialog box), you can use the Reset button in the 
command bar to automatically clear the sample assignments. The Samples page of a study 
does not have a command bar.

 To clear the assignments in the Samples pane

In the command bar, click Reset.

Clicking Reset resets the Sample Type and study factor assignments—that is, it resets the 
sample type to Sample and the study factor values to n/a for all the samples.

Selecting the Sample Types

You can select the sample type for the study samples from any of these locations:

• The Samples pane of the wizard’s Input File Characterization page

• The Samples pane of the Input File Characterization dialog box 

• The Samples page of an existing study

By default, the selected sample type for each input file is Sample. Clicking Assign on the Input 
File Characterization page (or dialog box) automatically assigns the Blank sample type to 
samples with a file name that includes “blank” as a delimited value (for example, 
solvent_blank_1.raw, where the underscore character is the delimiter).

Note  To edit the values for a study factor, you must first clear the sample assignments 
if the values are assigned to samples.
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 To select a sample type other than the default assignment

In the Samples pane (any location), do one of the following: 

• To select the sample type for a single sample, in the Sample Type column, select 
Sample, Control, Blank, Quality Control, Identification Only, Standard, or 
Labeled from the list. 

• To assign the same sample type to a consecutive sample range, use the SHIFT key to 
select a range of samples. Then, right-click and choose Set Sample Type To > 
Sample Type.

• To assign the same sample type to nonconsecutive samples, use the CTRL key to 
select the samples. Then, right-click and choose Set Sample Type To > Sample Type.

Related Topics

• Sample Types

Using the Regular Expression Builder to Extract the Study Factors
Use the Extract Sample Information From Sample Names dialog box to automate the setup 
and assignment of the study factors. This dialog box is accessible from the Input File 
Characterization page of the New Study and Analysis Wizard or from the Input File 
Characterization dialog box that opens when you add input files to a study.

Tip  To select a row, click a column without a list.

Note  For the extraction and assignment process to work, you must select the study factor 
portions of an example input file name and define these portions appropriately as 
categorical, numerical, or biological replicate factors. 

When the undefined portions of the file name are not exactly the same for all the samples 
that you want to characterize, you can mark the text to be ignored or you can manually 
assign or edit the study factor values for these samples after returning to the Input File 
Characterization page or dialog box.
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 To extract the sample information from the sample names

1. Open the Input File Characterization page (step 4 of 6) of the wizard or the Input File 
Characterization dialog box from within an existing study.

2. Click Advanced.

The Extract Sample Information From Sample Names dialog box opens with the first file 
name displayed in the Regular Expression Builder box and the file names of all the 
selected input files listed below it (Figure 43).

Figure 43. Extract Sample Information From Sample Names dialog box 

3. If the Regular Expression Builder box does not contain a representative sample name, 
right-click a representative sample name in the Sample Name column and choose Use 
Name of Selected Sample as Regular Expression Template (Figure 44).

Figure 44. Urine_0-4hr_01 sample name selected

The selected sample name replaces the nonrepresentative sample name (Figure 45).

• Defines a categorical variable. 

Inserts a regular expression 
that does the following: 

• Defines a numerical variable. 

• Defines a biological variable. 

• Ignores a text string. 
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Figure 45. Urine 0-4hr file name to be used as the regular expression template

4. For a representative sample name, do the following:

• For each categorical study factor, select the corresponding study factor item and click 
[A-Z].

For example, select 0-4hr and click [A-Z]. 

The CategoricalVariable_1 column appears to the right of the sample names. In this 
example, the application extracts the categorical study factor for the 
Urine_Predose_01 sample. The column is not populated with study factor values for 
the remaining samples for two reasons: 

– The remaining portions of the sample names are not the same (for example, _01 
and _02).

– The default expression for a categorical factor does not recognize the hyphen 
special character in the 0-4hr, 4-8hr, and 8-12hr time points.

• For each numeric study factor, select the corresponding study factor value and click 
[0-9]. For example, select 1 and click [0-9].

For this example, the following expression replaces the file name:

Urine_(?<CategoricalVariable_1>[0-9A-Z]+)_ (?<NumericalVariable_1>[0-9]+)

–and–

Only the study factor values for these file names appear in the table: 
Urine_Predose_01 and Urine_Predose_02 (Figure 46).
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Figure 46 shows the new regular expression in the regular expression builder box. This 
expression cannot interpret the time points that include hyphens (0-4hr, 4-8hr, 8-12hr). 
Only “Predose” matches the expression, which is looking for an alphanumeric string.

Figure 46. Building a regular expression with the default categorical and numeric operators

5. If the study factor columns do not populate as expected, modify the regular expression 
operators within the square brackets.

For example, to populate the rows for the other file names with defined time periods, add 
a hyphen to the operators in the categorical factor’s square brackets. Figure 47 shows the 
hyphen character added to the operator set for a categorical factor.

Table 10. Examples of regular expression operators

Operator Quantifier Matching pattern

[0-9] none A single integer

[0-9] + One or more integers

[A-Z] none One alphabetic character 

[0-9A-Z] none One alphanumeric character 

[0-9A-Z] + One or more alphanumeric characters 

[0-9A-Z-] + One or more alphanumeric characters, one or more 
hyphens, or both (for example, 555-0000)

[0-9A-Z] [0-9A-Z] + One or more alphanumeric characters, a space, and 
one or more alphanumeric characters (for example, 
ABC 123)
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Figure 47. Hyphen building block added to the regular expression for a categorical factor

6. If the sample names include extra text that differs from sample to sample and does not 
define a study variable, exclude this text from the regular expression by selecting it and 
clicking .

For example, in the sample set shown in Figure 48, exclude all the characters to the right 
of the categorical variable by selecting _01_MDF and clicking . 

Figure 48. Selecting the text that you want to exclude from the expression

Note  Figure 48 and Figure 49 show a different sample set than the previous figures.

Original operator set = [0-9A-Z]
Modified operator set = [0-9A-Z-]

The application ignores the extra text 
when extracting the study factor values 
from these sample names. 
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The regular expression builder replaces the selected text with the following expression:

(?:.+)?

Figure 49 shows the result of these actions:

• Selecting the time period (0-3) as a categorical variable

• Adding a hyphen to the categorical variable expression

• Selecting “_01_MDF” as text to ignore

Figure 49. Regular expression that defines the categorical variable and the text to ignore

7. To enter the study factor names, type the study factor names in the column-heading 
boxes.

For example, replace CategoricalVariable_1 with Time Period and NumericalVariable_1 
with Replicate (Figure 47 and Figure 50).

Figure 50. Study factors renamed

Tip  You can edit the study factor names in two ways:

• In the column-heading boxes, replace the default column headings with the study 
factor names.

• On the Input File Characterization page, edit the study factors.

Edited study factor names
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8. Click OK to return to the Input File Characterization page where you can modify the 
values in the study variable columns if necessary.

Table 11 describes the parameters in the Extract Sample Information From Sample Names 
dialog box.

Tip  The Regular Expression Builder does not assign sample types. To assign Blank as 
the sample type, click Assign on the Input File Characterization page after selecting 
the appropriate delimiters. 

For example, select the Underscore check box on the Input File Characterization page 
and click Assign, for the following file name: Solvent_Blank_1.

Table 11. Extract Sample Information From Sample Names dialog box parameters (Sheet 1 of 2)

Parameter Description

Regular Expression Builder

Initially displays the first file name in the Sample Name list. Use this file name (or a 
different file name in the list) to build a regular expression that extracts the study factor 
values for the file names in the Sample Name list.

Buttons

[0-9] Identifies a numeric factor.

Clicking [0-9] replaces the selected text with the following 
expression: (?<NumericalVariable_1>[0-9]+)

[A-Z] Identifies a categorical factor.

Clicking [A-Z] replaces the selected text with the following 
expression: (?<CategoricalVariable_1>[0-9A-Z]+)

[A-Z] Identifies a biological replicate factor.

Clicking [A-Z] replaces the selected text with the following 
expression: (?<ReplicateVariable_1>[0-9A-Z]+)

Excludes text that does not define a study variable and does not 
follow a pattern.

Clicking  replaces the selected text with the following 
expression: (?:.+)?

Columns

Sample Name Displays the file names of the selected input files.

CategoricalVariable_1 Displays the extracted items for this factor. You can edit the 
column heading.
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Setting Up the Sample Groups and Ratios for a New Analysis
Use the Sample Groups and Ratios page (step 5 of 6) of the New Study and Analysis Wizard 
to set up the sample groups that you want to compare and the group ratios that you want to 
include in the result file.

Follow these topics as needed:

• Opening the Wizard’s Sample Groups and Ratios Page

• Selecting the Study Variables for Sample Grouping

• Fixing Assignment Errors for Unset Study Variables

• Changing the Hierarchy of the Study Variables

• Individually Setting Up the Group Ratios

• Using the Bulk Ratio Generation Feature to Set Up the Group Ratios

Opening the Wizard’s Sample Groups and Ratios Page

 To open the Sample Groups and Ratios page of the wizard

1. From the menu bar, choose File > New Study and Analysis and click Next.

2. Make the appropriate selections on the Study Name and Processing Workflow page and 
click Next.

The Input File Selection page opens.

NumericalVariable_1 Displays the extracted values for this factor. You can edit the 
column heading.

ReplicateVariable_1 Displays the extracted values for this factor. You can edit the 
column heading.

Table 11. Extract Sample Information From Sample Names dialog box parameters (Sheet 2 of 2)

Parameter Description

Note  You can also use the Sample Groups and Ratios page within an existing study to set 
up the sample groups and ratios. However, when you start a new analysis in an existing 
study, you cannot set up the sample groups without first adding the input files to the Files 
for Analysis area of the Analysis pane.

IMPORTANT  Do not create ratios with sample groups that have an n/a assignment for a 
study variable. To use a sample group in a ratio, you must replace the n/a assignment with 
a study factor value. 
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3. Add all the input files for the study or add the input files for the current analysis and click 
Next.

If you selected a study template when you created the study, the Study Factors area of the 
Input File Characterization page contains one or more factors. Set up and assign the study 
factors and select the sample type for each sample.

4. Click Next.

The Sample Groups and Ratios page opens. The Study Variables area contains a File 
check box and a Sample Type check box. If you added study factors on the Input File 
Characterization page, the Study Variables area also contains an additional check box for 
each study factor.

Figure 51 shows a Sample Groups and Ratios page with generated sample groups and 
ratios.

Figure 51. Sample Groups and Ratios page of the wizard
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Selecting the Study Variables for Sample Grouping

You select the study variables that you want to group on the Grouping & Ratios page of an 
existing analysis or the Sample Groups and Ratios page of the New Study and Analysis wizard.

 To select the study variables for sample grouping 

In the Study Variables area of the Sample Groups and Ratios page, select the study 
variable or variables for sample grouping.

Selected study variables have a light green background, a dark green handle ( ) on the 
left, and a Sorting icon ( )on the right.

The Generated Sample Groups area displays the generated sample groups. The hierarchy 
of the study variables affects the sample group names and the denominator list for bulk 
ratio generation (see To change the hierarchy of the study variables). 

The naming scheme is as follows:

• Group names (green) consist of the common values for the selected study variables.

• Sample names (blue) consist of a unique ID and the input file name.

Following data processing, the result file displays the chromatographic peak areas for 
individual samples and the named sample groups.

Fixing Assignment Errors for Unset Study Variables

You select the study variables that you want to group on the Grouping & Ratios page of an 
existing analysis or the Sample Groups and Ratios page of the New Study and Analysis wizard.

When selecting a study variable generates an N/A group with Sample, Control, or Standard 
sample types, the application highlights the selected study variable and the N/A group in red 
and displays an error message.

 To fix an assignment error

1. Do one of the following:

• In the New Study and Analysis Wizard, return to the Input File Characterization 
page.

• From an existing study, open the Samples page.

2. Do one of the following:

• Assign study factor values to the Sample, Control, or Standard sample types. If 
necessary, create new study factor values for these samples.

• Change the sample type assignment for samples without a study factor value to 
Blank or Identification Only.
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3. Do one of the following:

• In the New Study and Analysis Wizard, return to the Sample Groups and Ratios page 
and verify the assignments.

• In an existing study where you have started a new analysis, return to the Grouping & 
Ratios page.

Changing the Hierarchy of the Study Variables

You can change the hierarchy of the study variables on the Grouping & Ratios page of an 
existing analysis or the Sample Groups and Ratios page of the New Study and Analysis wizard.

 To change the hierarchy of the study variables 

Place the pointer over the handle ( ) to the left of a variable name. When the move 
cursor ( ) appears, drag the variable up or down in the list.

Figure 52 and Figure 53 show the effect of changing the study variable hierarchy for a 
study where either the extraction solvent (IPA or WFI) or the o-ring type (E3609, FF350, 
or HF355) is the primary study variable. 

The ratios in Figure 52 (where extraction solvent is the primary variable) compare the 
compounds extracted with the same solvent from different o-ring types.

The ratios in Figure 53 (where o-ring type is the primary variable) compare the 
compounds extracted from each o-ring type with the two solvents. 

Original hierarchy ------> Dragging the variable ------>
up in the list

New hierarchy

Move cursor
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Figure 52. Extraction solvent is the primary variable

Figure 53. O-ring type is the primary study variable
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Individually Setting Up the Group Ratios

You can set up the group ratios on the Grouping & Ratios page of an existing analysis or the 
Sample Groups and Ratios page of the New Study and Analysis wizard.

 To set up group ratios one-by-one

In the Manual Ratio Generation area, select a group from the Numerator list, select a 
group from the Denominator list, and click Add Ratio. Repeat this step for each pair of 
groups that you want to compare.

Using the Bulk Ratio Generation Feature to Set Up the Group Ratios

You can set up the group ratios on the Grouping & Ratios page of an existing analysis or the 
Sample Groups and Ratios page of the New Study and Analysis wizard.

The sort order of the study variables affects the denominators to be used in the Bulk Ratio 
Generation area.

 To automatically set up multiple ratios 

1. To change the sort order of the study variables, click the Sorting icon for the study 
variable that you want to sort by and choose Sort Ascending or Sort Descending. If you 
do not want to apply a sort order, choose No Sorting.

2. In the Bulk Ratio Generation area, select one or more denominators and click Add 
Ratios.

When you select more than one variable in the Study Variables area and the selected 
variables have more than one value, the Select/Deselect Item in All Groups icon, , 
appears when you place the pointer near a denominator in the Denominators to Be Used 
area.

To automatically select multiple check boxes for the same value in all groups, select one of 
the check boxes for the value, and then click the Select/Deselect Item in All Groups 
icon, .

3. To modify the group ratio list, do either of the following:

• To remove a ratio, click the delete icon ( ) to its left.

• To clear the entire list, click Clear All.
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Preparing to Submit a Run to the Job Queue
The first time you use the New Study and Analysis Wizard, read the instructions on the final 
page of the wizard.

Clicking Finish on the Input File Selection page (after selecting input files), on the Input File 
Characterization page, or on the final wizard page opens the study page and the Analysis pane. 
The Analysis pane contains the selected input files. If you selected a processing workflow on 
the Study Name and Processing page of the wizard, the Workflow box on the Analysis pane 
displays the name of the processing workflow, and the Workflows page contains the 
processing workflow.

Before starting a run, you can edit the study, the processing workflow, the input file list, and 
the result file name. Some of the defined processing workflows require customization. For 
example, for a targeted analysis, you must select the target compounds for the Generate 
Expected Compounds node.

If the processing workflow is valid and the Analysis pane contains one or more input files, the 
Run command at the top right of the Analysis pane is available. 

If the Run command is unavailable, you must fix the analysis errors. 

Related Topics

• Troubleshooting Common Analysis Errors

About Accessing the Wizard Help
The New Study and Analysis Wizard has two types of Help: 

• Embedded instructions that appear to the left of each wizard page

• Context-sensitive Help topics that are part of the Help system

Task Action

Display the embedded instructions for the 
current page.

In the lower left corner of the wizard, click 
the light bulb icon ( ).

Hide the embedded instructions for the 
current page.

In the lower left corner of the wizard, click 
the light bulb icon ( ).

Open the context-sensitive Help topic for 
the current page.

Press the F1 key ( ) on your computer 
keyboard.
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4

Editing Existing Studies

In the Compound Discoverer application, you process your raw data files (run analyses) 
within the study environment. These topics describe the study features and how to edit an 
existing Compound Discoverer study. 

About Existing Study Files
When you create a study with the New Study and Analysis Wizard, the application creates a 
study file (.cdStudy) and a study folder. The study file contains a list of input files (Xcalibur 
RAW files) with their associated sample information and a list of analyses with their associated 
result files (.cdResult). The sample information includes the sample type of each input file 
and the relationship between the input files. 

When you open an existing study, it opens as a tabbed document with a command bar and a 
set of tabbed pages: Study Definition, Input Files, Samples, and Analysis Results.

The Input Files page of a study tracks the status of the input files. These input files typically 
reside outside the study folder, for example, on a shared server or on the data system computer 
where they were acquired. If you delete or rename an input file from the specified folder 
location after you add it to a study, this warning symbol, , appears to the left of the ID 
column for the deleted file. Placing the cursor over the warning symbol displays the missing 
file’s expected location and instructions for resolving the issue.

Contents

• About Existing Study Files

• Opening an Existing Study

• Study Page Commands and Tabs

• Editing the Study Factors and the Study Description

• Adding Input Files to an Existing Study

• Removing Input Files or Updating Their Location

• Editing the Sample Type and Study Factor Values

• Saving a Study File 
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The Analysis Results page of a study tracks the result files generated by analyses run within the 
study. Result files reside within the study’s folder.

Related Topics

• Resolving the Location of a Study’s Input Files

Opening an Existing Study
You can open an existing study from the Start Page or the Compound Discoverer window. 

 To open an existing study

Do one of the following:

• From the Start Page, under What Would You Like to Do?, click Open Study to open the 
Open Study dialog box. Select a study file and click Open.

• From the Start Page, under Recent Studies, click the study name of interest. 

The Start Page lists the 20 most recent studies. The study name appears in blue hypertext. 
Placing the cursor over a study name underlines it (Figure 54).

Figure 54. Application window and Start page

• From the application menu bar, choose File > Open Study to open the Open Study 
dialog box. Then, select a study file and click Open.

–or–

Study name
in blue hypertext

Menu bar Toolbar
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• From the application toolbar, click the Open an Existing Study icon, , to open the 
Open Study dialog box. Select a study file and click Open.

The study opens to the Analysis Results page. The study tab includes an image of two racked 
test tubes, , on the left, the study name in the middle, and a close icon, , on the right. 
When you make changes to a study, an asterisk (*) appears to the right of the study name to 
indicate unsaved changes (Figure 55).

Figure 55. Analysis Results page of a study

Study Page Commands and Tabs
The study page includes a command bar and four tabbed pages (Table 12).

Tip  See the option for “Turning Off the Auto-Save Feature for Studies” on page 567.

Table 12. Study page parameters (Sheet 1 of 2)

Command or page Description

Commands

The Add Files, New Analysis, and Open Analysis Template commands are independent of 
the active page within the study. The Remove Files command is only active when a file is 
selected on the Input Files page or the Analysis Results page.

Add Files Opens the Open dialog box where you select the input files 
(Xcalibur RAW files) that you want to include in the study.

Remove Files Executes one of two actions:

• Removes the selected files on the Input Files page when it 
is the active page.

• Removes the selected analysis results on the Analysis 
Results page when it is the active page.

Open Containing Folder Opens the folder that contains the selected file.

This command is only available for the Input Files and 
Analysis Results pages.
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Related Topics

• Removing Input Files or Updating Their Location

• Editing the Study Factors and the Study Description

• Editing the Sample Type and Study Factor Values

• Reviewing or Reprocessing an Analysis

New Analysis Opens the Analysis pane and adds the Workflows tab to the 
tab set on the study page. The Workflows page itself is empty.

This command is unavailable when the Analysis pane is open. 

Open Analysis Template Opens the Analysis Template dialog box where you select an 
analysis template.

This command is unavailable when the Analysis pane is open.

Tabbed pages

Use these pages as follows.

Study Definition Set up study factors and view the study name, file location, 
creation date, modification date, and description on this page.

Input Files Track the status and resolve the location of input files, as this 
page lists the file ID, file name, file type, and sample 
information for each input file. 

Clicking Add Files opens the Input File Characterization 
dialog box and the Input Files page, if it is not already open.

Samples Select the sample type and study factors for each raw data file.

Analysis Results Access the result files created within the study, review the 
analysis details for the results files, and reprocess an analysis.

Table 12. Study page parameters (Sheet 2 of 2)

Command or page Description
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Editing the Study Factors and the Study Description
Use the Study Definition page of a study to edit the existing study factors, to set up new study 
factors, and to edit or add a description of the study.

Follow these topics as needed:

• Editing the Study Description

• Adding, Deleting, or Editing Study Factors in an Existing Study

• Study Definition Page of a Study

Editing the Study Description

You can edit the description of a study on its Study Definition page.

 To add or edit a description of the study

Type or edit the description in the Study description area.

Adding, Deleting, or Editing Study Factors in an Existing Study

To add, delete, or edit study factors in an existing study, see the following subtopics in 
“Characterizing New Input Files” on page 77.

• Adding Numeric Study Factors

• Adding Biological Replicate Study Factors

• Deleting Study Factors

• Editing Study Factors

• Duplicating Study Factors

Study Definition Page of a Study

Table 13 describes the parameters on the Study Definition page.

Note  If you selected a study template with study factors when you created the study or 
added study factors by using the Input File Characterization page of the New Study and 
Analysis wizard, the Study Factors area contains the defined factors.

Table 13. Study Definition page parameters (Sheet 1 of 3)

Parameter Description

Study Summary pane

Study Name Displays the study name.
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Study Directory Displays the file location where the study is stored.

Last Changed Displays the date and time of the last saved change to the 
study.

Creation Date Displays the creation date of the study file.

Study Description pane

Use this pane to enter and store a description of the current study. 

Study Factors pane

Use this pane to set up or edit the study factors.

Menu commands

Paste Pastes the entries in the copied factors below the existing 
factors.

Copy Copies the selected factors to the Clipboard.

Add > Biological Replicate 
Factor

Opens a blank biological replicate editor. You can use the 
biological replicate factor to create nested studies.

Add > Categorical Factor Opens a blank categorical factor editor.

Add > Numeric Factor Opens a blank numeric factor editor. The numeric factor 
editor only accepts numeric values.

Factor box

Title bar Displays the editable factor name. 

Buttons and icons

Apply Saves the current entries in the factor editor.

Cancel Closes the item or value entry box and removes any entries 
made during the current editing session. Does not remove 
previously saved entries.

Deletes the factor from the study.

Add Adds an item to a categorical factor or a numeric value to a 
numeric factor.

Delete Deletes the selected item or value from the list in the 
respective Items or Values area.

Text entry boxes

[new factor] Type a factor name in this box.

Table 13. Study Definition page parameters (Sheet 2 of 3)

Parameter Description
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Adding Input Files to an Existing Study
Use the Add Files button on the study command bar to add files to a study.

 To add input files to an existing study

1. Open the study of interest.

2. On the study command bar, click Add Files.

3. In the Add Files dialog box, select the files of interest and click Open.

The Input File Characterization dialog box opens.

4. Select the sample types and study factor values for the new samples.

5. Click OK.

The Input Files page of the study opens.

Related Topics

• Characterizing New Input Files

Removing Input Files or Updating Their Location
Use the Input Files page to remove or update the location of the input files in an existing 
study. The input files for the Compound Discoverer application are Xcalibur RAW files 
acquired by a Thermo Scientific HRAM mass spectrometer.

Item box Type the name of an item that you want to add to the Items 
list for a categorical factor in this box.

Value box Type a numeric value that you want to add to the Values list 
for a numeric factor in this box.

Table 13. Study Definition page parameters (Sheet 3 of 3)

Parameter Description

Tip  To add input files to an analysis, drag the files of interest from the Input Files page to 
the Analysis pane (see “Setting Up a New Analysis from Within an Existing Study” on 
page 115). 
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Follow these topics as needed:

• Displaying the Location of a Study’s Input Files

• Removing Input Files from a Study

• Resolving the Location of a Study’s Input Files

• Input Files Page Parameters

Displaying the Location of a Study’s Input Files

 To display the file path for an input file

1. On a study’s Input Files page, select the input file of interest.

2. Below the table, click Show Details (Figure 56).

Figure 56. Input Files page

The Samples page opens below the input files table. 

3. Click the Files tab. 

Figure 57 shows the hidden Files page that lists the selected input file’s full file name, 
including its directory location. 

Figure 57. File path of selected input file

Show/Hide Details command
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Removing Input Files from a Study

 To remove input files from a study 

1. On the Input Files page, select the rows to remove and click Remove Files in the study 
command bar.

Depending on whether you have run an analysis with the selected input files, one of the 
following confirmation boxes appears:

• If you have not run an analysis, the Remove Input File confirmation box appears.

• If you have run an analysis, the Remove Analysis Result Files confirmation box 
appears.

2. Do one of the following:

• In the Remove Input File confirmation box, click Yes to remove the input files from 
the study. 

–or–

• In the Remove Analysis Result Files message box, click Remove Files to remove the 
input files and their associated analyses from the study. 

When you remove an input file from the study, the analyses associated with the input 
file disappear from the Analysis Results page, but the result files (.cdResult) remain in 
the study folder.

Resolving the Location of a Study’s Input Files

 To resolve the input files list when you move a study or the Xcalibur RAW files

1. On the study’s Input Files page, display the details for the missing files and check their 
original location.

2. If you know where the files are currently stored, add the files to the study by using the 
Add Files command in the Study page command bar or by using the Find Missing Files 
command from the shortcut menu.

The Adding Files confirmation box opens. The progress remains at 0.0% until you click 
OK (Figure 58).

Note  If the network or directory path changes between the study and the raw data 
files, an exclamation symbol ( ) appears to the left of the file ID. 
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Figure 58. Adding Files confirmation box with progress information

3. Click OK to continue. 

The Adding Duplicate Files message box opens. The progress again remains at 0.0% until 
you click OK.

4. Click OK to continue.

The application restores the connection between the study and the raw data files.

Input Files Page Parameters

Table 14 describes the parameters on the Input Files page.

Table 14. Input Files page parameters (Sheet 1 of 2)

Parameter or feature Description

Show Details/Hide Details Displays or hides the Samples and Files subpages.

Columns

Error Displays an exclamation mark, , if the file is missing.

ID Displays a unique ID in the following format: F#, where # is 
a unique integer. If you remove a file, and then add it again, 
the application updates the ID number.

Name Displays the file name of the raw data file.

File Type Displays the file type of the input file. The Compound 
Discoverer application supports Xcalibur RAW files (.raw).

Sample Information Displays the sample type and any other selected study 
factors.

Hidden pages (Samples and Files)

Samples page

Sample Displays a unique identifier for the input file.
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Sample Identifier Displays the file name of the raw data file.

Sample Type Displays the sample type (see “Sample Types” on page 68).

Study factor columns Displays the study factor values. You can modify the study 
factor selections.

Changing the factor values and sample types on the Input 
Files page also updates these items on the main Samples 
page.

Files page

ID Displays a unique ID (reserved for future implementation).

Name Displays the file name and directory location of the raw data 
file.

Date Modified Displays the acquisition date and time of the raw data file.

Size Displays the size of the raw data file in bytes.

Shortcut menu for the Input Files page

Set As Input File Adds the selected input file to the Files for Analysis area in 
the Analysis pane.

Available when the Analysis pane is open.

Find Missing Files Opens the Browse for Folder dialog box. Browse to the 
folder where the file is stored and click OK. Then, click OK 
to close the confirmation message.

Available when the Input Files table contains missing files.

Table 14. Input Files page parameters (Sheet 2 of 2)

Parameter or feature Description



4 Editing Existing Studies
Editing the Sample Type and Study Factor Values

110 Compound Discoverer User Guide Thermo Scientific

Editing the Sample Type and Study Factor Values
If you have not already characterized the study samples or you want to change their 
characteristics, use the Samples page (Figure 59) of an existing study. To open a study’s 
Samples page, click the Samples tab.

Figure 59. Samples page and its shortcut menu

To select or modify the sample types and study factor values or view the file information on 
the Samples page, follow these topics as needed:

• Editing the Sample Identifier on the Samples Page

• Editing the Sample Types on the Samples Page

• Editing the Study Factor Values on the Samples Page

• Viewing the File Information for Study Samples on the Samples Page

Editing the Sample Identifier on the Samples Page

To make it easier to identify each sample, you can modify the text in the Sample Identifier 
column.

 To edit the text in the Sample Identifier column

1. Point to the sample cell.

The Edit icon appears.

2. Click the Edit icon, .

3. Place the cursor in the cell, and then type or paste the new text.

Filter 
row

Shortcut menuShows the file information.
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Editing the Sample Types on the Samples Page

 To edit the sample types

Do any of the following: 

• To select the sample type for a single sample, in the Sample Type column, select 
Sample, Control, Blank, Quality Control, Identification Only, Standard, or 
Labeled from the list. 

• To assign the same sample type to a consecutive sample range, use the SHIFT key to 
select a range of samples. Then, right-click and choose Set Sample Type To > 
Sample Type.

• To assign the same sample type to nonconsecutive samples, use the CTRL key to 
select the samples. Then, right-click and choose Set Sample Type To > Sample Type.

Related Topics

• Sample Types

Editing the Study Factor Values on the Samples Page

 To edit the study factor values

Do any of the following:

• To select the factor values for a single sample, select the appropriate value from the 
list in each factor column.

• To select the same value for a consecutive sample range, drag the pointer across the 
rows of interest. Then right-click and choose Set Factor To > Value.

• To select the same value for nonconsecutive samples, hold down the CTRL key and 
click the samples of interest. Then right-click and choose Set Factor To > Value.

Viewing the File Information for Study Samples on the Samples Page

 To view the file name and location for a selected sample

Click Show Associated File at the bottom left of the Samples page.

The following details appear—the full file name and location, the file size in kilobytes, 
and the acquisition time of the Xcalibur RAW file.

Tip  To select a row, click a column that does not include a dropdown list.

Tip  To select a row, click a column that does not include a dropdown list.
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Samples Page Parameters

Table 15 describes the parameters on the Samples page.

Table 15. Samples page parameters

Parameter Description

Show/Hide Associated 
File

Shows or hides the file information for a selected sample.

Columns

Error Displays an error symbol.

Sample Displays a unique number for the sample (S#).

File Displays a unique number for the input file (F#).

Sample Identifier Displays the file name of the raw data file.

Sample Type Specifies the sample type for each sample.

Selections: Sample, Control, Blank, Quality Control, 
Identification Only, Standard, or Labeled.

Study factor columns Specifies the study factor values for each sample.

You can edit the study factor values.

Columns in hidden rows

ID Displays a unique file identifier.

File Name Displays the file name and directory location of the Xcalibur RAW 
data file.

File Size Displays the size of the Xcalibur RAW data file in bytes.

File Time Displays the acquisition date and time of the Xcalibur RAW data 
file.

Shortcut menu commands

For information about the Copy with Headers, Copy, Clear Selection, and Cell Selection 
Mode commands, see “Working with the Application Tables” on page 579. 

Set Sample Type To Assigns the selected sample type to a sample range. 

Set Factor To Assigns the selected study factor value to a sample range.

Set As Input File Adds the selected input file to the Files for Analysis area in the 
Analysis pane.

Available when the Analysis pane is open.
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Saving a Study File
By default, the application saves the study file when you close it. However, you can change 
this behavior by turning off the auto save feature.

 To save a study file

Do one of the following:

• From the menu bar, choose File > Save All, or in the toolbar, click the Save All Open 
Items icon, .

–or–

• Click the study tab to make it the active page. Then, from the menu bar, choose File 
> Save, or in the toolbar, click the Save the Currently Active Item icon, .

Related Topics

• Turning Off the Auto-Save Feature for Studies

IMPORTANT  If you turn off the auto save feature, the application prompts you to save 
your changes when you attempt to close a study file with unsaved changes. 

Unsaved changes include, for example, the last completed run on the Analysis Results 
page, new input files on the Input Files page, new study factors or study factor values on 
the Study Definition page, new sample assignments on the Samples page, and so on. 
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5

Creating, Running, and Reprocessing Analyses

To set up and submit new analyses, review the details of completed analyses, or reprocess 
analyses, see these topics. 

Setting Up a New Analysis from Within an Existing Study
You can set up a new analysis by beginning with an empty Workflows page, an empty 
Grouping & Ratios page, and an empty Analysis pane. Or, you can set up a new analysis by 
reprocessing an analysis from the Analysis Results page.

To set up a new analysis from within an existing study, follow these topics in order:

1. Starting a New Analysis from Within an Existing Study

2. Selecting the Input Files for a New Analysis

3. Naming the Result File for a New Analysis

4. Setting Up the Sample Groups and Ratios for a New Analysis

Contents

• Setting Up a New Analysis from Within an Existing Study

• Troubleshooting Common Analysis Errors

• Common Analysis Errors

• Submitting an Analysis to the Job Queue

• Common Validation Issues

• Working with the Job Queue

• Reviewing or Reprocessing an Analysis

• Analysis Pane Parameters

Tip  You cannot set up the sample groups and ratios on the Grouping and Ratios page 
without first adding the appropriate input files to the Analysis pane.
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For information about reprocessing an analysis, see “Reprocessing an Analysis” on page 131.

Starting a New Analysis from Within an Existing Study

This topic describes how to start a new analysis from within an existing study. For 
information about reprocessing an existing analysis, see “Reprocessing an Analysis” on 
page 131.

 To start a new analysis from within an existing study

1. Open the study.

2. In the study command bar, click New Analysis.

The Workflows tab and the Grouping & Ratios tab appear to the right of the study page 
tabs and an empty Analysis pane opens to the right of the tabbed pages. Both the 
Workflows and Grouping & Ratios pages are empty.

3. To select or create a processing workflow for the analysis, do the following: 

a. Click the Workflows tab.

b. In the Workflow Tree area, create a new processing workflow or in the Workflows 
command bar, do one of the following to select an existing processing workflow:

• To select a standard processing workflow from the Common Templates folder, 
click Open Common, click Workflow Templates, click the folder for your field 
of interest, select one of the provided processing workflow templates, and click 
Open.

The file name appears in the Workflow box, and a description of the processing 
workflow appears in the Description box.

• To select a processing workflow from another folder, click Open, locate the 
processing workflow file (.cdProcessingWF) of interest, and click Open.

The file name appears in the Workflow box. 

–or–

• To load the processing workflow that you previously used to process a specific 
result file, click Open, locate the result file (.cdResult) of interest, and click 
Open.

Note  You can also start a new analysis by opening an analysis template.

Command bar

Workflow box
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4. Customize the processing workflow as needed.

Table 16 lists the workflow nodes that require custom settings.

Thermo Fisher Scientific has optimized most of the parameter settings in the defined 
processing workflow templates by the area of study (vertical market). Table 17 lists the 
parameters that usually require a different setting, regardless of whether you use one of the 
defined templates or create your own processing workflow. 

Table 16. Workflow nodes that require customization

Node Required customization

Generate Expected 
Compounds 

From the Compound list, select library compounds. 

In the defined workflow templates, this selection is empty.

Create FISh Trace From the Compound list, select a library compound.

In the defined workflow templates, this selection is empty.

Create Pattern Trace In the Isotope Ratios box, define the ratio.

In the defined workflow templates, the ratio has been set to 
C15S. 

Search Mass Lists From the Input Files list, select mass lists. 

In the defined workflow templates, one of the preinstalled 
mass lists has been selected, according to the vertical market.

Search mzVault From the mzVault Library list, select mzVault libraries.

In the defined workflow templates, the preinstalled mzVault 
May 2019 library has been selected.

Compound Class 
Scoring

From the Compound Classes list, select a Compound Class 
file.

Pattern Scoring For the Isotope Patterns parameter, set up an isotope pattern.

In the defined workflow templates, the pattern has been set 
to C15S. You can define and add more ratios.

Table 17. Parameter modifications for workflow nodes (Sheet 1 of 2)

Node Parameter settings to optimize or modify

Create Analog Trace Select the trace of interest. 

Create Mass Trace Select the trace of interest. 

Generate Expected 
Compounds 

Set up the dealkylation and transformation steps and select 
the appropriate ions.
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Table 18 lists the recommended range for the minimum peak intensity parameter. The 
optimal setting depends on the sensitivity of the mass spectrometer. 

Go to the next topic, “Selecting the Input Files for a New Analysis.” 

Selecting the Input Files for a New Analysis

Follow this procedure to select the input files for a new analysis. If you are reprocessing a 
previous analysis, the Files for Analysis area of the Analysis pane includes its input files. If you 
are starting a new analysis, the Files for Analysis area is empty.

 To select the input files that you want to process

1. Open the study of interest and start a new analysis.

2. On the Input Files page or the Samples page of the study, select the files of interest.

3. Right-click the selection and choose Set As Input File, or drag the files of interest to the 
Files for Analysis area of the Analysis pane (Figure 60).

Search nodes Select the libraries or lists of interest.

Detect Compounds For the recommended minimum peak intensity settings for a 
specific mass spectrometer model, see Table 18.

Table 18. Recommended minimum peak intensity range

Mass spectrometer Minimum peak intensity 
(chromatographic peak height)

Q Exactive, Q Exactive Plus™, Q Exactive HF 500 000 to 1 000 000

Orbitrap Fusion, Orbitrap Lumos™, Orbitrap ID-X™ 50 000 to 100 000

Exactive, Exactive Plus™, Orbitrap Elite™, Orbitrap 
Velos Pro™ 

100 000 to 500 000

LTQ Orbitrap XL™, LTQ Orbitrap Velos™ 25 000 to 100 000

Table 17. Parameter modifications for workflow nodes (Sheet 2 of 2)

Node Parameter settings to optimize or modify
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Figure 60. Dragging input files to the Analysis pane

The file name of the last input file appears in the Result File box, and the Run command 
becomes available if the Workflows page contains a valid processing workflow. When you 
add more than one input file to the Files for Analysis area, the As Batch check box 
becomes available. 

If the Caution symbol in the Processing Step title bar remains, the processing workflow 
contains an error.

Go to the next topic, “Naming the Result File for a New Analysis.” 

Naming the Result File for a New Analysis

After you add the files to be processed to the Analysis pane, the application automatically 
populates the Result File box with the file name of the first input file.

 To change the name of the result file for an analysis 

In the Analysis pane, select the default file name in the Result File box and type the new 
name.

Go to the next topic, “Setting Up the Sample Groups and Ratios for a New Analysis.” 

Setting Up the Sample Groups and Ratios for a New Analysis

Note  When the processing workflow includes the Differential Analysis node, the Analysis 
Validation confirmation box opens if the analysis does not include defined sample groups 
and ratios on the Grouping & Ratios page.
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 To set up sample groups and ratios for a new analysis

1. Add input files to the Analysis pane (see “Selecting the Input Files for a New Analysis” on 
page 118).

2. Follow the instructions for the Sample Groups and Ratios page of the New Study and 
Analysis Wizard (“Setting Up the Sample Groups and Ratios for a New Analysis” on 
page 92).

Go to the next topic, “Troubleshooting Common Analysis Errors.” 

Troubleshooting Common Analysis Errors
After you set up an analysis, if a caution symbol appears in the Analysis pane and the Run 
button is unavailable, you must troubleshoot the analysis.

 To troubleshoot an analysis

1. In the Analysis pane, point to the Caution symbol, , to display the list of missing 
analysis items, or check the error information in the Current Workflow Issues pane 
(Figure 62) below the Post-Processing pane on the Workflows page.

2. Using the information provided in the list of missing items, fix the analysis errors until 
the Caution symbol disappears (see “Common Analysis Errors” on page 122).

For example, Figure 61 shows the error message that appears before you customize the 
defined processing workflow provided in the Common Templates folder:

Degradants w Statistics Expected w FISh Scoring and Unknown ID w Online and 
Local Database Searches.cdProcessing WF

Tip  The application does not know the polarity of the scan data or whether the data 
contains data-dependent or data-independent fragmentation (acquisition) scans. For best 
results, check the following:

• If the processing workflow contains any of these nodes—Create Mass Trace, Create 
FISh Trace, or Create Pattern Trace—verify that the node’s ion polarity setting 
matches the data.

• If the processing workflow contains the Create FISh Trace node, verify that the setting 
for Fragmentation Mode matches the data.
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Figure 61. Error messages for a defined processing workflow

Figure 62 shows the corresponding error messages in the Current Workflow Issues pane.

Figure 62. Current Workflow Issues pane

In addition, each workflow node that is missing a value for one of its parameters has an 
exclamation mark, , in its upper right corner.

To fix the analysis errors for this example, you must select a compound for the Create 
FISh Trace node, one or more compounds for the Generate Expected Compounds node, 
and a mass list for the Search Mass Lists node.

Go to “Submitting an Analysis to the Job Queue” on page 122.

Tip  To view new compounds in the Compound list or new mass lists in the Input 
Files list, close the current analysis and start a new analysis. This means that you must 
select the processing workflow on the Workflows page and add the input files that you 
want to process from the Input Files page to the Analysis pane.
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Common Analysis Errors
To troubleshoot common analysis errors, see Table 19. 

Submitting an Analysis to the Job Queue
After you set up an analysis and troubleshoot any analysis errors, the Run command becomes 
available.

 To submit an analysis to the job queue

1. Decide whether you want to create one result file for the entire set of input files or one 
result file for each input file.

• To create a single result file, leave the As Batch check box clear.

• To create a separate result file for each input file, select the As Batch check box.

2. (Optional) In the Result File box, type a name for the result file to overwrite the default 
name.

3. In the Analysis command bar, click Run. 

If the analysis contains no validation issues, the Job Queue page opens. 

If the analysis contains issues, the Analysis Validation Issues prompt opens.

Note  To troubleshoot validation issues, which occur after you submit a run, see 
“Common Validation Issues” on page 123.

Table 19. Common analysis errors

Error message Error Solution

The workflow does not contain a 
start node.

You have not added the Input Files 
node to the workflow.

Add the Input Files node to the 
beginning of the workflow.

No input files defined. You have not added input files to the 
Files for Analysis area.

Add input files from the Input files or 
Samples page to the Files for Analysis 
area.

The current workflow does not 
contain any nodes.

You have not set up a processing 
workflow on the Workflows page.

Select or set up a processing workflow 
on the Workflows page.

Node Name Missing value for 
parameter “Parameter Name”

The processing workflow contains a 
node that requires a custom 
parameter setting. 

Make the appropriate selections in 
the affected workflow nodes. 

Node Name Missing connection for 
“Connection Information”

You have not connected node to the 
processing workflow.

Make the appropriate node 
connections.



 5 Creating, Running, and Reprocessing Analyses
Common Validation Issues

Thermo Scientific Compound Discoverer User Guide 123

4. At the prompt, do the following:

a. Read the warning message.

b. Do one of the following:

• To modify the analysis, click Abort and remedy the error. 

• To start data processing, click Ignore.

Related Topics

• Working with the Job Queue

• Common Validation Issues

Common Validation Issues
To troubleshoot common validation issues, see Table 20.

Table 20. Validation issues (Sheet 1 of 2)

Validation issue Remedy

The processing workflow includes the 
Differential Analysis node, but you have not 
set up sample groups and ratios.

• On the Sample Groups and Ratios page, 
set up the appropriate sample groups 
and ratios.

• On the Workflows page, delete the 
Differential Analysis node.

–or–

• Do not change the analysis settings and 
click Ignore.

The analysis includes sample groups and 
ratios, but the processing workflow does not 
include the Differential Analysis node.

On the Workflows page, add the 
Differential Analysis node to the workflow.

IMPORTANT  If the analysis does not include sample ratios or the Differential Analysis 
node, the application does not run a differential analysis, and the Compounds and 
Expected Compounds tables in the result file does not include the following columns: 
Ratios, Log2 Fold Change, P-value, and Adj. P-value.

The processing workflow includes 
Compound Identification or Pathway 
Mapping nodes, but does not include the 
Assign Compound Annotations node.

On the Workflows page, add the Assign 
Compound Annotations node to the 
workflow.

IMPORTANT  If the analysis does not include the Assign Compound Annotations node, 
the application does not assign names or formulas to compounds in the Compounds table 
of a result file.



5 Creating, Running, and Reprocessing Analyses
Working with the Job Queue

124 Compound Discoverer User Guide Thermo Scientific

Working with the Job Queue
When you submit an analysis for processing, the Job Queue page opens (Figure 63). You can 
also open the Job Queue page by choosing View > Show Job Queue from the menu bar.

The application can process two runs simultaneously. If you submit a second run while the 
first run is being processed, the status of the second run goes to Not Queued, Running, or 
Execution Failed. If you submit a third run while the application is processing the first two 
runs, its status goes to Waiting. If you pause a run that is waiting, its status goes to Sleeping.

Figure 63. Job queue with runs in various processing states

To work with the Job Queue page, see the following topics:

• Opening the Job Queue Page

• Pausing a Run That Is Waiting to be Processed

• Resuming a Paused Run

• Canceling a Run

• Removing Completed or Failed Runs from the Job Queue

• Refreshing the Job Queue

• Opening a Result File from the Job Queue

• Displaying Verbose Messages in the Job Queue

The processing workflow includes the Assign 
Compound Annotations node, but the 
processing workflow does not include any of 
the Compound Identification or Pathway 
Mapping nodes.

Click Ignore.

–or–

Add one or more Compound Identification 
or Pathway Mapping nodes to the processing 
workflow.

Table 20. Validation issues (Sheet 2 of 2)

Validation issue Remedy
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• Viewing the Processing Steps for a Job

• Filtering the Job Queue

Opening the Job Queue Page

The Job Queue page automatically opens when you submit a job for processing.

 To open a hidden Job Queue page

From the Compound Discoverer window, choose View > Show Job Queue.

The Job Queue page opens as a tabbed document.

Pausing a Run That Is Waiting to be Processed

You can only pause runs with a status of Waiting.

 To pause a run that is waiting to be processed

1. In the Job Queue list, select the run that you want to pause.

2. In the command bar, click Pause.

The status of the run changes to Sleeping.

Resuming a Paused Run

 To resume a paused run

1. In the Job Queue list, select the paused run.

2. In the command bar, click Resume.

Canceling a Run

 To cancel a run that is being processed

1. In the Job Queue list, select the run that you want to cancel.

2. In the command bar, click Abort.

When you cancel a run, its status changes to Aborted, and the application does not create 
a result file for the run.
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Removing Completed or Failed Runs from the Job Queue

 To remove a completed or failed run from the Job Queue list

1. In the Job Queue list, select the run that you want to remove.

2. In the command bar, click Remove.

The selected run disappears from the Job Queue list. The application does not remove the 
result file from the study.

Refreshing the Job Queue

 To refresh the Job Queue list

In the command bar, click Refresh.

Opening a Result File from the Job Queue

 To open a result file from the Job Queue list

In the Job Queue list, do one of the following:

• Select the completed run of interest and click Open Results in the command bar.

–or–

• Double-click a completed run of interest.

The Results page for the selected run opens as a tabbed document in the application 
window.

Displaying Verbose Messages in the Job Queue

By default, the application only displays high-level processing information on the Job Queue 
page. To display all the available processing information, you can display the verbose 
messages.

 To display verbose messages in the Job Queue list

Select the Display Verbose Messages check box.

Viewing the Processing Steps for a Job

 To view the processing steps for a job

Click the expand icon, , to the left of the job row.
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Filtering the Job Queue

 To filter the Job Queue list 

1. Click the icon, , to the left of the Execution State filter list and select Equals.

2. In the Execution State filter list, select Aborted.

The Job Queue list displays the canceled runs only.

3. To undo filtering, close and reopen the Job Queue page.

Job Queue Page Parameters

Table 21 describes the command bar and progress table on the Job Queue page.

Note  Use the filters for the column that you want to sort by. For example, to display 
only the runs that you ended before completion, follow this procedure.

Table 21. Job Queue page features (Sheet 1 of 3)

Feature Description

Command bar

Pause Pauses a job that is waiting to start.

Selecting a job that is waiting to start activates this button.

Resume Resumes a processing job that is sleeping.

Selecting a job with a status of Sleeping activates this button.
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Abort Stops processing and removes the selected job from the queue.

Selecting a job that is being processed activates this button.

Remove Selecting a completed job activates this button.

Refresh Refreshes the job queue list.

Open Results Opens the result file for the selected job.

Display Verbose 
Messages

Displays more messages of less importance. When this check box 
is clear, the Job Queue displays no more than a few messages for 
each workflow node.

Table columns

Execution State Displays the status of the job.

• Not Queued—The application takes a finite length of time to 
start a job after you click the Run command.

• Running—The application is currently processing the job. 
The application can process two jobs simultaneously. When 
you submit an analysis as a batch, each input file is processed 
as a separate job.

• Aborted—You canceled the job while the application was 
processing the analysis.

• Execution Failed—The application was unable to complete 
the job.

• Waiting—The application has not begun to process the job.

• Sleeping—You paused the job while it was waiting in the 
queue.

• Completed—The application has completed the analysis and 
you can open the result file.

Details Displays whether the job ran with or without warnings.

Progress Displays the progress of the run as a percentage.

Type Displays the job type.

Name Displays the name of the result file.

Submitted At Displays the date and time when you submitted the run to the job 
queue.

Study Displays the name of the study.

Table 21. Job Queue page features (Sheet 2 of 3)

Feature Description
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Reviewing or Reprocessing an Analysis
When you submit a run to the job queue, the run appears in the list of analyses on the 
Analysis Results page of the current study. 

Use the Analysis Results page of a study to review or reprocess a completed analysis or to open 
a result file. An analysis consists of a processing workflow, optional sample groups and ratios, 
and the selected input files.

See these topics:

• Analysis Results Page Parameters

• Reviewing an Analysis

• Reprocessing an Analysis

Analysis Results Page Parameters

Table 22 describes the command bar and progress table on a study’s Analysis Results page. 

Data Source Displays the location and file names of the input files for the 
current job.

Description Displays the description that you typed in the Description box on 
the Workflows page.

Table 21. Job Queue page features (Sheet 3 of 3)

Feature Description

Note  The Execution State on the Job Queue page updates more quickly than the 
Execution State on the Analysis Results page.

Table 22. Analysis Results page parameters (Sheet 1 of 2)

Feature Description

Command bar

Selecting an analysis in the list on this page activates these commands.

Open Result Opens the selected result file.

Reprocess Opens the Analysis pane with the list of input files that were used 
for the selected analysis. The Workflows page contains the 
processing workflow and the Grouping & Ratios page contains 
the sample groups and ratios used for the selected analysis.

Table columns

Execution State Displays the status of the analysis.
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Reviewing an Analysis

Use the Analysis Sequence Details window to review an analysis.

 To review an analysis

1. On the Analysis Results page of a study, right-click the analysis and choose Show Details.

The Analysis Sequence Details window opens and displays the processing workflow in the 
Workflow Tree pane, and the result file name and input files in the Processing Step pane. 

2. To view a workflow node’s parameter settings, select it in the Workflow Tree pane to 
display its parameter settings in the Parameters pane on the left.

Creation Date Displays the date and time when you submitted the run to the job 
queue.

File Name Displays the file name of the result file.

Description Displays the description of the processing workflow that you or 
the originator typed in the Description box on the Workflows 
page.

Below the table

Show Associated 
Analysis/Hide 
Associated Analysis 

Opens a locked Processing Step area that shows the names of the 
processing workflow and result file and a list of the input files for 
the analysis.

Shortcut menu commands

Copy with Headers, 
Copy, Clear Selection, 
Cell Selection Mode, 
and Enable Row 
Grouping

See “Copying Table Entries to the Clipboard” on page 586 and 
“Grouping Table Rows” on page 582.

Open Result Opens the selected result file.

Open Containing 
Folder

Opens the folder that contains the result file.

Show Details Opens the Analysis Sequence Details window where you can view 
the analysis processing workflow in the Workflow Tree pane and 
the Processing Step information in the Analysis pane. You cannot 
start runs from this window.

Reprocess Same functionality as the Reprocess command in the command 
bar.

Table 22. Analysis Results page parameters (Sheet 2 of 2)

Feature Description
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Figure 64. Analysis Sequence Details window showing the parameter settings for the Detect 
Compounds node

Reprocessing an Analysis

You can reprocess an entire analysis or only the post-compound detection portions of an 
analysis.

 To reprocess an analysis

1. On the Analysis Results page of a study, right-click the analysis and choose Reprocess.

• If the Analysis pane is open and contains information for an analysis that you have 
not yet submitted to the job queue, the following prompt appears: 

The analysis was not started. Do you really want to discard the analysis?

• If the Analysis pane is closed, it reopens with the settings from the selected analysis. 
In addition, the Grouping & Ratios tab and Workflows tab appear to the right of the 
study tabs.

2. If prompted, do the following:

a. Check the Analysis pane and decide whether you want to discard the current settings. 

Note  The Processing Step is locked, preventing you from reprocessing the analysis 
from this window.
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b. Click Yes to replace the current settings in the Analysis pane with the settings from 
the selected analysis. Otherwise, click No to return to the in-progress analysis.

3. Do one of the following:

• To reprocess the entire analysis, go to step 5.

• To reprocess only part of the processing workflow, go to step 4.

4. To reprocess only part of the processing workflow, do the following:

a. Click the Workflows tab.

The processing workflow appears in the Workflow Tree (Reprocess) area. All the 
nodes are white with a gray tab, which indicates that they are not set for reprocessing.

b. Right-click the nodes that you want to reprocess and choose Reprocess.

The selected nodes and any related nodes revert to their original color, and the Run 
command becomes available in the Analysis pane.

c. If you are partially reprocessing the data, consider changing the result file name.

If you do not change the result file name, the application automatically appends a 
number to the file name when you submit the run.

d. Go to step 7.

5. To reprocess the entire processing workflow, right-click the Input Files node and choose 
Reprocess. Then, at the prompt, click OK.

6. If necessary, make changes to the sample groups and ratios on the Grouping & Ratios 
page and the settings in the Analysis pane.

7. To start the analysis, click Run.

Note  You can reprocess any of the Peak Area Refinement nodes, Pathway Mapping 
nodes, Search nodes, and Compound Scoring nodes without reprocessing the entire 
workflow.

You must reprocess the entire workflow to reprocess any of the nodes for Spectrum 
Processing, Trace Creation, Compound Detection (except the Mark Background 
Compounds node), or Expected Compounds (except the Mark Background 
Compounds and Merge Features nodes).

Note  If you are only partially reprocessing the existing input files, the Source File 
row appears in the analysis pane. You cannot edit the source file name.

Note  When you change any of the settings on the Grouping & Ratios page or the 
files for analysis in the Analysis pane, the application automatically reprocesses the 
entire processing workflow.
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Analysis Pane Parameters
The Analysis pane appears to the right of the analysis pages when you start a new analysis or 
open an existing analysis template. Table 23 describes the parameters in the Analysis pane.

Table 23. Analysis pane parameters (Sheet 1 of 2)

Parameters Description

Title bar 

As Batch check box Available when you add more than one input file to the Files for 
Analysis area.

• Clear (default setting)—The application creates one result file 
as it processes the input files in the Files for Analysis area.

• Selected—The application creates one result file for each 
input file in the Files for Analysis area.

Run command Submits the analysis to the job queue.

Available when the Workflow Tree pane on the Workflows page 
contains a valid processing workflow and the Files for Analysis 
area contains a list of input files.

Save command Opens the Save Analysis Template dialog box where you can 
provide a file name for the analysis template and save it to an 
appropriate directory.

Closes the Analysis pane, the Workflows page, and the Grouping 
& Ratios page.

Processing Step area

 Edit Opens the Workflows page.

If the analysis includes errors, such as missing parameter settings 
or no input files, a Caution symbol appears to the far right of the 
Processing Step. To display the error list, point to the Caution 
symbol. 

Workflow By default, the text matches the text in the Workflow box on the 
Workflows page. You cannot change the text in the Analysis pane. 
To change the name of the processing workflow, edit the text on 
the Workflows page.

Result File Specifies the file name for the result file. This box is empty until 
the Files for Analysis area lists at least one input file.

The name of the first input file automatically populates the Result 
File box. If the analysis creates only one result file, you can type a 
name for the result file in the Result File box.
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Related Topics

• Common Analysis Errors

• Selecting the Input Files for a New Analysis

Source File Displays the filename of the original result file.

Available when you set up an analysis for partial reprocessing.

Files for Analysis: (#) Displays the number of input files in the Files for Analysis area.

Files for Analysis area Displays the names of the input files after you add the input files 
from the Input Files page or the Samples page of the study to this 
area.

Table 23. Analysis pane parameters (Sheet 2 of 2)

Parameters Description
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6

Creating and Editing Processing Workflows

These topics describe how to create and edit processing workflows on the Workflows page of a 
study.

Contents

• Processing Workflows

• Workflows Page

• Editing a Processing Workflow

• Setting Up Isotope Patterns for Pattern Scoring or Pattern Traces

• Creating an Isotope Patterns List

• Extracting Analog Traces 

• Extracting PDA Traces

• Creating a Completely New Processing Workflow

• Connecting the Workflow Nodes

• Input and Output Nodes for the Workflow Nodes

• Saving a Processing Workflow as a Template
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Processing Workflows
The Compound Discoverer application uses a processing workflow to analyze the MS data 
acquired with a high-resolution, accurate-mass LC/MS/MS instrument. In addition to 
analyzing the MS data, the application can display chromatograms acquired with a 
photo-diode array (PDA) or ultraviolet-visible (UV-Vis) detector that is controlled by a 
Thermo Scientific data system or an analog detector that is connected to the mass 
spectrometer’s analog input channels.

Workflows Page
Within an existing study, use the Workflows page to create or edit processing workflows. The 
Workflows page is a tabbed page that opens to the right of the tabbed study pages when you 
start a new analysis or reprocess an existing analysis. You cannot edit a processing workflow 
from outside a study.

For information about opening the Workflows page and its command bar and shortcut menu, 
see these topics:

• Opening the Workflows Page

• Workflows Page Command Bar

• Workflows Page Shortcut Menu

Opening the Workflows Page

The Workflows page appears to the right of the four study pages and next to the Grouping 
and Ratios page after you set up a new study and a new analysis with the New Study and 
Analysis wizard. 

Closing a study erases the analysis settings, and reopening a study only opens the study pages.

 To open the Workflows page

Do one of the following:

• Use the New Study and Analysis wizard to set up a new study. Then, click the 
Workflows tab.

• Open an existing study, click New Analysis in the Study command bar, and then 
click the Workflows tab.

–or–

• From the Analysis Results page of a study, select an analysis, click Reprocess, and 
then click the Workflows tab.
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The Workflow Tree and Workflow Nodes panes appear (Figure 65). For a new analysis, 
the Workflow Tree pane is empty. For an existing analysis, the Workflow Tree pane 
usually contains a processing workflow.

Figure 65. Workflows page without a selected processing workflow

Command barWorkflow nodes list
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Workflows Page Command Bar

Table 24 describes the Workflows page commands.

Workflows Page Shortcut Menu

Table 25 describes the commands in the shortcut menu for the Workflow Tree pane or a 
workflow node.

Table 24. Workflows page commands

Command Description

Open Opens the Open Workflow dialog box for locating and opening a 
processing workflow.

Open Common Opens the Open Workflow dialog box to the following folder 
where the application installs the three common processing 
workflow templates:

C:\Users\Public\Public Documents\Thermo\Compound 
Discoverer 3.1\Common Templates

Save Opens the Save Workflow dialog box for selecting a folder and 
entering a file name for the processing workflow in the Workflow 
Tree pane.

Save Common Opens the Save Workflow dialog box to the folder where the 
application installs the common processing workflow templates. 
Saves the current processing workflow in the Workflow Tree pane 
to the Common Templates folder.

Auto Layout Automatically formats the layout of the workflow nodes.

Clear Clears the Workflow Tree pane.

Table 25. Workflow Tree pane and workflow node shortcut menu commands (Sheet 1 of 2)

Command Description

Cut Removes the node from the workflow.

Selecting any workflow node enables this command.

Copy/Paste Adds a copy of the selected node to the Workflow Tree pane.

Selecting a workflow node that can appear more than once in a 
workflow enables this command.

Auto Layout Automatically formats the layout of the workflow nodes.
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Editing a Processing Workflow
You can modify a processing workflow by adding and deleting workflow nodes and by 
changing the parameter settings in the workflow nodes. 

The application automatically connects some of the workflow nodes as you add them to a 
processing workflow. But for some of the workflow nodes, you must make the appropriate 
connections. When a node is missing a connection, a Caution symbol appears in its upper 
right corner.

Several workflow nodes require custom parameter selections. When a workflow node is 
missing a custom parameter selection, an exclamation mark appears in its upper right corner.

Follow these topics as needed.

• Fixing a Workflow Node That Has a Caution Symbol

• Fixing a Workflow Node that Has an Exclamation Mark

• Adding a Workflow Node to a Processing Workflow

• Deleting a Workflow Node from a Processing Workflow

• Editing the Parameter Settings for a Workflow Node

Fixing a Workflow Node That Has a Caution Symbol

When the node is missing a connection, a Caution symbol, , appears in its upper right 
corner. If the node is also missing a required parameter selection or the selected item is not 
found in its corresponding list or library, an exclamation mark appears after you fix the 
missing connection.

Hide Node Numbers Turns the numbering on or off.

Reprocess Sets the selected node for reprocessing or sets the selected node 
and its related nodes for reprocessing.

Available for an analysis that you have set up for reprocessing 
[Workflow Tree (Reprocess)]. 

Table 25. Workflow Tree pane and workflow node shortcut menu commands (Sheet 2 of 2)

Command Description
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 To fix a workflow node that is labeled with a Caution symbol

1. To view the validation errors, point to the Caution symbol in the Analysis pane.

A missing connection begins with the following text: 

Missing connection for

2. Make the appropriate node connections.

Related Topics

• Input and Output Nodes for the Workflow Nodes

• Connecting the Workflow Nodes

Fixing a Workflow Node that Has an Exclamation Mark

To edit a processing workflow, you must open it from the Workflows page within a study.

An exclamation mark, , appears in the upper right corner of a node when the node is 
missing a required parameter selection or the selected item is not found in its corresponding 
list or library. 

 To fix a workflow node that is labeled with an exclamation mark

1. To view the validation errors, point to the Caution symbol in the Analysis pane or review 
the issues described in the Current Workflow Issues pane below the Post-Processing 
Nodes pane.

For a missing parameter selection, the issue description includes the following text:

Missing value for parameter ‘Node’

2. To fix the workflow node error, select the node in the Workflow Tree pane.

3. In the Parameters of ‘Workflow Node’ page to the left, make a selection for the missing 
parameter value. 

Related Topics

• Common Analysis Errors

Adding a Workflow Node to a Processing Workflow

To edit a processing workflow, you must open it from the Workflows page within a study.

 To add a node to the processing workflow

1. Select the node in the Workflow Nodes pane and drag it to the Workflow Tree pane.
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2. If necessary, make the appropriate node connections.

3. To display a node’s parameters, click the node in the Workflow Tree pane.

The Parameters page lists the parameters for the selected node.

4. Edit the parameter settings for the node.

Related Topics

• Connecting the Workflow Nodes

• Input and Output Nodes for the Workflow Nodes

Deleting a Workflow Node from a Processing Workflow

To edit a processing workflow, you must open it from the Workflows page within a study.

 To delete a node from a processing workflow

1. Right-click the node in the Workflow Tree pane and choose Cut.

2. Check whether any validation issues appear.

3. (Optional) To save the processing workflow for reuse, click Save. Then, rename the 
workflow if necessary, select an appropriate folder, and click Save.

Editing the Parameter Settings for a Workflow Node

To edit a processing workflow, you must open it from the Workflows page within a study.

 To edit the parameter settings for a workflow node

1. In the Workflow Tree pane, select the node. 

The Parameters page opens with the parameters for the selected node.

2. Click Show Advanced Parameters below the Parameters page title bar.

If the node contains hidden advanced parameters, the advanced parameters appear below 
the basic parameters.

Note  A Caution symbol appears in the upper right corner of a workflow node that is 
missing a connection. Because a missing connection takes priority over a missing 
parameter setting, if a workflow node is also missing a parameter setting, a blue circle 
with an exclamation mark appears after you fix the missing connection. 

Tip  If you use the processing workflow for the current analysis, you can reuse the 
processing workflow without saving it. After you run the analysis successfully, you can 
rerun the analysis by selecting the completed analysis on the Analysis Results page of a 
study.
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When you place the cursor in the box to the right of the parameter name, information 
about the parameter appears at the bottom of the Parameters page.

3. Enter the appropriate values or make the appropriate selection for each parameter. 

Related Topics

See Chapter 7, “Workflow Nodes.” 

Setting Up Isotope Patterns for Pattern Scoring or Pattern Traces
Use the Isotope Ratio Editor dialog box to set up the pattern and the required isotopes for the 
Create Pattern Trace node or the Pattern Scoring node.

You can access the Isotope Ratio Editor dialog box from the Create Pattern Trace node or the 
Pattern Scoring node.

To set up an isotope pattern, follow these topics as needed:

• Opening the Isotope Ratio Editor

• Defining an Isotope Pattern from an Elemental Composition

• Copying an Elemental Composition from the Expected Compounds Library

• Exporting a Mass Spectrum from a RAW File to the Clipboard

• Isotope Ratio Editor Parameters

Opening the Isotope Ratio Editor

 To open the Isotope Ratio Editor

1. Open or create a processing workflow on the Workflows page. 

2. Add one or both of these nodes to the processing workflow: Create Pattern Trace or 
Pattern Scoring.

3. Do one of the following:

a. Click the Create Pattern Trace node.

The parameters for the node appear in the Parameters pane.

b. To display the browse icon, click the Isotope Ratios box.

c. Click the browse icon, .

The Isotope Ratio Editor dialog box opens (Figure 66).

–or–
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a. Click the Pattern Scoring node.

The parameters for the node appear in the Parameters pane.

b. To display the browse icon, click the Isotope Ratios box. 

c. Click the browse icon, .

The Pattern List Editor dialog box opens.

d. In the Pattern Editor dialog box, click Add Patterns.

The Isotope Ratio Editor dialog box opens (Figure 66).

Figure 66. Isotope Ratio Editor dialog box with an isotope pattern for a defined elemental 
composition
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Defining an Isotope Pattern from an Elemental Composition

 To set up the pattern for a compound by using its elemental composition

1. In the Isotope Ratio Definition Type area of the Isotope Ratio Editor dialog box, select 
the Define from Elemental Composition Formula option. 

2. In the Elemental Composition box, type or paste the alphanumeric elemental 
composition of the compound of interest.

The application automatically populates the Mass Shift and Intensity [%] columns.

3. Do the following:

• In the Int. Threshold [%] box, type the relative intensity threshold.

The application removes isotopic peaks below this relative intensity threshold from 
the Mass Shift versus Intensity [%] table.

• In the Resolution box, type the resolution for the scans. 

• In the Charge box, type or select the charge state of the ions.

The application uses the charge state to display the theoretical mass spectrum in the 
graphical display.

4. Select the check boxes of the required peaks.

Copying an Elemental Composition from the Expected Compounds Library

 To copy a compound’s elemental composition from the Expected Compounds library 

1. If the Isotope Ratio Editor dialog box is open, close it.

2. From the menu bar, choose Libraries > Expected Compounds 

The Expected Compounds library opens.

3. Right-click anywhere on the page and choose Cell Selection Mode.

Tip  To enter an elemental composition for a labeled compound, use brackets to 
identify the type and number of labeled atoms for each element. 

For example, to enter the elemental composition of omeprazole where only one of the 
carbon atoms has been replaced with carbon-13, type C16 [13]C H19 N3 O3 S.

Note  The scan header in the raw data file lists the resolution of each scan, and the 
instrument method that is associated with the raw data file lists the resolution of 
each scan event.
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4. Click the elemental composition of interest. 

The table cell turns a lighter blue than the remaining cells in the table row.

5. Right-click the highlighted cell and choose Copy. 

6. Open the Isotope Ratio Editor dialog box.

7. Right-click in the Elemental Composition box and choose Paste.

Setting Up a Custom Isotope Pattern

 To set up a custom pattern

1. In the Isotope Ratio Editor dialog box, select the Custom Isotope Ratio Pattern option.

Below the Isotope Ratio Definition Type area, the available parameters change 
(Figure 67).

Figure 67. Custom Isotope Ratio Pattern view

2. To set up the custom isotope ratio pattern, do one of the following:

• Type values in the Mass Shift and Intensity boxes.

• Click Get from Composition Formula.

The application uses the text in the hidden Elemental Composition box.

• Click Get from Clipboard.

The application uses the mass spectrum data that you copied to the Clipboard.
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Exporting a Mass Spectrum from a RAW File to the Clipboard

 To export a mass spectrum from a raw data file to the Clipboard

1. From the FreeStyle™ data-visualization application, do the following: 

a. Open the raw data file that contains the mass spectrum of interest and make the mass 
spectrum view or the spectrum list view the active view.

b. In the Exports area of the Spectrum Workspace Options toolbar, click Selection AS.

c. In the Copy to Clipboard/Export dialog box, select the To CSV File option and click 
OK.

d. In the Export Data dialog box, select a folder, name the file, and click Save.

The spreadsheet opens in a spreadsheet application.

2. In the spreadsheet application, select up to 20 rows of m/z and intensity values and copy 
them to the Clipboard. Do not select the spectrum header information.

Isotope Ratio Editor Parameters

Table 26 describes the parameters in the Isotope Ratio Editor dialog box.

Table 26.  Isotope Ratio Editor dialog box parameters (Sheet 1 of 3)

Parameter Description

Isotope Ratio Definition Type

These two options define the parameters that appear below the Isotope Ratio Definition 
Type area.

Define from Elemental 
Composition Formula

Selecting this option makes the following features visible:

• Elemental Composition box

• Int. Threshold [%] box

• Resolution box

• Charge box
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Custom Isotope Ratio 
Pattern

Selecting this option makes the following features visible:

• Get from Composition Formula button

• Get from Clipboard button

• Bar graph of Intensity [%] versus the m/z ratio of the isotopic 
mass peaks 

• Data entry table where you define a custom isotope pattern in 
terms of the mass shift and intensity of each mass peak 

Use this option to create a custom isotope pattern.

Elemental composition view

Selecting the Define from Elemental Composition Formula option makes the following 
parameters visible: Elemental Composition, Int. Threshold [%], Resolution, and Charge.

Elemental 
Composition

Specifies the elemental composition of the compound of interest. 

When you type a composition in this box, the application 
automatically creates a table of mass shifts and intensities.

Default: Empty (unless you have already specified the elemental 
composition in the Isotope Ratios box under General Settings for 
the Pattern node)

Int. Threshold [%] Specifies the intensity threshold of the isotope pattern. 

Default: 0.10; range: 0–100

Resolution Specifies the resolution of the isotope pattern. 

Default: 60 000; range: 2–1 000 000 000

Charge Specifies the charge of the ion fragment. 

Default: 1; range: 1–100

Graph of Intensity [%] versus m/z value

Displays a graph of the full isotope distribution in the mass shift and intensity table.

Table 26.  Isotope Ratio Editor dialog box parameters (Sheet 2 of 3)

Parameter Description
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Mass shift and intensity table

Use this table to specify the required peaks in the isotope pattern.

When you select the Define from Elemental Composition Formula option, the application 
automatically populates this table; you cannot edit the entries.

Required 

(for an isotope pattern 
defined from a 
user-specified 
elemental composition)

Specifies whether the isotope is required.

• When the check box is selected, the isotope is required.

• When the check box is clear, the isotope is not required.

Mass Shift Specifies the mass shift from the pattern base peak (A0). 

Intensity [%] Specifies the relative intensity [%] of the isotope to the pattern 
base peak. 

Rows Specify the values for the isotopes. 

Custom isotope ratio pattern view

Selecting the Custom Isotope Ratio Pattern option makes the following buttons visible: Get 
from Composition Formula and Get from Clipboard.

Get from Composition 
Formula 

Creates an isotope pattern for an elemental composition formula. 
The application reads the elemental composition that you entered 
in the Elemental Composition box before selecting the Custom 
Isotope Ratio Pattern option.

Get from Clipboard Imports the isotope pattern from the Clipboard. You can export a 
custom pattern to the Clipboard from the spectrum list view in 
the Qual Browser application or from a third-party software 
application.

Graph of Intensity [%] versus m/z value

Displays a graph of the full isotope distribution in the mass shift and intensity table.

Mass shift and intensity table

When you select the Custom Isotope Ratio Pattern option, you can edit the mass shift and 
intensity values for the isotope pattern.

Table 26.  Isotope Ratio Editor dialog box parameters (Sheet 3 of 3)

Parameter Description
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Creating an Isotope Patterns List
The Pattern Scoring node requires a list of isotope patterns.

 To add isotope patterns to the Isotope Patterns node

Do either of the following:

a. In the node’s Isotope Patterns box, type the elemental composition formulas for the 
defined isotope patterns that you want to compare. Separate each pattern with a 
semicolon and a space—for example, C15S; C17S. 

b. Click the browse icon, , to the right of the Isotope Patterns box of the Isotope 
Patterns node.

The Pattern List Editor opens (Figure 68).

c. Select the isotope pattern that you want to edit, and then click Edit Pattern.

d. To edit the pattern, see “Setting Up Isotope Patterns for Pattern Scoring or Pattern 
Traces” on page 142.

–or–

a. Click the browse icon, , to the right of the Isotope Patterns box of the Isotope 
Patterns node.

The Pattern List Editor opens (Figure 68).

Figure 68. Pattern List Editor

b. For each pattern that you want to add, click Add Patterns, and then set up the 
isotope pattern in the Isotope Ratio Editor.

After you add a pattern, it appears in the Patterns table of the Pattern List Editor 
dialog box. The Name and Elemental Composition columns display the elemental 
composition of the pattern. The text in the Name column is editable.

c. Click OK to close the Pattern List Editor dialog box.

The isotope patterns appear in the Isotope Patterns box of the Isotope Patterns node. 
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Table 27 describes the commands and table columns in the Pattern List Editor dialog box.

Related Topics

• Setting Up Isotope Patterns for Pattern Scoring or Pattern Traces

Table 27.  Pattern List Editor parameters

Parameter Description

Commands

Add Patterns Opens the Isotope Ratio Editor dialog box for setting up an 
isotope pattern.

Delete Patterns Deletes the selected pattern.

Edit Pattern Opens the Isotope Ratio Editor dialog box for editing the 
selected pattern.

Columns

Name By default, displays either the elemental composition for each 
isotope pattern that you create with a defined elemental 
composition or the text “CustomPattern #” for each isotope 
pattern that you create by setting up a custom isotope ratio 
pattern.

You can edit the text in this column.

Elemental Composition Displays the elemental composition for each isotope pattern 
that is based on a defined elemental composition.

Is Custom Pattern Displays an X for each isotope pattern that is based on a 
custom isotope ratio pattern.

# Isotopes Displays the number of isotopes in the defined pattern that 
are above the intensity threshold.

# Isotopes Required Displays the number of isotopes required to calculate the 
SFit% score.

Charge Displays the charge state used to simulate the isotope pattern.
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Extracting Analog Traces
To extract analog traces from your raw data, add the Create Analog Trace node to the 
processing workflow. Analog traces include data from a UV-Vis detector, analog data from LC 
devices controlled by the Xcalibur data system or an equivalent Thermo Scientific application, 
and analog signals from devices connected to the analog channels on the communications 
panel of your mass spectrometer.

 To extract UV or analog traces from the raw data

1. Under General Settings, select UV or Analog from the Trace Type list.

2. In the RT offset [min] box, type the offset time, in minutes, for the UV-Vis or Analog 
trace.

If there is a time difference between when the sample enters the mass spectrometer and 
the UV-Vis or analog detector’s flow cell, use the offset time to align the chromatographic 
traces. A value of 0 indicates that the UV-Vis or analog detector and the mass 
spectrometer detected the sample simultaneously.

3. In the Custom Label box, type text to identify the trace in the Specialized Traces table of 
the result file window.

Related Topics

• Create Analog Trace Node

Extracting PDA Traces 
To extract the traces acquired by a photodiode array detector from your raw data, add the 
Create Analog Trace node to the processing workflow. 

 To extract a PDA trace from the raw data

1. In the General Settings area, do the following:

• In the Trace Type list, select PDA.

• In the RT offset [min] box, type the offset time, in minutes, for the PDA traces.

If there is a time difference between when the sample enters the mass spectrometer 
and the PDA detector’s flow cell, use the offset time to align the chromatographic 
traces. A value of 0 indicates that the PDA detector and mass spectrometer 
simultaneously detect the sample.

• In the Custom Label box, type text to identify the trace in the Specialized Traces table 
on the result file page.
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2. In the PDA Settings area, do the following:

• To extract a plot of the average intensity of the scanned wavelength range versus time, 
select True for Total Scan.

This trace is labeled as a Total Scan in the Specialized Traces table.

• To extract a plot of the spectrum maximum of the scanned wavelength range versus 
time, select True for Spectrum Maximum.

This trace is labeled as a Spectrum Maximum in the Specialized Traces table.

• To extract a plot for a specified wavelength range, select True for Wavelength Range. 
Then, type the wavelength range in the Min. and Max. Wavelength boxes.

Related Topics

• Create Analog Trace Node

Creating a Completely New Processing Workflow
A processing workflow is part of an analysis, and you can only perform analyses from inside a 
study. Therefore, to edit or create a processing workflow, you must open a study and start a 
new analysis or open an analysis template.

A processing workflow always begins with the Input Files node. All processing workflows that 
process MS data require the Select Spectra node. The only processing workflow that does not 
require the Select Spectra node is limited to processing the data from an analog detector. 

 To create a completely new processing workflow from an empty Workflows page

1. Open the Workflows page. If the Workflows Tree area contains a processing workflow 
that you do not want to edit, click Clear.

2. Drag the required Input Files node from the Workflow nodes pane to the Workflow Tree 
pane.

The Input Files node reads the information in the raw data files.

3. To process the spectral data, drag the Select Spectra node to the Workflow Tree pane.

The Input Files node automatically connects to the Select Spectra node. The Select 
Spectra node reads and filters the MS scan data in the raw data files. The default 
parameter settings pass all the scan data to the next node.

4. To align multiple input files, drag the Align Retention Times node to the Workflow Tree 
pane. Then, connect the Select Spectra node to it.

The Align Retention Times node chromatographically aligns the MS scan data in the 
input files.
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5. To find expected compounds, do the following:

a. Check whether your Expected Compounds library contains the compounds of 
interest (see “Modifying the Expected Compounds List” on page 498).

b. Drag the Find Expected Compounds node to the Workflow Tree pane. Then, 
connect the Align Retention Times node to it.

c. Drag one or more Generate Expected Compounds nodes to the Workflow Tree 
pane. 

• To apply different transformation rules to multiple compounds, drag multiple 
Generate Expected Compounds nodes to the Workflow Tree pane, one for each 
set of rules.

• To apply the same transformation rules to one or more compounds, drag a single 
Generate Expected Compounds node to the Workflow Tree pane.

d. For each Generate Expected Compounds node, select the compounds of interest (see 
“Generate Expected Compounds Node” on page 234).

e. Connect the Generate Expected Compounds node or nodes to the Find Expected 
Compounds node. 

f. Drag the Group Expected Compounds node to the Workflow Tree pane. 

The Find Expected Compounds node automatically connects to it.

g. To add FISh scoring to the processing workflow for targeted compounds, drag the 
FISh Scoring node to the Workflow Tree pane. 

The Group Expected Compounds node automatically connects to it. 

Note   The Find Expected Compounds node accepts input from any of the 
Spectrum Processing nodes.

IMPORTANT  For analyses with multiple input files, always add the Align 
Retention Times node to the processing workflow. 

IMPORTANT  The Generate Expected Compounds node generates a list of 
expected compounds by using one or more user-specified library compounds and 
a set of user-specified chemical reactions. 

The Compounds parameter is empty until you select the compounds of interest. 
If you submit an analysis to the job queue without selecting the compounds of 
interest, a Caution symbol appears. 

Note  FISh scoring adds a significant amount of processing time to an analysis.
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h. Do one of the following:

• To detect unknown compounds in addition to the expected compounds, go to 
step 6.

• To merge the features found by the Expected Compounds node and detected by 
the Unknown Compounds node, go to step 10.

6. To detect unknown compounds, do the following:

a. Drag the Detect Compounds node to the Workflow Tree pane. Then, connect the 
Align Retention Times node to the Detect Compounds node. 

b. Drag the Group Compounds node to the Workflow Tree pane. 

The Detect Compounds node automatically connects to it.

7. To identify unknown compounds, do the following:

a. Drag the Predict Compositions node to the Workflow Tree pane. 

b. To assign a name, formula, and structure to the compounds in the Compounds table, 
drag the Assign Compound Annotations node to the Workflow Tree pane. 

c. (Optional) To search the online ChemSpider database, drag the Search ChemSpider 
node to the Workflow Tree pane. 

d. (Optional) To search mass lists, drag the Search Mass Lists node to the Workflow 
Tree pane. In the Workflow Tree pane, select the Search Mass Lists node, and then, 
in the parameters pane, select the appropriate mass lists (see ).

e. (Optional) To search the online mzCloud database, drag the Search mzCloud node 
to the Workflow Tree pane. 

f. (Optional) To search your local mzVault database, drag the Search mzVault node to 
the Workflow Tree pane. In the Workflow Tree pane, select the Search mzVault 
node, and then, in the parameters pane, select libraries from the mzVault Library list.

Note  The Group Compounds node automatically connects to all the Compound 
Identification nodes. In addition, the Group Expected Compounds node 
automatically connects to the Search Mass Lists, Search mzCloud, and Search 
mzVault nodes.

IMPORTANT  For best results, always include the Predict Compositions node in a 
processing workflow for untargeted compounds. Without the Predict 
Compositions node, the workflow does not report the elemental compositions of 
the unknown compounds without a hit from the online search databases or the 
local Metabolika database.
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8. To map detected compounds to a biochemical pathway, do any of the following:

• To search the local Metabolika pathways, drag the Map to Metabolika Pathways 
node to the Workflow Tree pane. 

• To search the KEGG database, drag the Map to KEGG Pathways node to the 
Workflow Tree pane. The Group Compounds node automatically connects to it. 

• To search the BioCyc database, drag the Map to BioCyc Pathways node to the 
Workflow Tree pane. 

The Group Compounds node automatically connects to it.

9. To rank the hits from the Search ChemSpider node, Map to Metabolika Pathways node, 
Search Mass Lists node, and Map to BioCyc Pathways node, drag the Apply mzLogic 
node to the Workflow Tree pane. 

When present, the Search ChemSpider node, Map to Metabolika Pathways node, Search 
Mass Lists node, and Map to BioCyc Pathways node automatically connect to it.

10. To compare the features found by the Find Expected Compounds and Detect 
Compounds nodes if applicable, drag the Merge Features node to the Workflow Tree 
pane. 

The Find Expected Compounds and Detect Compounds nodes automatically connect to 
it. 

11. To add Trace Creation nodes to the processing workflow, do the following:

• For each UV, PDA, or analog trace that you want to extract, drag a Create Analog 
Trace node from the Workflow Nodes pane to the Workflow Tree pane. 

The Input Files node automatically connects to it.

• For each pattern trace that you want to extract, drag a Create Pattern Trace node to 
the Workflow Tree pane. Then, connect the Align Retention Times node to each 
Create Pattern Trace node.

Note  The Group Compounds node automatically connects to all the Pathway 
Mapping nodes. 

Note  For information about adding the Mark Background Compounds nodes to an 
untargeted workflow, see “Marking Background Compounds in an Untargeted 
Analysis” on page 28. For information about using the Normalize Areas node for 
batch normalization, see “Quality Control Samples for Batch Normalization” on 
page 34.

Note  In this example, you connect the Align Retention Times node to the Create 
Pattern Trace, Create FISh Trace, and Create Mass Trace nodes. These nodes accept 
input from any of the Spectrum Processing nodes.
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• For each Fragment Ion Search (FISh) trace that you want to create, drag a Create 
FISh Trace node to the Workflow Tree pane. Then, connect the Align Retention 
Times node to each Create FISh Trace node.

• For each mass trace that you want to extract, drag a Create Mass Trace node to the 
Workflow Tree pane. Then, connect the Align Retention Times node to each Create 
Mass Trace node.

12. In the Post-Processing Nodes pane, do the following:

• To add a differential analysis (volcano plot) to the workflow for the specified sample 
groups and ratios, drag the Differential Analysis node to the Post-Processing Nodes 
pane below the Workflow Tree pane.

• To add the descriptive statistics columns to the Compounds and Expected 
Compounds tables in the result file, drag the Descriptive Statistics node to the 
Post-Processing Nodes pane below the Workflow Tree pane. The descriptive statistics 
columns provide information about the chromatographic peak areas (mean area, 
median area, minimum area, and so on) for each detected compound.

13. To export the MS scan data in the raw data files to a common data format, drag an 
Export Spectra node to the Workflow Tree pane. Then, connect one of these nodes to 
the Export Spectra node:

• Select Spectra

• Align Retention Times 

Related Topics

• Workflow Nodes

• Connecting the Workflow Nodes

Connecting the Workflow Nodes
Although most of the processing workflow nodes automatically connect to the appropriate 
input and output nodes, you might need to manually connect some of the nodes.

For a custom processing workflow, you must manually connect these nodes if you add them to 
the workflow:

• Spectrum Processing nodes 

• Find Expected Compounds node

• Trace Creation nodes (except for the Create Analog Trace node)

Note  In a result file, the descriptive statistics columns are hidden by default. 

Note  The Export Spectra node does not export analog data.
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 To connect the workflow nodes

1. Point to the input node of interest. 

Five white boxes appear, with one box at the center of the node and the other boxes at the 
center of each side.

2. Click one of the white boxes and hold down the mouse button until a red border and an 
arrowhead appear.

3. Continue holding down the mouse button as you drag the arrowhead to the output node 
of interest.

Depending on the compatibility, one of the following occurs:

• If the selected input node is not compatible with the output node, a red border 
appears around the output node.

• If the selected input node is compatible with the output node, a green border appears 
around the output node. When you release the mouse button, a directional arrow 
connects the input node to the output node.

4. To automatically format the layout of the workflow nodes, click Auto Layout in the 
Workflows command bar.

You can use the following nodes multiple times in a processing workflow: the Generate 
Expected Compounds node, all the Trace Creation nodes, and all the Spectrum Processing 
nodes, except for the Align Retention Times node.

Related Topics

• Workflows Page Command Bar

• Input and Output Nodes for the Workflow Nodes

Note  The Input Files node automatically connects to the Create Analog Trace node 
and the Select Spectra node.
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Input and Output Nodes for the Workflow Nodes
Table 28 describes the node connections. 

Table 28. Input and output nodes for each workflow node (Sheet 1 of 3)

Workflow node Input nodes Output nodes

1.0 Input/Output

Export Spectra Node Select Spectra Filter Centroids

Input Files
(Begins every processing workflow.)

None • Select Spectra
• Create Analog Trace

2.0 Spectrum Processing 

Align Retention Times Node Spectrum Processing • Spectrum Processing
• Trace Creation
• Find Expected Compounds
• Detect Compounds

Filter Centroids Node • Spectrum Processing • Spectrum Processing
• Trace Creation
• Find Expected Compounds
• Detect Compounds

Filter By Mass Defect Node • Spectrum Processing
• Generate Expected Compounds 

• Spectrum Processing
• Trace Creation
• Find Expected Compounds
• Detect Compounds

Filter By Scan Event Node Spectrum Processing • Spectrum Processing
• Trace Creation
• Find Expected Compounds
• Detect Compounds

Select Spectra Node Input Files • Spectrum Processing
• Trace Creation
• Find Expected Compounds
• Detect Compounds

3.0 Trace creation

Create Analog Trace Node Input Files None

Create Mass Trace Node Spectrum Processing None

Create FISh Trace Node Spectrum Processing None

Create Pattern Trace Node Spectrum Processing None

4.0 Compound Detection

Analyze Labeled Compounds Node Assign Compound Annotations None
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Detect Compounds Node Spectrum Processing • Group Compounds
• Merge Features

Fill Gaps Node Group Compounds • Normalize Areas 
• Mark Background Compounds

Group Compounds Node Detect Compounds • Compound Identification 
• Pathway Mapping 
• Fill Gaps 
• Mark Background Compounds 

5. Peak Area Refinement

Mark Background Compounds Node–
Unknown Compounds

See “Marking Background 
Compounds in an Untargeted 
Analysis” on page 28.

None

Normalize Areas Node Fill Gaps Mark Background Compounds

6. Compound Identification

Assign Compound Annotations Node Group Compounds None

Predict Compositions Node Group Compounds None

Search ChemSpider Node Group Compounds None

Search Mass Lists Node • Group Expected Compounds
• Group Compounds 

None

Search mzCloud Node • Group Expected Compounds
• Group Compounds 

None

Search mzVault Node • Group Expected Compounds
• Group Compounds 

None

7. Pathway Mapping

All Group Compounds None

8. Compound Scoring

Apply Spectral Distance Node • Search Mass Lists
• Search ChemSpider
• Map to KEGG Pathways
• Map to Metabolika Pathways
• Map to BioCyc Pathways

None

Apply mzLogic Node • Search Mass Lists
• Search ChemSpider
• Map to Metabolika Pathways
• Map to BioCyc Pathways 

None

Calculate Mass Defect Node Group Compounds None

Table 28. Input and output nodes for each workflow node (Sheet 2 of 3)

Workflow node Input nodes Output nodes
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Saving a Processing Workflow as a Template
You can run an analysis without saving the processing workflow in the Workflow Tree pane; 
however, you might want to save the processing workflow to a template for reuse later on. 
When you save the processing workflow as a template, the application does not automatically 
store it in the study folder. You can save a processing template to the Common Templates 
folder or a folder of your choice.

Compound Class Scoring Node Group Compounds None

Generate Molecular Networks Node 
(Beta)

Assign Compound Annotations None

Pattern Scoring Node Group Compounds None

9. Expected Compounds 

FISh Scoring Node Group Expected Compounds None

Find Expected Compounds Node • Generate Expected Compounds
• Spectrum Processing 

• Group Expected Compounds
• Merge Features

Generate Expected Compounds Node None • Find Expected Compounds
• Filter By Mass Defect

Group Expected Compounds Node Find Expected Compounds • FISh Scoring
• Mark Background Compounds

Mark Background Compounds Node–
Expected Compounds

Group Expected Compounds None

Merge Features Node • Find Expected Compounds
• Detect Compounds

None

10. Post-Processing (white nodes)

Descriptive Statistics Node None None

Differential Analysis Node None None

Export Xcalibur Inclusion or Exclusion 
List Node

None None

Table 28. Input and output nodes for each workflow node (Sheet 3 of 3)

Workflow node Input nodes Output nodes

Note  When you run an analysis, the application automatically saves the processing 
workflow to the result file. Selecting a result file on the Analysis Results page of a study 
and clicking Reprocess opens the processing workflow saved with the result file.
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 To save a processing workflow as a template

1. Do one of the following:

• To save the template in the Common Templates folder, click Save Common.

The Save Workflow dialog box opens to the Common Templates folder. 

• To save the template to the last folder that you opened or to another folder, click 
Save.

The Save Workflow dialog box opens to the last opened folder.

2. Select the folder where you want to store the template, name the template, and click Save.

If the processing workflow is valid, the application saves the template with the file name 
extension .cdProcessingWF. If the processing workflow contains an error, an error 
message box opens.

3. If the Exporting Template Workflow Failed message box opens, read the list of errors, 
close the message box, fix the errors, and click Save.

Use the Workflows page (in any study) to create or edit processing workflows. The Workflows 
page is a tabbed page to the right of the Grouping & Ratios page and is available only when 
the Analysis pane is open. 
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7

Workflow Nodes

A processing workflow consists of a set of connected workflow nodes and each workflow node 
has a set of associated parameters. To create and edit processing workflows, see Chapter 6, 
“Creating and Editing Processing Workflows.”  

On the Workflows page, in the Workflow Nodes pane, the workflow nodes are organized into 
functional groups. For information about the workflow nodes, see the following topics.

Input and Output Nodes
These topics describe the input and output nodes:

• Export Spectra Node

• Input Files Node

Note  The following nodes are new in Compound Discoverer 3.1—Apply Spectral 
Distance, Calculate Mass Defect, Generate Molecular Networks (Beta), and Scripting 
Node. 

Contents

• Input and Output Nodes

• Spectrum Processing Nodes

• Trace Creation Nodes

• Compound Detection Nodes

• Peak Area Refinement Nodes

• Compound Identification Nodes

• Pathway Mapping Nodes

• Compound Scoring Nodes

• Expected Compounds Nodes

• Post-Processing Nodes
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Export Spectra Node

Use the Export Spectra node to export all or a subset of the mass spectrum scans in an 
Xcalibur RAW file to an open-source format file. The Export Spectra node does not export 
the data from analog detectors. 

The Export Spectra node requires input from one of the data processing nodes. The 
processing workflow shown in Figure 69 reads the input files, extracts the MS scans of 
interest, and exports the data to an open source format file. Running this processing workflow 
does not require an active software license.

Figure 69. Minimum processing workflow for the Export Spectra node

Table 29 describes the parameters for the Export Spectra node.

Note  You can add multiple Export Spectra nodes to a processing workflow.

Table 29. Export Spectra node parameters (Sheet 1 of 2)

Parameter Description

1. Output Data

File Name Specifies the file name of the exported file. If you leave this box 
empty, the node uses the result file name.

File Name Suffix Specifies the suffix that the application appends to the file name of 
the exported file.
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Input Files Node

Every processing workflow must begin with the Input Files node. This node has no 
parameters.

To view information about a result file’s input files, open its Input Files Table.

Spectrum Processing Nodes
These nodes extract the mass spectral data from the input file set:

• Align Retention Times Node

• Filter By Mass Defect Node

• Filter By Scan Event Node

• Filter Centroids Node

• Select Spectra Node

Export Format Specifies the data format of the exported file.

Selections: 

• DTA archive (*.dta.zip)—Generates a zip file that contains an 
individual DTA file for each MS scan in the raw data file. The 
individual file names include the scan number of the scan. 
The DTA file format is a simple text file that contains a peak 
table of mass and intensity. This format does not store 
information about data acquisition, such as the instrument 
method or mass resolution, and you cannot reprocess DTA 
files with a mass spectrometry application.

• Mascot Generic Format (*.mgf )—Generates an MGF file, 
which lists the MS scans by retention time. The scan data for 
each time point consists of two columns: mass and intensity. 

• mzDATA (*mzData)—Generates an XML-based file that 
third-party mass spectrometry software packages can read.

• mzML (*mzML)—Generates an XML-based file that 
third-party mass spectrometry software packages can read.

Table 29. Export Spectra node parameters (Sheet 2 of 2)

Parameter Description
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Align Retention Times Node

Use the Align Retention Times node for chromatographic alignment of multiple input files. 
The Align Retention Times node compensates for small differences in the retention times of 
the components in a sequence of sample runs. 

Table 30 describes the parameters for the Align Retention Times node.

IMPORTANT  In the spectrum processing node that supplies spectra to the Alignment, do 
not apply a scan filter that excessively reduces the retention time window, as doing so 
might cause an alignment failure. The Align Retention Times node requires a minimum 
amount of representative scan data to chromatographically align the input files in an 
analysis.

Table 30. Align Retention Times node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Alignment Model Specifies the curve fitting algorithm that the workflow uses to 
chromatographically align the input files.

Default: Adaptive Curve
Selections: Adaptive Curve or Linear

Alignment Fallback Specifies the alternate model to apply when the Adaptive Curve 
regression model fails.

Default: Use Linear Model
Selections:

• None—There is no alternative. Continue to use the Adaptive 
Curve model.

• Don’t Align—Do not chromatographically align the input 
files.

• Use Linear Model—Use the Linear model instead of the 
Adaptive Curve model.

Maximum Shift [min] Specifies the maximum retention time shift between the 
alignment features (chromatographic peaks with the same 
m/z × RT dimensions) in the input files.

Default: 2 (± 2 minutes for each feature); range: 0.01–4.0 
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Related Topics

• Viewing the Corrected Retention Times of the Alignment Features

• File Alignments Table

Filter By Mass Defect Node

Use the Filter By Mass Defect node to keep or remove mass spectral peaks (centroids) in the 
full (MS1) scan data that fall within a set of specified mass tolerance and mass defect 
windows. 

You can add multiple Filter By Mass Defect nodes to a processing workflow. 

To specify the elemental compositions for the node, you can enter the elemental compositions 
in the Custom Compositions area of the node, or you can use the Generate Expected 
Compounds Node to provide the compositions.

Shift Reference File Specifies whether to shift the retention time of all the detected 
features to eliminate any negative retention time values in the 
input file set.

Default: True

Selections:
• True: If the data set includes features with negative retention 

times, the algorithm shifts all of the features to avoid 
cropping.

• False: Removes features with negative retention time values 
from the analysis (crops the feature from the feature list passed 
to the connected nodes).

Mass Tolerance Specifies the mass tolerance to be used for feature matching.

Default: 5.0 ppm; range: 0.1–50 ppm

Remove Outlier Specifies whether the retention time algorithm ignores outlier 
landmark features.

Default: True 

Table 30. Align Retention Times node parameters (Sheet 2 of 2)

Parameter Description
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Table 31 describes the parameters for the Filter By Mass Defect node.

Table 31. Filter By Mass Defect node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Filter Direction Specifies whether the selected mass defect filter keeps or removes mass 
spectral peaks (centroids) from further processing.

Default: Keep
Selections: Keep or Remove

Mass Defect Type Specifies the mass defect type.

Default: Standard Mass Defect

Selections: 

Where:

Calculates the integer mass using the selected rounding function 
(floor, ceiling, or round)

Kendrick Formula When you select the Kendrick Mass Defect type, this user-specified 
elemental composition specifies the Kendrick formula.

Nominal Mass 
Rounding

Specifies how the node calculates nominal masses. 

Default: Floor

Selections: 
• Floor rounds down.
• Ceiling rounds up.
• Round rounds to the nearest integer value.

Fractional Mass exact mass floor (exact mass)–=

Standard Mass Defect exact mass nominal mass–=

Relative Mass Defect 1e6 (exact mass nominal mass)–
(exact mass)

------------------------------------------------------------------------------------------------------=

Kendrick Mass Defect Kendrick mass nominal Kendrick mass–=

Exact mass Monoisotopic mass of the elemental composition=

Nominal mass Integer mass=

Kendrick Mass exact mass nominal mass of Kendrick formula
exact mass of Kendrick formula

------------------------------------------------------------------------------------------------------=
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Related Topics

• Adding or Editing Ion Definitions with the Ion Definition Editor

• Calculating the Mass Defect of an Elemental Composition

2. Tolerances

Using the mass defect values calculated above and the exact mass values calculated from the 
elemental composition input, these mass tolerance values define the rectangular mass defect 
filters.

Mass Tolerance The input from the data processing nodes is a table of m/z values and 
intensities for each full (MS1) scan.

Specifies the mass tolerance for the ions that the filter removes or 
passes through to the next node. 

Default: 50 Da
Selection: 0 to 6000 Da

Mass Defect 
Tolerance

Specifies the mass defect tolerance for the ions that the filter removes 
or passes through to the next node.

Default: 0.025 (Da or unit-less for the Relative Mass Defect selection)

Range: 0–No limit

3. Custom Compositions

Composition 
(5 entry boxes)

Specify the elemental compositions that the node uses to create the 
mass defect filters.

Leave these boxes empty if you want to use one or more Generate 
Expected Compounds nodes to generate the list of elemental 
compositions.

Ions Specifies the ion definitions to be used with the custom compositions. 
For each elemental composition, the node creates one mass defect filter 
for each ion definition—that is, if you select five ion definitions, the 
node creates five mass defect filters for each elemental composition.

Select the ion definitions from the dropdown list. Use the Ion 
Definition Editor to create new ion definitions.

Table 31. Filter By Mass Defect node parameters (Sheet 2 of 2)

Parameter Description
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Filter By Scan Event Node

Use the Filter By Scan Event node to filter the mass spectra by scan events. 

Table 32 describes the parameters for the Filter By Scan Event node.

Table 32. Filter By Scan Event node parameters  (Sheet 1 of 3)

Parameter Description

Filter Settings

Mass Analyzer Specifies the mass analyzer that the instrument used to acquire the 
scan. A Thermo Scientific hybrid mass spectrometer, such as the 
LTQ Orbitrap mass spectrometer, contains two mass analyzers 
and can acquire both ITMS (low-resolution) and FTMS 
(high-resolution) scans in one data file.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The application does not filter scan 
events by the mass analyzer that was used to acquire the data.

Check box selections:
• Ion Trap (ITMS)
• Fourier Transform (FTMS))
• Time of Flight (TOFMS)
• Single Quad (SQMS)
• Triple Quad (TSMS)
• Sector Field (SectorMS)

MS Order Specifies the MS order (scan power that the instrument used) of 
the scans that you want the node to filter. 

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter the scans by 
MS order.

Check box selections: MS1–MS7

Note  The Detect Compounds and Find Expected Compounds 
nodes search the full (MS1) scans for mass peaks. If you filter 
out the MS1 scans by selecting Is MS2 or higher for the MS 
Order, the result tables for these nodes are empty.
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Activation Type Specifies the activation types that the instrument used to produce 
the product ion spectra.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter the scans by 
activation type.

Check box selections:
• CID (Collision Induced Dissociation)
• MPD (Multi Photon Dissociation)
• ECD (Electron Capture Dissociation)
• PQD (Pulsed Q Collision Induced Dissociation)
• ETD (Electron Transfer Dissociation)
• HCD (Higher Energy Collision Dissociation)
• EThcD (ETD With Supplemental HCD)
• UVPD (Ultra Violet Photo Dissociation)
• Any Activation Type

Min. Collision Energy Specifies the minimum Normalized Collision Energy™ for a 
higher-order scan to pass through the filter.

Default: 0 (no filtering)
Minimum value: 0
Maximum value: Unchecked

Max. Collision Energy Specifies the maximum Normalized Collision Energy for a 
higher-order scan to pass through the filter. 

Default: 1000
Minimum value: 0
Maximum value: 1000

Table 32. Filter By Scan Event node parameters  (Sheet 2 of 3)

Parameter Description
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Scan Type Specifies the scan type for the scan event that the instrument used 
to produce the product ion.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter the scan events 
by scan type.

Check box selections:
• Full
• Single Ion Monitoring (SIM) 
• Single Reaction Monitoring (SRM) 

Polarity Mode Specifies the polarity mode for the scan.

Filter selection: Any, Is, Is Not

Default: (Not Specified)—The node does not filter the scan events 
by polarity mode.

Check box selections:
• Positive
• Negative

Table 32. Filter By Scan Event node parameters  (Sheet 3 of 3)

Parameter Description
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Filter Centroids Node

Use the Filter Centroids node to remove mass spectral peaks (centroids) that are below a 
user-specified intensity threshold from the mass scans, below a user-specified signal-to-noise 
threshold for FTMS scans, or both. 

Table 33 describes the parameters for the Filter Centroids node.

Table 33. Filter Centroids node parameters

Parameter Description

1. General 

S/N Threshold 
(for FT-only)

Specifies the minimum signal-to-noise threshold for each centroid 
in an FTMS scan. The node excludes centroids from the analysis 
that are below this intensity value. 

The application uses the spectrum noise reported by an 
instrument.

Default: 1.5

Minimum Intensity 
Threshold

Specifies the minimum intensity threshold for the mass spectral 
peaks (centroids). The node excludes centroids from the analysis 
that are below this intensity value.

Default: 0 (no filtering)
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Select Spectra Node

The raw data file (Xcalibur RAW file) contains the mass spectral scans acquired by your 
Thermo Scientific mass spectrometer and any optional data acquired by a PDA, UV-VIS, or 
analog detector during the acquisition run. The Select Spectra node can read and filter the 
mass spectral scan data. The Select Spectra node cannot read the optional data acquired by a 
PDA, UV-VIS, or analog detector.

The mass spectral scans are numbered 1, 2, 3, and so on from the beginning to the end of the 
acquisition run. Use the Select Spectra node to select the scans that you want the application 
to process. Limiting processing to the scans of interest decreases processing time and 
minimizes false positives. For example, if you know the retention time of the compounds of 
interest, exclude scans that fall outside a specific retention time window. 

Table 34 describes the parameters in the Select Spectra node.

IMPORTANT  When using settings other than the defaults for the Select Spectra node, 
follow these guidelines:

• The application uses the full (MS1) scans to measure the accurate mass and isotope 
patterns of the mass spectral peaks; therefore, do not filter out the full (MS1) scans 
when the processing workflow includes the Find Expected Compounds and Detect 
Compounds nodes.

• Both the Align Retention Times and Find Expected Compounds nodes require a 
representative amount of data to function properly. If you excessively reduce the 
retention time window (for example, by using an RT or scan number range), the 
Align Retention Times node’s chromatographic alignment algorithm and the Find 
Expected Compounds node’s automatic peak width detection algorithm might fail to 
produce satisfactory results.

Table 34. Select Spectra node parameters  (Sheet 1 of 8)

Parameter Description

1. General Settings

Precursor Selection Specifies the MS order of the precursor scans for higher-order 
MSn scans, like MS3, MS4, and so forth.

Default: Use MS(n – 1) Precursor

Selections: Use MS1 Precursor or Use MS(n – 1) Precursor
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Use Isotope Pattern in 
Precursor Reevaluation

Determines whether the node considers the isotope pattern in 
reevaluating precursors.

Default: True
Selections:

• True—The node considers the isotope pattern in reevaluating 
precursors.

• False—The node does not consider the isotope pattern in 
reevaluating precursors.

Provide Profile Spectra When set to True, the node stores the profile data for the scans.

When set to Automatic, the node checks whether any other nodes 
in the processing workflow that require profile data. If the profile 
data is not needed, the node only stores the centroid data. 

Default: Automatic

Store Chromatograms Specifies whether the application creates a TIC trace and a BPC 
trace for each input file and lists these traces in the Specialized 
Traces table.

Default: False

2. Spectrum Properties Filter

Note  The retention time filter excludes scans outside the specified limits; however, the 
application does not check the validity of the retention time settings against the actual 
acquisition time for the raw data file. When both the lower and upper RT limits are set to 
0 (default), the application does not use retention time to filter scans.

Lower RT Limit Excludes scans acquired before the user-specified retention time.

Default: 0 
Minimum value: 0
Maximum value: Unchecked 

Upper RT Limit With the exception of a setting of 0, excludes scans that were 
acquired after the user-specified retention time. 

Default: 0; Minimum value: 0; Maximum value: Unchecked 

Note  The scan number filter excludes scans outside the specified limits; however, the 
application does not check the validity of the scan number settings against the actual scan 
numbers in the raw data file. When both the first and last scan number are set to 0 
(default), the application does not filter scans by scan number. When filtering by scan 
number, verify the scan number range in a mass spectrometry viewer application, such as 
Qual Browser or FreeStyle. 

Table 34. Select Spectra node parameters  (Sheet 2 of 8)

Parameter Description
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First Scan Specifies the scan number of the first available scan that you want 
the node to process. 

When this parameter is set to 0, the node processes the first scan 
that passes through the other filters. 

When this parameter is set to a value that is greater than the last 
available scan number, the node filters out all of the scans.

Default: 0 (no filtering)

Minimum value: 0; Maximum value: Unchecked 

Last Scan Specifies the last available scan number that you want the node to 
process. 

When this parameter is set to 0 or a value that is greater than the 
last available scan number, the node processes the last scan that 
passes through the other filters.

Default: 0 (no filtering)

Minimum value: 0; Maximum value: Unchecked

Ignore Specified Scans Specifies the scan numbers that the analysis ignores. Placing the 
cursor in the Ignore Specified Scans box and clicking the More 
icon, , opens the Edit Parameter Text for Ignore Specified 
Scans dialog box where you can do the following:

• Manually enter the scan numbers to ignore.

• Load a text file that lists the scans numbers to ignore.

• Create and save a list of scans numbers to ignore.

Table 34. Select Spectra node parameters  (Sheet 3 of 8)

Parameter Description
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Note  The charge state filter excludes higher-order scans of precursor ions with a charge 
state that is outside the specified limits. The charge state filter does not affect the MS1 
scans.

Lowest Charge State Excludes higher-order scans of precursor ions with a lower charge 
state than the specified charge state.

Default: 0; Minimum: 0

Highest Charge State Filters out scans from precursor ions with a higher charge state 
than the specified charge state.

Default: 0 (specifies no upper limit)

Min. Precursor Mass Specifies the minimum precursor mass for a higher-order scan.

Default: 0 (no filtering)

Minimum value: 0; Maximum value: Unchecked 

Max. Precursor Mass Specifies the maximum precursor mass for a higher-order scan.

Default: 0 (no filtering)

Minimum value: 0; Maximum value: Unchecked 

Total Intensity 
Threshold

Excludes scans that fall below the specified total intensity 
threshold. The total intensity of a mass spectrum is the summed 
intensity of its mass spectrum peaks (centroids).

Minimum Peak Count Specifies the minimum number of mass spectrum peaks 
(centroids) that must be in the spectrum for the scan to pass 
through the filter.

Minimum value: 1; Maximum value: Unchecked

Table 34. Select Spectra node parameters  (Sheet 4 of 8)

Parameter Description
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3. Scan Event Filters

Mass Analyzer Specifies the mass analyzer that the instrument used to acquire the 
scan. An LTQ Orbitrap hybrid mass spectrometer can acquire 
both ITMS (low-resolution) and FTMS (high-resolution) scans in 
one data file.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter scan events by 
the mass analyzer used to acquire the data.

Check box selections:
• Ion Trap (ITMS)
• Fourier Transform (FTMS))
• Time of Flight (TOFMS)
• Single Quad (SQMS)
• Triple Quad (TSMS)
• Sector Field (SectorMS)

MS Order Specifies the MS order of the scans that you want the node to 
process.

Filter selection: Any, Is, Is Not
Default: Any—The application does not filter the scans by MS 
order.

Check box selections: MS1–MS7

Note  The Detect Compounds and Find Expected Compounds 
nodes search the MS1 scans for mass peaks. If you filter out the 
MS1 scans by selecting Is MS2 or higher for the MS Order, the 
result tables for these nodes are empty.

Table 34. Select Spectra node parameters  (Sheet 5 of 8)

Parameter Description
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Activation Type Specifies the activation type that the instrument used to produce 
the product ion spectra.

Filter selection: Any, Is, Is Not
Default: (Not Specified)—The node does not filter the scans by 
activation type.

Check box selections:
• CID (Collision Induced Dissociation)
• MPD (Multi Photon Dissociation)
• ECD (Electron Capture Dissociation)
• PQD (Pulsed Q Collision Induced Dissociation)
• ETD (Electron Transfer Dissociation)
• HCD (Higher Energy Collision Dissociation)
• EThcD (ETD With Supplemental HCD)
• UVPD (Ultra Violet Photon Dissociation)
• Any Activation Type

Min. Collision Energy Specifies the minimum Normalized Collision Energy for a 
higher-order scan to pass through the filter.

Default: 0 (no filtering)

Minimum value: 0; Maximum value: Unchecked

Max. Collision Energy Specifies the maximum Normalized Collision Energy for a 
higher-order scan to pass through the filter. 

Default: 1000; Minimum value: 0; Maximum value: 1000

Scan Type Specifies the scan type for the scan event that the instrument used 
to produce the product ion.

Filter selection: Any, Is, Is Not
Default: Any—The application does not filter the scan events by 
scan type.

Check box selections:
• Full
• Selected Ion Monitoring (SIM) 
• Selected Reaction Monitoring (SRM) 

Table 34. Select Spectra node parameters  (Sheet 6 of 8)

Parameter Description
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Polarity Mode Specifies the polarity mode for the scan.

Filter selection: Any, Is, Is Not

Default: (Not Specified)—The node does not filter the scan events 
by polarity mode.

Check box selections:
• Positive
• Negative

4. Peak Filters

S/N Threshold 
(FT-only)

Specifies the signal-to-noise threshold for mass peaks in an FTMS 
scan. Mass peaks below this threshold are filtered out.

Default: 1.5

5. Replacements for Unrecognized Properties

Unrecognized Charge 
Replacements

Specifies the charge state or states to process when the charge state 
of the precursor ion is indeterminate. 

Default: 1

In the Qual Browser window, an indeterminate charge state is 
specified with a question mark label (z=?) in a spectrum cell. In the 
FreeStyle application, ions with indeterminate charge states are 
labeled with a charge state of 0.

Default: 1; Selections: All, 1, 2, 3, 4, 5, 6, 7, and 8

Unrecognized Mass 
Analyzer Replacements

Specifies the mass analyzer used to acquire the data when the 
application cannot retrieve this information from the input file.

Default: ITMS

Selections: 
• Ion Trap (ITMS)
• Fourier Transform (FTMS)
• Time of Flight (TOFMS)
• Single Quad (SQMS)
• Triple Quad (TSMS)
• Sector Field (SectorMS)

Unrecognized MS 
Order Replacements

Specifies the MS order when the application cannot retrieve this 
information from the input file.

Default: MS2; Selections: MS1–MS10

Table 34. Select Spectra node parameters  (Sheet 7 of 8)

Parameter Description
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Trace Creation Nodes 
These nodes create specialized chromatographic traces:

• Create Analog Trace Node

• Create FISh Trace Node

• Create Mass Trace Node

• Create Pattern Trace Node

Unrecognized 
Activation Type 
Replacements

Specifies the activation type when the application cannot retrieve 
this information from the input file.

Default: CID

Selections: 
• CID (Collision Induced Dissociation)
• MPD (Multi Photon Dissociation)
• ECD (Electron Capture Dissociation)
• PQD (Pulsed Q Collision Induced Dissociation)
• ETD (Electron Transfer Dissociation)
• HCD (High Energy Collision Dissociation)
• EThcD (ETD With Supplemental HCD)
• UVPD (Ultra Violet Photon Dissociation)

Unrecognized Polarity 
Replacement

Specifies the polarity mode when the application cannot retrieve 
this information from the input file.

Default: (+)  Selections: Positive (+) or Negative (–)

Unrecognized MS 
Resolution @ 200 
Replacements

Specifies the resolution at m/z 200 for MS scans when the node 
cannot retrieve the resolution from the scan header.

Default: 60 000

Unrecognized MSn 
Resolution @ 200 
Replacements

Specifies the resolution at m/z 200 for MS/MS scans when the 
node cannot retrieve the resolution from the scan header.

Default: 30 000

Table 34. Select Spectra node parameters  (Sheet 8 of 8)

Parameter Description
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Create Analog Trace Node

Use the Create Analog Trace node to view the chromatograms for these trace types: 
ultraviolet-visible (UV), photo-diode array (PDA), or analog. Your Thermo Scientific data 
system supports several brands of UV-Vis and PDA detectors. You can acquire UV traces from 
a UV-Vis or a PDA detector and PDA traces from a PDA detector. If your analog detector is 
not supported by a Thermo Scientific data system, you can acquire an analog trace by 
connecting the detector to one of the analog channels on the communications panel of your 
Thermo Scientific mass spectrometer.

You can access analog traces from the Specialized Traces Table. 

Table 35 describes the parameters for the Analog Traces node.

Note  The Create Analog Trace node can also convert and display a pressure trace from an 
LC pump and a temperature trace from a column heater or autosampler with temperature 
control, when these instruments are controlled by the Xcalibur data system or equivalent 
Thermo Scientific application. 

Table 35. Create Analog Trace node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Trace Type Specifies whether the application extracts a UV, PDA, or analog 
trace from the raw data file.

Default: UV; Selections: UV, PDA, or Analog

RT Offset [min] Specifies the offset time, in minutes, between the UV, PDA, or 
analog detector and the mass spectrometer traces. 

A negative value shortens and a positive value lengthens the 
apparent retention time of the peaks detected by the UV, PDA, or 
analog detector. 

Default: 0; range: –10 to 10

Custom Label Type text to identify the trace in the Specialized Traces table on 
the result file page.

2. PDA Settings

Total Scan Specifies whether the node extracts a total scan trace for the 
scanned wavelength range. 

Total scan traces display the average absorbance for each time 
point of all the wavelengths in the scan range.

Default: False
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Spectrum Maximum Specifies whether the node extracts a spectrum maximum trace for 
the scanned wavelength range.

Spectrum maximum traces display a plot of the maximum 
absorbance values in the scan range for each time point.

Default: False

Note  Use the Min. and Max. Wavelength boxes to specify a trace of average absorbance 
versus time.

• To display the chromatogram for a specific scan wavelength, type the same 
wavelength number in the Min. and Max. Wavelength boxes.

• To display a plot of the average absorbance values for a range of wavelengths, type the 
beginning wavelength number in the Min. Wavelength box and the ending 
wavelength number in the Max. Wavelength box.

Wavelength Range Specifies whether the node extracts the entire acquired scan or a 
wavelength range.

Default: True—Uses a specified wavelength range.

Min. Wavelength Specifies the beginning wavelength, in nanometers, of the trace 
that you want the node to extract.

Default: 190; range: 190–800 nm

Max. Wavelength Specifies the ending wavelength, in nanometers, of the trace that 
you want the node to extract.

Default: 190; range: 190–800 nm

Table 35. Create Analog Trace node parameters (Sheet 2 of 2)

Parameter Description
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Create FISh Trace Node

Use the Create (Fragment Ion Search) FISh Trace node to create FISh traces. The Create FISh 
Trace node requires fragmentation scans and takes input from any of the data processing 
nodes. The output from the FISh trace node is a summed FISh trace that is accessible from 
the Specialized Traces Table, individual fragment traces that are accessible from the FISh Trace 
Fragments result table, or both.

Table 36 describes the parameters for the Create FISh Trace node.

Table 36. Create FISh Trace node parameters (Sheet 1 of 3)

Parameter Description

1. Compound Selection

Compound Specifies the compound that the node uses to generate expected 
fragment ions.

The selection list contains the compounds in the user-created 
Expected Compounds library .

IMPORTANT  To run an analysis that includes the Create FISh 
Trace node, you must select a compound from this list.

2. Trace Settings

Mass Tolerance Specifies the mass tolerance that the node uses to create the FISh 
trace.

Default: 2.5 mmu

Summed Trace Specifies whether the node generates a summed trace of all the 
detected fragment ions. You can access the summed FISh trace 
from the Specialized Traces result table.

Default: True

Individual Traces Specifies whether the node generates individual traces for each 
generated fragment ion. You can access the individual traces from 
the FISh Trace Fragments result table.

Default: True

Custom Label Type text that you can use to identify the chromatogram in a 
report.

This box accepts alphanumeric and special characters.

3. Scan Filter Settings

Scan Polarity Specifies the polarity of the scan.

Default: + (Positive); Selections: Positive or Negative
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Fragment Mode Specifies the fragmentation mode of the fragmentation scans that 
you want the node to extract.

Default: Data-Dependent; selections: Data-Dependent and Data 
Independent

Select Data-Dependent for data-dependent fragmentation (DDF) 
scans or Data Independent for all-ion fragmentation (AIF) scans.

4. Fragment Prediction Settings

Use General Rules Specifies whether the node uses the general fragmentation rules for 
fragment prediction.

Use Libraries Specifies whether the node uses the fragmentation libraries for 
fragment prediction.

Default: True

Max. Depth Specifies the maximum number of steps in the fragmentation 
pathway.

Range: 1 to 20

Aromatic Cleavage Specifies whether the node includes a cleavage step in the 
fragmentation pathway for highly aromatic structures—that is, for 
aromatic structures where n in Huckel’s rule is 2 or higher.

4n + 2 = 0 or a positive integer for the number of electrons in the 
delocalized, conjugated p-orbital cloud

For example, the following structure is aromatic with an n value 
of 2.

Default: True

Table 36. Create FISh Trace node parameters (Sheet 2 of 3)

Parameter Description
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Related Topics

• Modifying the Expected Compounds List

• Troubleshooting Common Analysis Errors

Create Mass Trace Node

Use the Create Mass Trace node to extract a mass chromatogram that you can access from the 
Specialized Traces Table of the result file. You can specify the type, the fragmentation order, 
and the polarity of the trace. For an XIC trace, you must specify the mass range.

Table 37 describes the parameters for the Create Mass Trace node.

Min. Fragment m/z Specifies the minimum m/z value of a fragment ion to be 
generated by the prediction fragmentation pathway. 

Default: 50; range: 0 or higher

Max. Fragment m/z Specifies the maximum m/z value of a fragment ion to be 
generated by the prediction fragmentation pathway.

When the value is set to 0, the node ignores this parameter.

Default: 0 

Table 36. Create FISh Trace node parameters (Sheet 3 of 3)

Parameter Description

Table 37. Create Mass Trace node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Trace Type Specifies the chromatogram type to be generated.

Default: BPC

Selections: TIC (total ion chromatogram), BPC (base peak 
chromatogram), or XIC (extracted ion chromatogram)

MS Order Specifies the MS order of the mass spectra that make up the 
chromatogram.

Default: MS1; Selections: MS1–MS10

Polarity Specifies the ionization polarity used to produce the mass spectra 
that make up the chromatogram.

Default: + (Positive); Selections: + (Positive) or – (Negative)
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Create Pattern Trace Node

Use the Create Pattern Trace node to draw a chromatogram from the mass peaks that match a 
specific pattern within the filtered set of spectra. The pattern can be based on the elemental 
composition of a target compound or on a user-specified pattern. To view the pattern trace in 
the Chromatogram view for a result file, open the Specialized Traces Table and select the 
pattern trace.

Table 38 describes the parameters for the Create Pattern Trace node.

Custom Label Use this box to type text that you can use to identify the 
chromatogram.

This text appears in the Custom Label column of the Specialized 
Traces result table.

This box accepts alphanumeric and special characters.

2. XIC Settings

Mass [Da] Defines the mass-to-charge (m/z) value of the extracted ion 
chromatogram (XIC).

Default: 0 

Mass Tolerance

(typed numeric value 
and selected units)

Specifies the mass tolerance for the spectral search. 

When you select Da or mmu (0.001 Da) in the units list, the mass 
tolerance is an absolute ± value for the mass specified in the Mass 
box. 

When you select ppm (parts per million) in the Units list, the 
mass tolerance is a relative range: 

Mass ± (Mass × User-specified ppm)/1e6 

Default: 3 ppm

Range: 0 to no upper limit; units: Da, mmu, ppm 

Table 37. Create Mass Trace node parameters (Sheet 2 of 2)

Parameter Description
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Table 38. Create Pattern Trace node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Isotope Ratios Displays either the elemental composition of the compound of 
interest or the following text: [custom pattern]. 

You use the Isotope Ratio Editor to set up the isotope pattern for 
the compound of interest.

The application can automatically set up the isotope pattern for a 
non-isotopically labeled compound by using its elemental 
composition. For isotopically-labeled compounds, you must enter 
the expected mass shifts of the isotopic peaks as well as their 
relative intensity to the A0 isotope.

IMPORTANT  In the defined processing workflows, this 
parameter is set to C15S with the following three isotope 
selections:

• Monoisotopic ion (100% intensity)

• A2 ion with one sulfur-34 atom (peak with a +1.9958 Da 
mass shift and a 4.52% relative intensity)

• A2 ion with two carbon-13 atoms (peak with a 
+2.00669 Da mass shift and a 1.27% relative intensity)

When you create a new processing workflow, you must specify 
the isotope ratios of interest to run an analysis.

Mass Tolerance Specifies the mass tolerance for the mass shifts between the mass 
spectral peaks in the pattern. 

Range: 0.0–1e6 ppm; default: 5 ppm

You set up the pattern with the Isotope Ratio Editor.

Intensity Tolerance [%] Specifies the relative intensity tolerance of the mass spectral peaks 
in the pattern.

Range: 0.01–100.0

The A0 isotope is always the isotope with the lowest m/z value, 
but it is not necessarily the isotope with the highest intensity. For 
example, with more than one bromine atom, a bromine and a 
chlorine atom, or more than four chlorine atoms, the M + 2 (A2) 
isotope is the most intense isotope.
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Related Topics

• Setting Up Isotope Patterns for Pattern Scoring or Pattern Traces

• Specialized Traces Table

Compound Detection Nodes
Use these nodes to detect unknown compounds:

• Analyze Labeled Compounds Node

• Detect Compounds Node

• Fill Gaps Node

• Group Compounds Node

Analyze Labeled Compounds Node

Use the Analyze Labeled Compounds node to detect labeled compounds and their labeling 
rates.

MS Order Specifies the MS order of the mass spectrum.

Selections: MS1–MS10

Polarity Specifies the polarity of the mass spectrum.

Selections: Positive or Negative

Custom Label Use this box to enter a description of the trace.

Table 38. Create Pattern Trace node parameters (Sheet 2 of 2)

Parameter Description

Table 39.  Analyze Labeled Compounds node (Sheet 1 of 3)

Parameter Description

1. Label Settings

Label Element Specifies the labeled element and its isotope in this format: 

[mass number]element symbol

Where element symbol is the symbol in the periodic table
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Max. Exchange Specifies the maximum number of exchangeable atoms for any 
of the compounds. If the number of exchangeable atoms for a 
compound is below this number, the application uses the lower 
number.

If set to zero, the compound’s elemental composition determines 
the maximum number of exchangeable atoms.

Default: 25

Source Efficiency [%] Specifies the isotopic purity of the labeled compound introduced 
into the biological system.

Most commercially available stable isotope labeled compounds 
have an isotopic purity of 98 to 99%. Keeping the setting at 
100% is appropriate for these compounds.

Default: 100

2. Pattern Analysis

Mass Tolerance [ppm] Specifies the mass tolerance for the isotope search and XIC trace 
generation.

Default: 5 ppm

Intensity Tolerance [%] Specifies the relative intensity tolerance for isotope pattern 
matching.

Default: 30

Intensity Threshold [%] Specifies the isotope intensity threshold, relative to the pattern’s 
base peak, for the theoretical isotope pattern.

Default: 0.1

S/N Threshold Specifies the signal-to-noise threshold for isotope pattern 
matching.

Default: 3

Table 39.  Analyze Labeled Compounds node (Sheet 2 of 3)

Parameter Description
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Related Topics

• Working with the Isotopologues Distribution Chart

Detect Compounds Node

Use the Detect Compounds node to detect unknown compounds. The processing results for 
the Detect Compounds node appear in the Compounds per File table and the Features table.

For information about an untargeted processing workflow, see “Untargeted Workflows for 
Identifying Unknown Compounds” on page 24. 

Table 40 describes the parameters for the Detect Compounds node. 

3. General Settings

Mark Irregular Exchange Adds the Irregular Exchange status to the following result table 
columns: Labeling Status column of the Compounds Table and 
the Status column of the Compounds per File Table.

The Irregular Exchange status applies to compounds where the 
exchange rate for the mid-mass isotopologues is less than 5% of 
the exchange rate for the isotopologues.

Default: True

Exclude Blanks Specifies whether to exclude blank samples (Sample Type: 
Blank) from the main Compounds table.

Default: True

Hide Unprocessed Specifies whether to hide compounds with unassigned formulas 
in the Compounds table. The node does not process compounds 
without formulas.

Default: True

Table 39.  Analyze Labeled Compounds node (Sheet 3 of 3)

Parameter Description

Table 40. Detect Compounds node parameters (Sheet 1 of 3)

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance for the XIC traces. 

Default: 5.0 ppm; range: 1–20.0 ppm

Intensity Tolerance Specifies the intensity tolerance for the isotope pattern search.

Default: 30%; range: 0 to 100%
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S/N Threshold Specifies the signal-to-noise threshold for mass spectral peaks 
(centroids). The unknown compound detection algorithm ignores 
centroids below this user-specified threshold. 

Default: 3; range: 0 to no upper limit

Min. Peak Intensity Specifies the minimum base peak height to detect peaks in the 
XIC traces. The analysis does not report chromatographic peaks 
below this minimum peak intensity (peak height at the apex).

The optimal minimum peak intensity setting depends upon the 
instrument (see Table 41).

Default: 10 000

Ions Specifies the adduct ions that might be in your samples. 

Default: [M+H]+1, [M+K]+1, [M+Na]+1

Selection: The ion definitions in your Ion Definitions library

Base Ions Specifies the adduct ions that you expect to have the highest 
intensity in your samples.

Default: [M+H]+1 and [M–H]–1

Note  The processing workflows (in the Common Workflows > Workflow Templates > E 
and L, MetID, folder) specify the following base ions: [M+H]+1, [M+NH4]+1, and [M–
H]–1.

The selection of base ions includes the ammonium adduct because extractable and 
leachable compounds tend to be nonpolar compounds that require ammonium acetate as 
a mobile phase modifier for optimal chromatography.

Min Element Counts Specifies the minimum number of each possible element. The 
node uses these values for the isotope pattern search.

Default: C H

Max Element Counts Specifies the maximum number of each possible element. The 
node uses these values for the isotope pattern search.

Default: C90 H190 Br3 Cl4 K2 N10 Na2 O15 P2 S5

2. Peak Detection

Filter Peaks Specify whether you want to turn on the chromatographic peak 
filtering parameters. 

Default: True

Table 40. Detect Compounds node parameters (Sheet 2 of 3)

Parameter Description
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Table 41 lists the recommended range for the minimum peak intensity parameter. The 
optimal setting depends on the sensitivity of the mass spectrometer. 

Fill Gaps Node

Use the Fill Gaps node to find chromatographic peaks that were detected by the Detect 
Compounds node in one of the input files but were missing from other input files in the file 
set.

For information about adding the Fill Gaps node to a processing workflow, see “Marking 
Background Compounds in an Untargeted Analysis” on page 28. 

The Fill Gaps node adds the (hidden) Gap Status column to the Compounds Table and 
creates the related (hidden) Filled Gaps Table. 

Max. Peak Width 
[min]

When Filter Peaks is set to True, specifies the maximum peak 
width at half height, in minutes, for detected chromatographic 
peaks.

Default: 0.3; range: 0.05 to no upper limit

Remove Singlets If set to True, does not report a component if the 
chromatographic peak for the component contains only A0 
centroids. 

Default: True

Min. #Scans per Peak Specifies the minimum number of scans (data points) required to 
define a chromatographic peak.

Default: 5; range: 3 to 20

Min. #Isotopes Specifies the minimum number of isotopes required in the mass 
spectral scans that define the chromatographic peak. 

Default: 1

Table 41. Recommended minimum peak intensity range

Mass spectrometer Minimum peak intensity 
(chromatographic peak height)

Q Exactive, Q Exactive Plus, Q Exactive HF 500 000 to 1 000 000

Orbitrap Fusion, Orbitrap Lumos, Orbitrap ID-X 50 000 to 100 000

Exactive, Exactive Plus, Orbitrap Elite, Orbitrap Velos 
Pro 

100 000 to 500 000

LTQ Orbitrap XL, LTQ Orbitrap Velos 25 000 to 100 000

Table 40. Detect Compounds node parameters (Sheet 3 of 3)

Parameter Description
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The Filled Gaps table describes how the node calculated the missing chromatographic peak 
areas. Clicking a row in the Filled Gaps table displays the gap-filled trace and the integrated 
The Fill Gaps node calculates the area of missing chromatographic peaks as follows.

1. Calculates the detection limit for each missing ion as an area of a simulated Gaussian peak 
that starts and ends at a zero intensity baseline. To calculate the area of the Gaussian peak, 
the node uses the expected peak width and the maximum spectrum noise in the expected 
retention time range multiplied by the S/N threshold.

2. Searches for the missing ion with the expected m/z × RT dimensions against all detected 
ions (in the mass list generated by the Detect Compounds node) while ignoring the 
assigned adduct type. If it finds a match (ion with the expected m/z × RT dimensions), it 
uses the ion’s area to fill the gap and displays Filled by Matching Ion for the Fill Status.

3. If the node does not find a matching ion, it attempts to detect the peak at a lower 
intensity threshold using the Parameterless Peak Detection (PPD) algorithm. If it detects 
a chromatographic peak at a lower threshold, it uses the integrated peak area to fill the gap 
and displays Re-detected Peak for the Fill Status.

4. If the node does not find a chromatographic peak by using a lower intensity threshold, it 
fits a Gaussian peak to the XIC trace for the expected m/z range and displays Filled by 
Simulated Peak for the Fill Status.

5. If the filled area is still zero or lower than the detection limit, the node uses the detection 
limit value to fill the gap and displays Filled by Spectrum Noise for the Fill Status.

6. If the node cannot fill the gap, it displays Area Could Not Be Filled for the Fill Status. 

Table 42 describes the parameters for the Fill Gaps node.

Table 42. Fill Gaps node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance that the node uses to search for 
matching mass peaks. 

Search range = expected mass ± mass tolerance/1e6

Default: 5 ppm; range: 0.1 to 20 ppm

S/N Threshold Specifies the minimum signal-to-noise threshold for centroids.

Default: 1.5; minimum: 1
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Related Topics

• Filled Gaps Table

Group Compounds Node

Use the Group Compounds node to combine unknown compounds across the input file set 
by their molecular weight and retention time. This node also selects the best representative 
MS1scan and fragmentation tree, which the Predict Compositions node and search nodes use 
for identification.

Table 43 describes the parameters for the Group Compounds node.

Use Real Peak 
Detection

Specifies whether the analysis fills gaps in the chromatogram by 
using a peak detection algorithm or only a peak simulation 
algorithm.

True—The analysis uses the Parameterless Peak Detection (PPD) 
algorithm to fill the gaps with redetected low-intensity peaks. 
Using PPD can significantly increase the processing time.

False—The analysis uses only a peak simulation algorithm to fill 
the gaps with simulated chromatographic peaks.

Table 42. Fill Gaps node parameters (Sheet 2 of 2)

Parameter Description

Table 43. Group Compounds node parameters

Parameter Description

1. Compound Consolidation

Mass Tolerance Specifies the mass tolerance that the node uses to search for 
matching mass peaks. 

Default: 5 ppm; range: 0.1 to 20 ppm

RT Tolerance [min] Specifies the retention time tolerance, in minutes, that the node 
searches for mass peaks within the specified mass tolerance.

Default: 0.05; range: 1.0

2. Fragment Data Selection

Preferred Ions Select the preferred ions (adducts) from the list. The application 
uses the list to select the best fragmentation data for each 
compound to submit to an mzCloud or mzVault search.

Selections: One or more of the ions in your Ion Definitions library

Default: [M+H]+1 and [M–H]–1
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Peak Area Refinement Nodes
Use these nodes to hide background compounds or to normalize the chromatographic peak 
areas:

• Mark Background Compounds Node–Unknown Compounds

• Normalize Areas Node

Mark Background Compounds Node–Unknown Compounds

Use the Mark Background Compounds node to identify the background compounds, which 
are compounds also found in the blank samples, in the Compounds Table.

For information about the parameter settings, see “Mark Background Compounds Node–
Expected Compounds” on page 240.

Always place the Mark Background Compounds node at the end of the processing workflow 
by following these examples:

• Group Compounds > Mark Background Compounds

• Group Compounds > Fill Gaps > Mark Background Compounds

• Group Compounds > Fill Gaps > Normalize Areas > Mark Background Compounds

Normalize Areas Node

Use the Normalize Areas node to normalize the chromatographic peak areas when you need 
the analysis to compensate for batch effects.

When the Normalize Areas node is part of a processing workflow, the Use Normalized Areas 
check box is available in the Descriptive Statistics view and the Principal Component Analysis 
view. The Normalize Areas node adds the Normalized Area column to the Compounds Table. 
When the analysis includes quality control samples, the node also adds the “QC” columns in 
the Compounds table. You can view the corrected compound areas in the Compound Area 
Corrections view (see “Viewing the QC-Based Compound Area Correction Curves” on 
page 367).

IMPORTANT  As you drag the Fill Gaps and the Normalize Areas nodes into the Workflow 
Tree pane, the application automatically connects the Group Compounds node to the Fill 
Gaps node, and the Fill Gaps node to the Normalize Areas node. The application does not 
connect the Mark Background Compounds node to other nodes, so you must manually 
make the appropriate connections. For more information about the node connections, see 
“Marking Background Compounds in an Untargeted Analysis” on page 28.
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If the input files include Quality Control samples, the application automatically performs a 
batch normalization on each compound that meets the user-specified criteria.

Table 44 describes the parameters for the Normalize Areas node.

IMPORTANT  When the Normalize Areas and Mark Background Compounds nodes are 
part of a processing workflow, connect the Normalize Areas node to the Mark Background 
Compounds node.

Table 44. Normalize Areas node parameters (Sheet 1 of 3)

Parameter Description

1. QC-based Area Correction

The analysis uses the QC samples to create a regression curve for each detected compound. 
The analysis does not create a regression curve for a particular compound or does not 
correct the areas in the non-QC samples unless all three of these conditions are met:

• It detects the compound in the specified minimum percentage of QC samples.

• The relative standard deviation of the detected peak areas for the compound in the QC 
samples does not exceed the specified threshold.

• The number of samples acquired between the QC samples does not exceed the specified 
number.

If the analysis does not create a regression curve for a compound, it does not perform a 
batch normalization of the peak areas for the compound in the non-QC samples (Sample 
type: Sample, Control, or Standard).

Regression Model Specifies the regression model as Linear or Cubic Spline.

Default: Linear

Min. QC Coverage [%] Specifies the minimum percentage of the QC samples where the 
analysis must detect a particular compound before it creates a 
regression curve for the compound. If the coverage falls below 
this value, the analysis does NOT perform a batch normalization 
of the peak areas for the compound in the non-QC samples.

Default: 50%; range: 25 to 100%
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Max. QC Area RSD [%] Specifies the maximum relative standard deviation (RSD%) for 
the areas for a particular compound across the QC samples. If 
the RSD% exceeds this maximum percentage, the analysis does 
not create a regression curve for the compound.

The application checks the RSD% of the peak areas both before 
and after applying a correction for the relative acquisition time. 
If the RSD% for the corrected peak areas differs by more than 
75% of the user-specified threshold, the application does not 
create a corrected-area regression curve for the compound.

Default: 30%; range: 10 to 50%

Max. #Files Between QC 
Files

The application checks the acquisition time stamp for each 
input file in an analysis and orders the samples within an analysis 
set by acquisition time.

Specifies the maximum number of non-QC samples that you 
can acquire between the QC samples. If the application detects 
more non-QC samples between the QC samples than the 
maximum allowable number, it does not correct the 
chromatographic peak areas in the non-QC samples—that is, it 
does not perform a batch normalization on these samples.

Default: 15; range: 1 to unchecked value

2. Area Normalization

Normalization Type For selections other than None, the analysis normalizes the 
chromatographic peaks areas after performing a batch 
normalization based on the QC samples.

Selections:
• None (Default)—The analysis does not normalize the 

chromatographic peak areas for injection variability.
• Constant Sum 
• Constant Mean
• Constant Median
• Median Absolute Deviation (MAD)
• Scaling Factor—The node multiplies the peak areas by the 

numeric values for the user-specified study factor.

Tip  For best results, select Constant Mean for input file sets 
that include matrix blanks.

Table 44. Normalize Areas node parameters (Sheet 2 of 3)

Parameter Description
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Exclude Blanks Specifies whether to exclude Blank sample types from 
normalization.

Default: True

Tip  For best results, follow these guidelines:

• Select True for solvent blanks to exclude them from the 
normalization process. Otherwise, the Fill Gaps node adds 
small “noise” peaks to the solvent blanks for each detected 
compound in the input file set. The Normalize Areas node 
magnifies these small peaks, causing the sample-to-blank 
ratio to fall below the user-specified value in the Mark 
Background Compounds node. The Mark Background 
Compounds node then hides most of the detected 
compounds across the input file set (marks them as 
background compounds).

• Select False for matrix blanks, such as plasma and urine, as 
these blanks typically contain a large number of 
compounds that you might want to hide. 

3. Scaling Factor

Study Factor Name Specifies the study factor to use as the scaling factor for the 
chromatographic peak areas when you select Scaling Factor in 
the Normalization Type list.

Multiplies a compound’s peak area by the input file’s value for 
the selected numerical study factor.

Selections: Defined numerical study factors
Default: Empty

Table 44. Normalize Areas node parameters (Sheet 3 of 3)

Parameter Description
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Compound Identification Nodes
Use these nodes to identify unknown compounds:

• Assign Compound Annotations Node

• Predict Compositions Node

• Search ChemSpider Node

• Search Mass Lists Node

• Search mzCloud Node

• Search mzVault Node

Assign Compound Annotations Node

Use the Assign Compound Annotations node to select the preferred data sources for the 
following annotations: name, formula, and structure. The application attempts to assign the 
annotations provided by the first data source. If the first source does not provide the 
annotation, the application uses the second data source, and so on. If the processing workflow 
does not include the Assign Compound Annotations node, the application does not populate 
the Name, Formula, or Structure columns of the Compounds table.

Table 45 describes the parameters for the Assign Compound Annotations node.

Table 45. Assign Compound Annotation node parameters (Sheet 1 of 2) 

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance for validating the annotations.

Default: 5 ppm; range: 0.1–20 ppm

2. Data Sources

Available sources: mzCloud Search, mzVault Search, BioCyc Search, Mass List Match, 
ChemSpider Search, and Predicted Compositions 

Data Source #1 Specifies the primary source for the compound annotations.

Default: mzCloud Search

Tip  If a stable isotope analysis misidentifies known compounds, 
consider reprocessing the analysis after selecting your custom 
mass list as the first data source. 

Data Source #2 Specifies the secondary source for compound annotations if the 
primary source is unavailable.

Default: Predicted Compositions
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Data Source #3 Specifies the source for compound annotations if the primary and 
secondary sources are unavailable.

Default: Mass List Search

Data Source #4 Specifies the source for compound annotations if all the previous 
sources are unavailable.

Default: ChemSpider Search

Data Source #5–7 Use to specify additional annotation sources in the list.

Default: Empty

3. Scoring Rules

Use mzLogic When set to True, uses the score from the Apply mzLogic node to 
select the best candidate.

Default: True

Use Spectral Distance When set to True, uses the SFit score from the Apply Spectral 
Distance node to select the best candidate.

Uses the SFit Threshold and SFit Range values to limit the 
number of valid candidates.

Default: True

SFit Threshold Specifies the minimum SFit score for a candidate.

Default: 20; range: 0 to 100

SFit Range Specifies the maximum allowed difference between the SFit scores 
for the best and worst candidates.

Default: 20; range: 0 to 100

Table 45. Assign Compound Annotation node parameters (Sheet 2 of 2) 

Parameter Description
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Predict Compositions Node

Use the Predict Compositions node to predict the chemical formulas of the unknown 
compounds. This node creates the Predicted Compositions Table and populates the Formula 
column of the Compounds Table when the processing workflow also includes the Assign 
Compound Annotations node.

Table 46 describes the parameters for the Predict Compositions node. 

Table 46. Predict Compositions node parameters (Sheet 1 of 4)

Parameter Description

1. Prediction Settings

Mass Tolerance Specifies the mass tolerance for the XIC traces. 

Default: 5.0 ppm; range: 1–20.0 ppm

Min. Element Counts Specifies the minimum count for each element in the 
hypothetical compound. If an element is not listed, its minimum 
count is zero. 

Default: C H

Max. Element Counts Specifies the maximum count for each element in the 
hypothetical compound. If an element is not listed, its maximum 
count is the same as its minimum count. 

Default: C90 H190 Br3 Cl4 K2 N10 Na2 O15 P2 S5 
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Min. RDBE and
Max. RDBE

Specifies a range of values for ring and double-bond equivalents. 
The RDBE value is a measure of the number of unsaturated 
bonds in a compound. The specified value limits the calculated 
formulas to only those that make sense chemically. 

The following formula determines the RDBE value for an 
elemental composition:

where:

• D is the value for the RDB equivalents

• imax is the total number of different elements in the 
composition

• Ni is the number of atoms of element i

• Vi is the valence of atom i

Min. H/C Specifies the minimum hydrogen-to-carbon ratio.

Default: 0.1

The value of 0 means no limit. The application does not accept 
negative values.

Max. H/C Specifies the maximum hydrogen-to-carbon ratio.

Default: 3

The value of 0 means no limit. The application does not accept 
negative values.

Table 46. Predict Compositions node parameters (Sheet 2 of 4)

Parameter Description

D 1

Ni Vi 2– 

i

imax



2
------------------------------------------+=
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Note  For most compounds, the hydrogen-to-carbon ratio falls within the range from 0.5 
to 2.0. 

• Long chain alkanes have an H/C ratio of approximately 2.

• Polycyclic aromatics have an H/C ratio of approximately 0.5.

Max. #Candidates Specifies the maximum number of compositions to store for each 
compound in the result file.

Default: 10; range: 1–50

Max # Internal 
Candidates

Specifies the maximum number of compositions to calculate for 
each detected component. 

Default: 200; range: 1 to unchecked

Tip  To optimize the processing time, the maximum number of 
internal candidates is limited to 200 by default and sorted by 
the mass error. Normally, this works well for masses below 
500 Da. However, as a component’s mass or the number of 
elements increases, the number of possible elemental 
compositions also increases. This increase means that the 
chance of rejecting the correct formula, when it has a higher 
mass error than the first 200 candidates, also increases. 

For samples with components that have a relatively large 
number of elements or a mass above 500 Da, consider 
increasing the limit to 500.

2. Pattern Matching

Intensity Tolerance [%] Specifies the intensity tolerance for the isotope pattern search.

Default: 30%; range: 0 to 100%

Intensity Threshold [%] Specifies the intensity threshold, relative to the base peak (most 
intense ion) in the isotope pattern, for the isotope pattern search. 
The analysis ignores isotopes below this threshold.

Default: 0.1%; range: 0.1 to 10%

S/N Threshold Specifies the signal-to-noise threshold for the isotope search. 
Isotopes with a theoretical intensity below the threshold are not 
required.

Min. Spectral Fit [%] Specifies the minimum spectral fit for reporting a predicted 
composition in the Predicted Compositions result table.

Default: 10%; range: 0 to 100%

Table 46. Predict Compositions node parameters (Sheet 3 of 4)

Parameter Description
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Min. Pattern Cov. [%] Specifies the minimum percentage for the summed intensity of 
the matching isotope peaks in the measured MS1 spectrum 
relative to the summed intensity of the theoretical isotope 
pattern.

Use Dynamic 
Recalibration

Specifies whether the application uses the dynamic recalibration 
algorithm to shift the theoretical pattern for the candidate 
formula by the difference in the observed m/z value of the 
leftmost (A0) isotopic peak in the measured spectrum.

Use dynamic recalibration when there is a systematic error (due 
to calibration) in the measured spectrum.

Default: True

3. Fragments Matching

Use Fragments 
Matching

Specifies whether the application uses the fragment matching 
algorithm, which ranks the identified candidates (chemical 
formulas) by the number of matching centroids (with an 
m/z value that matches a subset of the elemental composition for 
a particular candidate) in the fragmentation scan for the 
precursor ion.

Default: True

Mass Tolerance Specifies the mass tolerance for matching the centroids in the 
fragmentation scans to the m/z values for the expected fragments.

Default: 5 ppm; range: 0 to unchecked

S/N Threshold Specifies the signal-to-noise threshold for the centroids in the 
fragmentation scans. The node ignores centroids with an 
intensity below this threshold.

Default: 3; range: 0 to unchecked

Table 46. Predict Compositions node parameters (Sheet 4 of 4)

Parameter Description

Summed intensity of the matching isotope peaks 100
Summed intensity of the theoretical isotope pattern

------------------------------------------------------------------------------------------------------
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Search ChemSpider Node

Use the Search ChemSpider node to search mass spectral databases for matching compounds 
within a specified mass tolerance range or with a certain elemental composition. This node 
requires input from the Group Compounds node. It adds the #ChemSpider Results column 
to the Compounds Table, and creates the ChemSpider Results Table.

When the processing workflow includes a ChemSpider search, the processing computer must 
have Internet access. To verify whether the processing computer can access the ChemSpider 
database, run the Communication test. See Chapter 17, “Testing Communication to the 
Online Databases.”  

Table 47 describes the parameters for the Search ChemSpider node.

Table 47. Search ChemSpider node parameters (Sheet 1 of 2)

Parameter Description

1. Search Settings

Database(s) Specifies the databases for the ChemSpider search.

Default: KEGG

Search Mode Default: By Formula or Mass

Selections: By Formula or Mass, By Formula and Mass, By 
Formula or Mass, By Mass Only

Mass Tolerance Specifies the mass tolerance that the node uses to search for 
matching mass peaks. 

Default: 5 ppm; range: 0.1 to 20 ppm or 0.0 to 0.1 Da

Max# of Results Per 
Compound

Specifies the maximum number of hits (matches) to return (store 
in the result file).

Default: 100; range: 1 to 2000

Max # of Predicted 
Compositions to be 
Searched per 
Compound

Specifies the maximum number of predicted compositions to 
search for in the ChemSpider database.

Default: 3; range: 1 to 100
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Search Mass Lists Node

Use the Search Mass Lists node to search mass lists for masses that match the detected 
compounds. This node requires input from the Group Compounds node, adds the #Matched 
Masses to the Compounds Table, and creates the Mass List Search Results Table.

Table 48 describes the parameters for the Mass List Search node.

Result Order (for Max# 
of Results per 
Compound)

Specifies the sort order in the ChemSpider Results table.

Selections:

• Order By Reference Count (DESC)—Sorts the search results 
by the number of references for each compound.

• Order By Data Source Count (DESC)—Sorts the search 
results by the number of data sources. 

• Order By Mass Deviation (ASQ)—Sorts the search results by 
mass deviation from the expected mass.

• Order By PubMed Count (DESC)—Sorts the search results 
by the number of PubMed references.

• Order By RSC Count (DESC)—Sorts the search results by 
the number of RSC references.

• Order By CSID (ASQ)—Sorts the search results by the 
ChemSpider ID.

2. Predicted Composition Annotation

Check All Predicted 
Compositions

Specifies whether to add a flag to the Predicted Compositions 
table. When set to True, the Search ChemSpider node adds the In 
ChemSpider column to the Predicted Compositions table and 
marks the matched Predicted Compositions with an X.

Default: False

Table 47. Search ChemSpider node parameters (Sheet 2 of 2)

Parameter Description
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Table 48.  Search Mass List node parameters

Parameter Description

1. Search Settings

Mass Lists Specifies the mass list files that the node searches for matching 
masses.

The mass list must have the following columns—Mass, Retention 
Time, and Name. The mass list can also contain the following 
additional columns—Molecular Structure and Text Annotation.

 To select input files for the mass list search

1. In the Mass box, click the browse icon, .

The Select Input Files dialog box opens.

2. Select the check boxes for the files that you want to use for the 
mass list search.

3. Click OK.

Use Retention Time Specifies whether to search for compounds by retention time in 
addition to mass.

Default: True

RT Tolerance [min] Specifies the retention time tolerance, in minutes, for the search. 
The node searches for matching peaks in a retention time window 
equal to the expected retention time plus or minus the specified 
RT tolerance.

Default: 0.05; range: 1.0

Mass Tolerance Specifies the mass tolerance that the node uses to search for 
matching compounds. 

Default: 5 ppm; range: 0.1 to 20 ppm or 0.0 to 0.1 Da
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Table 49 describes the table columns in the Select Input Files dialog box.

Search mzCloud Node

Use the Search mzCloud node to search the mzCloud database for matching fragmentation 
spectra. This node creates the mzCloud Results Table, and adds the #mzCloud Results and 
mzCloud Best Match columns to the Compounds table.

The Search mzCloud node requires input from the Group Compounds node.

When the processing workflow includes an mzCloud search, the processing computer must 
have Internet access. To verify whether the processing computer can access the mzCloud 
database, run the Communication tests. 

Table 50 describes the parameters for the Search mzCloud node.

Table 49.  Select Input File(s) dialog box parameters

Table column Description

Selected Selecting the check box for a mass list adds the list to the search.

Filename Displays the file name of the imported file.

Description Editable text field.

Clicking the table cell displays a text entry field for typing a name 
or a description of the mass list. Use this column to name and sort 
your mass lists.

File Size Displays the file size of the imported file.

Uploaded Displays the date (month/day/year) and time (hour/minute) when 
you added the file to the library in the following format: 

MM/DD/yyyy HH:mm

Updated Displays the date and time when the file was updated.

Context Displays the source of the mass list—for example, Import from 
CSV or Import from XML.

State Specifies whether the mass list is available, corrupted, or missing.

If you remove a mass list from the ServerFiles folder or edit a mass 
list in the ServerFiles Folder, and then restart the application, the 
mass list’s state changes to Missing or Corrupted, respectively.

Note  In addition to running an automated search with an analysis, you can manually 
submit a fragmentation scan to the mzCloud database from the Mass Spectrum view for 
an active result file. 
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Table 50.  Search mzCloud node parameters (Sheet 1 of 5)

Parameter Description

1. General Settings

Compound Classes Specifies the compound classes for the search. Select All 
or select specific classes.

Default: All

Precursor Mass Tolerance Specifies the tolerance for the precursor mass. 

Default: 10 ppm; range: 0–0.1 Da or 0–20 ppm

FT Fragment Mass Tolerance Specifies the mass tolerance for high-resolution 
fragmentation scans performed in the Orbitrap analyzer 
(FTMS). 

Default: 10 ppm; range: 0–0.5 Da or 0–100 ppm

IT Fragment Mass Tolerance Specifies the mass tolerance for low-resolution 
fragmentation scans performed in the ion trap analyzer 
(ITMS). 

Default: 0.4 Da; range: 0–0.1 Da or 0–20 ppm

Library Specifies the mzCloud library for the search: 
Autoprocessed, Reference, or both. 

• Reference library—Contains only spectra that have 
been manually curated by mass spectrometry experts.

• Autoprocessed library—Contains spectra curated 
with an automated process. As time permits, spectra 
in the Autoprocessed library are manually curated 
and transferred to the Reference library.

Post Processing Specifies whether to search the library for filtered or 
recalibrated spectra.

Selections: 

• Filtered—Removes extraneous mass peaks that do 
not match the theoretical mass spectrum.

• Recalibrated (Default)—The mass peaks for the 
known ion fragments are recalibrated to match the 
theoretical mass spectrum by a series of manually 
supervised ion calibration steps.
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Max. # Results Specifies the maximum number of hits for each 
compound and search spectrum to store in the result file. 

Default: 10; range: 1 to 50

Annotate Matching Fragments Specifies whether the processing workflow annotates the 
matching fragments with structures that you can review 
in the Spectrum view of the result page.

Default: False

2. DDA Search

Identity Search Specifies the identity search algorithm.

Selections: 

• Confidence—Takes into account the dot product of 
both spectra, distribution of peaks, activation energy 
difference, and polarity, and uses a machine-learning 
Bayesian Network model to estimate the likelihood 
of a correct match.

• HighChem DP—Alternative score using a modified 
dot product algorithm that includes a “hard penalty” 
function for spectra with a low number of fragment 
ions.

• HighChem HighRes—Use for high-resolution data. 
Correlation algorithm that uses the geometric mean 
of a modified Spearman’s rank order correlation to 
separately determine the intensity and m/z accuracy 
of the fragment ions.

• NIST

• Cosine—Dot product algorithm with fragment 
intensities weighted by 0.75 and no weighting on 
fragment m/z values.

Default: HighChem HighRes

Match Activation Type Specifies whether to only search for fragmentation spectra 
with the same activation type.

Default: True

Table 50.  Search mzCloud node parameters (Sheet 2 of 5)

Parameter Description
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Match Activation Energy Specifies whether to search for fragmentation spectra 
generated by the same ion activation energy within a 
tolerance or by any ion activation energy.

Default: Match with Tolerance

Activation Energy Tolerance Specifies the tolerance as an absolute value for the ion 
activation energy used to generate the fragmentation 
spectrum.

For example, if the ion activation energy used to generate 
your spectrum was a normalized collision energy of 35% 
and you specify an ion activation energy tolerance of ±20, 
the search looks for spectra with an ion activation energy 
from 15 to 55.

Default: 20; range: 0 to 200

Apply Intensity Threshold Specifies whether to apply an automatic intensity 
threshold that sets the threshold intensity by calculating 
the spectrum noise level.

Default: True

Table 50.  Search mzCloud node parameters (Sheet 3 of 5)

Parameter Description
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Similarity Search Specifies the similarity search algorithm.

Selections:

• Confidence Forward— Takes into account the dot 
product of the forward search match and distribution 
of peaks, and the ratio of the most intensive matching 
peaks. A higher similarity score indicates the extent to 
which the unknown component resembles the library 
compound.

• Confidence Reverse—Takes into account the dot 
product of the reverse search match and distribution 
of peaks, and the ratio of the most intensive matching 
peaks. A higher similarity score indicates the extent to 
which the library compound resembles the unknown 
component.

• None (Default)—Does not run a similarity search.

• Similarity Forward—Searches for a match between 
the best fragmentation scan for a compound (across 
the input file set) and a fragmentation scan in the 
mzCloud database. Unlike the Identity Search, this 
search ignores the m/z value of the precursor ion.

• Similarity Reverse—Searches for a match between the 
fragmentation scans in the mzCloud database and the 
best fragmentation scan for a compound (across the 
input file set).

Match Factor Threshold Specifies the minimum match factor for reporting a 
spectrum match.

Default: 60; range: 0 to 100%

3. DIA Search

Use DIA Scans for Search Specifies whether to submit data independent scans to the 
mzCloud database for a spectral search.

Default: False

Max. Isolation Width [Da] Specifies the maximum MS2 isolation width. The 
isolation width for a scan is listed in its scan header.

Default: 500 Da; minimum width: 10 Da

Table 50.  Search mzCloud node parameters (Sheet 4 of 5)

Parameter Description
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Related Topics

• mzCloud Results Table

Search mzVault Node

Use the Search mzVault node to search a local mass spectra database for compounds of 
interest. This node requires input from the Group Compounds node and creates the mzVault 
Results table.

 To use mzVault libraries created with the mzVault 1.1 or earlier application

Change the following settings: 

• For the Match Ion Activation Type, select False.

• For the Match Ion Activation Energy, select Any.

• For the Match Ionization Method, select False.

Table 51 describes the parameters for the Search mzVault node.

Match Activation Type See Match Activation Type under DDA Search.

Default: False

Match Activation Energy See Match Activation Energy under DDA Search.

Default: Any

Activation Energy Tolerance See Activation Energy Tolerance under DDA Search.

Default: 100

Apply Intensity Threshold See Apply Intensity Threshold under DDA Search.

Default: False

Match Factor Threshold See Match Factor Threshold under DDA Search.

Default: 20

Table 50.  Search mzCloud node parameters (Sheet 5 of 5)

Parameter Description

Table 51.  Search mzVault node parameters (Sheet 1 of 4)

Parameter Description

1. Search Settings

mzVault Library Specifies the mzVault libraries to search. You can select 
one or more of the mzVault libraries in your Spectral 
Libraries list.
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Compound Classes Specifies the compound classes for the search. Select All 
or select specific classes.

Default: All

Match Ion Activation Type Specifies whether to only search for library scans that 
match the ion activation type of the query spectrum.

Default: True

Match Ion Activation Energy Specifies whether to search for library scans generated by 
the same ion activation energy within a tolerance of the 
query spectrum or by any ion activation energy.

Default: Match with Tolerance

Ion Activation Energy 
Tolerance

Specifies the tolerance as an absolute value for the ion 
activation energy used to generate the fragmentation 
spectrum.

For example, if the ion activation energy used to generate 
your spectrum was a normalized collision energy of 35% 
and you specify an ion activation energy tolerance of ±20, 
the search looks for spectra with an ion activation energy 
from 15 to 55.

Default: 20; range: 0 to 200

Match Ionization Method Specifies whether to only search for library spectra from 
the same ionization method (for example, ESI, APCI, 
and so on) as the query spectrum.

Default: True

Apply Intensity Threshold Specifies whether to apply an automatic intensity 
threshold that sets the threshold intensity by calculating 
the spectrum noise level.

Default: True

Remove Precursor Ion When set to True, the search ignores (removes from 
consideration) mass peaks within 2.2 Da of the precursor 
ion’s m/z value in the query spectrum—that is, the match 
score is not negatively affected if the library spectrum 
does not include a mass peak within 2.2 Da of the 
m/z value for the precursor ion.

Default: True

Table 51.  Search mzVault node parameters (Sheet 2 of 4)

Parameter Description
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Precursor Mass Tolerance Specifies the tolerance for the precursor mass. 

Default: 10 ppm; range: 0–0.1 Da or 0–20 ppm

FT Fragment Mass Tolerance Specifies the mass tolerance for high-resolution 
fragmentation scans performed in the Orbitrap analyzer 
(FTMS). 

Default: 10 ppm; range: 0–0.5 Da or 0–100 ppm

IT Fragment Mass Tolerance Specifies the mass tolerance for low-resolution 
fragmentation scans performed in the ion trap analyzer 
(ITMS). 

Default: 0.4 Da; range: 0–0.1 Da or 0–20 ppm

Match Analyzer Type Specifies whether to only search for library spectra from 
the same mass analyzer type as the query spectrum.

Default: True

Search Algorithm Specifies the identity search algorithm.

Selections: 

• HighChem DP—Alternative score using a modified 
dot product algorithm that includes a “hard penalty” 
function for spectra with a low number of fragment 
ions.

• HighChem HighRes—Use for high-resolution data. 
Correlation algorithm that uses the geometric mean 
of a modified Spearman’s rank order correlation to 
separately determine the intensity and m/z accuracy 
of the fragment ions.

• NIST

Default: HighChem HighRes

Match Factor Threshold Specifies the minimum match factor for reporting a 
spectrum match.

Default: 50; range: 0 to 100%

Table 51.  Search mzVault node parameters (Sheet 3 of 4)

Parameter Description



 7 Workflow Nodes
Pathway Mapping Nodes

Thermo Scientific Compound Discoverer User Guide 217

Related Topics

• Modifying the Spectral Libraries List

Pathway Mapping Nodes
Use these nodes to map detected compounds to a biochemical pathway:

• Map to BioCyc Pathways Node

• Map to KEGG Pathways Node

• Map to Metabolika Pathways Node

Map to BioCyc Pathways Node

Use the Map to BioCyc Pathways node to map the BioCyc pathways for each compound. 
This node requires input from the Group Compounds node—that is, it requires a list of 
molecular weights or chemical formulas. 

The Map to BioCyc Pathways node adds the following items to the result file:

• The BioCyc Pathways and BioCyc Results main tables

• The #BioCyc Pathways and BioCyc Pathways columns in the main Compounds table

• The BioCyc Compound IDs, BioCyc Compound Names, and BioCyc Compound 
Formula columns in the related Compounds table and the related BioCyc Pathways table.

Max. # Results Specifies the maximum number of hits for each 
compound to store in the result file. Displays the hits 
with the highest match score above the cutoff storage 
number in the result file.

Default: 10

RT Tolerance [min] Specifies the retention time tolerance for the library 
search.

Default: 2; range: 0 to 10 minutes

Use Retention Time Specifies whether to filter the database hits by their 
retention time. Filters out scans without retention time 
information.

Default: False

Table 51.  Search mzVault node parameters (Sheet 4 of 4)

Parameter Description



7 Workflow Nodes
Pathway Mapping Nodes

218 Compound Discoverer User Guide Thermo Scientific

Table 53 describes the parameters for the Map to BioCyc Pathways node.

Table 52. Map to BioCyc Pathways node parameters

Parameter Description

1. Search Settings

BioCyc Database/Organism 
to be Searched

Specifies the databases for the search.

Search Mode Default: By Formula or Mass

Selections: By Formula or Mass, By Formula and Mass, By 
Formula or Mass, By Mass Only

2. By Mass Search Settings

Mass Tolerance Specifies the mass tolerance that the node uses to search for 
matching compounds. 

Default: 5 ppm; range: 0.1 to 20 ppm

3. By Formula Search Settings

Max. # of Predicted 
Compositions to be 
Searched per Compound

Specifies the maximum number of predicted compositions to 
search for per compound.

Default: 3; range: 1.0

4. Display Settings

Maximum # of Pathways in 
“Pathways” Column

Specifies the maximum number (n) of pathways to display by 
name in the Pathways column of the Compounds result 
table. The Pathways column displays the names of the first 
n – 1 pathways that include the compound. The other 
pathways that include the compound are grouped in the 
Other category.

Default: 20; range: 1–30
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Map to KEGG Pathways Node

The KEGG (Kyoto Encyclopedia of Genes and Genomes) pathway database contains 
connection diagrams of molecular interactions, reactions, and relations. Use the Map to 
KEGG Pathways node to add explanations to the result file about the reaction pathways for 
each detected compound. The node requires input from the Group Compounds node—that 
is, it requires a list of molecular weights or chemical formulas. 

The Map to KEGG Pathways node adds the following items to the result file:

• The KEGG Pathways table

• The KEGG Compound IDs, KEGG Compound Names, and KEGG Compound 
Formula columns in the related Compounds Table

• The #Pathways and Pathways columns in the main Compounds table

When the processing workflow includes the Map to KEGG Pathways node, the processing 
computer must have Internet access. To verify whether the processing computer can access the 
KEGG Pathways database, run the Communication test. See Chapter 17, “Testing 
Communication to the Online Databases.” 

Table 53 describes the parameters for the Map to KEGG Pathways node.

Table 53. Map to KEGG Pathways node parameters (Sheet 1 of 2)

Parameter Description

1. Search Settings

Search Mode Specifies the search mode.

Default: By Formula or Mass

Selections: By Formula or Mass, By Formula and Mass, By 
Formula or Mass, By Mass Only

2. By Mass Search Settings

Mass Tolerance Specifies the mass tolerance that the node uses to search for 
matching compounds. 

Default: 5 ppm; range: 0.1 to 20 ppm

3. By Formula Search Settings

Max. # of Predicted 
Compositions to be 
Searched per Compound

Specifies the maximum number of predicted compositions to 
search for per compound.

Default: 3; range: 1.0
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Map to Metabolika Pathways Node

To search your local database of Metabolika pathways for pathways that include matching 
structures for the unknown compounds in your data set (by formula, mass, or both), add the 
Metabolika Pathways node to the processing workflow and select the pathways to search.

Table 54 describes the parameters for the Map to Metabolika Pathways node.

4. Display Settings

Maximum # of Pathways in 
“Pathways” Column

Specifies the maximum number (n) of pathways to display by 
name in the Pathways column of the Compounds result 
table. The Pathways column displays the names of the first 
n – 1 pathways that include the compound. The other 
pathways that include the compound are grouped in the 
Other category.

Default: 20; range: 1–30

Table 53. Map to KEGG Pathways node parameters (Sheet 2 of 2)

Parameter Description

Note  378 Metabolika pathway files are automatically installed with the application. You 
can edit these pathways or create your own pathways by using the Metabolika pathway 
editor (“Modifying the Metabolika Pathways List” on page 528).

Table 54. Map to Metabolika Pathways node parameters (Sheet 1 of 2)

Parameter Description

1. Search Settings

Metabolika Pathways Specifies the Metabolika pathways to search.

Default: All 

Search Mode Specifies whether to search by formula, mass, or both.

Default: By Formula or Mass

Selections: By Formula and Mass, By Formula Only, By 
Formula or Mass, By Mass Only

2. By Mass Search Settings

Mass Tolerance Specifies the mass tolerance that the node uses to search for 
matching compounds. 

Default: 5 ppm; range: 0.1 to 20 ppm
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Compound Scoring Nodes
Use these nodes to score the explanations for each detected compound.

• Apply Spectral Distance Node

• Apply mzLogic Node

• Calculate Mass Defect Node

• Compound Class Scoring Node

• Generate Molecular Networks Node (Beta)

• Pattern Scoring Node

To specify the isotope pattern for the Pattern Scoring node or the Pattern Trace node, see this 
topic “Setting Up Isotope Patterns for Pattern Scoring or Pattern Traces” on page 142.

3. By Formula Search Settings

Max. # of Predicted 
Compositions to be 
Searched per Compound

Specifies the maximum number of predicted compositions to 
search for per compound.

Default: 3; range: 1 to 100

4. Display Settings

Maximum # of Pathways in 
“Pathways” Column

Specifies the maximum number (n) of pathways to display by 
name in the Pathways column of the Compounds result 
table. The Pathways column displays the names of the first 
n – 1 pathways that include the compound. The other 
pathways that include the compound are grouped in the 
Other category.

Default: 20; range: 1 to 30

Table 54. Map to Metabolika Pathways node parameters (Sheet 2 of 2)

Parameter Description
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Apply Spectral Distance Node

Use the Apply Spectral Distance node to calculate a spectral similarity score (SFit[%]) for the 
compound annotations. The SFit[%] column appears in the related “compound annotations” 
tables for the compound selected in the Compounds table. Depending on the processing 
workflow, the related “compound annotations” tables can include any of these tables: 
ChemSpider Results, Mass List Search Results, Metabolika Results, and BioCyc Results. In 
addition to providing an SFit score for you to review in the related “compound annotations” 
tables, the node sends the scores to the Assign Compound Annotation node.

Table 55 describes the parameters for the Apply Spectral Distance node.

Related Topics

• ChemSpider Results Table

Table 55. Apply Spectral Distance node parameters

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance that the node uses to search for 
matching mass peaks. 

Search range = expected mass ± mass tolerance/1e6

Default: 5 ppm; range: 0.1 to 20 ppm

Intensity Tolerance [%] Specifies the relative intensity tolerance of the mass spectral peaks 
in the isotope pattern.

Default: 30; range: 0 to 100%

Intensity Threshold 
[%]

Specifies the isotope intensity threshold, relative to the base peak 
of the isotope pattern, that the node uses for pattern simulation. 
The node does not add isotopes below this threshold to the 
simulated pattern.

Default: 0.1

S/N Threshold Specifies the signal-to-noise threshold for the isotope search. The 
node does not include isotopes that are expected to be below this 
threshold in the SFit score—that is, these isotopes are not required 
in the measured isotope pattern.

Default: 3

Use Dynamic 
Recalibration

Specifies whether to shift the theoretical isotope pattern if the 
pattern base peak in the query spectrum is shifted. 

Default: True
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• Mass List Search Results Table

• BioCyc Results Table

• Metabolika Results Table

Apply mzLogic Node

Use the Apply mzLogic node to score explanations from the ChemSpider node, Search Mass 
List node, Map to BioCyc Pathways node, and Map to Metabolika Pathways node.

Table 56.  Apply mzLogic node parameters

Parameter Description

1. Search Settings

Max # Compounds Specifies the maximum number of compounds to display and 
score in the result table.

Default: 0 (no maximum limit)

Max # mzCloud Similar 
Results to Consider per 
Compound

Specifies the maximum number of compounds to consider from 
an mzCloud similarity search. Increasing the number of 
compounds to consider increases the processing time.

Range: 5 to 100

Match Factor Threshold Specifies the minimum match score returned for a compound by 
an mzCloud similarity search. The analysis ignores compounds 
with match scores below this threshold.

Default: 30

Advanced parameters

FT Fragment Mass 
Tolerance

Specifies the mass tolerance for the mass peaks in 
high-resolution fragmentation spectra when searching the 
mzCloud spectral database.

Default: 10 ppm; range: 0 to 0.5 Da or 0 to 100 ppm

IT Fragment Mass 
Tolerance

Specifies the mass tolerance for the mass peaks in low-resolution 
fragmentation spectra when searching the mzCloud spectral 
database.

Default: 0.4 Da; range: 0 to 1 Da or 0 to 1500 ppm
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Calculate Mass Defect Node

Use this node to calculate the mass defect for each detected compound. You can specify up to 
four calculation methods and up to five Kendrick formulas. This node adds the Mass Defect 
column to the Compounds table for reviewing the result of the specified calculations.

Table 31 describes the parameters for the Filter By Mass Defect node.

Table 57. Filter By Mass Defect node parameters

Parameter Description

1. Mass Defect

Fractional Mass

Standard Mass 
Defect

Relative Mass 
Defect

Kendrick Mass 
Defect

where:

Nominal Mass 
Rounding

Specifies how the node calculates nominal masses. 

Default: Round

Selections: 
• Floor rounds down.
• Ceiling rounds up.
• Round rounds to the nearest integer value.

2. Kendrick Formulas

When you select Kendrick Mass Defect as the Mass Defect Type, this user-specified 
elemental composition specifies the Kendrick formula.

Formula 1–5 Use to add Kendrick formulas.

Fractional Mass exact mass floor (exact mass)–=

Standard Mass Defect exact mass nominal mass–=

Relative Mass Defect 1e6 (exact mass nominal mass)–
(exact mass)

------------------------------------------------------------------------------------------------------=

Kendrick Mass Defect Kendrick mass nominal Kendrick mass–=

Kendrick Mass exact mass nominal mass of Kendrick formula
exact mass of Kendrick formula

------------------------------------------------------------------------------------------------------=

Exact mass Monoisotopic mass of the elemental composition=

Nominal mass Integer mass=
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Compound Class Scoring Node

Use the Compound Class Scoring node to score detected compounds against a set of fragment 
ions commonly present in the fragmentation scans for a compound class. The node compares 
the ions (m/z values) detected in the fragmentation scans to the fragments in the selected 
compound class libraries. 

In a processing workflow, connect the Group Compounds node to the Compound Class 
Scoring node.

The Compound Class Scoring node does the following: 

• Annotates the centroids in the fragmentation scans for a compound with the matching 
fragment structures from the selected compound class libraries.

• Provides a Class Coverage score in the Mass Spectrum view legend.

• Adds the Class Coverage column with the percent coverage to the Compounds table.

• Creates the Compound Class Matches Table—a table related to the Compounds table.

When you add the Compound Class Scoring node to a processing workflow, you must select 
the compound class fragment lists. For information about adding compound class fragment 
lists to the Compound Classes library, see “Modifying the Compound Classes List” on 
page 535.

Table 58 describes the parameters for the Compound Class Scoring node.

Table 58. Compound Class Scoring node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Compound Classes Select the compound classes that you want to use for the fragment 
search.

Compound classes contain a list of fragment structures and 
m/z values that the application compares to the fragmentation 
scans for each detected compound (see “Modifying the 
Compound Classes List” on page 535).

S/N Threshold Specifies the signal-to-noise threshold for the centroids in the 
fragmentation spectra. The application ignores centroids below 
the signal-to-noise threshold. The application attempts to match 
centroids with m/z values above the threshold to the fragment 
structures in the selected compound classes.

Default: 50
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Generate Molecular Networks Node (Beta)

Use the Generate Molecular Networks node to determine and visualize the similarity between 
the various compounds detected by the Detect Compounds node.

Table 59 describes the parameters for the Generate Molecular Networks node.

High Acc. Mass 
Tolerance

Specifies the mass tolerance for high-resolution mass spectra 
measured in the Orbitrap mass analyzer of a Thermo Scientific 
mass spectrometer.

Default: 2.5 mmu; Minimum: 0.0; Maximum: Unchecked

Low Acc. Mass 
Tolerance

Specifies the mass tolerance for low-resolution mass spectra 
measured in the ion trap mass analyzer of a Thermo Scientific 
mass spectrometer.

Default: 0.5 Da; Minimum: 0.0; Maximum: Unchecked

Use Full MS Tree Specifies whether scoring is applied on the full spectrum tree or 
only the MS2 scans.

Allow DIA Scoring Specifies whether the node uses DIA scans for scoring when there 
are no available data-dependent scans. If set to false, the node 
annotates DIA scans, but it does not use them for scoring.

Default: True

Table 58. Compound Class Scoring node parameters (Sheet 2 of 2)

Parameter Description

Table 59. Connect Similar Compounds node parameters (Sheet 1 of 4)

Parameter Description

1. Spectral Similarity

These parameters define how fragmentation spectra are compared to determine the 
similarity score between two compounds.

Use Full MSn Tree Specifies whether the node determines the spectral similarity from 
the full MSn tree or only from the MS2 spectra.

Default: True

Match Mass Shift For fragments that are not a direct match by mass, specifies 
whether the shift to the fragment’s mass must match the mass shift 
between the two compounds. 

Default: True



 7 Workflow Nodes
Compound Scoring Nodes

Thermo Scientific Compound Discoverer User Guide 227

Match Transformations For fragments that are not a direct match by mass, specifies 
whether the shift to the fragment’s mass must match the mass of 
the assigned transformation between the two compounds.

Default: True

Variate 
Transformations

For fragments that are not a direct match by mass, specifies 
whether the masses of all the variations of the individual steps of 
the assigned transformation between the two compounds will be 
used as the expected fragments shifts. Fragments shifted by these 
masses will be considered as matching.

S/N Threshold Specifies the signal-to-noise threshold for the centroids in the 
fragmentation spectra. The node ignores centroids below the 
signal-to-noise threshold—that is, the node attempts to match 
only centroids with m/z values above the threshold.

Default: 50

Mass Tolerance Specifies the mass tolerance to use for fragments matching.

Min. Fragment m/z Specifies the minimum m/z values of the centroids to consider.

2. Transformations

Phase I Specifies the set of possible single-step Phase 1 transformations. 

Default: All check boxes are clear.

Phase II Specifies the set of possible single-step Phase II transformations. 

Default: All check boxes are clear.

Others Specifies other possible single-step transformations. 

The node treats Others transformations as Phase I 
transformations.

Max. # Phase II Specifies the maximum number of Phase II steps to be applied. 

Default: 1; range: 1–10

Max. # All Steps Specifies the maximum number of all steps to be applied. 

All steps that occur as a result of the selections in the Dealkylation 
area equal one step in the maximum number of all steps—that is, 
after the node applies the steps in the Dealkylation area, the 
remaining number of possible steps is equal to the 
Max. # All Steps – 1.

Default: 3; range: 1–10

Table 59. Connect Similar Compounds node parameters (Sheet 2 of 4)

Parameter Description
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3. Applied View Filters

These parameters filter out (hide) connections with lower confidence in the Similar 
Compounds table for a compound. This filtering has no effect on the stored data—that is, 
you can click the filter icon on the Similar Compounds tab to undo all of these filters.

Require 
Transformation

When set to True, similar compounds without assigned 
transformations are hidden.

Default: True

Require MSn When set to True, similar compounds without a spectral similarity 
score are hidden.

Min. MSn Score Specifies the minimum MSn Score value for a similar compound. 
If a similar compound has no fragmentation data, the filter is not 
applied.

Min. MSn Coverage Specifies the minimum Forward or Reverse Coverage value for a 
connection. The connection is hidden only if both values are 
below this threshold. If a connection has no fragmentation data, 
this filter is not applied.

Min. # Fragments Specifies the minimum Forward or Reverse Matches value for a 
connection. The connection is hidden only if both values are 
below this threshold. If a connection has no fragmentation data, 
the filter is not applied.

4. Applied Thresholds

These parameters define the filtering rules applied to the stored connections. Compounds 
that fall below these thresholds are not stored as similar compounds. The main purpose is to 
filter out low confidence connections to reduce the amount of stored data. 

Require 
Transformation

If set to True, removes connections without assigned 
transformations.

Default: True

Require MSn If set to True, removes connections without a spectral similarity 
score.

Default: True

Min MSn Score Specifies the minimum MSn Score value for a stored connection. 
If a connection has no fragmentation data, the filter is not applied.

Table 59. Connect Similar Compounds node parameters (Sheet 3 of 4)

Parameter Description
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Pattern Scoring Node

Use the Pattern Scoring node to provide a spectrum fit score (SFit%) for each detected 
compound. The Pattern Scoring node compares the measured isotope pattern for each 
detected compound to a defined isotope pattern—that is, it compares the mass shifts and 
intensities of the centroids in the isotope pattern for the detected compound to a set of 
defined mass shifts and relative intensities. Use the Pattern List Editor dialog box to store 
defined isotope patterns for your analyses.

The Pattern Scoring node adds the Pattern Matches column to the Compounds table and 
creates the related Matched Patterns Table.

Table 60 describes the parameters for the Pattern Scoring node.

Min MSn Coverage Specifies the minimum Forward or Reverse Coverage value for a 
stored connection. The connection is removed only if both values 
are below this threshold. If a connection has no fragmentation 
data, the filter is not applied.

Min. # Fragments Specifies the minimum Forward or Reverse Matches value for a 
connection to be stored (i.e. only if both values are below 
threshold the connection is removed). If a connection has no 
fragmentation data, the filter is not applied, and the connection 
may still be stored.

Table 59. Connect Similar Compounds node parameters (Sheet 4 of 4)

Parameter Description

Table 60.  Pattern Scoring node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Isotope Patterns Specifies the isotope patterns to be used for scoring.

Mass Tolerance Specifies the mass tolerance for calculated elemental 
compositions and pattern matching. 

Default: 5 ppm; range: 0.0–no limit

Intensity Tolerance [%] Specifies the relative intensity tolerance of the mass spectral 
peaks in the isotope pattern.

Default: 30; range: 0.01–100.0

S/N Threshold Specifies the signal-to-noise threshold for the search. The 
application ignores isotopes with a theoretical intensity value 
below this threshold. 
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Expected Compounds Nodes
These nodes extract information about the compounds that you expect to find in the input 
file set. The Find Expected Compounds and FISh Scoring nodes require structural 
information about the targeted compounds. You supply this information by adding it to the 
Expected Compounds library.

• Find Expected Compounds Node

• FISh Scoring Node

• Generate Expected Compounds Node

• Group Expected Compounds Node

• Mark Background Compounds Node–Expected Compounds

• Merge Features Node

Find Expected Compounds Node

Use the Find Expected Compounds node to search for compounds in the compound ions list 
provided by one or more Generate Expected Compounds nodes. 

Using the input from one or more Generate Expected Compounds nodes, the Find Expected 
Compounds node looks for expected compounds in the MS1 scans filtered through the data 
processing nodes. The expected compounds are the parent compounds that the Generate 
Expected Compounds nodes provide to the Find Expected Compounds node, and the 
reaction products for these parent compounds. Each Generate Expected Compounds Node 
predicts the reaction products by using the user-specified Dealkylation step and the 
user-specified transformation steps. The Dealkylation step can comprise multiple dealkylation 
and dearylation reactions. 

The processing results for the Find Expected Compounds node appear in these tables: 
Expected Compounds Table, Expected Compounds per File Table, Expected Formulas Table, 
and Expected Features Table. 

For more information about how the application finds expected compounds, see “Targeted 
Workflows for Expected Compounds” on page 16. 

Table 61 describes the parameters for the Find Expected Compounds node.

Min. Spectral Fit [%] Specifies the minimum required spectral fit value as a 
percentage.

Range: 0 to 100%

Table 60.  Pattern Scoring node parameters (Sheet 2 of 2)

Parameter Description
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Table 61. Find Expected Compounds node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance that the node uses to create each 
extracted ion chromatogram (XIC).

Default: 5 ppm; range: 0.1 to 20 ppm

Intensity Tolerance [%] Specifies the relative intensity tolerance that the node uses for 
isotope pattern comparison.

Default: 30%; range: 0–100

Intensity Threshold 
[%]

Specifies the minimum intensity relative to the base peak for an 
isotopic peak in an isotope pattern simulation. The application 
does not search for isotopic peaks below the specified intensity 
threshold. 

Default: 0.1; range 0.01–10.0

SN Threshold Specifies the signal-to-noise threshold for the pattern search. 
Isotopes that are expected to be below this intensity level are not 
required. This means that if the intensity for an isotope in the 
theoretical isotope pattern (based on the expected elemental 
composition) is below the signal-to-noise threshold, the 
application ignores the isotope and requires one less matching 
isotope in the measured isotope pattern.

Range: 1 or greater

Min. # Isotopes Specifies the minimum number of isotopes (mass spectrum peaks 
in a centroided mass spectrum) that must match the theoretical 
isotope pattern of the expected elemental composition.

Default: 2; range: 1 to no limit

Minimum Peak 
Intensity

Specifies the minimum apex intensity, in counts, of the detected 
chromatographic peak. The node discards chromatographic peaks 
below this intensity threshold.

Default: 1000; Minimum: 0.0
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FISh Scoring Node

Use the FISh Scoring node to provide a confirmation score for compounds that the Find 
Expected Compounds node detects and to annotate the fragmentation spectra for these 
compounds. The FISh Scoring node requires data-dependent fragmentation (DDF) scans to 
calculate the FISh coverage scores for related structures.

For information about how the node calculates the confirmation score, see “FISh Scoring for 
Targeted Compounds and Proposed Structures” on page 36. 

Average Peak Width Specifies the average chromatographic peak width (FWHM) in 
the filtered time range.

Default: 0 (automatic peak width detection); range: unchecked

When this value is set to 0, the node automatically determines the 
average peak width. 

IMPORTANT  The node detects no chromatographic peaks in 
the following cases:

• The filtered retention time is too small compared to the 
determined or user-specified average peak width value. For 
information about filtering the scan data, see “Select Spectra 
Node” on page 174.

• The determined or user-specified average peak width value 
is too small compared to the scan rate of the instrument. 

For example, if the instrument acquires a full (MS1) scan 
every 0.01 minutes, do not enter an Average Peak Width 
value of less than 0.02 (2 × 0.01 minutes), as the peak 
detection algorithm requires a minimum of three data 
points to detect a chromatographic peak.

For best results, keep the default setting of 0, which turns on 
automatic peak width detection. Enter a nonzero value only 
when the automatically detected peak width is not suitable or 
fails for your chromatographic method.

Table 61. Find Expected Compounds node parameters (Sheet 2 of 2)

Parameter Description
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Table 62 describes the parameters for the FISh Scoring node.

Table 62. FISh Scoring node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Annotate Full Tree Specifies whether the node annotates the full spectrum tree or 
only the MS2 scans in the Mass Spectrum view.

For information about viewing the FISh annotations in the Mass 
Spectrum view, see “Working with the Mass Spectrum View” on 
page 305.

Default: True

Match Transformations Specifies whether the node matches fragments with 
transformation shifts. 

Default: True

S/N Threshold Specifies the signal-to-noise threshold for centroids. The node 
ignores centroids below this threshold in the fragmentation 
(MS/MS, MS3, and so on) spectra. 

Default: 3

High Acc. Mass 
Tolerance

Specifies the mass tolerance for high-resolution mass spectra 
measured in the Orbitrap mass analyzer of a Thermo Scientific 
mass spectrometer.

Default: 2.5 mmu; Minimum: 0.0; Maximum: Unchecked

Low Acc. Mass 
Tolerance

Specifies the mass tolerance for low-resolution mass spectra 
measured in the ion trap mass analyzer of a Thermo Scientific 
mass spectrometer.

Default: 0.5 Da; Minimum: 0.0; Maximum: Unchecked

2. Fragment Prediction Settings

Use General Rules Specifies whether the node uses the general fragmentation rules.

Default: True

Use Libraries Specifies whether the node uses fragmentation libraries for 
fragment prediction.

Default: True

Note  Using fragmentation libraries to predict fragments adds 
significant time to data processing; however, it also provides 
significantly more predicted fragments.
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Generate Expected Compounds Node

Use the Generate Expected Compounds node to generate a list of m/z values for the ionized 
compounds that you expect to find in a sample. The list includes the parent compounds and 
their possible dealkylation, dearylation, and transformation products. The application 
generates the list by using the structures of the parent compounds, the user-specified 
transformation lists and number of combinatory steps, and the user-specified ionic species. 

The default transformations library contains common Phase 1 and Phase 2 metabolic 
transformations. If the transformation list does not include the possible transformations for 
your compound, add them to the transformations library as described in “Adding or Editing 
Transformations with the Transformation Editor” on page 512. 

When you add transformations to the library, you can assign them to one of the following 
groups: Phase I, Phase II, or Others. The Generate Expected Compounds node treats 
transformations assigned to the Others group as Phase I transformations; that is, it applies 
Phase I and Others transformations before it applies Phase II transformations.

Max. Depth Specifies the maximum number of steps in the fragmentation 
pathway.

Range: 1 to 20

Aromatic Cleavage Specifies whether the node includes a cleavage step in the 
fragmentation pathway for highly aromatic structures—that is, for 
aromatic structures where n in Huckel’s rule is 2 or higher.

4n + 2 = 0 or a positive integer for the number of electrons in the 
delocalized, conjugated p-orbital cloud

For example, the following structure is aromatic with an n value of 
2.

Default: True

Min. Fragment m/z Specifies the minimum m/z value of a fragment ion to be 
generated by the prediction fragmentation pathway.

Default: 50 

Table 62. FISh Scoring node parameters (Sheet 2 of 2)

Parameter Description
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To predict the transformation products for the selected parent compounds, the Generate 
Expected Compounds node follow these rules:

1. When the user enables Dealkylation, apply the dealkylation steps first. If a subsequent 
transformation reverses the dealkylation step, reject the subsequent transformation. When 
the user enables both Dealkylation and Dearylation, apply both of these steps first, and 
then determine two separate reaction pathways for the remaining transformation steps. 

Consider all steps under Dealkylation together as one step. For example, consider the 
selections shown in Figure 70 as one step in the total set of reaction pathways and create 
separate reaction pathways. Apply the transformation steps on the parent compound and 
the reaction products from the dealkylation pathways. 

Figure 70. Dealkylation step example

2. When more than one reaction pathway produces the same elemental composition, use the 
pathway with the lowest number of transformation steps. 

3. Reject transformations that remove elements that are not present. For example, do not 
apply an oxidative dechlorination step if the compound does not contain chlorine.

4. For Phase I and Others transformations, limit the maximum number of times to apply 
the transformation on a single compound to the lower of these two values:

– Max Occurrence setting for the transformation in the Transformations library 

For example, for the oxidation transformation, the default value for Max Occurrence 
is 3.

– Maximum number of steps specified by the node’s Max. # All Steps parameter minus 
any previously applied Dealkylation step. 

Parent compounds

Products of 
one dealkylation step 

and
one dearylation step

Products of
one dearylation

step

Products of 
two dearylation 

steps

Products of 
one dealkylation

step

Products of 
two dealkylation

steps

Parent compounds
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5. For Phase II transformations, limit the maximum number of times to apply the 
transformation on a single compound to the lowest of these three values:

– Max Occurrence setting for the transformation in the Transformations library

– Maximum number of steps for all reactions (setting for node’s Max. # All Steps 
parameter) minus any previously applied Dealkylation or Transformation step

– Maximum number of steps for a Phase II transformation (setting for node’s Max. # 
Phase II parameter)

You can connect one or more Generate Expected Compounds nodes to the Find Expected 
Compounds Node and the Filter By Mass Defect Node.

Table 63 describes the parameters for the Generate Expected Compounds node. The 
application cannot use the processing workflow until you select a compound from the 
Compound list. 

If you want to generate expected compounds for more than one parent compound, do the 
following: 

• To target multiple compounds with a different set of transformation rules for each 
compound, add multiple Generate Expected Compounds nodes to the processing 
workflow.



 7 Workflow Nodes
Expected Compounds Nodes

Thermo Scientific Compound Discoverer User Guide 237

• To target multiple compounds with the same set of transformation rules, add one 
Generate Expected Compounds node to the processing workflow and select multiple 
compounds in the node’s Compound list. 

Table 63. Generate Expected Compounds node parameters (Sheet 1 of 3)

Parameter Description

1. Compound Selection

Compound Specifies the parent compounds that the node uses to build a list 
of possible product compounds.

Show Checked 
Items Only

Displays only the selected compounds.

Check All Selects all compounds in the list.

Uncheck All Undoes all selections.

Note  Before you can use the Generate Expected Compounds node to predict the 
transformation products of specific compounds, you must first add the compounds to the 
Expected Compounds library.

2. Dealkylation

Apply Dealkylation When you select True, the node applies the dealkylation 
transformations for the specified compound before applying other 
transformations.

Default: True

Apply Dearylation When you select True, the node applies the dearylation 
transformations for the specified compound before applying other 
transformations. 

Default: False
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Max. # Steps Specifies the maximum number of Dealkylation steps. 

For example, if you select True for Dealkylation, True for 
Dearylation, and 1 for the Max. # Steps, the node applies up to 
one dealkylation step and up to one dearylation step as the initial 
Dealkylation step in the set of reaction pathways. For another 
example, see Figure 70 on page 235.

Default: 1; Selection: 1–10

Min. Mass [Da] Specifies the minimum mass of the dealkylation product.

Default: 200

3. Transformations

Phase I Specifies the set of possible Phase 1 transformations. 

Default: All check boxes are clear.

Phase II Specifies the set of possible Phase II transformations. 

Default: All check boxes are clear.

Others Specifies other possible transformations. 

The node treats Others transformations as Phase I 
transformations.

Max. # Phase II Specifies the maximum number of Phase II steps to be applied. 

Default: 1; range: 1–10

Table 63. Generate Expected Compounds node parameters (Sheet 2 of 3)

Parameter Description

Parent compound

Products of 
one dearylation

step

Products of
one dearylation

step
Parent compound
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Group Expected Compounds Node

Use the Group Expected Compounds node to combine similar components 
(chromatographic peaks with the same MW×RT dimensions) that the Find Expected 
Compounds node finds across the input file set. This node combines chromatographic peaks 
by using their chemical formula (resulting from the dealkylations and dearylations and 
transformations of a parent compound) and retention time. This node also selects the best 
representative MS1 scan and fragmentation tree, which other nodes, such as Predict 
Compositions, Search mzCloud, Search mzVault, and so on, use for identification.

Table 64 describes the parameters for the Group Expected Compounds node.

Max. # All Steps Specifies the maximum number of all steps to be applied. 

All steps that occur as a result of the selections in the Dealkylation 
area equal one step in the maximum number of all steps—that is, 
after the node applies the steps in the Dealkylation area, the 
remaining number of possible steps is equal to the 
Max. # All Steps – 1.

Default: 3; range: 1–10

4. Ionization

Ions Specifies the possible ionic species.

Default: [M+H]+1 (protonated species for the positive mode)

Note  The ion definitions library that the application provides 
contains the common ionic species associated with the positive 
and negative modes for the electrospray ionization-mass 
spectrometry (ESI-MS) technique. If the Ions list does not 
include the possible ionic species for your analysis, add the ion 
definition to the Ion Definition library as described in 
“Modifying the Ion Definitions List” on page 505.

Table 63. Generate Expected Compounds node parameters (Sheet 3 of 3)

Parameter Description

Table 64. Group Expected Compounds node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

RT Tolerance [min] Specifies the retention time tolerance, in minutes, that the node 
uses to group mass peaks generated from the same parent 
compound through the same reaction pathway. 

Default: 0.05; range: 1.0
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Mark Background Compounds Node–Expected Compounds

Use the Mark Background Compounds node to flag compounds that are also found in the 
sample blanks (Sample Type—Set to Blank). The Mark Background Compounds node for a 
targeted analysis has a blue background. 

For information about editing the assigned sample types, see “Editing the Sample Type and 
Study Factor Values” on page 110.

Table 65 describes the parameters for the Mark Background Compounds node.

2. Fragment Data Selection 

Preferred Ions Select the preferred ions (adducts) from the list. The application 
uses the list to select the best fragmentation data for each 
compound to submit to an mzCloud or mzVault search.

Table 64. Group Expected Compounds node parameters (Sheet 2 of 2)

Parameter Description

Table 65. Mark Background Compounds node parameters (Sheet 1 of 2)

Parameter Description

1. General Settings

Max. 
Sample/Blank

Below this ratio threshold, the node labels the expected compound as a 
background compound in the Expected Compounds table. If the input 
file set includes more that one blank sample, the node uses the largest 
peak area for the compound in the blank input files as the peak area of 
the blank.

Default: 5

When this setting is 0, the node ignores this parameter.

Peak AreaSample
Peak AreaBlank
----------------------------------- Specified value
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Merge Features Node

Use the Merge Features node to do the following:

• Combine the expected compounds found by the Find Expected Compounds node and 
the unknown compounds found by the Detect Compounds node by using their 
chromatographic retention time and m/z values.

• Create the Merged Features table that includes four status columns: Ion Conflict Status, 
Detect Compounds, Find Expected Compounds, and Custom Explanations.

• Link the manual peaks table to the related Compounds table. 

Table 66 describes the parameters for the Merge Features node.

Max. 
Blank/Sample

Below this ratio threshold, the node labels the expected compound as a 
background compound in the Expected Compounds table. If the input 
file set includes more that one blank sample, the node uses the largest 
peak area for the compound in the blank input files as the peak area of 
the blank.

If the compound is found in a blank sample but not in a non-blank 
sample, (ratio X/0), the node marks the compound as a background 
compound.

Default: 0 (The node does not use this parameter to mark background 
compounds.)

Hide 
Background

When the Hide Background parameter is set to True, the tab for the 
Expected Compounds Table includes a filter icon ( ), 
and the expected compounds that fall below the threshold are hidden. 
Clicking the filter icon displays the filtered compounds.

When the Hide Background parameter is set to False, the background 
compounds appear in the result table.

The Background column is a hidden column in the Expected 
Compounds table. When a compound is flagged as a background 
compound, its Background check box is selected.

Default: True

Table 65. Mark Background Compounds node parameters (Sheet 2 of 2)

Parameter Description

Peak AreaBlank
Peak AreaSample
----------------------------------- Specified value
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Post-Processing Nodes
These nodes provide additional information about the detected compounds. 

• Descriptive Statistics Node

• Differential Analysis Node

• Export Xcalibur Inclusion or Exclusion List Node

• Scripting Node

Descriptive Statistics Node

Use the Descriptive Statistics node to store descriptive statistics for each expected or unknown 
compound in the result file and add the following hidden columns to the Compounds and 
Expected Compounds tables: Mean Area, Median Area, Minimum Area, Q1 Area, and Q3 
Area.

To store the descriptive statistics in the result file, the processing workflow must include the 
Group Expected Compounds node for targeted workflows and the Group Compounds node 
for untargeted workflows.

The Descriptive Statistics node has no parameters.

Table 66. Merge Features node parameters  

Parameter Description

1. General Settings

Mass Tolerance Specifies the mass tolerance for chromatographic peak grouping.

Default: 5 ppm; range: 0.1–20 ppm

RT Tolerance [min] Specifies the retention time tolerance, in minutes, for 
chromatographic peak grouping.

Default: 0.05; range: 0.0–1.0

Note  The Descriptive Statistics node generates the descriptive statistics for individual 
compounds; it has no effect on the Descriptive Statistics view that is available for a result 
file.
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Differential Analysis Node

Use the Differential Analysis node to calculate the statistics for a differential analysis (fold 
change, ratio, p-values, and so on), store this data in the result file, and create a volcano plot in 
the Differential Analysis view by using the data stored in the Compounds Table or Expected 
Compounds Table. A volcano plot is a type of scatter plot for replicate data where the x axis 
represents the log2 of the fold change between two sample groups (generated ratio), and the 
y axis represents the negative log10 of the p-value (test of significance) of the fold change.

This node requires input from the Group Compounds node or the Group Expected 
Compounds node for a sample set with replicate data points and generated ratios. If the 
Grouping and Ratios page of an analysis does not contain generated ratios, the following 
confirmation message appears:

No quan ratios defined in ‘Grouping & Ratios’ tab

Table 67 describes the parameter for the Differential Analysis node.

Export Xcalibur Inclusion or Exclusion List Node

Use the Export Xcalibur Inclusion/Exclusion List node to create an Inclusion/Exclusion mass 
list for a Thermo Scientific mass spectrometer.

Table 68 describes the parameters for the Export Xcalibur Inclusion or Exclusion List node.

Table 67. Differential Analysis node parameters  

Parameter Description

1. General Settings

Log10 Transform 
Values

Specifies whether to calculate log10 values of the chromatographic 
peak areas before storing the data in the result file.

Default: True

Table 68. Export to Xcalibur Inclusion/Exclusion List node parameters (Sheet 1 of 2) 

Parameter Description

1. General Settings

File Name Specifies the file name for the inclusion/exclusion list.

Selected Instrument Bases the format of the inclusion/exclusion list on the selected 
MS.

Selections: LTQ Orbitrap, Orbitrap Fusion, Q Exactive

2. Use Filter Set

Add Filter Set Specifies the filters sets (FILTERSET file type) that you want to 
apply to the generated inclusion list or exclusion list.
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Scripting Node

Use the Scripting Node to perform custom post-processing actions on the data in the result 
tables.

Table 68 describes the parameters for the Scripting Node.

3. Advanced Settings

Left RT [min] Specifies the window to the left of the specified retention time for 
a mass.

Default: 1 min; range: 0.001 to 1000 min

Left RT [min] Specifies the window to the right of the specified retention time 
for a mass.

Default: 1 min; range: 0.001 to 1000 min

Include Isotopic Peaks Specifies whether to include isotopic peaks in the list.

Default: False

4. LTQ Orbitrap Settings

Maximum Concurrent 
Entries

Specifies the maximum number of entries with overlapping time 
windows.

Default: 500; range: 1 to 2000

Mass Precision 
Decimals

Specifies the required number of decimal places for the mass 
values.

Default: 5

Table 68. Export to Xcalibur Inclusion/Exclusion List node parameters (Sheet 2 of 2) 

Parameter Description

Tip  For information about using the Scripting Node, go to the Resources page of the 
following web site: https://mycompounddiscoverer.com/.

Table 69. Scripting Node parameters (Sheet 1 of 2) 

Parameter Description

Executable and Parameters

Path to Executable Specifies the path to the executable file, for example, 
c:\Python37\python.exe.

Command Line 
Arguments

Specifies command line arguments provided to the executable, for 
example, "d:\My Scripts\script.py \" %NODEARGS%.


https://mycompounddiscoverer.com/
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Requested Tables and 
Columns

Specifies the requested result table columns for the executable.

If you specify a table without specifying specific columns in the 
table, the node exports the entire table.

Use a colon to separate the table name from the table columns, a 
comma to separate the table columns, and a semicolon to separate 
tables.

Format: 

TableName1:Column1, Column2;TableName2:Column3, Column4

 To enter this list

1. Click the browse icon.

The Edit Parameter Text for Requested Tables and Columns 
dialog box opens.

2. Do one of the following:

• Enter the tables and columns requested. Use a new line 
for each table.

• Click Load File, select a text file that contains the table 
and column information, and click Open.

3. Click OK.

Use R-Friendly 
Columns

Specifies whether the column names are R-Friendly.

Default: True

Archive Datafiles Specifies whether the node creates an archive containing the 
JSON files and the text (.txt) files.

Default: False

Table 69. Scripting Node parameters (Sheet 2 of 2) 

Parameter Description
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8

Reviewing the Analysis Results

The Compound Discoverer application stores the results of an analysis in a result file 
(cdResult). 

These topics describe how to open result files, filter the result tables to remove non-pertinent 
data, edit the compound annotations, propose custom structures, and modify and store the 
layout of the current result file. They also describe how to export mass lists and spectral data.

Related Topics

• Chapter 9, “Working with the Graphical Result Views.” 

• Chapter 10, “Reviewing the Tabular Result Data.” 

Contents

• Opening, Closing, and Updating Result Files

• Factory Default Layout for a Result Page

• Modifying the Result Page Layout

• Saving, Restoring, and Managing Layouts

• Editing Compound Annotations

• Adding and Deleting Proposed Structures for a Compound

• Replacing an Annotation with a Structure Proposal

• Applying FISh Scoring

• Using Result Filters for Data Reduction and Creating Filter Sets

• Viewing the Result Summary

• Exporting the Tabular Results to an External File

• Exporting Spectral Data to a New or Existing mzVault Library

• Exporting Compounds to a New or Existing Mass List

• Copying or Saving Graphical Views for Publication
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Opening, Closing, and Updating Result Files
During an analysis, the Compound Discoverer application processes a set of input files 
(Xcalibur RAW files) by using a processing workflow and stores the processing results in a 
result file (CDRESULT). 

When you open a result file for the first time, you see a tabbed document with the default 
layout in the application window. You can modify the layout and save these changes with the 
result file. The next time you open the result file, it will open with your custom layout. 

To open a result file from a previous version of the application, you must update the file to the 
current version.

For instructions on how to open, close, and update result files, see these topics:

• Opening Result Files Created in the Current Application Version

• Opening Result Files Created in Previous Versions of the Application

• Update Modes for Legacy Result Files

• Closing a Result File

Opening Result Files Created in the Current Application Version

You can open a result file from the application window, the Start Page, the Job Queue page, or 
the Analysis Results page. A result file opens as a tabbed document. The tab displays the file 
name of the result file (  File Name X). 

 To open a result file

• From the application window, do one of the following:

– From the menu bar, choose File > Open Result. In the Open dialog box, browse to 
the appropriate folder, select the result file of interest, and click Open.

– From the menu bar, choose File > Recent Results > recent result file.

• From the Start Page, do one of the following:

– Under Recent Results, click the blue hyperlink for the result file of interest.

– Under What Would You Like to Do?, click Open Result.

• From the Job Queue page, do one of the following:

– Double-click the table row for a completed job. 

– Select the table row of a completed job and click Open Results.

• From the Analysis Results page, do one of the following:

– Double-click the table row for a completed analysis.

– Select the file of interest and click Open Results.
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You can open as many result files as you want. To view a particular result file, click its tab.

Opening Result Files Created in Previous Versions of the Application

 To open a result file from a previous version of the application

1. From the menu bar, choose File > Open Result. In the Open dialog box, browse to the 
appropriate folder, select the result file of interest, and click Open.

The File Update Required dialog box opens (Figure 71).

Figure 71. File Update Required dialog box

2. Select one of the following update processes:

• To retain the original result file, select the Keep Original File check box. 

The application automatically selects the Failsafe Update check box as well. 

• To automatically delete the original file after the update process ends, select only the 
Failsafe Update check box.

When the Failsafe Update check box is selected, the application automatically backs 
out of the update process if an error occurs.

–or–

• To minimize the processing time, clear both check boxes.

The application immediately processes the file without first creating a temporary file. 
Errors that occur during the update process can corrupt the file. 

3. To start the update process, click Update.

Tip  You can also drag and drop result files (CDRESULT) from Windows Explorer into 
the application window.

IMPORTANT  To prevent loss of data when not using the fail-safe mode to update 
legacy result files, Thermo Fisher Scientific recommends that you manually store 
copies of these files in another directory.
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Update Modes for Legacy Result Files

When you attempt to open a legacy result file, the application prompts you to select an 
update process:

• Selecting the Keep Original File check box runs the update process in the fail-safe mode 
and renames the original result file with an appended version number. This option takes 
the most processing time, but it prevents data corruption of the original file.

• Selecting the Failsafe Update check box runs the update process in the fail-safe mode, but 
it does not save the original result file. If the update process fails, the application retains 
the original result file. You can make another attempt to update the file or you can open 
the file in a previous version of the application.

• Clearing both check boxes turns off the fail-safe mode. This option takes the least amount 
of processing time, but it risks the possibility of corrupting the original file and making it 
unrecoverable.

In the fail-safe mode, the application does the following:

1. Creates a temporary file.

2. Runs the updates on the temporary file.

3. After completing the update process successfully, it does the following:

a. Appends the application version to the file name of the original file. Because the 
application does not reprocess the original file, the file retains its original time stamp.

b. Changes the file name extension of the temporary file to CDRESULT. The time 
stamp for the updated file corresponds to the completion of the update process.

If the update process fails, the application does not rename the original file.

Closing a Result File

You can close a result file (CDRESULT) in two ways.

 To close a result file

• Right-click the tab and choose Close. 

–or–

• Click the close icon on the document’s tab ( ).

If the tab is not visible, click the Current Tabs icon, , and select the result file from the 
list (see “Working with the Tabbed Documents” on page 41).

Note  You can install multiple versions of the Compound Discoverer application on 
the same data system computer.
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Factory Default Layout for a Result Page
When you open a result file (see Opening, Closing, and Updating Result Files), it appears as a 
tabbed page in the application window. 

The factory default layout for a result page includes the following items:

• A tab with the result file name

• A Chromatograms view on the top left that is populated with XIC traces for the 
component with the largest chromatographic peak area across the input files—that is, the 
view is populated with the XIC traces for the compound listed in the first row of the 
Compounds table or the Expected Compounds table. The view is zoomed to the start and 
end points of the chromatographic peak.

• A Mass Spectrum view on the top right that is populated with the MS1 scan with the 
highest resolution and highest intensity related to the preferred ions across the input files. 
The spectrum tree to the left includes the MS1 scans and the available fragmentation 
scans within the following time range for a compound:

– Peak apex (RT) ± the peak’s full width at half maximum (FWHM) 

–or– 

– Start and end points of the chromatographic peak, as determined by the peak 
detection algorithm

• A set of tabbed main tables below the two graphical views 

• A collapsed area for the related tables below the main tables
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Figure 72 shows a result page for a result file generated by using the MetID w Stats Expected 
w Background Removal workflow template. 

Figure 72. Default layout for a result page 

You can change the layout as follows:

• The views that you want to display and their location

• The main and related tables and table columns that you want to display and the order of 
the table columns from left to right

• The data (table rows) displayed or hidden in the result tables 

Related Topics

• Opening, Closing, and Updating Result Files

Select Table Visibility icon

Mass Spectrum view with a 
mass spectral tree on the left

Field Chooser icon

Chromatograms view with a 
collapsible pane on the left

Tabbed 
result 
tables

Click to open the tabbed related tables.

Result file tab
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Modifying the Result Page Layout
The result file layout includes the relative positions of the graphical views, the visible result 
tables, the column arrangement and column fixing if it is enabled, and the applied result 
filters.

These topics describe some of the ways that you can change the layout of a tabbed page for a 
result file:

• Floating a Result Page View

• Enlarging a Result Page View

• Collapsible Pane Options for Filtering, Grouping, Coloring, and Discriminating By 

• Using a View’s Collapsible Pane to Filter the Data By the Study Variable Values

• Using a View’s Collapsible Pane to Group the Data

• Showing or Hiding Result Tables

Floating a Result Page View

 To change a docked view on a result page to a floating view

Do one of the following:

• Right-click the view’s title bar and choose Floating.

• Double-click the view’s title bar.

–or–

• Drag the view away from its docked position.

Enlarging a Result Page View

 To enlarge a floating view for a result page to fill the screen

Double-click the view’s title bar.

To restore the previous size of a floating window, double-click the view’s title bar again.

Collapsible Pane Options for Filtering, Grouping, Coloring, and Discriminating By

These four views on a result page include a collapsible pane of filtering options and grouping, 
coloring, or discriminating by options: 

• Chromatograms view (see “Working with the Chromatograms View” on page 294)

• Trend Chart view (see “Working with the Trend Chart View” on page 332)
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• Principal Component Analysis view (see “Working with the Principal Component 
Analysis View” on page 341)

• Partial Least Squares Discriminant Analysis (see “Working with the Partial Least Squares 
Discriminant Analysis View” on page 358)

• Descriptive Statistics view (see “Working with the Descriptive Statistics View” on 
page 347)

Table 70 describes the effect of clearing and selecting the check boxes in the collapsible pane 
at the left of a view.

Note  If the analysis does not include samples with different study factor values or sample 
types, the application cannot group the samples, and only the Files check box appears in 
the Group By list.

Table 70. Effect of clearing or selecting the check boxes in the collapsible pane

Objective Selection

Remove or display data 
points

Use the check boxes under Filter By to remove or display data 
points by sample type, study factor value, or individual file. By 
default, the application selects all the check boxes with the 
exception of Blank sample types

Visually distinguish data 
points by grouping them

For the Chromatograms view, use the check boxes under Group 
By to colorize the traces by group. The application duplicates the 
check boxes in the Study Variables area of the Grouping and 
Ratios page of the analysis. 

For the Trend Chart view, use the check boxes under Group By 
to change how the data points for the selected compound are 
grouped across the input files.

Distinguishing data 
point by color

For the Principal Component Analysis view, use the Color By 
check boxes to distinguish the principal components by color. 
For the Descriptive Statistics view, use the Color By check boxes 
to visually group the box plots by color.

Discriminate by specific 
study variables

For the Principal Least Squares–Discriminant Analysis view, use 
the Discriminate By check boxes to select the study variables for 
the supervised analysis.
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Table 71 describes the Group By and Filter By options in the collapsible pane.

Table 71. Options in the collapsible left pane  

Feature Description

(X/Y) The left integer is the number of samples that are selected under 
Filter By (and that also contain the selected compound). The right 
integer is the number of samples that contain the selected 
compound.

ON/OFF toggle for 
the Filter By items

ON—The check boxes are available. 

OFF—The check boxes are unavailable and the items are not 
filtered out.

Check boxes

Group By Study 
Variable

Selecting one or more of these check boxes groups the samples 
with the same value or values for the selected study variable or 
variables and displays the groups in different colors.

By default, the application duplicates the selection in the Study 
Variables pane on the Grouping and Ratios page of the analysis. 
Study variables include the study factor values and the sample 
types.

Group By Sample Selecting this check box displays the data points for the selected 
samples in the Filter By area in different colors.

Default: Clear

Filter By Study Factor Select these check boxes to display data for one or more study 
factors.

By default, the application selects all the study factors. 

Filter By Sample Type Select these check boxes to display data for one or more sample 
types.

By default, for the Chromatograms view, the application selects all 
sample types. For the statistical views, the application excludes the 
Identification Only sample type and clears the Blank sample type 
check box. 

Filter By File Select these check boxes to display data from one or more of the 
files. 

By default, the application selects all of the files.
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Using a View’s Collapsible Pane to Filter the Data By the Study Variable Values

You can filter the data points displayed in a result page view by selecting or clearing the check 
boxes for the study variable values in the collapsible pane.

 To filter data points by the study variable values

1. If the view’s collapsible pane is closed, click the icon, , in the upper left corner of the 
view.

1. Under Filter By, click the expand icon to the left of the study variable name to open the 
values list.

2. Clear the check boxes for the items that you want to hide or values that you want to 
remove from the statistical calculations.

Using a View’s Collapsible Pane to Filter the Data By Input File

You can filter the data points displayed in a result page view by selecting or clearing the check 
boxes for the input files in the collapsible pane.

 To filter the data by selected files

1. Under Filter By, click the expand icon to the left of File to open the File list.

2. Clear the check boxes for the files that you want to exclude from the display or the 
statistical calculations.

Using a View’s Collapsible Pane to Group the Data

You can group the data points displayed in a result page view by selecting or clearing the check 
boxes under Group By in the collapsible pane.

 To group the data points in a view

1. To group the data by the study variables or by the individual files, select a row in the 
active result table. Then, select one or more check boxes under Group By

2. To view a color legend of the sample groups, right-click the Chromatograms view and 
choose Display Options > Show Legend. 

Note  By default, for the statistical views, the check box for the Blank sample type under 
Filter By is clear. 
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Showing or Hiding Result Tables

The set of result tables in a result file depends on the processing workflow. 

By default, some of the result tables are hidden. For example, the Adducts table is hidden for 
both targeted and untargeted analyses and the Filled Gaps related table is hidden for an 
untargeted analysis.

 To show or hide result tables

1. Open a result file (see “Opening, Closing, and Updating Result Files” on page 248).

2. Click the Select Table Visibility icon, , to the left of the result table tabs.

The Select Visible Tables dialog box opens.

3. Select the check box that corresponds to the table that you want to show, or clear the 
check box that corresponds to the table that you want to hide.

By default, the Adducts and Filled Gaps tables are hidden.

4. Click OK to accept the changes.

Saving, Restoring, and Managing Layouts
The layout of the result file includes the location of the graphical views, the result tables that 
you want to display, the columns and rows that you want to display in the result tables, the 
filter set, the custom annotations, and the Group By and Filter By settings.

In addition to the factory default layout, the application comes with the following custom 
layouts:

• Identification—Adds the Structure column to the Compounds and Expected 
Compounds tables. Opens the primary set of related tables to the Structure Proposals 
table. Closes the search result tables if they are visible.

• Quantification—Opens the Trend Chart view. Opens the primary set of related tables to 
the Structure Proposals table. Closes the search result tables if they are visible.

• Stable Isotope Labeling—Opens the Isotopologues Distribution Chart, the Trend Chart, 
and the Metabolika Pathways view. In the Compounds table, hides the following 
columns: #Metabolika Pathways, Avg. Exchange, FISh Coverage, and Metabolika 
Pathways, 

• Statistics—Opens the Differential Analysis, Trend Chart, Principal Component Analysis, 
and Partial Least Squares Discriminant Analysis views. Closes the Chromatograms and 
Mass Spectrum views. Closes the search result tables if they are visible. 

Follow these topics as needed:

• Saving the Current Layout of a Result File
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• Resetting the Layout to the Factory Defaults

• Creating a Custom Layout

• Applying a Custom Layout

• Managing the Layouts

Saving the Current Layout of a Result File

 To save the current layout of the result file

With the result file selected as the active page, do one of the following:

• In the toolbar, click the Save the Currently Active Item icon, .

–or–

• From the menu bar, choose File > Save (save the currently active item).

Resetting the Layout to the Factory Defaults

 To reset the layout to the factory default settings

With the result file selected as the active page, from the menu bar, choose Window > 
Reset Layout.

The application closes the result file, and then reopens the result file to the factory default 
layout.

Creating a Custom Layout

 To create a custom layout

1. Open a result file and modify its layout.

For details, see “Opening, Closing, and Updating Result Files” on page 248 and 
“Modifying the Result Page Layout” on page 253.

2. From the menu bar, choose Window > Save Layout.

The Save Result Layout dialog box opens.

3. Name the layout and click OK.



 8 Reviewing the Analysis Results
Editing Compound Annotations

Thermo Scientific Compound Discoverer User Guide 259

Applying a Custom Layout

 To apply a custom layout

1. With the result file selected as the active page, from the menu bar, choose Window > 
Apply Layout. 

2. Select a layout from the list or use the hot keys.

Managing the Layouts

 To manage the layouts

1. From the menu bar, choose Window > Manage Layouts.

The Manage Result File Layouts dialog box opens. The list order corresponds to the hot 
keys in the Apply Layout list. For example, for this list, the hot key combination for the 
Statistics layout is CTRL+ALT+1.

2. Do the following as needed:

• To delete a layout, select it and click Delete.

• To rename a layout, select it and click Rename. Then, in the Rename Result Layout 
dialog box, rename the layout and click OK.

• To make the layout the default layout, select it and click As Default.

• To change the list order, select a layout, and use the Up/Down buttons, , to move 
the layout up or down in the list.

Editing Compound Annotations
Annotations include the compound name, formula, annotation source, FISh coverage score, 
and structure. 

Use the Compound Annotation Editor dialog box to edit the annotations for compounds of 
interest in the Compounds Table, Expected Compounds Table, and the Structure Proposals 
Table. Saving a custom annotation overwrites the original processing results.

Use these buttons to change the order 
of the layouts.

Changing the order changes the 
associated hot keys. The first 10 layouts 
in the list have associated hot keys.
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 To edit a compound annotation

1. Double-click the row of interest in the Compounds table, Expected Compounds table, or 
related Structure Proposals table.

The Compound Annotation Editor dialog box opens (Figure 73).

The application automatically populates the Molecular Weight/Error in Da, and 
Molecular Weight to Fit boxes. If the formula, structure, and name are available, the 
application also populates these fields.

2. To add a structure to the drawing area, do any of the following: 

• Use the structure drawing tools. See “Using the Structure Drawing Tools or 
Commands” on page 542.

• Open a structure file. See “To open a structure file” on page 501.

• Run a ChemSpider search and select one of the hits. See “Finding a Structure in the 
ChemSpider Database” on page 541.

3. Click Save to save your custom annotations in the result file.

Figure 73. Compound Annotation Editor dialog box

Save
(structure file)

Open
(structure file)

Drawing area

The application 
populates these 
boxes as you draw 
the structure.

Opens the ChemSpider Search dialog box.
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Table 72 describes the parameters in the Compound Annotation Editor dialog box.

Adding and Deleting Proposed Structures for a Compound
In a result file, every compound in the Compounds table or the Expected Compound table 
has a related Structure Proposals table.

To add or delete proposed structures for a compound, follow these topics:

• Adding Structure Proposals

• Deleting Structure Proposals

Table 72. Compound Annotation Editor parameters

Parameter Description

Description page

Formula Displays the elemental formula of the structure in the drawing 
area or the assigned formula.

Formula to Fit Displays the elemental formula of the component found by the 
Find Expected Compounds node.

Molecular 
Weight/Error in Da 

Displays the molecular weight (MW) of the structure in the 
drawing area and the difference between the structure’s calculated 
MW and the MW for the selected compound—that is, the MW 
in the Molecular Weight to Fit box.

Molecular Weight to 
Fit

Displays the molecular weight (based on the formula) of the 
compound selected in the Compounds table or the Expected 
Compounds table. 

Name Displays the name of the compound from an online or local 
database search.

To change the name, type alphanumeric text in this box.

Buttons and check box at the bottom of the dialog box

ChemSpider Opens ChemSpider Search dialog box for searching the 
ChemSpider database.

Apply FISh Scoring Select this check box and click Save to run the FISh Scoring 
algorithm.

Save Saves the changes.

Cancel Cancels the changes and closes the dialog box.

FISh Scoring page

See “Applying FISh Scoring” on page 262.
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Adding Structure Proposals

 To add structure proposals to a Structure Proposals table

1. Select a compound in the main Compounds table or the main Expected Compounds 
table.

2. Click Show Related Tables below the Compounds table or Expected Compounds table.

3. Click the Structure Proposals tab.

4. For each structure proposal, do the following:

a. Right-click anywhere below the Structure Proposals tab and choose Structure 
Proposals > Add Structure Proposal.

b. To edit the structure proposal, follow the instructions in “Editing Compound 
Annotations” on page 259.

Deleting Structure Proposals

 To delete a structure proposal from a Structure Proposals table

Right-click the row and choose Structure Proposals > Delete Structure Proposal.

Replacing an Annotation with a Structure Proposal
Annotations include the compound name, formula, annotation source, FISh coverage score, 
and structure.

 To replace the annotations for a compound in the main result table

Right-click a row in the Structured Proposals table and choose Structure Proposals > Use 
As Compound Annotation.

Applying FISh Scoring
You can apply FISh scoring to a selected entry in the Compounds table, the Expected 
Compounds table, or the entries in the following compound-related search result tables: 
Structure Proposals, mzCloud Results, mzVault Results, Mass List Search Results, BioCyc 
Results, and ChemSpider Results. You can also apply FISh scoring from the Compound 
Annotation Editor dialog box.

The FISh scoring algorithm uses the structure in the structure column of the result table or 
the drawing area of the Compound Annotation Editor dialog box. 
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Follow these topics as needed:

• Applying FISh Scoring from a Result Table

• Applying FISh Scoring from the Compound Annotation Editor Dialog Box

• Specifying the FISh Scoring Parameter Settings

Applying FISh Scoring from a Result Table

 To apply FISh Scoring from a result table

1. Make sure that the entries of interest include structures. 

2. To open the Specify FISh Scoring Settings dialog box (Figure 74), do one of the 
following:

• To submit a compound in the Compounds or Expected Compounds table, 
right-click the selection and choose Apply FISh Scoring. 

• To submit a single selection in a Structure Proposals table, right-click the selection 
and choose Structure Proposals > Apply FISh Scoring to Selection.

• To submit all of the entries in a Structure Proposals table, right-click the table and 
choose Structure Proposals > Apply FISh Scoring to All.

• To submit an entry in a related search result table, right-click the table and choose 
Add to Structure Proposals and Apply FISh Scoring.

Figure 74. Specify FISh Scoring Settings dialog box

3. Set up the parameters (see “Specifying the FISh Scoring Parameter Settings” on 
page 264).

4. Click OK.

In the FISh Scoring Queue view to the left of the table, one job appears for each selected 
entry. For each entry that includes a structure, the application runs the FISh scoring 
algorithm. The run time increases as the complexity of the structure increases. When an 
entry does not include a structure, the job ends in failure and is highlighted with a red 
border.
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Applying FISh Scoring from the Compound Annotation Editor Dialog Box

 To apply FISh Scoring from the Compound Annotation Editor dialog box

1. To open the FISh Scoring page of the Compound Annotations dialog box, right-click an 
entry in the Compounds table or the Expected Compounds table and choose Edit 
Compound Annotation. 

2. Make sure that the drawing area on the Description page includes a structure.

3. Click the FISh Scoring tab.

4. Select the Apply FISh Scoring check box (Figure 75).

Figure 75. FISh Scoring page of the Compound Annotation Editor dialog box

5. Specify the parameter settings (see “Specifying the FISh Scoring Parameter Settings” on 
page 264).

6. Click Save.

Specifying the FISh Scoring Parameter Settings

 To set up the FISh scoring parameters

1. In the Specify FISh Scoring Settings dialog box or on the FISh Scoring page of the 
Compound Annotation Editor dialog box, make the following selections:

• To annotate the full spectrum tree, select the Annotate Full Spectrum Tree check 
box.

• To use the general fragmentation rules, select the Use General Rules check box.

• To use the fragmentation libraries, select the Use Fragmentation Libraries check 
box.

Tip  If time allows, select the Use Fragmentation Libraries check box. Using the 
fragmentation libraries provides significantly more structural information; 
however, it can also add a significant amount of processing time.
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• To allow aromatic cleavage as one of the fragmentation steps, select the Allow 
Aromatic Cleavage check box.

• In the Max. Depth list, select the maximum number of steps allowed in the 
fragmentation pathway.

2. Use the default values or type new values in the following boxes:

• For the FTMS scans, type a value in the High Accuracy Mass Tolerance box and 
select the appropriate units.

• For the ITMS scans, type a value in the Low Accuracy Mass Tolerance box and select 
the appropriate units.

• In the S/N Threshold box, type a value for the FTMS scans.

Table 73 describes the parameter settings for the FISh scoring algorithm.

Table 73. FISh scoring parameters

Parameter Description

Annotate Full 
Spectrum Tree

Annotates the full spectrum tree (MS/MS, MS3, and so on) in the 
Mass Spectrum view.

Use General Rules Uses the general fragmentation rules.

Use Fragmentation 
Libraries

Uses the fragmentation libraries.

Allow Aromatic 
Cleavage

Allows aromatic cleavage as one of the reaction steps.

Max. Depth Specifies the maximum number of fragmentation reactions to 
consider in the fragmentation pathway. 

Default: 5; range: 1–20

High Accuracy mass 
tolerance and units

Specifies the mass tolerance for FTMS data.

Default: 2.5 mmu

Low Accuracy Mass 
Tolerance and units

Specifies the mass tolerance for ITMS data.

Default: 0.5 Da

S/N Threshold Specifies the signal-to-noise threshold for FTMS data. The FT 
mass analyzer calculates the S/N level for each centroid.
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Using Result Filters for Data Reduction and Creating Filter Sets
To show only the most pertinent data, use the Result Filters view to apply filters to the 
processed data. By default, the left pane of the Result Filters view lists the main tables in the 
current result file. The right pane displays the filters for the table that you select in the left 
pane. 

Figure 76. Result Filters view with an empty filter for the Compounds table 

To set up and apply the data reduction filters, see these topics:

• Setting Up, Applying, and Saving Filter Sets

• Creating a Result Filter for a Status Column

• Creating a Result Filter with an AND Logical Conjunction

• Creating a Result Filter with an OR Logical Conjunction

• Creating a Result Filter with Both of the Logical Conjunctions

• Loading a Saved Filter Set

• Result Filters View Parameters

Setting Up, Applying, and Saving Filter Sets

This topic describes how to set up, apply, and save a set of result filters (FILTERSET) for the 
result tables in a result file. 

 To set up, apply, and save a filter set 

1. Open a result file.

Note  The filters for each table are independent of other table filters. For example, a 
retention time filter for the Merged Features table does not affect the entries in the other 
tables that include a retention time column. In addition, filtering only removes rows from 
the display; it does not update or change any of the calculated values.

Adds the visible related tables to 
the result filters list.
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2. From the application menu bar, choose View > Result Filters.

The Result Filters view opens as a floating window or as a docked view and displays the 
filter tree for the current table. 

Each table has its own set of filter conditions.

3. (Optional) To display a filter tree that includes all the visible result tables in the result file, 
select the Show All Tables check box.

4. In the Result Filters view, select the table of interest in the left pane.

The table name appears in the right pane. The following selection tree appears below the 
table name.

5. Click Add Property.

A list that begins with the AND and OR logic selections followed by the columns in the 
selected table appears. 

6. Select the table column (property) that you want to filter by.

7. Do any of the following:

• For the Checked property, select a condition.

This figure shows the condition list for the Checked property.

• For a numeric property, such as retention time (RT), select a mathematical 
relationship and type a value in the adjacent box, if applicable.

Note  To change which tables are visible, use the Select Visible Tables dialog box.

Tip  When you select the Is Equal To relationship, type a numeric value to a 
minimum precision of two decimal places or a minimum precision that is equal 
to the number of decimal places that are displayed in the column, whichever is 
greater. For example, for any of the Area columns, type a numeric value with two 
decimal places, even though the Area column displays a numeric value with no 
decimal places.

Table Name
AND Add group

Add property Click to open a dropdown list of table columns.

Condition list
Selected 
property
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This figure shows the relationship list for numeric properties.

This figure shows a set of filter conditions that limits the displayed results to 
chromatographic peaks from 2 to 7 minutes.

• For a non-numeric property, such as Parent Compound, select a condition and type a 
value in the value box if applicable.

This figure shows the condition list for non-numeric properties.

8. Do any of the following:

• To apply the filter conditions in the current filter set, click Apply Filters.

• To save a filter to a FILTERSET file, click Save or Save As. Then, browse to the 
location where you want to store the file, name the file, and click Save.

• To turn off the filter conditions for a specific table, in the left pane of the Result 
Filters view, click ON to the left of the table name.

Relationship list
Value box

Selected 
property

Condition list
Value box
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The indicator icon to the left of the table name turns from green to yellow, and the 
button displays OFF.

• To clear the filter conditions for a specific table, in the left pane of the Result Filters 
view, select the table. Then, click Clear.

• To clear all of the filters conditions in a filter set, click Clear All.

Creating a Result Filter for a Status Column

This topic describes how to set up a filter for a status column of a result table in a result file.

 To set up filters for the status columns

1. In the Result Filters view, select one of these tables: Merged Features or Compounds.

2. Select a status property; for example, for the Merged Features table, select Find Expected 
Compounds. 

From left to right, the following items appear:

• A (pink) list with one selection: Has Status

• A (green) condition list with no selection 

• A (pink) file relationship list with the selection of In File

• A (green) input file list with no selection

These two filters 
are off. 

Status (Has Status)
Condition list

File relationship list
Input file list

Selected status column in 
the Merged Features table
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The input file list changes to a value box when you select anything other than In File in 
the file relationship list:

• If you select In File, select the file of interest in the input file list.

• If you select a file relationship that requires additional input, a value box appears. 

3. Select a status condition for the selected property (table column).

4. Select a file relationship and enter a value or select a file. 

Ion Conflict Status Find Expected Compounds, Detect Compounds, or 
Custom Explanations

No Data to Compare No Matches Found
No Conflict Single Match Found
Conflicting Ions Multiple Matches Found
Multiple Ions Per Node –
Not Found by Detect Unknown 
Compounds node

–

Found Only By Detect Unknown 
Compounds node

–

Condition list File relationship list

Input file list

Condition list
File relationship list

Value box
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Creating a Result Filter with an AND Logical Conjunction

This topic describes how to use the AND logical conjunction in a result filter.

 To create a filter set using the AND logical conjunction

1. In the Result Filter view, keep the AND logical conjunction as the first item in the filter 
tree.

2. For each property that you want to conjoin with the AND conjunction, click Add 
Property, select a property from the list, and set the property boundaries.

This figure shows a filter set that uses three properties conjoined with an AND 
conjunction. When you apply this filter set to the data in the Expected Compounds per 
File table, only those rows that meet all three conditions remain; that is, you see only 
those detected chromatographic peaks with a retention time greater than 3.00 minutes, 
with an integrated peak area greater than 1 000 000, and where at least two or more 
matching isotopes were found in the MS scans that make up the peak’s data points.

Creating a Result Filter with an OR Logical Conjunction

This topic describes how to use the OR logical conjunction in a result filter.

 To create a filter set using the OR logical conjunction

1. Select the OR logical conjunction as the first item in the filter tree.

2. For each property that you want to conjoin with the OR conjunction, click Add 
Property, select a property from the list, and set up the property conditions.

Note  When you use the AND logical conjunction, all of the connected property 
conditions must be True.

Three properties connected
to an AND conjunction

Note  When you use the OR logical conjunction, only one of the connected property 
conditions must be True.
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This figure shows a filter set that uses two properties conjoined with an OR conjunction. 
When you apply this filter set to the data in the Expected Compounds table, those rows 
that meet at least one of the conditions remain—that is, you see the rows where the FISh 
coverage value is greater than or equal to 30 or where the FISh coverage column has no 
reported value.

Creating a Result Filter with Both of the Logical Conjunctions

This topic describes how to use both of the logical conjunctions in a result filter.

 To create a filter set using both the AND and the OR logical conjunctions

1. Keep the AND logical conjunction as the first item in the filter tree.

2. To conjoin two properties with the OR conjunction, do the following:

a. Click Add Property and select OR from the dropdown list.

b. Set up the properties that you want to conjoin with the OR conjunction. 

This example shows the condition where the FISh Coverage must be greater than or 
equal to 30 or have no value. (The FISh scoring algorithm does not calculate scores 
for DIA scans.)

Two properties 
connected to an OR 
conjunction

Add Property list that connects to 
the OR conjunctionAdd Property list that 

connects to the AND 
conjunction
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3. For each property that you want to conjoin with the AND conjunction, click the Add 
Property list that connects to the AND conjunction, select a property from the list, and 
set up the property boundaries.

This figure shows a result filter that keeps chromatographic peaks that meet the following 
conditions:

• A FISh Coverage score that meets one of these conditions:

– A FISh Coverage score that is greater than or equal to 30 

–or–

– No FISh Coverage score

–and–

• A Retention Time from 4 to 7 minutes

Loading a Saved Filter Set

This topic describes how to load the filters from a FILTERSET file.

 To load a saved filter set

1. In the Result Filters view, click Load.

The Load Filter Set dialog box opens.

2. Browse to the appropriate folder and select the filter set of interest.

3. Click Open.

If the filter set contains filter conditions for tables that are not in the current result file, 
the application automatically hides the unused filters. You can modify the filter 
conditions for the applicable tables only.
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Result Filters View Parameters

Use the Result Filters view to create data reduction filters for the tables in a result file. The 
Result Filters view is a floating window that can remain open while you work in other areas of 
the application.

Table 74 describes the panes, buttons, icons, and check box in the Result Filters view.

Table 74. Result Filters panes and buttons

Feature Description

Left pane Lists the main tables included in the current result file. An On/Off 
button and an indicator icon appear to the left of the table name.

ON/OFF button Use to turn on or turn off the conditions for the associated main 
table.

Indicator icons ( ) Gray—Indicates that the table is unfiltered.

( ) Green—Indicates that a filter has been applied to the table.

( ) Yellow—Indicates that the table filter is off.

Right pane

Displays the filter settings for the selected table. You can modify these settings as described 
in “To set up, apply, and save a filter set” on page 266.

AND or OR  Specifies the logical connection between properties or groups.

Add Group Adds a group.

Add Property Adds a property.

Check box

Show All Tables Selecting this check box adds the related tables to the table list.

Buttons

Load Opens the Load Filter Set dialog box where you can select a saved 
filter set and open it.

Save If a saved filter set is open, clicking Save overwrites the settings in the 
file with the current filter conditions in the Result Filters window.

Save As Opens the Save Filter dialog box where you can define the file name 
and select a folder for a FILTERSET file.

Clear All Clears all of the filter conditions for the current filter set.

Clear Clears the current filter condition.

Apply Filters Applies all of the filter conditions for the current filter set.
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Viewing the Result Summary
In the Summaries view, you can view the following summaries:

• Workflow Summary

• Processing Messages Summary

• Filter Summary

• Study Summary

• Grouping & Ratios Summary

 To open the Summaries view

1. Open the result file of interest (see “To open a result file” on page 248).

2. From the menu bar, choose View > Result Summary.

The Summaries view includes these five pages: Workflow, Processing Messages, Filter, 
Study, and Grouping & Ratios (Figure 77).

Figure 77. Summaries view
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Workflow Summary

To view the processing workflow used to create the active result file, open the Workflow page. 
This page lists the name of the processing workflow, the creation date for the result file 
(.cdResult), the raw data files (.raw) that were processed to create the result file, and the 
parameter settings for the workflow nodes.

For information about creating a processing workflow, see Chapter 6, “Creating and Editing 
Processing Workflows.”  For information about selecting one of the defined workflows, see 
“Nomenclature for the Defined Processing Workflows” on page 29.

Processing Messages Summary

To view a summary of the processes used to create the active result file, open the Processing 
Messages page.

Filter Summary

To view a summary of the filters used to reduce the data in the results window, open the Filter 
page. This page lists the name of the latest filter set (FILTERSET file type) that you applied to 
the result file and the filter conditions in the filter set. Use the Result Filters view to create 
filter sets (see “Using Result Filters for Data Reduction and Creating Filter Sets” on page 266).

Study Summary

To view a summary of the study settings for the input files that make up the result file, open 
the Study page. This page lists the following:

• Name and creation date of the study

• Directory location of the study

• Study factors and their values

• Sample names (Xcalibur RAW files) and their directory location 

Grouping & Ratios Summary

To view a summary of the sample groups and ratios for the analysis, open the Grouping & 
Ratios page.

Figure 78 shows an example summary of the sample groups and ratios for an analysis. The 
summary lists the selected study variables, sample groups, and ratios in order from top to 
bottom. 
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Figure 78. Grouping & Ratios Summary page

Exporting the Tabular Results to an External File
These topics describe how to export the contents of a result table to an external file:

• Shortcut Menu Commands for the Result Tables

• Exporting the Result Table Contents to a Spreadsheet

• Exporting the Result Table Contents to a Text File

• Exporting an Xcalibur Inclusion or Exclusion List

• Exporting the Contents of the Compounds Table to TraceFinder
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Shortcut Menu Commands for the Result Tables

Table 75 describes the shortcut menu commands for the result tables.

Table 75. Shortcut menu commands for the result tables (Sheet 1 of 3)

Command Description

All main and related result tables

Copy With Headers Copies the current table row and its associated column 
headings to the Clipboard.

Copy Copies the current table row to the Clipboard. Does not 
copy the column headings.

Clear Selection Undoes any row selections. Clears the Chromatograms view, 
the Mass Spectrum view, or both of these views if they are 
populated with data.

Cell Selection Mode Turns on the cell selection mode. When the Cell Selection 
Mode is on, you cannot sort the table columns.

Enable Column Fixing or 
Disable Column Fixing

Turns on the column pins. Pinning (or freezing) a column 
moves it to the left of the Checked column.

Export > As Plain Text Exports the data to a comma-separated values file.

Export > As Excel Exports the data to an Excel™ spreadsheet file.

All result tables with a Checked column

Check Selected Places a check in the selected row’s check box.

Check All Selects the check boxes for all of the table rows.

Uncheck Selected Clears the selected row’s check box.

Uncheck All Clears the check boxes for all of the table rows.

Remove All Checkmarks in 
All Tables

Clears the check boxes in all the result tables.

All result tables with expanding table headings

Expand All Column 
Headers

Expands the collapsed column headings.

Collapse All Column 
Headers

Collapses the expanded column headings.
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Expected Compounds and Compounds tables

Edit Compound Annotation If the table does not already include the Name and FISh 
Coverage columns, adds these columns and opens the 
Compound Annotation Editor where you can name the 
compound, add a structure that matches the formula and 
molecular weight, run a ChemSpider search, and apply the 
FISh Scoring algorithm.

Clear Compound 
Annotation

Removes the custom annotation.

Export > As Xcalibur 
Inclusion/Exclusion List

Exports information about all of the compounds in the table 
or only the selected compounds in the table to a text file in 
the format required for the selected mass spectrometer. The 
information includes the m/z value of the monoisotopic ion 
and the start and stop times for the chromatographic peak.

Export > Single Compound 
to an Existing mzVault 
Library 

Exports a selected compound to an existing mzVault library.

Export > Compounds to a 
New mzVault Library

Exports the selected compounds to a new mzVault library.

Compounds table

Export > Export to 
TraceFinder

Exports information about all of the compounds, only the 
named compounds, or only the checked compounds in the 
table to a CSV file in a format appropriate for the 
TraceFinder application.

Export > As Mass List Exports the selected items to a new mass list.

Add Selected Compounds to 
Existing Mass List

Adds the selected compounds to the specified mass list.

Molecular Networks (Beta) Opens the “molecular networking” viewer in your default 
web browser.

Structure Proposals table (related to the Compounds and Expected Compounds tables)

Structure Proposals > Add 
Structure Proposal

Adds a new row to the Structure Proposals table that includes 
the formula and molecular weight from the selected row in 
the main Compounds or Expected Compounds table.

You can type a name in the Name column and a description 
in the Comments column. Double-click the new row to 
open the Compounds Annotation Editor where you can 
draw the compound’s structure, open a structure file, or run a 
ChemSpider search.

Table 75. Shortcut menu commands for the result tables (Sheet 2 of 3)

Command Description
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Related Topics

• Copying Table Entries to the Clipboard

• Freezing Table Columns

• Exporting the Result Table Contents to a Text File

• Exporting the Result Table Contents to a Spreadsheet

• Exporting an Xcalibur Inclusion or Exclusion List

Structure Proposals > Edit 
Structure Proposal

Opens the Compound Annotation Editor where you can 
name the compound, add a structure that matches the 
formula and molecular weight, run a ChemSpider search, 
and apply the FISh Scoring algorithm.

Structure Proposals > Delete 
Structure Proposal

Removes the selected row from the Structure Proposals table.

Structure Proposals > Use as 
Compound Annotation

Replaces the annotations in the selected row of the 
Compounds or Expected Compounds table with the 
annotations in the current row of the Structure Proposals 
table.

Structure Proposals > Apply 
FISh Scoring to Selected

Opens a dialog box where you can specify the settings for the 
FISh scoring algorithm and submit the information in the 
selected row.

To apply FISh scoring, the selected row in the Structure 
Proposals table must include a formula or a structure.

Structure Proposals > Apply 
FISh Scoring to All

Opens a dialog box where you can specify the settings for the 
FISh scoring algorithm and submit all the rows in the 
Structure Proposals table.

All related tables that have a corresponding main table

Go to Same Item in Main 
Table

Opens the main table with the same name as the related table 
and selects the corresponding table row in the main table.

Table 75. Shortcut menu commands for the result tables (Sheet 3 of 3)

Command Description
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Exporting the Result Table Contents to a Spreadsheet

You can export the contents of any of the result tables to a spreadsheet file.

 To export the contents of a result table to a spreadsheet file

1. Right-click the result table that you want to export and choose Export > Export to Excel.

The Export to Excel dialog box opens (Figure 79). The default storage path is 
C:\Users\Public\Documents\result file name. The default selection in the Level 1 box is 
the name of the active result table. 

Figure 79. Export to Excel dialog box with the Compounds table selected

2. If necessary, select a different result table from the Level 1 list. 

The list includes all the main tables in the result file.

3. Click the browse icon next to the Path box.

A second Export to Excel dialog box (where you specify the location and file name for the 
file) opens in front of the first Export to Excel dialog box.

4. Browse to the folder where you want to store the file.

By default, the File Name box displays the name of the result table that you are exporting. 

5. Overwrite or rename the file as appropriate, select the spreadsheet type (XLS or 
Microsoft Excel File), and click Save.

6. In the Export to Excel dialog box (for selecting the table rows to be exported), select 
related tables from the Level 2 and Level 3 lists as appropriate.
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7. In the Options area, make the following selections: 

• To export only those rows that are checked in the result table or tables, select the 
Checked Items Only check box. Otherwise, leave the check box clear to export all of 
the table rows.

• To automatically open the newly created spreadsheet after you export it, select the 
Open File After Export check box.

8. Click Export to export the data to a spreadsheet.

When the export is finished, you receive a confirmation message with the file’s location.

9. At the prompt, click OK.

Exporting the Result Table Contents to a Text File

You can export the contents of any of the result tables to a text file.

 To export the contents of a result table to a text file

1. Right-click the result table that you want to export and choose Export > Export to Text 
File.

The Export to CSV File dialog box opens. The File Name box displays the name of the 
selected result table.

2. Select the folder where you want to store the file, name the file as necessary, and click 
Save.

The text file (.csv) appears in the selected folder.

Exporting an Xcalibur Inclusion or Exclusion List

You can export the contents of the Compounds table or the Expected Compounds table to an 
Xcalibur Inclusion/Exclusion list, and then import this list into an instrument method that 
controls your Thermo Scientific mass spectrometer.

 To export an Xcalibur inclusion or exclusion list 

1. Right-click the Compounds table or the Expected Compounds table and choose Export 
> As Xcalibur Inclusion/Exclusion List.

The Export Xcalibur Inclusion/Exclusion List dialog box opens (Figure 80).
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Figure 80. Export Xcalibur Inclusion/Exclusion List dialog box

2. Make the appropriate selections and entries (Table 76).

3. Click Export.

The application attempts to save the text file to the specified location. If the file name 
conflicts with an existing file, a confirmation message appears. In the absence of a 
conflicting file, a completion message appears indicating that the exported file is in the 
selected folder.

4. If a confirmation message appears, do one of the following:

• To overwrite the existing file, click Yes, and then click OK when the completion 
message appears. 

• To cancel the export, click No.

Table 76 describes the parameters in the Export to Xcalibur Exclusion List dialog box.

Table 76. Export to Xcalibur Inclusion/Exclusion List dialog box parameters (Sheet 1 of 3)

Parameter Description

Path Specifies the file name and directory path of the text file that 
contains the inclusion/exclusion list for your Xcalibur instrument 
method.
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Options

IMPORTANT  An Orbitrap Fusion mass spectrometer accepts a retention time range of 
0.01 to 999 minutes. 

Make sure that the retention time window for each compound falls within the retention 
time range of the instrument method. 

• Expected RT – Left RT Tolerance > Minimum retention time for the instrument 
method

• Expected RT + Right RT Tolerance < Maximum retention time for the instrument 
method

Left RT Tolerance 
[min]

Specifies the minimum start time for the chromatographic peak. If 
the Expected RT minus the Left RT Tolerance setting is less than 
zero, the application exports a value of zero.

Default: 1
Range: 0.001 to 1000

Right RT Tolerance 
[min]

Specifies the maximum stop time the chromatographic peak.

There is no error checking for the calculated maximum retention 
time.

Default: 1
Range: 0.001 to 1000

Checked Items Only Specifies that the application exports only the selected compounds 
to the named text file.

Default: Clear

Include Isotopic Peaks Adds an entry for each isotopic spectral peak.

LTQ Orbitrap Options

Mass Precision 
(Decimals)

Specifies the mass precision. 

For the LTQ Orbitrap, the mass precision of the exported data 
must match the required mass precision for your Xcalibur 
instrument methods. You specify the required mass precision for 
Xcalibur instrument methods in the Instrument Configuration 
dialog box of the Foundation platform. 

Default: 5; range: 0 to 5

Table 76. Export to Xcalibur Inclusion/Exclusion List dialog box parameters (Sheet 2 of 3)

Parameter Description
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Max. Concurrent 
Entries

Specifies the maximum number of entries with overlapping time 
windows.

Default: 500; range: 1 to 2000

Remove Charge Specifies whether the application exports the m/z value of the best 
ion for each detected compound or the neutral mass of each 
detected compound.

Default: Clear

Instrument

LTQ Orbitrap Exports the list in the appropriate format for the LTQ Orbitrap 
instrument control software.

Q Exactive Exports the list in the appropriate format for the Q Exactive 
instrument control software.

The mass list includes the formula of each compound in the 
Comment column when the formula is available.

Orbitrap Fusion Exports the list in the appropriate format for the Orbitrap Fusion 
instrument control software.

If the table contains both positive and negative scans, the 
application creates two mass lists.

The maximum number of target compounds for an Orbitrap 
Fusion mass list is 50 000. If the table includes more than 50 000 
compounds, filter the table or check the compounds of interest 
before you export the mass list.

Buttons and check box

Open File(s) after 
Export

Specifies that the file opens after the application completes the 
export.

Export Exports the specified information to a text file.

Close Closes the dialog box.

Table 76. Export to Xcalibur Inclusion/Exclusion List dialog box parameters (Sheet 3 of 3)

Parameter Description
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Exporting the Contents of the Compounds Table to TraceFinder

You can export the contents of the Compounds table to a CSV file that the TraceFinder 
application can use for data processing.

 To export a compounds list for the TraceFinder application

1. Right-click the Compounds table and choose Export > As TraceFinder List.

The Export to TraceFinder dialog box opens. The default folder is either 
drive:\Users\Public\Documents or the last folder you selected. The default file name is the 
name of the active result file.

Figure 81. Export to TraceFinder dialog box

2. Select the folder where you want to store the file.

3. Do the following as needed:

• To exclude unnamed compounds, select the Exclude Items Without Name check 
box.

• To include only the checked compounds, select the Checked Items Only check box.

• To automatically display the exported compounds list, select the Open File After 
Export check box.

4. Click Export.

A status box appears when the export process finishes.

5. Click OK.

Exporting Spectral Data to a New or Existing mzVault Library
To export spectral data to a new or existing mzVault Library file, see these topics:

• Adding a Compound to an Existing mzVault Library

• Creating a New mzVault Library
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Adding a Compound to an Existing mzVault Library

From a Compounds or Expected Compounds result table, use the Export > Single 
Compound to an Existing mzVault Library shortcut menu command to export a selected 
compound to an existing mzVault library. 

 To add a compound to an existing mzVault Library

1. Open a result file (see “Opening, Closing, and Updating Result Files” on page 248).

2. Click the Compounds tab or the Expected Compounds tab.

3. Right-click a compound in the table and choose Export > Single Compound to an 
Existing mzVault Library.

The Export to mzVault Library dialog box opens (Figure 82). Its Spectra view displays the 
available fragmentation spectra for the selected compound.

Figure 82. Export to mzVault Library dialog box populated with a Compounds table compound

4. Do the following:

• In the spectrum tree, select the check boxes for the spectra that you want to add to 
the compound entry.

• In the mzVault Library area, select the existing mzVault library from the Selected 
Library list.

Tip  The application comes with an empty library named Custom mzVault Library.db. 
You can create other libraries by clicking New on the Libraries > Spectral Libraries page.
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5. Do one of the following:

• To add the spectra to an existing compound entry in the library, select the entry in 
the Similar Compounds Found in Library list. Then, click Add to Selected.

• To add the compound and the selected spectra as a new compound entry, click Add 
as New.

6. Close the dialog box.

Creating a New mzVault Library

From a Compounds or Expected Compounds result table, use the Export > Compounds to a 
New mzVault Library shortcut menu command to export all or selected compounds to new 
mzVault library.

 To export compounds to a new mzVault library

1. Open a result file (see “Opening, Closing, and Updating Result Files” on page 248).

2. Click the Compounds tab or the Expected Compounds tab.

3. (Optional) Filter the table to display only the compounds of interest or select the check 
boxes for the compounds of interest.

4. Right-click the table and choose Export > Compounds to a New mzVault Library.

The New mzVault Library dialog box opens. By default, the application populates the 
Library Name box with the name of the opened result file.

5. Do the following:

• Type a new library name or keep the default name.

• In the Options area, select whether to exclude compounds without a name, export 
only the compounds with selected check boxes, or both.

6. Click Export.

7. At the prompt, click OK.

The new library appears in the Spectral Libraries list.

8. To modify a library with the mzVault 2.2 application, export it to another folder. Then, 
use the Replace command to replace the existing library with the modified library.
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Exporting Compounds to a New or Existing Mass List
You can create new mass lists or add compounds to existing mass lists by exporting 
compounds from the Compounds table of a result file.

Follow these topics as needed:

• Exporting Compounds from the Compounds Table to a New Mass List

• Exporting Compounds from the Compounds Table to an Existing Mass List

Exporting Compounds from the Compounds Table to a New Mass List

 To create a new mass list by exporting a set of compounds from the Compounds table

1. Open the result file of interest.

2. Open the Compounds table.

3. (Optional) To export only the checked compounds, select the check boxes for the 
compounds of interest in the Checked column.

4. Right-click the Compounds table and choose Export > As Mass List.

5. In the Export to New Mass List dialog box, do the following:

a. In the Mass List Name box, type a name for the mass list.

b. In the Options area, do any of the following:

• To export only checked compounds, select the Checked Items Only check box.

• To export only named compounds, select the Exclude Items without Name 
check box.

• To include the retention time information in the mass list, select the Export 
Retention Time check box.

c. Click Export.

6. At the prompt, click OK.

The new mass list appears in your Mass Lists library.

Exporting Compounds from the Compounds Table to an Existing Mass List

 To export compounds to an existing mass list

1. Open a result file of interest.

2. Open a main or related Compounds table.

3. Highlight the compounds of interest by using the SHIFT and CTRL keys.
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4. Right-click your selection and choose Export > Add Selected Compounds to Mass List.

The Export to Existing Mass List dialog box opens.

Figure 83. Export to Existing Mass List dialog box

5. Do the following:

• In the dropdown Mass List Name list, select the mass list where you want to add the 
selected compounds.

• (Optional) To add the retention time information to the mass list, select the Export 
Retention Time check box.

6. To avoid exporting named compounds that are already in the mass list, do one of the 
following:

• To exclude any named compound with a name that matches that of a named 
compound in the existing mass list, select the Do Not Add Duplicate Names check 
box.

–or–

a. To exclude a named compound only if its mass and retention time match the 
duplicate compound in the mass list within specified tolerances, clear the Do Not 
Add Duplicate Names check box.

The Mass Tolerance and RT Tolerance boxes become available.

b. Enter the tolerances that you want the application to use to exclude duplicate named 
compounds from being exported to the mass list.

Note  This feature is case sensitive.

Note  If you do not want to exclude a named compound unless both its mass and 
retention time are an exact match to the named compound in the mass list, set 
both tolerance values to 0.
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Copying or Saving Graphical Views for Publication
You can copy the contents of a graphical view (see “Working with the Graphical Result Views” 
on page 293) to the Clipboard as editable text or as an image, or to an external file.

• To save a graphical view as a raster image, save it as one of these file types: PNG, GIF, 
JPG, TIF, or BMP.

• To save a graphical view as a vector image, save it as an EMF file.

Table 77 lists the shortcut menu commands for copying data to the Clipboard or an external 
file. 

Table 77. Commands for copying an image of a graphical view (Sheet 1 of 2)

Graphical view Copy the image 
to the Clipboard

Copy the data points to the 
Clipboard

Copy the data to an 
image file

Copy the data to a 
TEXT or CSV file

Chromatograms view Copy > Image Copy > Points Export > Image As Export > Points As

Mass Spectrum view Copy > Image Copy > Points—Copies the 
scan label and the m/z and 
intensity values for annotated 
centroids to the Clipboard. 
Copy > Raw Points—Copies 
the m/z and intensity values 
for all centroids to the 
Clipboard. Does not copy the 
scan label.

Export > Image As Export > Points As

Scatter Chart Copy > Image Copy > Data Export > Image As Export > Data As

Histogram Chart Copy > Image Copy > Data Export > Image As Export > Data As

Bar Chart Copy > Image Copy > Data Export > Image As Export > Data As

Pie Chart Copy > Image Copy > Data Export > Image As Export > Data As

Trend Chart Copy > Image Copy Information to 
Clipboard

Export > Image As Export > Data As

Principal Component 
Analysis view

Copy > Image Copy > Points Export > Image As Export > Points As 
(CSV file)

PLS-DA view Copy > Image Copy > Points

Copy > Point Details

Export > Image As Export > Points As 
(CSV file)

Export > Point 
Details As 

Descriptive Statistics 
view

Copy > Image Copy Information to 
Clipboard

Export > Image As Save Information 
As (CSV file)
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Differential Analysis 
view

Copy > Image Copy > Points

Copy > Point Details (Use this 
command if the 
corresponding table includes 
structures.)

Export > Image As Export > Points As 

Export > Point 
Details As

KEGG Pathways Copy N/A Save Picture As (a 
PNG or BMP file)

N/A

Retention Time 
Correction

Copy > Image Copy > Points Export > Image As Export > Points As 

Compound Area 
Corrections

Copy > Image Copy > Points Export > Image As Export > Points As 

Table 77. Commands for copying an image of a graphical view (Sheet 2 of 2)

Graphical view Copy the image 
to the Clipboard

Copy the data points to the 
Clipboard

Copy the data to an 
image file

Copy the data to a 
TEXT or CSV file
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Working with the Graphical Result Views

To work with the graphical views that are available when a result page is active, see these 
topics.

Contents

• Working with the Chromatograms View

• Working with the Mass Spectrum View

• Working with the Result Charts

• Plotting the Data as a Histogram Chart

• Working with the Trend Chart View

• Working with the Mass Defect Plot View 

• Working with the Principal Component Analysis View

• Working with the Descriptive Statistics View

• Working with the Differential Analysis View

• Working with the Partial Least Squares Discriminant Analysis View

• Viewing KEGG Pathways

• Viewing BioCyc Pathways

• Viewing Metabolika Pathways

• Viewing the Corrected Retention Times of the Alignment Features

• Viewing the QC-Based Compound Area Correction Curves

• Viewing the FISh Scoring Queue

• Running a Hierarchical Clustering Analysis 

• Running an mzLogic Analysis 

• Working with the Isotopologues Distribution Chart
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For information about using the Result Filters view, see “Using Result Filters for Data 
Reduction and Creating Filter Sets” on page 266. For information about viewing a summary 
of the analysis parameters for a result file, see “Viewing the Result Summary” on page 275.

Working with the Chromatograms View
When you initially open a result file, the Chromatograms view displays the XIC traces for the 
compound in the first row of the Compounds table or the Expected Compounds table. By 
default, the display zooms in on the detected peaks for the selected rows. 

The Chromatograms view consists of a collapsible pane on the left and the graphical view on 
the right. Right-clicking the graphical view opens a shortcut menu (see Table 79).

Follow these topics as needed:

• Viewing a Chromatogram

• Adding a Chromatogram Plot

• Overlaying Chromatogram Plots

• Changing the Grouping in the Collapsible Pane

• Hiding the Traces for a Study Variable Value

• Updating All the Chromatogram Plots Simultaneously

• Manually Integrating Chromatographic Peaks

• Chromatograms View Shortcut Menu Commands

Viewing a Chromatogram

You can display chromatogram traces (a plot of intensity versus time) by selecting a row in any 
of these tables: Compounds, Compounds per File, Expected Compounds, Expected 
Compounds per File, Expected Formulas, Merged Features, Expected Features, FISh Trace 
Fragments, Specialized Traces, or Manual Peaks.

 To view a chromatogram 

1. Open a result file that contains chromatographic data.

2. If the Chromatograms view is closed, open it by choosing View > Chromatogram from 
the menu bar.

Note  When you select a row for a filtered study file, the Chromatograms view does 
not display a trace. For example, if the Blank check box is clear under Filter By 
Sample Type and you select a row for a Blank sample, the Chromatograms view 
remains empty. By default, the Blank Sample Type check box is clear until you select 
it.
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3. Do one of the following:

• Click the Compounds tab or the Expected Compounds tab and select a row.

The Chromatograms view displays overlaid traces of the chromatographic peaks that 
were detected across the input files for the molecular weight and retention time 
(MW × RT dimensions) listed in the selected table row. Each trace is a composite of 
the adducts found. For the Expected Compounds table, the chromatographic peak 
for each row is also derived from the same parent compound and reaction steps.

• Click the Expected Formulas tab and select a row.

The Chromatograms view displays overlaid traces for all of the chromatographic 
peaks found for an expected elemental composition (same MW, parent compound, 
and elemental composition). 

• Click the Merged Features tab and select a row.

The Chromatograms view displays overlaid traces of the chromatographic peaks 
detected by the Detect Compounds and Find Expected Compounds nodes for the 
selected feature (same m/z × RT dimensions).

• Click the Features tab or the Expected Features tab and select a row.

The Chromatograms view displays the integrated chromatographic peak for the 
selected table row (m/z × RT dimensions). 

• Click the Compounds per File tab or the Expected Compounds per File tab and 
select a row.

The Chromatograms view displays the integrated chromatographic peak for the 
selected table row (MW × RT dimensions). Each trace is a composite of its related 
adducts, and the peak area for a compound is the sum of the areas for its related 
adducts (parent area for the adducts listed in the Expected Features table or the 
Features table). 

• Click the FISh Trace Fragments tab and select a row.

The Chromatograms view displays a trace for the structure displayed in the selected 
table row. The FISh Trace Fragments table appears in the main table set when you 
select True for Individual Traces in the Create FISh Trace node of a processing 
workflow.

• Click the Specialized Traces tab and select a row. 

Note  The Specialized Traces table contains traces generated by these nodes: 
Create Mass Trace, Create Analog Trace, Create Pattern Trace, and Create FISh 
Trace.



9 Working with the Graphical Result Views
Working with the Chromatograms View

296 Compound Discoverer User Guide Thermo Scientific

• Open the related tables, click the Filled Gaps tab, and select a row.

4. To determine the origin of a trace in a result file that includes multiple input files, 
right-click the Chromatograms view and choose Display Options > Show Legend. 

5. To decrease or increase the number of legends displayed, right-click the Chromatograms 
view and choose Display Options > Legend Size > #Rows, where # is an integer value 
from 1 to 10 (Figure 84).

Table 78. Workflow nodes that generate specialized traces

Workflow node Generates any of these trace

Create Mass Trace An extracted ion (mass range) chromatogram (XIC), a 
base peak chromatogram (BPC), or a total ion 
chromatogram (TIC)

Create Analog Trace A UV-Vis trace from a UV-Vis or PDA detector, up to 
three traces from a PDA detector, or an analog trace from 
an LC detector that you connected to one of the analog 
input channels of a Thermo Scientific mass spectrometer

 Create Pattern Trace A TIC trace of the summed intensities of the mass 
spectral peaks (across the entire scan) that match the 
user-defined isotope pattern

Create FISh Trace • A summed FISh trace of all the matching fragment 
ion scans [data-dependent acquisition (DDA) or data 
independent acquisition (DIA)] when you select True 
in the Summed Trace list. 

• An individual FISh trace for each fragment ion when 
you select True in the Individual Traces list. To view 
the individual trace for each fragment ion, see the 
FISh Trace Fragments table.

Tip  By default, the Filled Gaps table is hidden. To display this table, open the 
Select Visible Tables dialog box, select the Filled Gaps check box, and click OK. 
For more information, see “Filled Gaps Table” on page 411.
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In Figure 84, the vertical red line indicates the peak apex of an integrated 
chromatographic peak. The triangle below the retention time label indicates the 
corresponding data point in the XIC trace.

Figure 84. Chromatograms view showing the shortcut menu

When the number of legend lines becomes too large for the available display space, the 
application displays an empty view with the following text: 

Not enough space for drawing the chart properly.

Adding a Chromatogram Plot

 To add a plot to the Chromatograms view

1. Open a result file that contains chromatographic data.

2. Right-click the Chromatograms view and choose Plots > Add Plot.

The new plot appears below the original plot. Only the screen size of your computer 
monitor limits the maximum number of plots that you can add to the Chromatograms 
view. When you exceed the maximum number of plots, the plots disappear from the view.

In a Chromatograms view with more than one plot, a light blue bar on the left border 
highlights the active plot (Figure 85). If you right-click the Chromatograms view and 
choose Plots > Remove Plot, the application removes the active plot.

Red line indicating the 
apex of the integrated 
chromatographic peak

Triangle indicating the data 
point that corresponds to the 
retention time label
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Figure 85. Chromatograms view with two plots

Overlaying Chromatogram Plots

 To overlay multiple chromatograms in one chromatogram plot

1. Open a result file that contains chromatographic data.

2. Do one of the following:

• Hold down the SHIFT key and select a range of contiguous rows.

• Hold down the CTRL key and select contiguous or noncontiguous rows one by one.

• Hold down the SHIFT key and press the Down Arrow on the keyboard.

Light blue bar on 
the left border of 
the active plot

Plots shortcut menu

Tip  Take care to avoid clicking an editable column in the result table, as doing so 
undoes the row selection and sets the focus to the table cell.
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Changing the Grouping in the Collapsible Pane

 To change the grouping of the chromatogram traces

1. Open the collapsible left pane by clicking the icon, .

2. Under Group By, select or clear one or more of the check boxes.

3. To display all of the study file traces in different colors, clear all of the check boxes under 
Group By, or under Group By, select only the Samples check box.

Hiding the Traces for a Study Variable Value

 To hide the chromatogram trace or traces for a study variable value

Under Filter By, clear the check box for the study variable value.

Updating All the Chromatogram Plots Simultaneously

 To update all the plots in the Chromatograms view simultaneously

1. Open a result file that contains chromatographic data.

2. Add two or more plots to the Chromatograms view.

3. Right-click the view and choose Plots > Distribute to All Selections.

As you select different table rows, all of the plots update. When Distribute to All 
Selections is not enabled, only the active plot updates.

Manually Integrating Chromatographic Peaks

 To manually integrate chromatographic peaks

1. Open a result file that contains specialized traces.

2. In the Specialized Traces table, select the trace of interest.

3. Right-click the Chromatograms view and choose Manual Peak Integration.

Two red dashed lines appear and the integrated peak area appears in blue.

4. Drag one line to the beginning of the chromatographic peak and the other line to the end 
of the chromatographic peak.

The integrated peak area changes as you move the start and end points of the 
chromatographic peak.

Note  These workflow nodes generate specialized traces: Create Mass Trace, Create 
Analog Trace, Create Pattern Trace, and Create FISh Trace.
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5. Place the cross-hair cursor on the peak.

A pop-up box appears with the selected retention time range and the Apply and Cancel 
buttons (Figure 86).

Figure 86. Manually integrated chromatographic peak

6. To add the manual peak to the Manual Peaks table, either click Apply, or on the 
keyboard, press A.

If the result file did not already contain a Manual Peaks table, the new table appears in the 
main table tab set. The Manual Peaks table contains a row for the new manual peak.

Chromatograms View Shortcut Menu Commands

Table 79 describes the shortcut menu commands for the Chromatograms view.

Table 79. Shortcut menu commands for the Chromatograms view (Sheet 1 of 4) 

Command Description

Note  The default zoom settings are as follows: 

• X-axis Zoom > To Detected Peaks (Active Plot)

• Y-axis Zoom > Auto Scale Y-axis

Undo Last Zoom/Pan Undoes the last zoom or pan movement.

Undo All Zoom/Pan Zooms out to the full data acquisition time for the chromatogram 
on the x axis and the height of the largest chromatographic peak 
on the y axis.
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X-axis Zoom > Keep 
Zoom

Maintains the same x-axis zoom range as you select different table 
rows. Overrides the Zoom to Detected Peaks command.

X-axis Zoom > Full 
Range

Displays the full data acquisition time for the chromatogram. 

X-axis Zoom > To 
Detected Peaks (Active 
Plot)

Zooms the x axis to the detected peaks for the selected table rows.

X-axis Zoom > To 
Detected Peaks (All 
Plots)

Zooms the x axis to display the detected peaks in all of the plots.

Y-axis Zoom > Auto 
Scale Y-Axis

Default selection—Scales the y axis to the maximum intensity 
within the current x-axis (retention time) zoom range.

Manual zooming of the y axis is unavailable in this mode.

Y-axis Zoom > Manual 
(Synchronize All Plots)

Scales the y axes of all the plots to the same scale. Manual zooming 
on both axes is available.

To reset the y-axis scaling, choose Y-axis Zoom > Auto Scale 
Y-Axis, and then choose Undo All Pan/Zoom.

Y-axis Zoom > Manual 
(Each Plot Individual)

Only changes the y-axis scaling of the current plot. Manual 
zooming on both axes is available.

Copy > Image Copies an image of the Chromatograms view (including the 
legend) to the Clipboard.

You can paste the image into a Microsoft Office document as a 
raster image or into a vector-drawing program as a vector image.

Copy > Points Copies the data as a two-column list of data points and copies the 
scan header. The first column lists the retention time and the 
second column lists either the relative intensity or the counts. 

Export > Image As Opens the Save As dialog box where you can specify a file name 
and save the contents of the Chromatograms view as one of these 
selectable image formats: EMF, PNG, GIF, JPG, TIFF, or BMP. 
The EMF format is a vector image. 

Table 79. Shortcut menu commands for the Chromatograms view (Sheet 2 of 4) 

Command Description
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Exports > Points As Opens the Save As dialog box where you can specify a file name 
and save the contents of the Chromatograms view as a text file. 
The default file name is Chart.txt. 

When the chromatogram is a plot of relative intensity versus 
retention time, the application saves the data points as a 
two-column list. The first column lists the retention time and the 
second column lists the relative intensity (%). When the 
chromatogram is a plot of area (in counts) versus retention time, 
the second column lists the area for the peaks.

Plots > Add Plot Adds an empty, active plot to the Chromatograms view. Only the 
screen size limits the maximum number of displayed plots. When 
you reach the screen’s limit, the Chromatograms view appears to 
be empty and the following message appears:

Not enough space for drawing chart properly.

Plots > Remove Plot Removes the active plot, which has a gray border.

Adding more than one plot activates this command.

Plots > Remove Other 
Plots

Removes all of the plots in the Chromatograms view.

Adding more than one plot to the Chromatograms view activates 
this command.

Plots > Freeze Content Keeps the chromatogram of the currently selected row in the view 
when you select another row (in the current table or another result 
table). The application uses dashes to distinguish the frozen 
chromatogram trace. 

Plots > Clear Frozen 
Content

Clears the frozen chromatogram from the view.

Table 79. Shortcut menu commands for the Chromatograms view (Sheet 3 of 4) 

Command Description

Frozen peak with dashes
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Plots > Distribute 
Selection to All

Updates all of the plots simultaneously as you select different table 
rows. When Plots > Distribute Selection to All is not enabled, 
only the active plot updates.

Display Options > 
Show Tooltips

Displays a pop-up box with the following information, from top 
to bottom, when you place the cursor, +, over a chromatographic 
peak:

• Parent compound and any applicable transformations
• Chemical formula of the peak component
• Molecular weight of the peak component
• Selected retention time, in minutes
• Intensity, in counts, of the selected point on the 

chromatogram trace
• File name of the input file

Display Options > 
Show Gridlines

Adds grid lines to the Chromatograms view.

Display Options > 
Show Detected Peaks

Uses a fill color for the integrated area under the detected 
chromatographic peaks.

Turning off this command removes the fill color. 

Tip  To see the peaks underneath the larger peaks in a set of 
overlaid traces, turn off the Show Detected Peaks command.

Display Options > 
Show Legend

Displays a legend for the sample groups at the top of the view. 

Display Options > 
Legend Size

Specifies the number of legend lines that you want the application 
to display.

Selections: 0 to 10

Display Options > 
Relative Intensity

Displays the y-axis scale as relative intensity (0 to 100%). The 
legend changes to Intensity [%].

The default y-axis scale is an absolute scale; the y-axis legend is 
intensity [counts].

Display Options > 
Crop to Detected Peaks

Redraws only the chromatographic peaks of the displayed traces. 
Does not redraw the baseline portions of the traces as you select 
different table rows.

Manual Peak 
Integration

Use to add a manual peak to a specialized trace. Adding a manual 
peak adds the Manual Peaks table to a result file (see “To manually 
integrate chromatographic peaks” on page 299).

Selecting a trace in the Specialized Traces table activates this 
command. 

Table 79. Shortcut menu commands for the Chromatograms view (Sheet 4 of 4) 

Command Description
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Table 80 describes the traces that you can display in the Chromatograms view.

Table 80. Chromatograms view traces

Trace type Description

UV Displays a chromatogram created from the UV signal from a 
UV-Vis detector or the analog channel of a PDA detector.

Analog Displays a trace of response versus time. 

Raw data files can contain analog data from a device that is 
hard-wired to the analog channels of a Thermo Scientific mass 
spectrometer.

PDA total scan Displays a chromatogram of the total absorbance for the entire 
scan wavelength range for each time point.

PDA spectrum 
maximum

Displays a chromatogram of the highest absorbance reading in the 
wavelength range for each time point.

PDA wavelength range Displays a chromatogram of the total absorbance for the specified 
wavelength range for each time point. 

Base peak 
chromatogram (BPC)

Displays a chromatogram of the most intense mass spectral peak 
in the specified mass range for each time point.

Total ion 
chromatogram (TIC)

Displays a chromatogram of the total intensity from all the mass 
spectral peaks in the specified mass range for each time point.

Extracted ion 
chromatogram (XIC)

Displays an XIC trace, which is a mass range trace, when you 
select a row in any of these tables: Merged Features, Expected 
Compounds, Expected Compounds per File, Expected 
Compound Features, Compounds, Compounds per File, 
Unknown Compound Features, FISh Trace Fragments, or 
Specialized Traces.

The XIC trace is made up of the mass spectral peaks that match 
the specified mass value within the specified mass tolerance.

Pattern trace Displays a TIC trace of the summed intensities of the mass 
spectral peaks that match a specified pattern for each time point. 

FISh trace Displays a TIC trace of the summed intensities of the mass 
spectral peaks in a fragmentation scan (MS/MS or MS3) that 
match the predicted fragments of the selected library compound 
and its transformation products for each time point.
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Working with the Mass Spectrum View
The Mass Spectrum view displays the spectral tree of a selected component in the result table 
and the mass spectrum of the selected scan in the spectral tree.

See these topics:

• Displaying a Mass Spectrum

• Changing the Zoom Level of the Mass Spectrum View

• Viewing Fragment Structures for Expected Compounds

• Creating a Mirror Plot

• Searching the mzCloud Library for a Matching Fragmentation Spectrum

• Spectral Tree Pane of the Mass Spectrum View

• Isotope Pattern Matching for Compounds with Formulas

• Mass Spectrum View Shortcut Menu Commands

Displaying a Mass Spectrum

 To display a specific mass spectrum

1. Open a result file.

2. If the Mass Spectrum view is closed, choose View > Mass Spectrum from the menu bar.

3. Do any of the following:

a. Select a row in any of these result tables.

The Mass Spectrum view displays the matching spectral tree and a zoomed-in view of 
the full MS scan.

b. Select the scan of interest from the spectral tree.

• Compounds Table • Features Table

• Compounds per File Table • Expected Features Table

• Expected Compounds Table • mzCloud Results Table

• Expected Compounds per File Table • Structure Proposals Table
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Changing the Zoom Level of the Mass Spectrum View

In the Mass Spectrum view for a result file, you can independently zoom in or out on the x or 
y axis by dragging the cursor horizontally or vertically, respectively, or you can zoom in or out 
of a rectangular section of the plot.

Viewing Fragment Structures for Expected Compounds

 To review the matching fragment structures predicted by the FISh Scoring node for 
expected compounds 

1. Open a result file that was generated by a processing workflow that included the FISh 
Scoring node.

2. Select a compound in the Expected Compounds table.

3. (Optional) Enlarge the Mass Spectrum view. 

4. In the spectral tree, select an MS2 or higher scan. 

5. Review the color-coded mass spectral peaks, the theoretical fragment structures, and the 
transformations for the shifted mass spectral peaks.

Table 81. Working with the zoom level in the Mass Spectrum view

Task Action

Zoom in on the x axis. Drag the cursor to the right over the 
m/z range of interest.

 Zoom out on the x axis. Drag the cursor horizontally to the left over 
the m/z range of interest.

Zoom in on the y axis. Drag the cursor vertically down the y axis.

Zoom out on the y axis. Drag the cursor vertically up the y axis.

Zoom in on a section of the plot. Drag the cursor diagonally across the section.

Undo the last zoom-in action. Right-click the plot and choose Zoom Out.

Change the zoom level to the full m/z range 
on the x axis and the full response range on 
the y axis.

Right-click the plot and choose Undo All 
Zoom/Pan.
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The FISh Scoring Node annotates centroids that match the m/z value of a theoretical 
fragment ion with its theoretical structure and color-codes the centroids in a 
fragmentation scan as follows.

Figure 87 shows an annotated fragmentation spectrum.

Figure 87. Fragmentation spectrum with FISh annotations

Creating a Mirror Plot

Create a mirror plot to compare an experimental spectrum to a reference spectrum.

 To create a mirror plot of two fragmentation scans

1. Open a result file with fragmentation scans.

2. If the Mass Spectrum view is closed, choose View > Mass Spectrum from the menu bar.

3. In the spectral tree pane, select a reference scan.

4. Right-click the Mass Spectrum view and turn off the Show Library Spectra as Reference 
command if it is enabled.

5. Right-click the Mass Spectrum view and choose Use As Reference.

Color Meaning

( ) Green Direct match—Matches the m/z value of a theoretical fragment ion.

( ) Blue Shifted match—Matches the m/z value of a theoretical fragment ion 
with at least one transformation applied. 

Note  The Use As Reference command is unavailable when the Show Library Spectra 
As Reference command is enabled.
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6. Select the fragmentation scan that you want to compare.

The reference scan appears on the bottom and the comparison scan appears on the top.

7. To remove the reference scan from the plot, right-click the Mass Spectrum view and 
choose Clear Reference.

Searching the mzCloud Library for a Matching Fragmentation Spectrum

 To manually search the mzCloud database for a matching fragmentation spectrum

1. Open a result file with data-dependent fragmentation data.

2. In the spectral tree pane of the Mass Spectrum view, select a fragmentation scan.

3. Right-click the spectrum plot and choose Submit To mzCloud.

The online mzCloud application opens to the Select Spectrum dialog box and displays 
the selected query spectrum.

4. Check the settings and click OK.

Spectral Tree Pane of the Mass Spectrum View

The collapsible pane on the left of the Mass Spectrum view contains a spectral tree with the 
high-resolution scans for preferred ions that elute within the following retention time 
window:

• Peak apex (RT) ± the peak’s full width at half maximum (FWHM)

–or–

• From the start time to the end time for the chromatographic peak as defined by the peak 
detection algorithm

For MS1 scans, the tree lists the scan number, the retention time at the apex of the 
chromatographic peak, the mass analyzer, and the scan polarity.

For MSn scans, the tree lists the scan number, the retention time at the apex of the 
chromatographic peak, the mass analyzer, the scan polarity, and the fragmentation 
information, including the scan power, collision cell type, and the fragmentation type 
[data-dependent acquisition (DDA) or data-independent acquisition (DIA)].

Note  The mzCloud database is only compatible with the Internet Explorer™ web 
browser. To access the mzCloud spectral database from the Compound Discoverer 
application, set Internet Explorer as your default Internet browser.



 9 Working with the Graphical Result Views
Working with the Mass Spectrum View

Thermo Scientific Compound Discoverer User Guide 309

Isotope Pattern Matching for Compounds with Formulas

Selecting a row in the following result tables populates the Mass Spectrum view with a spectral 
tree for the selected retention time in the left pane and the first MS1 scan for the selected 
retention time in the right pane. 

• Expected Compounds

• Expected Compounds per File

• Expected Features

• Compounds

The MS1 scan shows the isotope pattern fit for the detected compound. Colored rectangles 
highlight the mass spectral peaks (centroids) that match the theoretical isotope pattern. These 
rectangles have a minimum display width to ensure that they are still visible when you zoom 
out or use the Undo All Zoom/Pan shortcut menu command. 

Figure 88. MS1 scan with color-coded mass spectrum peaks and the shortcut menu 

Note  The isotope pattern fit algorithm is “resolution aware”; that is, in addition to the list 
of elemental compositions provided by the Generate Expected Compounds node, it uses 
the resolution information provided with the scan data to perform an isotope pattern fit 
and calculate a spectral distance score. 

If the resolution information is unavailable, it uses the setting for the Unrecognized MS 
Resolution parameter in the Select Spectra node.
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Table 82 describes the color coding for the centroids in an MS1 spectrum.

Mass Spectrum View Shortcut Menu Commands

Table 83 describes the shortcut (right-click) menu commands for the Mass Spectrum view 
(Figure 88 on page 309).

Table 82. Color coding for the centroids in an MS1 spectrum for an expected compound (per file)

Color Meaning 

( ) Lavender The labeled centroid matches the monoisotopic mass of the expected 
compound ion.

( ) Green The labeled centroid matches the delta mass and the relative intensity of 
the theoretical isotope pattern within the specified tolerances.

( ) Red The expected centroid for this m/z value is missing or its intensity does not 
fall within the tolerance range for the theoretical isotope pattern.

( ) Light blue The expected centroid for this m/z value might be missing because its 
theoretical intensity is at the level of the baseline noise.

Table 83. Mass Spectrum view shortcut menu commands (Sheet 1 of 2)

Command Description

Show Position Tooltips Displays the m/z value and intensity of the mass spectrum peaks 
as you point to them.

Zoom Out Zooms out to the full scan range.

Undo All Zoom/Pan Zooms out to the full scan range.

Copy > Image Copies the mass spectrum as a bitmap (raster) image to the 
Clipboard.

Copy > Points Copies the data points and the scan header for the selected scan 
to the Clipboard. Also copies all text annotations, such as the 
FISh fragment annotations and the adduct information. 

Use this command to copy the FISh annotations to the 
Clipboard.

Copy > Raw Points Copies the data points for the selected scan to the Clipboard.

Use this command to copy points to a library search application.

Export > Image As Opens the Save As dialog box, where you can type a name and 
select a file type for the current scan. The available file types are 
BMP, EMT, GIF, JPG, PNG, and TIF.

Export > Points As Opens the Save As dialog box, where you can type a name and 
select a file type for the current scan. The available file type is 
TXT. 
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Working with the Result Charts
Use the Result Charts view to plot the data in a result table as a scatter plot, histogram, bar 
chart, or pie chart.

Follow these topics as needed:

• Opening the Result Charts View

• Using the Copy, Export, and Zoom Commands for a Result Charts View

• Displaying and Pinning the Options Pane for the Result Charts View

• Plotting the Data as a Histogram Chart

Submit to mzCloud Opens the Spectrum Search dialog box for the mzCloud database 
where you can submit a search for the selected fragmentation 
scan.

Available for an MS/MS data-dependent scan.

IMPORTANT  The mzCloud web application is only 
compatible with the Internet Explorer™ web browser. 

Tip  To test your computer’s ability to connect to the mzCloud 
database, choose Help > Communication Tests from the 
application toolbar. Click the mzCloud tab, and then click 
Run Tests. 

To set up the mass tolerances for manual searches, choose Help 
> Configuration from the application toolbar. In the left pane, 
select Submit Single Spectrum to mzCloud Options. Edit the 
settings as applicable.

Use As Reference Creates a mirror plot that initially consists of the currently 
selected scan. When you select another scan, the reference scan 
remains in the –y-axis portion of the graph and the new scan 
appears in the +y-axis portion of the graph.

Unavailable when the Show Library Spectra Reference command 
is enabled.

Clear Reference Removes the reference plot from the Mass Spectrum view.

Show Library Spectra as 
Reference

Displays the recalibrated library spectrum from the mzCloud 
database in the bottom portion of the mirror plot.

Available when you select a row in the mzCloud Results table.

Table 83. Mass Spectrum view shortcut menu commands (Sheet 2 of 2)

Command Description
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• Plotting the Data as a Bar Chart

• Plotting the Data as a Pie Chart

Opening the Result Charts View

 To open the Result Charts view

1. Open a result file.

2. In the menu bar, choose View > Result Charts.

By default, the Result Charts view opens as a floating window (Figure 89). You can resize 
the window, drag the window to another screen, or dock the window. 

The Options pane for modifying the appearance of a chart view is a collapsible pane to 
the left of each chart.

Figure 89. Result Charts view with the collapsed (unpinned) Options pane at the left

Related Topics

• Opening, Closing, and Updating Result Files

• Rearranging the Tabbed Documents and Graphical Views

Using the Copy, Export, and Zoom Commands for a Result Charts View

 To access and use the shortcut menu commands for a Result Charts page

1. On the selected page of the Result Charts view, select the variables that you want to plot.

2. Click Refresh to plot the data.

3. Right-click the chart and choose one of the commands listed in Table 84.
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Displaying and Pinning the Options Pane for the Result Charts View

The Options pane of the Result Charts view contains the formatting options for the grid 
lines, fonts, and so on.

 To display and pin the Options pane

1. Point to the vertical Options tab on the left. 

2. To keep the pane open, click the pin icon, , in the upper right corner of the Options 
pane.

Plotting the Data as a Histogram Chart

Use the Histogram Chart page of the Result Charts view to plot the frequency distribution of 
a variable (result table column). You can display the data as a column chart, a bar chart, a line, 
or a stepped line chart.

 To display the data as a histogram

1. Open a result file.

2. Choose View > Result Charts.

Table 84. Common shortcut menu commands for the Result Chart viewsa

a The shortcut menu for the Scatter Chart view has additional commands.

Command Availability Function

Undo All Pan/Zoom Scatter Chart, Histogram 
Chart, and Bar Chart

Undoes all panning and zooming. 
Returns the view to the default 
magnification.

Zoom Out Scatter Chart, Histogram 
Chart, and Bar Chart

Undoes the last zoom-in action.

Copy > Image All Copies a raster image of the plot to 
the Clipboard.

Copy > Data All Copies a list of the data points to the 
Clipboard.

Export > Image As All Saves the plot in the selected file 
format. 

File types: EMF, PNG, GIF, JPG, 
TIF, and BMP

Export > Data As All Exports a list of data points to a text 
file.
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3. Click the Histograms Chart tab.

4. From the Data Source list, select the variable (result table column) that you want to plot.

5. Click Refresh.

6. (Optional) To change the appearance of the histogram, do the following:

a. Open the Options pane.

b. Modify the settings for the colors, labels, and legends of the display, as necessary. 

–or–

Click Load to load the settings that you most recently saved.

c. To save the settings, click Save in the Options pane.

The new settings overwrite any previously saved settings. The application loads these 
new settings when you click Load.

d. To return the settings to the original default settings, in the Options pane, click 
Factory Defaults.

Table 85 describes the parameters for the Histogram Chart page.

Table 85. Histogram Chart parameters  (Sheet 1 of 6)

Parameters Description 

Data Source Specifies the source of the data that you want to plot. The 
available data sources are the result table columns in the result file.

Refresh Refreshes the display with data points from the selected data 
source.

Options pane commands

Load Loads the Option pane settings that you saved with the Save 
command.

Save Saves the settings that you selected in the Options pane.

Factory Defaults Resets the settings of the options in the Options pane to the 
defaults in effect when you installed the application.
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1. Chart Options

Chart Type Determines how the application plots the data.

• (Default) Column: Displays the data as columns extending 
from bottom to top.

• Bar: Displays the data as bars extending from left to right.

• Line: Displays the data as a line. Reported and excluded items 
are not stacked as they are in column and bar types.

• StepLine: Displays the data as a line drawn in a series of 
90-degree angles.

Show Cumulative Determines whether the application displays a cumulative 
histogram, which can be useful if you want to compare 
distribution curves. For these charts, the application calculates the 
column height as the height of the current column plus the sum 
of all previous columns. The rightmost column height is therefore 
the total count or 100%, depending on the y-axis settings. 

• (Default) True: displays a cumulative histogram.

• False: Displays a non-cumulative histogram.

Horizontal Grid Lines Determines whether the histogram displays horizontal grid lines 
and specifies the style of these lines.

• (Default) None: Displays no horizontal grid lines on the 
histogram.

• Solid: Displays solid horizontal grid lines on the histogram.

• Dotted: Displays dotted horizontal grid lines on the 
histogram.

Vertical Grid Lines Determines whether the histogram displays vertical grid lines and 
specifies the style of these lines.

• (Default) None: Displays no vertical grid lines on the 
histogram.

• Solid: Displays solid vertical grid lines on the histogram.

• Dotted: Displays dotted vertical grid lines on the histogram.

Table 85. Histogram Chart parameters  (Sheet 2 of 6)

Parameters Description 
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2. Column Options

Show Column Amount Determines whether the chart displays the amount or count of 
items.

• True: Displays the amount or count of items in the chart.

• (Default) False: Does not the display the amount or count of 
items in the chart.

Show Percentages Determines whether percentage values appear above the columns 
or to the right of the bars.

• True: Displays percentage values above the columns or to the 
right of the bars.

• (Default) False: Does not display percentage values above the 
columns or to the right of the bars.

Column Display Specifies the appearance of the columns or bars.

• (Default) Flat: Displays the columns or bars as flat rectangles.

• Cylinder: Displays the columns or bars as cylinders.

• Embross: Displays the columns or bars as three-dimensional 
rectangles.

• LightToDark: Displays the columns or bars as shaded 
rectangles.

Column Width Specifies the relative width of the columns as a fraction between 0 
and 1.

Default: 0.8

Column Label Font Specifies the font of the column labels that appear on top of the 
bars in the histogram. These labels are visible if you set Show 
Column Amount to True. 

Default: 8-point Arial

3. Axis Options

X-Axis Number Format Specifies the notation of the numbers used for the x axis.

• (Default) Decimal: Uses decimal notation.

• Scientific: Uses scientific notation.

Table 85. Histogram Chart parameters  (Sheet 3 of 6)

Parameters Description 
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X-Axis Title Specifies the label for the x axis. 

The default x-axis title is the category selected from the Data 
Source list. 

Y-Axis Type Specifies the axis type (scale) of the y axis.

• (Default) Linear: Plots the data on a linear scale.

• Log: Plots the data on a logarithmic scale.

• Percent: Plots the data as a percentage of the number of items.

Y-Axis Title Specifies the label for the y axis. The default y-axis title is Count.

Reduce Number of 
Axis Labels

Determines whether the application increases readability by 
reducing the maximum number of axis labels to 30. If the chart 
includes more than 30 values, it displays only every second or 
every third label.

• (Default) True: Reduces the maximum number of axis labels 
to 30.

• False: Does not reduce the maximum number of axis labels to 
30.

Axis Title Font Specifies the font used to denote the labels of the x and y axes. 

Default: 12-point Arial

Axis Scale Font Specifies the font used to denote the scale of the x and y axes. 

Default: 10-point Arial

4. Binning Options

Binning Method Specifies the number of data groups to display or the width of a 
single data group. 

• (Default) Auto: Groups the data by estimating the number of 
columns needed to display the number of data items.

• FixedWidth: Groups the data according to the Width value.

• FixedNumber: Groups the data according to the Number of 
Categories value.

Number of Bins Specifies the number of categories used to group the data. 

Default: 20

Note  For discrete numbers, the actual group number might be 
different.

Table 85. Histogram Chart parameters  (Sheet 4 of 6)

Parameters Description 
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Bin Width Specifies the width of a single category used to group the data. 

Default: 1

Note  For discrete numbers, the actual group number might be 
different.

Use Full Series Value 
Range

Determines the range of data values that the application uses to 
compile the histogram.

• (Default) True: Uses all data for the histogram.

• False: Uses only the data between the values specified by the 
Minimum Value option and the Maximum Value option.

Minimum Value Specifies the minimum value of the displayed data range. When 
you use this parameter and the Maximum Value parameter, set 
Use Full Data Range to False. Use these two parameters when you 
want to show only a subrange of the data in a histogram.

Maximum Value Specifies the maximum value of the displayed data range. When 
you use this option and the Minimum Value option, set the Use 
Full Data Range parameter to False.

5. Legend Options

Show Legend Determines whether a legend appears and where it appears.

• (Default) None: Does not display a legend.

• Top: Displays a legend at the top of the histogram.

• Left: Displays a legend to the left of the histogram.

• Bottom: Displays a legend at the bottom of the histogram.

• Right: Displays a legend to the right of the histogram.

Legend Font Specifies the font for the legend.

Default: 8-point Arial

Table 85. Histogram Chart parameters  (Sheet 5 of 6)

Parameters Description 
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Related Topics

• Displaying and Pinning the Options Pane for the Result Charts View

Plotting the Data as a Bar Chart

Bar charts plot categorical and ordinal data types in columns with the count of the data types 
as the column height. 

The Data Source list contains the numerical data categories that are available for the bar chart. 
The Options pane contains the different options that you can use to customize the bar chart. 
Moving the cursor over the columns in the chart activates a tooltip with information about 
the data category.

 To display the data as a bar chart

1. In an open result file, choose View > Result Charts.

2. Click the Bar Charts tab in the Result Charts view.

3. From the Data Source list, select the type of data to display as a bar chart.

4. Click Refresh to draw the chart.

5. (Optional) To change the chart’s appearance, do the following:

a. Open the Options pane and adjust the colors, labels, and legends of the display. Or, 
click Load to load the option settings that you most recently saved.

b. To save all the settings, click Save in the Options pane.

The new settings overwrite any previously saved settings. The application loads these 
new settings when you click Load.

6. Series Options

Show Only Checked 
Items

Determines whether the chart is compiled from data in all result 
rows or only data in result rows marked by check marks.

• True: Compiles the chart only from data in result rows 
marked by check marks.

• (Default) False: Compiles the chart from data in all result 
rows.

Target Series Color Specifies the color of the target series. 

Default: Firebrick

Table 85. Histogram Chart parameters  (Sheet 6 of 6)

Parameters Description 
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c. To return the Options pane settings to the original default settings, in the Options 
pane, click Factory Defaults.

Table 86 describes the parameters on the Bar Chart page of the Result Charts view.

Table 86. Bar Chart parameters (Sheet 1 of 3)

Command or option Description 

Options pane

Load Loads the Option pane settings that you saved with the Save 
command.

Save Saves the settings that you selected in the Options pane.

Factory Defaults Resets the options in the Options pane to the default settings in 
effect when you installed the application.

Chart Options

Chart Type Determines how the application plots the data.

• (Default) Column: Displays the data as columns extending 
from bottom to top.

• Bar: Displays the data as bars extending from left to right.

Horizontal Grid Lines Determines whether the bar chart displays horizontal grid lines 
and specifies the style of these lines.

• (Default) None: Displays no horizontal grid lines in the bar 
chart.

• Solid: Displays solid horizontal grid lines in the bar chart.

• Dotted: Displays dotted horizontal grid lines in the bar chart.

Axis Options

X-Axis Title Specifies the label for the x axis. The default x-axis title is the 
category selected from the Data Source list.

Y-Axis Title Specifies the label for the y axis. The default y-axis title is Count.

Y-Axis Type Specifies the axis type (scale) of the y axis.

• (Default) Linear: Plots the data on a linear scale.

• Log: Plots the data on a logarithmic scale.

• Percent: Plots the data as a percentage of the number of items.

Axis Title Font Specifies the font used to denote the labels of the x and y axes. 

Default: 12-point Arial
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Axis Scale Font Specifies the font used to denote the scale of the x and y axes. 

Default: 10-point Arial

Bar Options

Show Rotated Scale Determines whether the scale labels along the x axis are slightly 
rotated to the right.

• (Default) True: Rotates the scale labels.

• False: Does not rotate the scale labels.

X-Axis Scale Angle Specifies the angle between the label and the x axis for the labels 
when the Show Rotated Labels parameter is set to True.

Range: –90 to 90 degrees

Default: 30

Bar Display Specifies the appearance of the columns or bars.

• (Default) Flat: Displays the columns or bars as flat rectangles.

• Cylinder: Displays the columns or bars as cylinders.

• Embross: Displays the columns or bars as three-dimensional 
rectangles.

• LightToDark: Displays the columns or bars as shaded 
rectangles.

Bar Width Specifies the relative width of the columns. 

Range: 0.1–1.0

Default: 0.8 

Show Amount Determines whether the amount, or count of items, is displayed in 
the chart.

• True: Displays the amount or count of items in the chart.

• (Default) False: Does not the display the amount or count of 
items in the chart.

Table 86. Bar Chart parameters (Sheet 2 of 3)

Command or option Description 
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Show Percentage Determines whether percentage values are displayed above the 
columns or to the right of the bars.

• True: Displays percentage values above the columns or to the 
right of the bars.

• (Default) False: Does not display percentage values above the 
columns or to the right of the bars.

Column Label Specifies the font of the column labels that appear on top of the 
bars in the bar chart.

Default: 8-point Arial

Legend Options

Show Legend Determines whether a legend appears and where it appears.

• (Default) None: Does not display a legend.

• Top: Displays a legend at the top of the bar chart.

• Left: Displays a legend to the left of the bar chart.

• Bottom: Displays a legend at the bottom of the bar chart.

• Right: Displays a legend to the right of the bar chart.

Legend Font Specifies the legend font. 

Default: 8-point Arial

Series Options

Show Only Checked 
Items

Determines whether the chart is compiled from data in all result 
rows or only data in result rows marked by check marks.

• True: Compiles the chart only from data in result rows 
marked by check marks.

• (Default) False: Compiles the chart from data in all result 
rows.

Series Color Specifies the color of the bars.

Default: CornflowerBlue

Data Source Displays the result category used to plot the data.

Table 86. Bar Chart parameters (Sheet 3 of 3)

Command or option Description 
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Plotting the Data as a Pie Chart

The Pie Chart page shows several categories of data as a solid circle composed of slices (a pie) 
or as a ring (a doughnut). You can use a pie chart or a doughnut chart to indicate the relative 
size of quantities of data. 

 To display the data as a pie chart

1. With an active result file, choose View > Result Charts from the menu bar.

2. Click the Pie Chart tab in the Result Charts view.

3. From the Data Source list, select the type of data to display.

4. Click Refresh to draw the chart.

5. (Optional) To change the chart’s appearance, do the following:

a. Open the Options pane and adjust the colors, labels, and legends of the display and 
specify how the chart displays small slices. Or, click Load to load the option settings 
that you most recently saved.

b. To save all the settings, click Save in the Options pane.

The new settings overwrite any previously saved settings. The application loads these 
new settings when you click Load.

When you close the Result Charts view, the application stores the chart settings that 
you selected. When you reopen the chart, it displays these stored settings if they are 
available.

c. To return the Options pane settings to the original default settings, in the Options 
pane, click Factory Defaults.

Table 87 describes the parameters on the Pie Chart page of the Result Charts view.

Tip  By default, the application consolidates small slices of 5% or less. To change 
this setting, do one of the following: 

• Select False for Collect Small Segments.

–or–

• Change the Small Slice Threshold (%) setting.

Table 87. Pie Chart page parameters (Sheet 1 of 4)

Command or Option Description 

Options pane

Load Loads the Option pane settings that you saved with the Save 
command.

Save Saves the settings that you selected in the Options pane.
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Factory Defaults Resets the options in the Options pane to the default settings in 
effect when you installed the application.

Chart Options

Chart Type Specifies the type of chart to display:

• (Default) Pie: Displays the chart as a solid circle composed of 
slices.

• Doughnut: Displays the chart as a ring.

Vertical Rotation Specifies the angle of rotation around the vertical axis.

Default: 0

Angle of First Slice Specifies the location of the first chart slice.

Default: 0

Pie Slice Options

Show Type Name with 
Value

Determines whether the application displays the name of the data 
group next to the value.

• True: Displays the name of the data group next to the value.

• (Default) False: Does not display the name of the data group 
next to the value.

Show Slice Amount Determines whether the application displays the amount of each 
slice.

• (Default) True: Displays the amount of each slice.

• False: Does not display the amount of each slice.

Show Slice Percentage Determines whether the application displays the percentage of 
each slice.

• (Default) True: Displays the percentage of each slice.

• False: Does not display the percentage of each slice.

Label Style Specifies the label style of the chart segments. 

• Disabled: Does not display a label.

• (Default) Inside: Displays the label on top of the chart 
segment.

• Outside: Displays the label outside the chart segment.

Table 87. Pie Chart page parameters (Sheet 2 of 4)

Command or Option Description 
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Labels Font Specifies the font of the data set labels.

Default: 9-point Microsoft Trebuchet bold

Small Slices Options

Collect Small Segments Determines whether the application consolidates small segments 
together into a single slice.

• (Default) True: Consolidates small segments into a single 
slice.

• False: Leaves small segments as is.

Small Slice Threshold 
(%)

Specifies a percentage threshold for the slices to be consolidated 
into a single slice. 

Default: 5%

Small Slice Collection 
Label

Specifies the label for the pie segment composed of consolidated 
segments.

Default: Other

Small Slice Collection 
Color

Specifies the color of the pie segment composed of consolidated 
segments.

Default: Gray

Show as Supplemental 
Pie

Determines whether to display small segments as a supplemental 
pie chart.

• True: Displays small segments as a supplemental pie chart.

• (Default) False: Leaves small segments as is.

Table 87. Pie Chart page parameters (Sheet 3 of 4)

Command or Option Description 
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Working with a Scatter Plot
Use the Scatter Chart page to set up a scatter plot for visualizing whether there is a linear or 
logarithmic relationship between two or three variables (columns) in a result table. 

To plot the data as a scatter chart, follow these topics as needed:

• Setting Up a Scatter Plot

• Using a Filter Set to Filter the Scatter Plot

• Customizing the Appearance of a Scatter Plot

• Customization Options for a Scatter Plot

• Scatter Chart Parameters

• Scatter Chart Shortcut Menu Commands

Related Topics

• Working with the Result Charts

Supplemental Pie Size Specifies the size of the supplemental pie chart relative to the 
original pie chart.

• Largest: Displays the supplemental pie chart as much larger 
than the original pie chart.

• Larger: Displays the supplemental pie chart as larger than the 
original pie chart.

• Comparable: Displays the supplemental pie chart as about the 
same size as the original pie chart.

• (Default) Smaller: Displays the supplemental pie chart as 
smaller than the original pie chart.

• Smallest: Displays the supplemental pie chart as much smaller 
than the original pie chart.

Data Source Displays the result category used to plot the data. 

Table 87. Pie Chart page parameters (Sheet 4 of 4)

Command or Option Description 
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Setting Up a Scatter Plot

 To set up a scatter plot

1. Open a result file.

2. In the menu bar, choose View > Result Charts.

By default, the Result Charts view opens as a floating window. 

3. Click the Scatter Chart tab.

4. In the Data Source list, select one of the available result tables.

The available selections depend on the workflow nodes in the processing workflow.

5. Select the variables as follows: 

a. In the X Data list, select the variable that you want to plot against the x axis.

b. In the Y Data list, select the variable that you want to plot against the y axis.

c. To create a three-dimensional scatter plot, select the variable in the Z Data list that 
you want to plot against the z axis. 

Selecting a data value for the z axis adds a color gradient to the plotted data points 
ranging from the lowest to the highest Z data value.

6. Click Refresh.

Depending on your selections, a two- or three-dimensional linear plot of the data points 
appears. With the default appearance settings, the data points appear as blue circles in a 
2D plot and as circles of varying colors in a 3D plot. For a 3D plot, a color legend for the 
lowest to the highest Z data value appears to the right of the scatter chart (Figure 90).
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Figure 90. Three-dimensional scatter chart

Using a Filter Set to Filter the Scatter Plot

 To interactively filter the scatter plot by using the Result Filters view

1. Set up and apply a set of result filters in the Result Filters view.

In the Scatter Chart view, the Refresh button turns orange.

2. Click Refresh to refresh the scatter chart plot.

Customizing the Appearance of a Scatter Plot

In the Options pane, do any of the following:

• To change the scaling, colors, labels, and legends in the display, under Axis Options, make 
the appropriate changes.

The application applies the changes as you make them.

• To change the font size or font type of the axis labels, click the expand icon to the left of 
Axis Scale Font or Axis Title Font. Then, make the appropriate selections or click the 
browse icon to open the Font dialog box where you can make your selections.

A browse icon and a set of font parameters appear.

• To return the option settings to the original default settings, click Factory Defaults.

Related Topics

• Displaying and Pinning the Options Pane for the Result Charts View
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Customization Options for a Scatter Plot

Table 88 describes the formating options for the Scatter Chart page.

Table 88. Options pane for a Scatter Chart

Parameter Description

Buttons

Load Loads the saved Options pane settings. Only click Load to apply a 
set of saved settings; otherwise, the view reverts to the last saved 
set.

Save Saves the new settings.

Tip  The Scatter Chart view automatically updates as you change the settings in the 
Options pane. However, the application does not save the settings until you click Save. If 
you click Load before saving the new settings, the view reverts to the previously saved 
settings.

Factory Defaults Resets the options in the Options pane to the default settings in 
effect when you installed the Compound Discoverer application.

Axis Options

X Axis Type Specifies the axis type (scale) of the x axis: Linear or Logarithmic.

Y Axis Type Specifies the axis type (scale) of the y axis: Linear or Logarithmic.

Z Axis Type Specifies the axis type (scale) of the z axis: Linear or Logarithmic.

Axis Scale Font Specifies the font used to denote the scale of the x and y axes. 

Axis Label Font Specifies the font used for the titles of the x and y axes. 

X-Axis Title Specifies the title of the x axis.

Y-Axis Title Specifies the title of the y axis.

Series Options

Points Specifies the appearance of the points in the scatter chart. Also 
specifies whether to show the points in the scatter chart.

Selected Points Specifies both the appearance of the selected points in the scatter 
chart and whether to show the points in the scatter chart.

Filtered-out Points Specifies the appearance of the filtered-out points in the scatter 
chart and whether to show the points in the scatter chart.

Excluded Points The Compound Discoverer workflow nodes do not generate 
excluded data points.
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Scatter Chart Parameters

Table 89 describes parameters that are visible on the Scatter Chart page. Use these parameters 
to set up the scatter plot.

Scatter Chart Shortcut Menu Commands

Table 89. Scatter Chart parameters

Parameter Description

Data Source Specifies the data source for the plot. The data source is one of the 
available result tables produced by the processing workflow.

Note  The X, Y, and Z Data boxes list the available variables for the selected data source. 
The variables are the available columns in the selected data source (result table).

X Data Specifies the variable to plot against the x axis.

Y Data Specifies the variable to plot against the y axis.

Z Data Specifies the variable to plot against the z axis.

Plot grid Two-dimensional grid where the application plots the data points. 
By default, the plot area has no grid lines. 

To add horizontal and vertical lines to the plot, make the 
appropriate selection under Options in the Options pane.

Axis labels The default axis labels are the selected variable names. 

Color legend When you create a 3D plot, the scatter chart includes a color 
legend for the z-axis color gradient. The numeric value of the 
highest z-axis data point appears above the color legend.

Options panel Use the parameters in this pane to customize the Scatter Chart 
page. For more information, see Table 88.

Buttons

Refresh Refreshes the content of the chart area.

Table 90. Scatter Chart shortcut menu commands (Sheet 1 of 2)

Command Description

Show Position Tooltips Displays a tooltip when you place the cursor over a data point.

Zoom Out Decreases the zoom of both axes.

Undo All Zoom/Pan Displays the full x-axis range of the plot.

Copy > Image Copies the scatter chart plot as a bitmap (raster) image to the 
Clipboard.

Copy > Data Copies the data points for the selected variables to the Clipboard.
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Export > Image As Saves the plot to any of these file types: EMF, PNG, GIF JPG, 
TIF, and BMP

Export > Data As Opens the Save As dialog box where you can save the data as a 
plain text file.

By default, the application saves the file to the last open folder 
and uses the following convention to name the file:

ResultTable_x_XDataSelection_Range_YDataSelection_Range
_z_ZDataSelection_Range_DataPointType.txt

Use the Browse icon to select a different folder.

Exporting data from a scatter plot creates three text files: File 
name Filtered-out Points.txt, File name Points.txt, and File name 
Selected Points.txt.

Select Item for Point Highlights the appropriate row in the result table (selected Data 
Source).

Check Point By default, changes the selected point to a red diamond and 
selects the check box in the Checked column for the selected 
point (row in the selected Data Source result table). You can 
change the appearance of selected points by making the 
appropriate selections in the Series Options > Checked Points 
area of the Options pane. When you save the data to a text file, 
the Selected Points.txt file lists the selected points.

To select a point, right-click the point of interest on the plot and 
choose Check Point.

Uncheck Point Undoes the selection of a selected point. You can change the 
appearance of points by making the appropriate selections in the 
Selected Options > Points area of the Options pane. 

Check All Visible Points Selects all of the visible points in the scatter plot.

Uncheck All Visible 
Points

Undoes the selection of the visible points in the scatter plot.

Table 90. Scatter Chart shortcut menu commands (Sheet 2 of 2)

Command Description
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Working with the Trend Chart View
Use the Trend Chart view to compare the chromatographic peak areas for compounds by 
sample group. 

You define the sample groups by selecting one or more check boxes under Group By in the 
collapsible pane to the left of the chart. In addition, you can change the sort order of each 
sample group and the hierarchy of the sample groups. 

You can use the Trend Chart view to plot the data for a compound (or feature) in these result 
tables: Compounds, Expected Compounds, and Merged Features. For a single compound, the 
chart can plot the data as a trendline plot or a box-and-whisker plot. For two or more 
compounds, the chart displays the data only as a trendline plot, with one trendline for each 
compound.

By default, the trendline plot type plots the median peak area for the selected component on 
the y axis against equally spaced sample groups on the x axis and connects the data points with 
straight lines. Each data point appears as a solid circle with two error bars. The circle 
represents the median (Figure 91). If the group includes a least three data points, the 
application uses the following equation to calculate the standard error of the median and draw 
the error bars:

Figure 91. Trendline display of the data distribution

Note  The trendline plot can plot sample groups that include only one data point; 
however, to plot the error bars for a group, it requires a minimum of two data points. 
With two data points, the circle represents the calculated median and the error bars 
represent the minimum and maximum areas.

The box-and-whisker plot requires a minimum of two data points to plot the box for a 
sample group. It does not plot sample groups that include only one data point. If none of 
the sample groups includes the minimum number of data points, the following text 
appears in the chart area: No results available to plot.

standard error of the median  2 std. dev (x) N =

MedianError bars = standard error 
of the median
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The box-and-whisker chart plots the peak area for a selected component on the y axis as a 
rectangle against equally spaced sample groups on the x axis. The height of the rectangle 
represents the peak areas in the interquartile range (Figure 92). The application uses the 
following equations to calculate the upper and lower whiskers:

Interquartile range (IQR) = Quartile 3 (Q3) – Quartile 1 (Q1)

Upper whisker = Q3 + IQR × 1.5

Lower whisker = Q1 – IQR × 1.5

When the data set contains a small number of data points, the whiskers typically end at the 
highest and lowest data points. If the data set does not include a data point between the top of 
the interquartile range and the calculated value for the upper whisker, the application does not 
draw an upper whisker. If the data set does not include a data point between the bottom of the 
interquartile range and the calculated value for the lower whisker, the application does not 
draw a lower whisker.

Figure 92. Box-and-whisker display of the data distribution

Follow these topics as needed:

• Opening the Trend Chart View

• Defining the Sample Groups to Compare

• Comparing the Peak Areas for a Single Compound by Sample Group

• Changing the Sort Order of the Defined Groups

• Comparing the Peak Areas for Multiple Compounds by Group

• Changing the Hierarchy of the Variables Used for Grouping

• Showing the Error Bars in a Trendline Chart

• Trend Chart View Parameters

Note  To calculate the quartiles, the application uses a method that is similar to the type 6 
method in the R statistical computing software.

Upper whisker

Third quartile

Median

First quartile

Lower whisker

Interquartile 
range
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Opening the Trend Chart View

 To open the Trend Chart view

1. Open the result file of interest.

2. From the menu bar, choose View > Trend Chart.

The Trend Chart view opens as a docked window to the right of the result tables. 

• If the active result table does not contain a consolidated compounds list, the 
following text appears in the graph area: No Results Available to Plot. The 
Compounds, Expected Compounds, and Merged Features tables contain a 
consolidated compounds list. 

• If the active result table contains a consolidated compounds list and you select a row, 
a box-and-whisker plot appears in the graph area with data from the first table row.

Defining the Sample Groups to Compare

 To define the sample groups for a trend chart plot

1. Open the result file of interest, and then open the Trend Chart view.

2. In the left pane, under Group By, select the appropriate check boxes to define the sample 
groups.

Comparing the Peak Areas for a Single Compound by Sample Group

 To compare the peak areas for a single compound by sample group

1. Open a result file, open the Trend Chart view, and define the sample groups that you 
want to compare. 

2. In the Compounds, Expected Compounds, or Merged Features table, select the 
compound (or feature) of interest.

3. Right-click the graph area and choose Show Legend.

The legend displays the sample group colors.

4. In the Plot Type list, select Trendline Chart or Box Whisker Chart.

Depending on the selection, either a trendline plot or a box-and-whisker plot appears in 
the graph area. A tooltip opens when you place the cross-hair cursor anywhere on a box or 
whisker in the box-and-whisker plot or on data point in a trendline plot. 

Figure 93 shows a box-and-whisker plot. Placing the cross-hair cursor on a box or whisker 
opens a tooltip with descriptive statistics.
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Figure 93. Box-and-whisker plot for one compound

Changing the Sort Order of the Defined Groups

In the Trend Chart view, you can display the defined groups from left to right in ascending or 
descending order by chromatographic peak area.

 To change the sort order of the defined groups in the Trend Chart view

In the left pane, under Group By, click the sorting icon, , next to the study variable to 
sort and choose Sort Ascending or Sort Descending.

Changing the sort order changes the order of the groups on the x axis (Figure 94).
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Figure 94. Trend chart with compounds grouped by solvent and sorted in ascending or 
descending order by chromatographic peak area

Comparing the Peak Areas for Multiple Compounds by Group

 To compare the peak areas for multiple compounds by group

1. Open the result file of interest, open the Trend Chart view, and define the sample groups.

2. To select the compounds to plot, press the CTRL key and select rows in the result table 
(Compounds, Expected Compounds, or Merged Features), taking care to avoid clicking 
an editable table cell.

The plot changes to a scaled trendline. The data points represent the group median. The 
legend displays the name (if available), molecular weight, and retention time of each 
selected compound.

Figure 95 shows a scaled trendline chart. To view descriptive statistics for the data points, 
click anywhere in the plot to activate the cross-hair cursor, and then place the cross-hair 
cursor on each data point of interest. 

Sorted in 
descending 
order

Sorted in 
ascending 
order
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Figure 95. Trendline chart with three compounds 

Changing the Hierarchy of the Variables Used for Grouping

Changing the hierarchy of the variables used for grouping in the Trend Chart view modifies 
the sample grouping.

 To change the hierarchy of the variables used for grouping

Use the handle ( ) next to the variable to drag the variable up or down in the list.

Showing the Error Bars in a Trendline Chart

 To view error bars for each data point in a trendline chart

1. In the Scaling list above a trendline plot in the Trend Chart view, select Unscaled.

2. Right-click the plot and choose Show Standard Errors.

The application plots the group median with error bars for the standard error of the 
median (Figure 96). 
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Figure 96. Trendline chart with error bars



 9 Working with the Graphical Result Views
Working with the Mass Defect Plot View

Thermo Scientific Compound Discoverer User Guide 339

Trend Chart View Parameters

Table 91 describes the parameters in the Trend Chart view. 

Working with the Mass Defect Plot View
Use the Mass Defect Plot view to find similar compounds by visualizing the calculated mass 
defects for a set of compounds against their molecular weights. Your choices for calculating 
the mass defect in this view are the same as those for the Calculate Mass Defect and Filter By 
Mass Defect nodes.

 To set up the mass defect plot and examine it for similar compounds

1. Open a result file from a processing workflow that included the Detect Compounds 
node.

2. From the application menu bar, choose View > Mass Defect Plot.

The compounds listed in the Compounds table appear as blue circles in the Mass Defect 
plot. The y-axis label displays the mass defect type, and the red dashed lines indicate the 
valid range of the mass defect values.

3. To specify how to calculate the mass defect, do the following:

• From the Type list, select the mass defect calculation. Then, if you selected Kendrick 
Mass Defect, enter the Kendrick formula.

• From the Rounding list, select Ceiling, Floor, or Round.

Table 91. Trend Chart view parameters

Parameter Description

Plot Type Controls the plot type in the graph area.

Selections: Trendline Chart or Box Whisker Chart

The Box Whisker Chart selection is only available for displaying 
a single compound.

Scaling (for the 
trendline chart)

Select the chart scaling:
• Unscaled—Enables the Show Standard Errors command in 

the shortcut menu.
• Scaled
• Scaled to Study Factor Value

Use Normalized Areas Displays the normalized areas for the data.

Available when the processing workflow included the Normalize 
Areas node.
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4. To highlight the compounds that have an assigned name in orange, select the Highlight 
Named Compounds check box.

5. To work interactively with the plot, do the following:

• Use the view’s shortcut menu commands to do any of the following:

– Zoom in or out of the plot.

– Copy the image or the data points to the Clipboard.

– Export the image or the data points to an external file.

– Check or uncheck the visible data points. Checking a data point highlights the 
data point in red and places a check mark in the Checked column for the 
compound in the Compounds table.

• Double-click a data point to navigate to the compound in the Compounds table.

• Point to a compound to display a tooltip with information about the compound’s 
mass defect, name, elemental composition, molecular weight, and retention time.

Figure 97. Mass Defect Plot view with its shortcut menu displayed

Related Topic

• Calculating the Mass Defect of an Elemental Composition



 9 Working with the Graphical Result Views
Working with the Principal Component Analysis View

Thermo Scientific Compound Discoverer User Guide 341

Working with the Principal Component Analysis View
Use the Principal Component Analysis view to visualize the correlation between multivariate 
data in a set of observations. A principal component analysis transforms a set of observations 
for possibly correlated variables into an artificial set of independent linear combinations of the 
original variables known as principal components (PC1, PC2, PC3 and so on). PC1 has the 
most variation and the highest principal component has the least variation. 

The Principal Component Analysis view contains three pages: Scores Plot, Loadings Plot, and 
Variances Plot. The scores plot shows the correlation among the observations. The loadings 
plot shows the relationship among the variables for a given pair of principal components. The 
variance plot shows the percentage and cumulated percentage of the variance that a principal 
component accounts for. In general, as the proportion of variance increases for the first two or 
three principal components, the dissimilarity between the sample groups increases.

To work with the Principal Component Analysis view, follow these topics:

• Setting Up a Principal Component Analysis

• Interpreting the Scores Plot

• Interpreting the Loadings Plot

• Working Interactively with the Loadings Plot

• Interpreting the Variance Plot

• Principal Component Analysis Parameters

Setting Up a Principal Component Analysis

 To set up a principal component analysis

1. Open a result file that contains any of these result tables: Compounds, Expected 
Compounds, or Merged Features.

2. From the menu bar, choose View > Principal Component Analysis.

If the result file contains a Compounds table, the Principal Component Analysis view 
opens with the Compounds table selected as the data source.

1. In the Data Source list, select the Compounds, Expected Compounds, or Merged 
Features table as appropriate for the data set.

2. In the X Data list, select PC1, PC2, PC3, PC4, or PC5. 

In most cases, select PC1 or PC2, as these principal components have the most variation.

3. If the data points differ by several orders of magnitude, select the Center and Scale check 
box.
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4. If the processing workflow included the Normalize Areas node, select the Use 
Normalized Areas check box as appropriate.

5. To display a legend at the bottom of the plot, right-click the plot and choose Show 
Legend.

6. To show a tooltip when you place the cross-hair cursor on a data point in the plots, 
right-click the plot and choose Show Position Tooltips.

7. To remove points from the plot, clear the check boxes under Filter By as appropriate.

Using the new population, the application recalculates the principal components, 
including their contribution to the variance, and shifts the coordinates of the remaining 
data points.

Interpreting the Scores Plot

Use the scores plot of the Principal Component Analysis view to interpret the relationship 
among the sample groups. Sample groups that are near each other are similar.

The Principal Component Analysis view is available for result files that include any of these 
tables: Compounds, Expected Compounds, or Merged Features.

 To review and interpret the scores plot

• Check the percentage values for the principal components. The labels on the x and y axes 
include the proportion of variance that the principal components add to the total variance 
as a percentage.

• Place the cross-hair cursor on a data point to view its coordinates.

Figure 98 shows the scores plot for the compounds that leach out of four o-ring types 
soaked in ethanol. The black, brown, and white o-rings show a similar variance for PC1, 
whereas the red o-rings show a significant variance in the other direction for PC1. The 
brown and white o-rings show a similar variance for PC2. 
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Figure 98. Scores plot for four o-ring types (white, brown, red, and black)

Interpreting the Loadings Plot

Use the loadings plot to interpret the relationship among the variables. 

 To interpret the loadings plot

1. To determine the relative correlation between various data points, review their relative 
location in the plot.

• Data points that are near each other are similar. 

• Data points that are on opposite sides of the origin have a negative correlation. 

• Data points in the corners of the plot have a strong contribution to both principal 
components—that is, these data points differentiate between groups.



9 Working with the Graphical Result Views
Working with the Principal Component Analysis View

344 Compound Discoverer User Guide Thermo Scientific

2. Place the cross-hair cursor on a data point to display a tooltip with the following 
information about the compound: the principal component coordinates, molecular 
weight, retention time, maximum peak area, and number of adduct ions (Figure 99).

Figure 99. Loadings plot with its shortcut menu displayed

Working Interactively with the Loadings Plot

The Loadings Plot is interactive with the selected data source table—that is, double-clicking a 
data point in the loadings plot selects its row in the data source table and updates the other 
opened graphical views. In addition, checking data points (compounds, expected compounds, 
or features) in the Loadings Plot checks the corresponding data points in these interactive 
views—Differential Analysis, Partial Least Squares Discriminant Analysis, and Descriptive 
Statistics. 

Shortcut menu 

Tooltip
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 To select a data point or check one or more data points in the Loadings Plot

• To select a data point, double-click it. 

The application highlights the corresponding row in the data source table and updates the 
other opened and interactive views.

• To check a single data point, right-click the point and choose Check Point.

• To check multiple points, drag the cursor across a rectangular area of the plot to zoom in 
on that area, then right-click the plot and choose Check All Visible Points.

The application selects the check boxes for the checked data points in the data source 
table and changes the color of the selected points to blue in the Loadings Plot 
(Figure 100). The color of the checked data points also changes to blue in the interactive 
views.

Figure 100. Loadings plot with checked points shown in blue

• To clear all the selected check boxes in the result table, right-click the result table and 
choose Uncheck All > In This Table.

Interpreting the Variance Plot

Use the variance plot to determine the relative differentiation between sample groups.

 To interpret the variance plot

Compare the contribution of the first two or three principal components to the 
cumulative variance. 
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For example, Figure 101 shows the variance plot for the compounds leached from red 
o-rings soaked either in water or an aqueous solution of sodium chloride, and Figure 102 
shows the variance plot for the same type of o-rings soaked either in water or ethanol. 

The PC1–PC3 components make up more of the cumulative variance when comparing 
the extraction strength of water to ethanol than when comparing water to a salt solution. 
From these results, you can infer that the extraction strengths of water and ethanol differ 
more than the extraction strengths of water and a salt solution.

Figure 101. Water versus an aqueous solution of sodium chloride (extraction strength)

Figure 102. Water versus ethanol (extraction strength)
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Principal Component Analysis Parameters

Table 92 describes the parameters in the Principal Component Analysis view.

Working with the Descriptive Statistics View
Use the Descriptive Statistics view to visually compare the statistics of the peak areas for all 
compounds currently displayed in the Compounds table or the Expected Compounds table as 
a box-and-whisker plot.

A box-and-whisker plot displays the data for a variable as a rectangular box with a set of 
whiskers at each end (Figure 103). The line through the rectangle represents the median value 
in the data set. The lower portion of the rectangle represents the data points that fall within 
the second quartile and the upper portion represents the data points that fall within the third 
quartile. The circles that fall outside the fence whiskers are outliers. 

Table 92. Principal Component Analysis parameters

Parameter Description

Data Source Specifies the source of the data. The selection list depends on the 
processing workflow.

Selections: Compounds, Expected Compounds, and Merged 
Features

X Data Specifies the principal component to plot on the x axis. 

Selections: PC1, PC2, PC3, PC4, or PC5

Y Data Specifies the principal component to plot on the y axis. 

Selections: PC1, PC2, PC3, PC4, or PC5

Center and Scale Centers and scales the data.

Use Normalized Areas Uses the normalized data.

Available if the processing workflow includes the Normalize 
Areas node.

Scores Plot page Displays a plot of one principal component versus a second 
principal component.

Loadings Plot page Displays the compounds in the selected table plotted against the 
selected principal components. 

This plot is interactive with the selected results table.

Variances Plot page Displays the proportion and the cumulative proportion of the 
variance contributed by each principal component. 
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The application uses the following equations to calculate the upper and lower fences:

Interquartile range (IQR) = Quartile 3 (Q3) – Quartile 1 (Q1)

Upper fence = Q3 + IQR × 1.5

Lower fence = Q1 – IQR × 1.5

Figure 103. Box-and-whisker display of the data distribution

By default, the graph displays the data for all the samples and duplicates the grouping on the 
Grouping and Ratios page of the analysis. Each group appears in a different color. The legend 
shows the colors of the sample groups.

Use the Group By check boxes in the collapsible pane to change the grouping. Use the Filter 
By check boxes to remove samples from the plot.

For more information about the shortcut menu commands, see “Copying or Saving Graphical 
Views for Publication” on page 291.

Follow these procedures as needed:

• To copy or save the data as an image

• To copy or save the data as editable text

Note  To calculate the quartiles, the application uses a method that is similar to the type 6 
method in the R statistical computing software.

Upper fence

Third quartile

Median

First quartile

Lower fence

Interquartile 
range

Outlier data points

Outlier data point
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• To view the table row for an outlier data point

• To select the check box for an outlier data point

• To select the check boxes for all of the visible data points

• To export the outlier data points to a spreadsheet

 To copy or save the data as an image

1. Right-click the plot and choose Show Legend.

2. Right-click the plot and choose Copy > Image to copy an image to the Clipboard.

–or–

Right-click the plot, choose Export > Image As, and select an image type to save the data 
to an image file.

 To copy or save the data as editable text

Right-click the plot and choose Copy > Data to copy the text to the Clipboard. 

You can paste this text to Notepad, an Excel spreadsheet, and so on. The data appears in a 
columnar format.

–or–

Right-click the plot and choose Export > Data As to save the data to a text file. 

The file contains two data sets. The first set consists of these columns from left to right: 
Groups, Name, Minimum Value, Maximum Value, Std. Deviation, Mean, Median, Q1 
Value, Q2 Value, and Q3 Value. The second set lists the outlier data points and consists 
of these columns from left to right: Groups, Name, and Outlier.

 To view the table row for an outlier data point

In the plot, double-click the data point.

 To select the check box for an outlier data point

In the plot, right-click the data point and choose Check Point.

In the result table, the check box is selected for the corresponding compound or expected 
compound.
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 To select the check boxes for all of the visible data points

Right-click the plot and choose Check All Visible Points. 

 To export the outlier data points to a spreadsheet

1. In the view, zoom in on the outlier points so that they are the only visible points on the 
screen.

Figure 104 shows a box-and-whisker plot for the chromatographic peak areas of 
compounds that leach out of four different o-ring types. The compounds leached from 
the red and black o-rings show more variation; however, the peak areas for all of the these 
compounds fall within the lower and upper fences. The compounds leached from the 
brown and white o-rings show less variation (in peak area); however, the peak areas for 
numerous compounds fall outside the upper fences.

Figure 104. Box-and-whisker plot for the leachable compounds in four types of o-rings 

Four o-ring types

Compounds with chromatographic peak
areas that are greater than the upper
fences for the brown and white o-rings
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2. Right-click the plot and choose Check All Visible Points to select the rows for these 
outliers in the Compounds table.

3. In the Compounds table, sort the checked rows by the variable of interest. For example, 
sort the rows by molecular weight, retention time, or both.

4. Right-click the Compounds table and choose Export > Export to Excel.

5. In the Export to Excel dialog box, select a folder and name the file, select the Checked 
Items Only check box, and click Export.

Table 93 describes the components of the Descriptive Statistics view.

Table 93. Descriptive Statistics view parameters (Sheet 1 of 2)

Parameter Description

Data Source Specifies the result table for the source data.

Selections: Compounds or Expected Compounds

Log-transform Data Determines whether the data appears in a linear scale or the log10 
scale.

Selecting this check box transforms the area counts to the log10 
scale.

Use Normalized Areas Select to display normalized chromatographic peak areas. 

Available when the processing workflow includes the Normalize 
Areas node.

Graph

x axis Displays the name of the sample group.

y axis Displays the area in a linear scale or in a log10 scale.

Outlier data points The circles represent outlier points. When the Show Position 
Tooltips command is enabled, placing the cursor over a data point 
displays the following information: MW, RT, Max. Area, and 
#Adducts.
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Working with the Differential Analysis View
Use the Differential Analysis view to view a volcano plot of the differential analysis performed 
during data processing or to run a new differential analysis.

Follow these topics as needed:

• Reviewing the Initial Differential Analysis

• Changing the Analysis Settings for a Differential Analysis

• Running a New Differential Analysis

• Running a New Differential Analysis

• Differential Analysis View Parameters and Shortcut Menu Commands

Reviewing the Initial Differential Analysis

 To open the Differential Analysis view and review the initial analysis

1. Open the result file for an analysis that included at least two raw data files.

2. In the menu bar, choose View > Differential Analysis.

If the processing workflow included the Differential Analysis node, the Differential 
Analysis view opens with the differential analysis from data processing. The ratios in the 
Comparison list match the ratios on the Grouping and Ratios Summary page of the 
Summaries view. The initial p-value setting is 0.05 (–log10 0.05 = 1.3) and the initial 
Log2 Fold change setting is 1 (a ratio of 2 to 1). Depending on the setting for the Log10 
Transform parameter in the Differential Analysis node, the y-axis scale spans the p-value 
range (0–1) or the –log10 p-value range (–log10 0 = Infinity, –log10 1 = 0).

Rectangle The rectangles represent the second and third quartiles for the 
data set. 

When the Show Position Tooltips command is enabled, placing 
the cursor over the rectangle displays the following information: 
filename, group, maximum value (including the outliers), 3rd 
quartile, median, 1st quartile, minimum value (including the 
outliers).

Legend By default, the legend is hidden.

Choosing Show Legend from the shortcut menu displays the 
legend. The legend shows the group colors.

Table 93. Descriptive Statistics view parameters (Sheet 2 of 2)

Parameter Description
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3. To show the legend, right-click the plot and choose Show Legend.

The data points are color-coded, as defined by the legend. 

Figure 105 shows a comparison between two extraction solvents—water and an aqueous 
solution of 50% ethanol. 

Figure 105. Differential Analysis view with the analysis run during data processing

Changing the Analysis Settings for a Differential Analysis

 To change the analysis displayed in the volcano plot

• Select a different ratio from the Comparison list. This changes the data points in the plot.

• Change the p-value setting by dragging the slider. This changes the y-axis range of the 
shaded areas.

Analysis summary for the negative fold 
changes (down-regulated compounds)

Analysis summary for the positive fold 
changes (up-regulated compounds)
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Figure 106 shows the effect of changing the p-value setting.

Figure 106. P-value decreased from 0.05 to 1E–12

• Change the fold change setting by dragging the slider. This changes the x-axis range of the 
shaded areas.

Figure 107 shows the effect of changing the Log2 Fold Change setting.

Figure 107. Fold change increased from 1 to 8

Running a New Differential Analysis

 To run a new differential analysis 

1. In the Differential Analysis view, click the Perform New ANOVA Calculation icon, , 
to the right of the Data Source box.

The Perform New ANOVA Calculation dialog box opens (Figure 108).

Note  Use the Perform New ANOVA Calculation dialog box to set up and compare 
different ratios than those on the Grouping and Ratios page of the analysis.
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Figure 108. Perform New ANOVA Calculation dialog box

2. In the Data Source list, select a different result table if applicable.

3. In the Fixed Effect area, select one or more variables to create new sample groups.

4. In the Reference list, select one of the new sample groups as the denominator for the 
group ratios.

5. (Optional) To transform the data to the log10 scale, select the Transform Data check box.

6. (Optional) To normalize the chromatographic peak areas, select the Use Normalized 
Areas check box. This check box is available if the processing workflow included the 
Normalize Areas node.

7. (Optional) To calculate p-values for a nested design, select the Use Nested Design check 
box. This check box is available if the original analysis included a biological study factor 
and nested sample groups.

8. Click Calculate.

The Perform New ANOVA Calculation dialog box closes and the Pending Results area 
appears at the bottom of the view. The Pending Results area displays the data source 
(result table), the reference group, and the progress of the new calculation.

When the calculation is complete, the new ratio (sample group vs. reference group) appears 
in the Comparison list.
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9. To view the analysis, select the data source in the Data Source list and the new ratio in the 
Comparison list. 

The volcano plot updates with the selected analysis.

Differential Analysis View Parameters and Shortcut Menu Commands

Table 94 describes the parameters in the Differential Analysis view.

Table 94. Differential Analysis view parameters (Sheet 1 of 2)

Parameter Description

Data Source Specifies the result table for the source data.

Selections: Compounds or Expected Compounds table

Perform New 
ANOVA 
Calculation 

Opens the Perform New ANOVA Calculation dialog box for 
setting up a new differential analysis.

Comparison Specifies the ratio for comparison.

Selections: Generated ratios on the Grouping and Ratios page of 
the analysis and any new analyses that you have run and saved

To save the differential analyses run in the Differential Analysis 
view, save the result file.

P-value Specifies the p-value for the null hypothesis.

Use the slider to change the value in the corresponding box.

Default: 0.05 (–log10 0.05 = 1.3)

Log2 Fold Change Specifies the fold change (ratio in the log base 2 scale) between the 
sample group and the reference group. This value creates an upper 
and lower threshold for each group ratio.

Use the slider to change the value in the corresponding box. Data 
points that fall outside the upper and lower thresholds are in the 
shaded regions.

Default: 1 (two-fold change)

Graph

x axis Displays the log2 fold change. 

y axis Displays the p-value in a linear scale or in a –log10 scale.

Analysis summaries The summaries display the number of data points with a p-value 
above the statistical significance level and a fold change outside the 
empirical threshold.
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Table 95 describes the shortcut menu commands for the Differential Analysis view.

Shaded regions The region shaded in red identifies the data points that are 
significantly different (populations differ based on the p-value 
setting) and that fall outside the lower fold change threshold.

The region shaded in green identifies the data points that are 
significantly different (populations differ based on the p-value 
setting) and that fall outside the upper fold change threshold.

Legend By default, the legend is hidden.

Choosing Show Legend from the shortcut menu displays the 
legend. The legend contains color-coded circles for these 
conditions:

• Nonsignificant and does not meet FC (fold change) threshold
• Nonsignificant and greater than upper FC threshold
• Nonsignificant and less than lower FC threshold
• Significant and does not meet FC threshold
• Significant and greater than upper FC threshold
• Significant and less than lower FC threshold

Table 95. Shortcut menu commands for the Differential Analysis view (Sheet 1 of 2)

Command Description

Show Position Tooltips Displays information about the compound.

Zoom Out Undoes the last zoom.

Undo All Zoom/Pan Zooms out to the full plot range.

Copy and Export 
commands

See “Copying or Saving Graphical Views for Publication” on 
page 291.

Show Legend Displays the legend for the color-coded data points.

Note  The color-coded data points (circles) represent compounds in the selected data 
source (the Compounds table or the Expected Compounds table). Selecting a data point 
turns it blue and selects the check box for the corresponding compound in the data source 
table.

Check Point To activate this command, point to a data point.

Selects the data point in the view and the check box for the 
corresponding compound in the data source table.

Uncheck Point To activate this command, point to a selected compound.

Returns the data point to its original color clears the 
corresponding check box in the data source table. 

Table 94. Differential Analysis view parameters (Sheet 2 of 2)

Parameter Description
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Working with the Partial Least Squares Discriminant Analysis View
Use the Partial Least Squares - Discriminant Analysis view to determine whether two groups 
are different and to identify the variables that contribute to that difference.

See these topics:

• Identifying a Set of Compounds to Discriminate Between Groups

• Partial Least Squares - Discriminant Analysis View Parameters

Identifying a Set of Compounds to Discriminate Between Groups

 To determine a set of compounds that you can use to discriminate the experimental 
variables by

1. Open a result file from an analysis with study factors.

2. From the menu bar, choose View > Partial Least Squares - Discriminant Analysis. 

The Partial Least Squares Discriminant Analysis view opens to the right of the tabbed 
result tables.

1. In the collapsible pane on the left, under Discriminate By, select the study factors that you 
want to discriminate by.

2. On the right above the plot, in the Data Source list, select the data source.

3. In the #sPLS-DA Compounds box, type the number of compounds that you want to use 
to differentiate the selected study factors.

4. To update the plot, click anywhere in the plot.

The orange circles represent the discriminating compounds.

5. Right-click the plot and choose Check All sPLS-DA Points.

Check All Visible Points Selects all the visible data points.

Uncheck All Visible Points Clears the check boxes for all the visible data points.

Check All Up-Regulated 
Points

Selects all the data points in the pink-shaded region of the 
plot.

Check All Down-Regulated 
Points

Selects all the data points in the green-shaded region of the 
plot.

Table 95. Shortcut menu commands for the Differential Analysis view (Sheet 2 of 2)

Command Description
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The application selects the check boxes of the corresponding compounds in the selected 
data source. The blue circles represent the checked discriminating compounds 
(Figure 109).

Figure 109. PLS-DA view with five checked discriminating compounds

6. To view the list of compounds that you can use to differentiate the selected experimental 
variables, set up a result filter to display only the checked compounds in the selected result 
table.

Partial Least Squares - Discriminant Analysis View Parameters

Table 96 describes the parameters in the Partial Least Squares - Discriminant Analysis view.

Table 96. Partial Least Squares - Discriminant Analysis view parameters (Sheet 1 of 2)

Parameter Description

Data Source Specifies the result table for the source data.

Selections: Compounds or Expected Compounds table

sPLS-DA Component Specifies the analysis component.

Selection: 1 to 6
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Viewing KEGG Pathways
Use the KEGG Pathways view to view the reaction pathway of a detected compound in a 
KEGG pathway.

 To view the KEGG pathways for a compound in the Compounds table

1. Open a result file that contains mapped KEGG pathways—that is, a result file from an 
analysis that included the Map to KEGG Pathways node.

2. In the main Compounds table, select a compound.

3. Below the main Compounds table, click Show Related Tables to show the related tables.

4. Click the KEGG Pathways tab to make it the active result table.

5. In the KEGG Pathways table, select the pathway that you want to view.

6. In the menu bar, choose View > KEGG Pathways.

The selected KEGG pathway opens. The blue circle indicates the selected compound in 
the KEGG pathway. The red circles indicate related compounds that were not found in 
the mzCloud database. The green circles indicate related compounds that were found in 
the mzCloud database. Figure 110 shows the selections of caffeine in the Compounds 
table and caffeine metabolism in the KEGG Pathways table. The related Compounds 
tables shows the compounds related to caffeine, which appear as red circles in the pathway 
diagram.

#sPLS-DA 
Compounds

Specifies the number of compounds that when used together can 
discriminate between the values for the study variables selected 
under Discriminate By.

Use Normalized Areas Uses the normalized areas in the result file. 

Available when the processing workflow includes the Normalize 
Areas node.

Table 96. Partial Least Squares - Discriminant Analysis view parameters (Sheet 2 of 2)

Parameter Description
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Figure 110. Caffeine metabolism pathway where caffeine appears as a blue circle
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Viewing BioCyc Pathways
When the result file’s processing workflow includes the Map to BioCyc Pathways Node, use 
the BioCyc Pathways view to view the mapped pathways for a selected compound.

 To view the BioCyc Pathways for a compound

1. Open a result file for an analysis that maps the detected compounds to their BioCyc 
pathways.

2. In the main table panel, click the BioCyc Pathways tab.

3. Select a pathway of interest.

4. Below the BioCyc Pathways table, click Show Related Tables.

5. Click the BioCyc Results tab.

6. In the BioCyc Results table, select a compound of interest (Figure 111).
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Figure 111. BioCyc Results table for the selected pathway

7. From the menu bar, choose View > BioCyc Pathways.

The BioCyc Pathways view opens to the right of the result tables.

8. In the upper right corner of the view, click the Fit Pathway to Browser icon, .

9. In the Omics-Overlay list (to the left of the icon ), select Area.

Figure 112 shows a BioCyc pathway with an Area overlay.
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Figure 112. BioCyc Pathways view with an Area overlay

Viewing Metabolika Pathways
Use the Metabolika Pathways view to view the mapped pathways for a selected compound.

 To view a mapped pathway for a compound

1. Open a result file from an analysis that included the Map to Metabolika Pathways node.

2. In the Compounds table, select the compound.

3. Click Show Related Tables.

4. In the Related Tables panel, click the Metabolika Pathways tab.

5. Select the pathway that you want to view.
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6. From the application menu bar, choose View > Metabolika Pathways.

The view opens to the right of the Compounds table and displays the selected pathway. 
The structure for the selected compound is blue, the structures for other detected 
compounds are red, and the structures for undetected compounds in the pathway are 
black.

7. To overlay a data source, select the source from the Overlay Data Source list and type or 
select a cell size from 6 to 30 pixels in width in the Overlay Cell Size box.

The data source selections depend on the processing workflow, but always include the 
annotation source, chromatographic peak area, or Metabolika pathways graphic.

Viewing the Corrected Retention Times of the Alignment Features
When the result file’s processing workflow includes the Align Retention Times Node and the 
analysis includes more than one input file, use the Retention Time Correction view to inspect 
the regression curves for the alignment features. 

 To open the Retention Time Correction view

1. Open a result file for an analysis with multiple input files.

2. In the menu bar, choose View > Retention Time Corrections.

In the default layout, the Retention Time Correction view opens to the right of the 
tabbed result tables. Because you need to select a row in the Input Files table, the view is 
empty.

3. In the main result tables, click the Input Files tab.

4. Do the following as needed:

• To view the regression curve for one input file as well as the prediction interval for the 
file’s landmark features, select one input file (Figure 113).
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Figure 113. Retention Time Correction view with the regression curve for one input file

• To view overlaid regression curves for multiple input files, select multiple input files 
(Figure 114).

Figure 114. Retention Time Correction view with regression curves for multiple input files
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Viewing the QC-Based Compound Area Correction Curves
When the result file’s processing workflow includes the Normalize Areas Node and the 
analysis includes samples with the sample type assignment of Quality Control, use the 
Compound Area Corrections view to inspect the corrected peak areas for each detected 
compound in the Compounds Table across the input files.

For information about acquiring a set of raw data files with interspersed quality control 
samples, setting up the batch normalization criteria in the (post-acquisition) processing 
workflow, and setting up the Region and Language settings for the processing computer, see 
“Quality Control Samples for Batch Normalization” on page 34.

 To open the Compound Area Correction view

1. Open a result file for an analysis with batch normalization—that is, and analysis that 
includes QC samples and a processing workflow with the Normalize Areas node.

2. In the Compounds table, select one or more compounds.

3. From the menu bar, choose View > Compound Area Corrections.

In the default layout, the Compound Area Correction view opens to the right of the 
tabbed result tables. The Compound Area Correction view displays a scatter plot of the 
areas for the selected compound on the y axis against the acquisition time for each input 
file on the x axis.

Figure 115 shows the Compound Area Corrections view for the compound selected in 
the Compounds table, with the following legend:

• Blue triangles represent the original compound areas for the QC samples.

• Orange triangles represent the corrected compound areas for the QC samples.

• Blue circles represent the original compound areas for the non-QC samples.

• Orange circles represent the corrected compound areas for the non-QC samples.

• The blue line is the regression curve for the original compound areas in the QC 
samples.

• The orange line is the regression curve for the corrected compound areas in the QC 
samples.

Pointing to a circle or triangle displays a tooltip with the input file name, the compound 
area, and the status—original or corrected.
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Figure 115. Compound Area Corrections view for a selected compound

Viewing the FISh Scoring Queue
Use the FISh Scoring Queue view to view the progress of FISh scoring.

 To open the FISh Scoring Queue view

1. Open a result file.

2. From the menu bar, choose View > FISh Scoring Queue.

The FISh Scoring Queue opens to the right of the result tables.
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3. Start the FISh scoring process as follows:

a. Do one of the following for compounds with assigned structures:

• In the Compounds table or the Expected Compounds table, right-click a 
compound and choose Apply FISh Scoring. 

• In any of the following related search results tables, right-click a compound and 
choose Add to Structure Proposals and Apply FISh Scoring.

• In a Structure Proposals table, right-click a compound and choose either Apply 
FISh Scoring to Selected or Apply FISh Scoring to All.

The  Settings dialog box opens.

b. In the  Settings dialog box, make the appropriate selections and click OK.

–or–

a. Do one of the following for compounds without assigned structures:

• In the Compounds table or the Expected Compounds table, right-click a 
compound and choose Edit Compound Annotations.

• In a Structure Proposals table, double-click a compound.

The Compound Annotation Editor dialog box opens.

b. Enter the structure by opening a structure file, drawing the structure, or running a 
ChemSpider search. 

c. Click the FISh Scoring tab.

d. Make the appropriate selections for the FISh scoring algorithm.

e. At the bottom of the dialog box, select the Apply FISh Scoring check box and click 
Save.

Running a Hierarchical Clustering Analysis
Use the Hierarchical Cluster Analysis view to visualize the correlation between detected 
compounds and selected samples in a two-dimensional array of color-coded rectangles (heat 
map) where each rectangle represents the relative amount (by area) of a specific compound in 
a specific sample. 

The application uses an agglomerative (bottom-up) approach to find the similarities between 
samples and compounds. Initially, the hierarchical cluster analysis assigns each compound to 
its own singleton cluster. The analysis then proceeds iteratively, at each stage joining the two 
most similar clusters into a new cluster, continuing until there is one overall cluster 
represented by a dendogram. 

Figure 116 shows the results of a hierarchical cluster analysis for compounds detected in 
samples from six ZDF rats (phenotypes: Fatty and Lean).
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The dendogram to the left of the heat map represents the distance (or dissimilarity) between 
the compound clusters. The width of each node is proportional to the distance (or 
dissimilarity) between two compounds at the lowest level or two compound clusters at the 
higher levels. The dendogram above the heat map represents the distance (or similarity) 
between samples. The height of each node is proportional to the distances (or similarity) 
between two samples at the lowest level or two sample clusters at the higher levels. 

Pointing to a dendogram node displays the distance between clusters, and pointing to a heat 
map cell displays the compound and sample information.

By default, under Filter By, all the input files are selected, and under Other Settings, the Show 
Labels check box for the compound labels is clear.

Figure 116. Hierarchical cluster analysis for the compounds detected in six samples

To determine how to cluster the data, the application provides a choice of commonly used 
distance functions and linkage methods (see Table 98 and Table 99).

Dendogram that represents the distance (or 
dissimilarity) between compound clusters

Dendogram that represents the distance 
(or similarity) between samplesHeat map legend (scaled areas)

Column 
labels

Red bar indicates 
checked 
compounds in the 
data source table.

Display and 
analysis 
options

Color bar (for 
selected variable)

Zoom Out (Rows) Zoom Out (Columns)
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To set up a hierarchical clustering analysis and work interactively with the heat map’s cells, see 
these topics:

• Setting Up a Hierarchical Clustering Analysis

• Working Interactively with the Heat Map Grid

• Hierarchical Cluster Analysis View Parameters

Setting Up a Hierarchical Clustering Analysis

 To set up the hierarchical clustering analysis

1. Filter the result table that you want to use as the data source. The analysis only uses the 
visible compounds in the table.

2. In the Data Source list, select the data source.

The Compounds table is the data source for untargeted analyses, and the Expected 
Compounds table is the data source for targeted analysis. For a combination analysis that 
generates a Compounds table and an Expected Compounds table, you can select either 
table as the data source.

3. In the Scale Values list, select whether to scale the heat map data before or after clustering 
or not at all.

4. To normalize the areas for the compounds, select the Use Normalized Areas check box.

5. In the left pane, under Filter By, select the check boxes for the samples to include in the 
analysis.

By default, all the sample files are selected.

Note  The Heat Map supports clustering for 2 to 2000 compounds. 

Note  When you apply a filter that displays only the checked compounds in the 
selected result table, a red bar appears to the right of the heat map. If only a subset of 
the compounds is checked, the bar is discontinuous, with red indicating a checked 
compound and gray indicating an unchecked compound.

Note  By default, under Other Settings, the following check boxes are selected:

Column Settings: Show Clusters and Show Labels—Displays a dendogram above the 
heat map and sample labels below the heat map.

Row Settings: Show Clusters—Displays a dendogram to the left of the heat map.
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6. In the left pane, under Other Settings, select these analysis options:

• Under Distance Function, select how the analysis determines the distance between 
the data points, where the data points are files (columns) or compounds (rows) 
(Table 98).

• Under Linkage Method, select how the analysis performs the clustering analysis 
(Table 99).

7. In the left pane, select these labeling options:

• Under Color By, select whether to display color bars above the heat map to visually 
differentiate the samples by their study factor variables.

• Under Other Settings > Row Settings, select whether to display the compound labels. 

Selecting the Show Labels check box under Row Settings displays the compound 
labels to the right of the heat map.

• Under Other Settings > X-Axis Label, select the label for the sample columns.

8. To run the analysis, click Refresh.

Working Interactively with the Heat Map Grid

After you run a hierarchical heat map analysis, you can enlarge the heat map, zoom in and out 
on the heat map, and point to specific cells in the heat map for more information. 

Task Instructions

Enlarge the heat map. To increase the heat map width, drag its left or right edge.

To increase its height, drag its top or bottom edge.

Zoom in on an area of the heat 
map.

Drag the pointer across the rectangular area of the heat 
map.

Zoom out of an enlarged area of 
the heat map by using the 
shortcut menu commands.

Right-click the heat map and choose one of the following: 
Zoom Out Column, Zoom Out Row, Undo All 
Column Zoom, or Undo All Row Zoom.

Zoom out of an enlarged area of 
the heat map by using the zoom 
icons.

To zoom out of a row selection, click the Zoom Out Row 
icon, , or the Undo All Row Zoom icon, , below 
the heat map legend.

To zoom out of a column selection, click the Zoom Out 
Column icon, , or the Undo All Column Zoom 
icon, , to the right of the heat map legend.
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Hierarchical Cluster Analysis View Parameters

Table 97 describes the parameters in the Hierarchical Clustering Analysis view.

View information about a heat 
map cell.

Point to the cell.

The tooltip displays the compound’s name (if available), 
its MW, RT, file ID, and the study factor value (if 
available).

View the distance value for a 
dendogram node.

Point to the node.

The tooltip displays the distance value. 

For an analysis where the 
chromatographic peak areas are scaled 
before clustering, the distance values are 
scaled. 

For an analysis where the 
chromatographic peaks areas are 
not scaled or are scaled after 
clustering, the distance values are 
not scaled. 

Task Instructions

Table 97. Hierarchical Clustering Analysis view parameters (Sheet 1 of 3)

Parameter Description

Button

Refresh Runs the hierarchical clustering analysis on the compounds 
displayed in the selected data source (result table) and the samples 
selected in the left pane under Filter By.

Parameters in the right pane

Data Source Specifies the result table for the source data.

Selections: Compounds table or Expected Compounds table
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Scale Values Specifies if and when to perform a z-score transformation on the 
data points:

• None—The application does not scale the data. The heat map 
legend displays a scale in area counts, and the dendogram 
nodes display the distance in area counts.

• Scale After Clustering— Applies a z-score transformation 
after performing the hierarchical clustering. The heat map 
legend displays the range of the scaled values, and the 
dendogram nodes display the distance in area counts.

• Scale Before Clustering—Applies a z-score transformation 
before performing the hierarchical clustering. The heat map 
legend displays the range of the scaled values, and the 
dendogram nodes display the scaled distance values. 

Use Normalized Areas When selected, normalizes the chromatographic peak areas for the 
selected compounds before running the analysis.

Parameters in the left pane

Color By

Displays the selected color bars for the selected variables above the heat map.

Filter By

By default, all the check boxes—except for the Blank sample type—are selected. Clearing a 
check box removes the corresponding item from the analysis.

Other Settings

Column Settings

Show Clusters When selected, displays the dendogram for the samples above the 
heat map; that is, this selection displays the dendogram for the 
items selected under Filter By.

Show Labels When selected, displays the labels across the bottom of the heat 
map for the items selected under Filter By. The X-Axis Label 
parameter at the bottom of the left pane provides labeling options.

Row Settings

Show Clusters When selected, displays the dendogram for the compounds to the 
left of the heat map.

Show Labels When selected, displays the labels across the bottom of the heat 
map for the items selected under Filter By. The X-Axis Label 
parameter at the bottom of the left pane provides labeling options.

Table 97. Hierarchical Clustering Analysis view parameters (Sheet 2 of 3)

Parameter Description
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Color Schemes Specifies the color scheme for the heat map. 

Default: Available values  and Missing values 

Selection:

Distance Function Specifies the distance function to use for calculating the distance 
between data points (see Table 98).

Default: Euclidean

Linkage Method Specifies the method to use for hierarchical clustering (see 
Table 99). 

Default: Complete

X-Axis Label Specifies the labels for the sample columns.

Selections: All Factors, Selected Factors, File ID, Full File Name, 
and Sample Name

Table 98. Distance functions (Sheet 1 of 2)

Distance function Description

Euclidean Computes the Euclidean distance between two data vectors, 
which is the geometric distance in the multidimensional space.

Manhattan Computes the city-block (Manhattan) distance between two 
vectors. The Manhattan distance between two data items is the 
sum of the differences of their corresponding components. In 
most cases, the Manhattan distance measure yields results similar 
to the simple Euclidean distance. Note, however, that the effect of 
outliers is dampened, since they are not squared.

Maximum Computes the maximum distance on any one of the dimensions 
between two vectors. Use this function to define two objects as 
different if they differ in any one of the dimensions.

Table 97. Hierarchical Clustering Analysis view parameters (Sheet 3 of 3)

Parameter Description

Available values Missing values
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Pearson Computes the Pearson product-moment correlation, which is a 
measure for the shape similarity between two clusters. 

Squared Euclidean Computes the squared Euclidean distance between two data 
vectors. The Euclidean Squared distance metric uses the same 
equation as the Euclidean distance metric, but does not take the 
square root.

Table 99. Linkage methods

Linkage method Description

Average Computes the distance between two clusters as the average 
distance between all pairs of objects in the two different clusters.

Centroid Computes the distance between two clusters as the difference 
between centroids. The centroid of a cluster is the average point in 
the multidimensional space.

Complete Computes the distance between two clusters as the greatest 
distance between any two objects in the different clusters (furthest 
neighbors).

Median Computes the distance between two clusters as the difference 
between centroids, using the size of each cluster as a weighting 
factor.

Single Computes the distance between two clusters as the distance of the 
two closest objects (nearest neighbors) in the clusters.

WARD Computes the distance between two clusters using Ward’s 
method, which uses an analysis of variance approach to evaluate 
the distances between clusters. The smaller the increase in the total 
within-group sum of squares as a result of joining two clusters, the 
closer they are. The within-group sum of squares of a cluster is 
defined as the sum of the squares of the distance between all 
objects in the cluster and the centroid of the cluster. Ward’s 
method tends to produce compact groups of well-distributed size.

Weighted Average Computes the distance between two clusters as the average 
distance between all pairs of objects in the two different clusters, 
using the size of each cluster as a weighting factor.

Table 98. Distance functions (Sheet 2 of 2)

Distance function Description
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Running an mzLogic Analysis
You can use the mzLogic Analysis view in two ways:

• To run an mzLogic analysis for a data set that was processed with a workflow that did not 
include the Apply mzLogic node

• To update an older analysis with new similarity results from the mzCloud spectral 
database

To run and review an mzLogic Analysis, see these topics:

• Performing an mzLogic Analysis

• Reviewing the Results of an mzLogic Analysis

• mzLogic Analysis View Parameters

Performing an mzLogic Analysis

 To perform an mzLogic analysis

1. Open a result file from an untargeted analysis.

2. Select a compound in the Compounds table.

3. From the application menu bar, choose View > mzLogic Analysis.

The mzLogic Analysis view opens to the right of the Compounds table. If the selected 
result file does not include results from an identity search, the Candidates area is empty. 
Otherwise, the Candidates area contains candidates from the identity search nodes.

4. To add candidates from the ChemSpider database, click ChemSpider and run a search.

5. To run forward and reverse similarity searches on the candidates, click mzCloud 
Similarity.

If the application finds similar structures in the mzCloud database, it populates the 
Similar Structures from mzCloud area and the Calculate Score button becomes available. 
The structure tiles in this area include an mzCloud Match score and a Coverage value at 
the top and a formula and delta mass value at the bottom.

6. To display an mzLogic score for each candidate, click Calculate Score.

Note  The application does not save the results from this mzLogic analysis to the result 
file; however, you can add suitable candidates to the Structure Proposals table for a 
compound and apply FISh scoring.

The ranking score provided by an mzLogic analysis is not a probability score. It is only a 
measure of how similar a putative structure is to closely matching structures in the 
mzCloud spectral database.
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Reviewing the Results of an mzLogic Analysis

 To review the results of an mzLogic analysis

1. In the mzLogic Analysis view, open the Similar Structures from mzCloud area.

2. In the Candidates area, click a candidate to select it.

In the Similar Structures form mzCloud area, the matching portions of the similar 
structures are highlighted in blue.

mzLogic Analysis View Parameters

Table 100.mzLogic Analysis view parameters (Sheet 1 of 2)

Parameter Description

ChemSpider Opens the ChemSpider Search dialog box (see “Finding a 
Structure in the ChemSpider Database” on page 541).

mzCloud Similarity Runs a forward and reverse mzCloud similarity search.

Calculate Score Calculates the mzLogic scores for the available candidates.

Available when the Candidates and Similar Structures from 
mzCloud areas are populated.

Back Returns the focus to the previously selected compound in the 
Compounds table.

Available when the Auto Refresh check box is clear and you select 
a different compound in the Compounds table.

Refresh Refreshes the Candidates area when you select another 
compound.

Available when the Auto refresh check box is clear.

Auto refresh Select so that when you select another compound, the application 
automatically refreshes the Candidates area.

Size Controls the size of the structure tiles in the Candidates area.

Default: Medium 

Selection: Small, Medium, or Large
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Working with the Isotopologues Distribution Chart
If the analysis included the Analyze Labeled Compounds node, labeled samples, and at least 
one unlabeled reference sample, you can view a distribution chart of the detected 
isotopologues.

 To open the Isotopologues Distribution Chart and review the isotopologues

1. Open a result file for a stable isotope labeling analysis.

2. From the application menu bar, do one of the following:

• Choose Window > Apply Layout > Stable Isotope Labeling.

The Isotopologues Distribution Chart, Trend Chart, and Metabolika Pathways view 
open as a tabbed group to the right of the result tables. Under Group By, the File 
check box is selected.

Candidates area Displays structure candidates as tiles. The structure candidates are 
provided by identity searches during data processing or a separate 
ChemSpider search from the result file. If the identity searches 
find duplicate structures, the application consolidates them.

Right-clicking a tile displays a shortcut menu with the following 
commands:

• Add to Structure Proposals—Adds the selected structure to 
the Structure Proposals table for the selected compound.

• Add to Structure Proposals and Apply FISh Scoring—Opens 
the  Settings dialog box for applying the FISh scoring 
algorithm. Then, runs the FISh scoring algorithm and adds 
the structure and FISh Coverage score to the Structure 
Proposals table for the selected compound.

Similar Structures from 
mzCloud area

Displays the results of the mzCloud similarity search for the 
selected compound.

Selecting a candidate highlights the maximum common 
substructure in blue for the similar structures.

Sort By Sorts the similar structures by the selected parameter.

Default: mzCloud Match

Selection: mzCloud Match, Forward Coverage, or Reverse 
Coverage

Table 100.mzLogic Analysis view parameters (Sheet 2 of 2)

Parameter Description
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–or–

• Choose View > Isotopologues Distribution Chart.

The Isotopologues Distribution Chart opens to the right of the result tables. Under 
Group By, all the check boxes are clear.

The compound’s name, elemental composition, MW, and RT appear above the graph 
(Figure 117). The bars are colorized by input file.

Figure 117. Isotopologues Distribution Chart with no grouping selected

3. Do any of the following:

• To display a tooltip for a bar, point to the bar.

Tip  By default, the Show Position Tooltips feature is turned on. If a tooltip does 
not appear, click the chart. If a tooltip still does not appear, right-click the chart 
and choose Show Position Tooltips.
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Figure 118. Isotopologues Distribution Chart with a tooltip

• To group the isotopologues by input file, under Group By, select the File check box.

• To group the isotopologues by sample type, under Group By, select the Sample Type 
check box (Figure 119).

Figure 119. Isotopologues grouped by sample type
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10

Reviewing the Tabular Result Data

For information about the tabular data in the result files, see these topics.

For general information about opening result files and working with the result tables, see 
Chapter 8, “Reviewing the Analysis Results.” 

Common Result Tables
You can run a targeted analysis that finds expected compounds, an untargeted analysis that 
detects unknown compounds, or both types of analyses with the Compound Discoverer 
application.

For information about the result tables that are independent of the analysis type, see these 
topics:

• Adducts Table 

• Chromatogram Peaks Table

• File Alignments Table

• FISh Trace Fragments Table

Contents

• Common Result Tables

• Expected Compounds Result Tables

• Compound Detection Result Tables

• Compound Identification Result Tables

• Pathway Mapping Result Tables

• Compound Scoring Tables

• Differential Analysis Columns

• Descriptive Statistics Columns
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• Input Files Table

• Manual Peaks Table

• Merged Features Table

• Specialized Traces Table

• Structure Proposals Table 

Adducts Table

Use the Adducts table to view the list of adducts in the Adducts library. By default, the 
Adducts table is hidden (see “Showing or Hiding Result Tables” on page 257).

Chromatogram Peaks Table

Use the Chromatogram Peaks table to view information about the quality of the 
chromatographic peak for the detected or expected feature. The Chromatogram Peaks table is 
related to the Features and Expected Features tables. 

Table 101 describes the columns in the Chromatogram Peaks table.

Table 101.Chromatogram Peaks table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Area Displays the integrated peak area.

Apex m/z Displays the m/z value of the mass spectral peak at the 
chromatogram peak apex. 

Apex RT [min] Displays the retention time of the chromatogram peak apex.

Apex Intensity Displays the intensity at the chromatogram peak apex.

Left RT [min] Displays the start point for the chromatographic peak.

Right RT [min] Displays the end point for the chromatographic peak.
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File Alignments Table

Use the File Alignments table to check the alignment process for each input file.

The Align Retention Times Node creates the File Alignments table.

Table 102 describes the columns in the File Alignments table.

Isotope Number 
(hidden)

(For chromatographic peaks detected by the Detect Compounds 
node) Displays the index number for the isotopic mass spectrum 
peak that the application used to create the XIC. The Detect 
Compounds node creates an XIC trace for each isotope.

(For chromatographic peaks found by the Find Expected 
Compounds node) Always displays a value of 0, as the Find 
Expected Compounds node creates only one filtered XIC trace for 
each ion. The Find Expected Compounds node creates the filtered 
XIC trace by summing the intensity of all the mass spectrum 
peaks that match the theoretical isotope pattern. If even one 
required isotope is missing, the intensity of the XIC drops down 
to 0.

Peak Model Displays the peak model for the chromatographic peak and 
includes information about the peak’s width and symmetry.

Table 101.Chromatogram Peaks table  (Sheet 2 of 2)

Column Description

Table 102.File Alignments table 

Column Description

Study File ID Displays the study file ID of the sample where the algorithm has 
corrected the measured retention time of the detected features 
against a set of features from the reference file.

Ref. File ID Displays the study file ID of the sample being used as a reference.

Kind Displays the parameter that the algorithm used in the regression 
model. Retention time (RT) is the current regression model.

Description Displays a description of the alignment process.

#Landmarks Displays the number of features that the analysis used to align the 
specified file to the reference file.

Alignment Details Displays additional information about the alignment.

RMSE Displays the estimated error for the corrected retention times of 
the features in the selected input file as the root mean square error.
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FISh Trace Fragments Table

Use the FISh Trace Fragments table to view the structures and the summed intensities of the 
expected fragment ions.

The Create FISh Trace Node creates the FISh Trace Fragments table when the Individual 
Traces parameter for this node is set to True.

Table 103 describes the columns in the FISh Trace Fragments table.

Input Files Table

Use the Input Files table, which is common to all processing workflows, to view information 
about the input file set (Xcalibur RAW files) that the application processed to produce the 
result file. For a result file from an analysis of multiple input files, use the related File 
Alignments Table to check the chromatographic alignment of the features in the input files.

 To check the chromatographic alignment of the input files

1. Click the Input Files tab.

2. Select a row (input file).

3. Click Hide Related Tables below the main tables.

4. Click the File Alignments tab.

5. From the menu bar, choose View > Retention Time Corrections.

The Retention Time Corrections view displays the regression curve for the selected input 
file.

Table 103.FISh Trace Fragments table

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Parent Compound Displays the selected compound in the Create FISh Traces node.

Formula Displays the elemental composition of the fragment ion.

Ion Displays the ion description.

m/z Displays the ion’s mass-to-charge ratio.

TIC Displays the total ion current for the fragment ion.

Mode Displays the fragmentation mode.

File ID Displays the integer that the application assigned to the input file.

Study File ID Displays the study file ID of the input file.

Structure Displays the ion’s molecular structure.
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Table 104 describes the information displayed in the Input Files table. 

Manual Peaks Table

Use the Manual Peaks table to view information about the manual peaks that you add to the 
result file.

The Manual Peaks table is a main table. It is also related to the main Specialized Traces table. 
To create this table, you must add a manual peak to a specialized trace (see “To manually 
integrate chromatographic peaks” on page 299).

Table 104.Input Files table

Column Description

Study File ID Displays the identification number assigned by the Compound 
Discoverer application.

File Name Displays the file name of the input file.

Creation Date Displays the acquisition time stamp from the data system.

RT Range [min] Displays the data acquisition time for the raw data file.

Instrument Name Displays the mass spectrometer type used to acquire the raw data 
file.

Software Revision Displays the software version of the instrument control software 
used to acquire the raw data file.

Instrument Hardware 
(hidden)

Displays the hardware version of the Thermo Scientific mass 
spectrometer or analog detector used to acquire the raw data file. 

Ref. File ID Displays the reference file that the retention time alignment 
algorithm used to align the landmark features.

Sample Type Displays the sample type.

Study Factors Displays the study factor value (item).
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Table 105 describes the columns in the Manual Peaks table.

Merged Features Table

Use the Merged Features table to view ion conflicts between the Features and Expected 
Features tables. Also use the Merged Features table to correlate the chromatographic peaks 
detected by an analog detector to the chromatographic peaks detected by the mass 
spectrometer.

The Merge Features Node adds the Merged Features table to the result file. The Merged 
Features table has the following primary related tables: Expected Compounds, Expected 
Compounds per File, Compounds, Compounds per File, and Manual Peaks. Figure 7 on 
page 23 shows the hierarchy of the result tables for a targeted analysis, and Figure 9 on 
page 27 shows the hierarchy of the result tables for an untargeted analysis. 

Table 105.Manual Peaks table 

Column Description

Trace Type Displays the trace type. The trace type can be any of the 
specialized traces, including Analog, UV, PDA, TIC, BPC, XIC, 
Pattern Trace, or FISh Trace.

Area Displays the chromatographic peak area.

Left RT [min] Displays the start point of the chromatographic peak.

Right RT [min] Displays the end point of the chromatographic peak.

Study File ID Displays the study file ID of the input file (see “Removing Input 
Files or Updating Their Location” on page 105).

Tip   When you add the Merge Features node to the processing workflow, the application 
automatically connects the Find Expected Compounds node and the Detect Compounds 
node to it. The Merge Features node consolidates the chromatographic peaks detected by 
these two nodes. 
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Table 106 describes the columns in the Merged Features table.

Table 106.Merged Features table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Name Use this column to describe or name the found chromatographic 
peak. To name the chromatographic peak, type alphanumeric text 
in the Name table cell.

Apex m/z Displays the area weighted average mass of all related features.

RT [min] Displays the area weighted average retention time of all related 
features (same m/z × RT dimensions within the specified 
tolerances).

Max. Area Displays the area of the largest chromatographic peak found in the 
data set for the current m/z × RT dimensions.

Ion Conflict Indicates whether there is a conflict between the Detect 
Compounds and Find Expected Compounds nodes.

( ) Green No conflict—Both nodes assigned the same ion to this 
chromatographic peak.

( ) Orange Missing unknown component—Not found by the Detect 
Compounds node. 

Indicates that the expected compound might be in doubt because 
the Detect Compounds node did not detect it.

( ) Gray No data to compare—The related node did not detect this ion.

( ) Red Either the two nodes assigned different ions or one of the nodes 
assigned more than one ion to this m/z value and retention time.

Detect Compounds Indicates whether the Detect Compounds node found the current 
feature in each input file.

( ) Gray No matches found

( ) Green Single match found

( ) Red Multiple matches found

m/z Area
m/z

-------------------------------

RT Area
RT

-------------------------------
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Specialized Traces Table

Use the Specialized Traces table to view traces created by the tracer nodes.

The Specialized Traces table lists the specialized traces that you requested in the processing 
workflow. For information about manually integrating chromatographic peaks in a specialized 
trace, see “To manually integrate chromatographic peaks” on page 299.

For information about the Chromatograms view, see “Working with the Chromatograms 
View” on page 294.

 To view a trace in the Chromatograms view

Select the trace of interest in the Specialized Traces table.

Table 107 describes the columns in the Specialized Traces table. 

Find Expected 
Compounds

Indicates whether the Find Expected Compounds node found the 
current feature in each input file.

( ) Gray No matches found

( ) Green Single match found

( ) Red Multiple matches found

Max. Areas (for each 
input file)

For each input file, displays the maximum chromatographic peak 
area for the features with the same m/z × RT dimensions (within 
the specified tolerances) found by the Find Expected Compounds 
node, the Detect Compounds node, or both nodes.

Note  The Differential Analysis node generates these columns: Group Areas, Ratio, and 
Log2 Fold Change. For information about these columns, see “Differential Analysis 
Columns” on page 432.

Comments Use this column to store comments about the current feature 
(unique m/z × RT dimensions). This column accepts 
alphanumeric text and special characters.

Table 106.Merged Features table  (Sheet 2 of 2)

Column Description

Table 107.Specialized Traces table (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
results table and in reports after you apply result filters. 

Study File ID Displays the study file ID of the input file (see “Removing Input 
Files or Updating Their Location” on page 105.
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Structure Proposals Table

Use the Structure Proposals table to store custom structure proposals for the selected 
compound or expected compound in the result file.

For information about adding structure proposals to the table, see “Adding and Deleting 
Proposed Structures for a Compound” on page 261.

Table 108 describes the columns in the Structure Proposals table.

Trace/Detector Type Displays the trace type generated during data processing.
• Create Mass Trace Node—TIC, BPC, or XIC 
• Create Analog Trace Node—UV Trace, Total Scan, Spectrum 

Maximum, Wavelength–Wavelength, or Analog trace 
• Create FISh Trace Node—FISh Trace 
• Create Pattern Trace Node—Pattern Trace 

Custom Label Displays the text that you entered in the Custom Label box for the 
processing workflow node that generated the trace.

You can edit the text in this column.

Description Displays a description of the trace.

Spectrum File Displays the file name of the raw data file that includes the trace.

Table 107.Specialized Traces table (Sheet 2 of 2)

Column Description

Table 108.Structure Proposals table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Structure Displays the structure of the compound (see “Modifying the 
Result Page Layout” on page 253).

Name Displays an application-generated name or a user-specified name 
for the compound. 

To edit this entry, click the table cell and type text in the box.

Formula Displays the elemental composition formula of the compound.

Molecular Weight Displays the molecular weight of the compound.
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Expected Compounds Result Tables
For information about the result tables for a targeted workflow with the Find Expected 
Compounds node, see these topics:

• Expected Compounds Table

• Expected Compounds per File Table

• Expected Features Table

• Expected Formulas Table

• Related Structures Table

• Transformations Table

Expected Compounds Table

Use the Expected Compounds table to view information about the targeted compounds that 
the analysis finds. This result table contains all of the expected compounds that the analysis 
found in the input file set. The compounds are grouped by formula, molecular weight, and 
retention time. 

The Group Expected Compounds Node adds the Expected Compounds table to the result 
file. The Descriptive Statistics post-processing node adds the descriptive statistics columns, 
and the Differential Analysis post-processing node adds the differential analysis columns 
(Ratio, Log2 Fold Change, P-value, and Adjusted P-value).

Table 109 describes the columns in the Expected Compounds table.

FISh Coverage Displays the FISh coverage score that is based on the proposed 
structure (see “FISh Scoring for Targeted Compounds and 
Proposed Structures” on page 36).

Comments Displays an application-generated comment or a user-specified 
comment for the compound.

To edit this entry, click the table cell and type text in the box.

Table 108.Structure Proposals table  (Sheet 2 of 2)

Column Description

Table 109.Expected Compounds table (Sheet 1 of 3)

Column Description

Checked Use this column to select the rows that you want to display in the 
results table and in reports after you apply result filters. 

Structure (hidden) Displays the structure of the compound if available.
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Name Displays the user-specified compound name.

To populate this cell, you can type a name or use the Edit 
Compound Annotation command.

Parent Compound Displays the selected compound for each Generate Expected 
Compounds node that you connected to the Find Expected 
Compounds node. Before you can select a specific compound in 
the Generate Expected Compounds node, you must first add it to 
the compound library (see “Importing, Exporting, and Deleting 
Compounds” on page 498).

Formula Displays the elemental formula of the parent compound and the 
theoretical formulas for the dealkylation and transformation 
products.

Molecular Weight Displays the molecular weight (MW) of the compound calculated 
from the formula (neutral mass). Expected compounds include 
the parent compounds and their theoretical dealkylation and 
transformation products.

Dealkylated When this column contains an X, the expected compound is the 
product of a dealkylation reaction.

Transformations Displays the chemical transformation for the expected compounds 
that have undergone any of the user-specified transformations.

Composition Change Displays the composition change caused by any dealkylation or 
dearylation reaction, any of the user-specified transformation 
reactions, or both.

RT (min) Displays the weighted average of the retention times for this 
chromatographic peak in the input file set.

RT Tolerance (min.) Displays the retention time tolerance setting in the Group 
Expected Compounds Node.

FISh Coverage Displays the FISh coverage score from the FISh Scoring Node (see 
“FISh Scoring for Targeted Compounds and Proposed Structures” 
on page 36).

Area (Max.) Displays the area of the largest chromatographic peak found for 
this compound (Formula × MW× RT) in the sample set. 

#Adducts (hidden) Displays the number of adducts found for this compound.

#MS2 (hidden) Displays the number of available MS2 scans for the compound. If 
the MS2 scans are not from an Identification Only sample, you 
can view them by selecting the rows in the related Expected 
Features table. 

Table 109.Expected Compounds table (Sheet 2 of 3)

Column Description
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Expected Compounds per File Table

Use the Expected Compounds per File table to review the expected compounds found in each 
input file. The uniqueness for each row is defined by the following expression: 

Parent Compound × Formula × MW × Dealkylations and Transformations × RT 

Clicking a row in the Expected Compounds per File table displays an XIC trace for the 
selected compound (Figure 120). The XIC trace is a summation of the related ion traces. The 
integrated peak area is shaded, the vertical red line indicates the chromatographic peak apex, 
and the triangle indicates the data point that corresponds to the retention time (RT) label. If 
the data has been chromatographically aligned (by using the Align Retention Times node), 
the RT values for the labeled data points might differ slightly from those for the closest MS1 
scan in the spectral tree.

Area (per input file) Displays the area for the compound (Formula × MW× RT) in 
each sample (input file).

To display the sample names, click the expand icon to the right of 
the column heading.

Note  See the following topics for information about the differential analysis columns and 
the hidden descriptive statistics columns.

• See “Descriptive Statistics Columns” on page 435 for information about the following 
columns: Min. Area, Median Area, Mean Area, Q1 Area, Q3 Area, Area CV%, and 
Area SD.

• See “Differential Analysis Columns” on page 432 for information about the following 
columns: Group Areas, Ratio, and Log2 Fold Change.

Table 109.Expected Compounds table (Sheet 3 of 3)

Column Description
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Figure 120. Expected compound trace for a single input file

The Find Expected Compounds Node creates the Expected Compounds per File table. The 
primary tables related to this table are as follows: Expected Compounds, Input Files, Expected 
Formulas, Merged Features, Expected Features, and Related Structures (see Figure 7 on 
page 23).

Table 110 describes the columns in the Expected Compound per File table. By default, some 
of these columns are hidden.

Table 110.Expected Compounds per File table (Sheet 1 of 3)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Parent Compound Displays the user-specified parent compound or compounds.

You specify the parent compound or compounds in the Generate 
Expected Compounds node or nodes.

Formula Displays the elemental formula of the expected compound.

Molecular Weight Displays the molecular weight (MW) of the expected compound.

Dealkylated Displays an X if the parent compound has undergone a 
dealkylation reaction.

Transformations Displays the chemical transformations for the expected 
compound.

Composition Change Displays the composition change caused by a dealkylation 
reaction, any of the user-specified transformation reactions, or 
both.

Red line that indicates the 
apex of the integrated 
chromatographic peak

Triangle indicating the data point that 
corresponds to the retention time label
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RT [min] Displays the apex retention time (in minutes) of the largest 
chromatographic peak that the node found for the expected 
compound.

The chromatographic peak is a composite peak of all of the ionic 
species (adduct ions) that the analysis found for the expected 
compound. The chromatographic peak area is the summed area of 
the adduct peaks.

FWHM [min] Displays the width of the chromatographic peak at its half-height. 
Use this value to determine the best RT tolerance for peak 
grouping.

Best SFit [%] Displays the best spectral fit value for the set of expected 
compound ions for the expected compound. The spectral fit value 
increases as the number of matching isotopes increases. 

Best SD (hidden) Displays the best spectral distance value between the theoretical 
and measured isotope pattern.

Max. #MI Displays the maximum number of matching isotopes for any of 
the expected compound ions. 

#Adducts Displays the number of detected adducts. The analysis only 
detects the adduct ions that you specified for the Ions parameter 
in the Generate Expected Compounds node. With the default 
setting of [M+H]+1 only, the application finds only this one 
adduct ion species for each compound.

Area Displays the summed chromatographic peak area for all of the 
expected compound ions (adducts) that make up the 
chromatographic peak.

To display the table of expected compound ions for the expected 
compound, show the related tables and click the Expected 
Features tab. 

Parent Area [%] Displays the area of the selected component (Parent Compound × 
Formula × MW × Dealkylations and Transformations × RT) as a 
percentage of the total chromatographic peak area for the related 
components (Parent Compound × Formula × MW × 
Dealkylations and Transformations). 

Table 110.Expected Compounds per File table (Sheet 2 of 3)

Column Description
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Expected Features Table

Use the Expected Features table to review the expected features (chromatographic peaks with 
the same m/z × RT dimensions) found across the input file set.

The Find Expected Compounds node creates the Expected Features table. 

Table 111 describes the columns in the Expected Features table.

File ID Displays the integer that the application assigned to the input file.

Study File ID Displays the study file ID of the input file (see “Removing Input 
Files or Updating Their Location” on page 105).

You can filter the data by using this integer; for example, the 
following filter reduces the table to the expected compounds 
found in one input file: Study File ID is equal to F1, F2, F3...F11, 
and so on.

Table 110.Expected Compounds per File table (Sheet 3 of 3)

Column Description

Table 111.Expected Features table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Ion Displays the ionized form of the compound.

Charge Displays the charge of the ion.

Molecular Weight Displays the molecular weight of the monoisotopic neutral 
compound.

m/z Displays the mass-to-charge ratio of the ion.

Mass [Da] Displays the mass difference, in daltons, between the theoretical 
mass of the ion and the measured mass.

Mass [ppm] Displays the mass difference, in ppm, between the theoretical mass 
of the ion and the measured mass.

RT [min] Displays the chromatographic retention time of the ion.

FWHM [min] Displays the width of the chromatographic peak at its half-height 
in minutes.

SFit [%] Displays the similarity score between the theoretical and measured 
isotope patterns as a percentage.

SD Displays the spectral distance score.

#MI Displays the number of matched isotopes for the ion.
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Expected Formulas Table

Use the Expected Formulas table to review the chemical formulas that the analysis found 
across the input file set. This table lists the theoretical compounds that the Generate Expected 
Compounds nodes predict by evaluating the effect of the user-specified dealkylation, 
dearylation, and transformation reactions on the user-specified parent compounds. 

Clicking a row in the Expected Formulas table displays overlaid XIC traces for the selected 
expected compound, with one XIC trace for each input file where the compound is detected. 
Each XIC trace is a summation of the ion traces for the same neutral elemental composition 
(same molecular weight). By default, the Chromatograms view zooms in on the x-axis range of 
the detected peaks for the same expected compound.

The Find Expected Compounds Node creates the Expected Formulas table, which has the 
following primary related tables: Expected Compounds, Input Files, Expected Compounds 
per File, Related Structures, and Transformations. 

For information about targeted processing workflows, see “Targeted Workflows for Expected 
Compounds” on page 16.

Table 112 describes the columns in the Expected Formulas table. 

Intensity Displays the maximum intensity of all the related peaks per input 
file.

Area Displays the summed area of all the related peaks (same expected 
compound) in the current input file.

Parent Area [%] Displays the chromatographic peak area of the current ion as a 
percentage of the total chromatographic peak area at the current 
retention time (within the specified tolerance) for the expected 
compound selected in the Expected Compounds per File table. 

File ID Displays the integer that the application assigned to the input file.

Study File ID Displays the study file ID of the input file (see “Removing Input 
Files or Updating Their Location” on page 105).

Table 111.Expected Features table  (Sheet 2 of 2)

Column Description

Table 112.Expected Formulas table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
results table and in reports after you apply result filters. 

Order (related table) When you select the Expected Formulas table that is related to the 
Transformations table, this column displays the order of the 
selected transformation.
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Related Structures Table

There is a Related Structures table for each feature in the Expected Features table and each 
compound in the Expected Compounds per File table. The Related Structures table shows the 
structure of the product compound generated by the dealkylation reaction.

 To open the Related Structures table

1. Open a result file from a targeted analysis (Find Expected Compounds node).

2. Select a row in one of these tables—Expected Features or Expected Compounds per File.

Parent Compound Displays the selected compound for each Generate Expected 
Compounds node that you connected to the Find Expected 
Compounds node. Before you can select a specific compound in 
the Generate Expected Compounds node, you must first add it to 
the compound library (see “Importing, Exporting, and Deleting 
Compounds” on page 498).

Formula Displays the elemental formula of the parent compounds and the 
theoretical formulas for the dealkylation and transformation 
products.

Molecular Weight Displays the molecular weight (MW) of the expected compound. 
Expected compounds include the parent compounds and their 
theoretical dealkylation and transformation products.

Dealkylated When this column contains an X, the expected compound is the 
product of a dealkylation reaction.

Transformations Displays the chemical transformation for the expected compounds 
that have undergone any of the user-specified transformations.

Composition Change Displays the composition change caused by any dealkylation or 
dearylation reaction, any of the user-specified transformation 
reactions, or both.

Area (Max.) Displays the maximum summed chromatographic peak area for 
the expected formula in one of the input files. 

• When the result file contains data from only one input file, 
this area matches the summed chromatographic peak area for 
the expected formula.

• When the result file contains data from more than one input 
file, this area comes from the input file with the largest 
summed chromatographic peak area for the expected formula.

Table 112.Expected Formulas table  (Sheet 2 of 2)

Column Description
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3. Click Show Related Tables.

4. Click the Related Structures tab.

Table 113 describes the columns in the Related Structures table.

Transformations Table

Use the Transformations table to review the transformations for each formula in the Expected 
Formulas table. Figure 7 on page 23 shows the relationship between the Expected Formulas 
table and the Transformations table.

Table 114 describes the columns in the Transformations table.

Table 113. Related Structures table 

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Parent Compound Displays the user-specified parent compound or compounds.

Formula Displays the chemical formula of the parent compound or the 
theoretical transformed compounds.

Molecular Weight Displays the molecular weight (MW) of the parent compound or 
theoretical reaction product.

Dealkylated Displays an X if the parent compound has undergone a 
dealkylation reaction.

Composition Change Displays the composition change caused by any dealkylation 
reaction. 

Structure If a compound is the result of transformations that include a 
dealkylation step, this column displays the product of the 
dealkylation step. Otherwise, this column displays the structure of 
the parent compound. 

Table 114.Transformations table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Name Displays the name of the transformation.

Phase Displays the Phase assignment for the transformation.

Leaving Group Displays the leaving group for the transformation.

Arriving Group Displays the arriving group for the transformation.
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Compound Detection Result Tables
For information about the result tables for the Compound Detection nodes, see these topics, 
listed in alphabetical order:

• Compounds Table

• Compounds per File Table

• Features Table

• Filled Gaps Table

• Labeled Features Table

• Labeled Compounds per File Table

• Similar Compounds (Beta) Related Table

Compounds Table

Use the Compounds table to review the unknown compounds found across the input file set.

The Group Compounds Node creates the Compounds table.

Clicking a row in the Compounds table displays XIC traces for the selected unknown 
compound, with one XIC trace for each input file. Each XIC trace is the summation of all the 
related ion traces. The summed XIC trace is made up of the data points with the highest 
intensity at each time point. 

Mass [Da] Displays the neutral mass shift for the transformation in daltons.

Order Displays when the transformation was applied in the reaction 
pathway. 

Range: An integer from 1 to the user-specified maximum number 
of steps.

Table 114.Transformations table  (Sheet 2 of 2)

Column Description

Tip  To view the related traces for each XIC trace, do the following:

1. Select a row in the Compounds table. 

2. In the first set of related tables, select a row in the Compounds per File table.

3. In the second set of related tables, open the Features table.
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For information about exporting the compounds as a TXT or CSV file, see “Exporting the 
Tabular Results to an External File” on page 277. To edit the annotations, see “Editing 
Compound Annotations” on page 259.

Table 115 describes the columns in the Compounds table, with the additional columns in the 
related Compounds tables described at the end.

Table 115. Compounds table  (Sheet 1 of 8)

Column Description

Checked Specifies the rows that you want to display in the result table and 
in reports after you apply result filters. 

Structure (hidden) Displays the structure of the compound. 

The structure field is populated if any of the searches returns a 
structure or you edit the annotations.

Name When the processing workflow includes a search node, this 
column displays the compound name from the best match in the 
searched databases. 

Formula Displays the predicted chemical formula for the neutral 
compound. For the analysis to predict and display a chemical 
formula for all compounds in the table, the processing workflow 
must include the Predict Compositions Node and the Assign 
Compound Annotations Node. When the processing workflow 
includes any of the search nodes, the Assign Compound 
Annotations node assigns the formula by using the specified 
priority for the data sources. The default priority for the data 
sources is (1) mzCloud Search, (2) Predicted Compositions, (3) 
Mass List Match, (4) ChemSpider Search.
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Annotation Source Displays colorized rectangles that represent the match status for 
the selected compound from the search nodes in the processing 
workflow. The expanded column heading displays the annotation 
sources.

The Assign Compound Annotations node determines the validity 
of the annotations from the Predict Compositions node and the 
search nodes in the processing workflow.

Possible states for each annotation source:

( ) Green—Full Match—The current formula and structure 
annotations match the best available item from the particular 
source (online database or local mass list).

( )Gray—No Results—Retrieved no data from the particular 
source.

( ) Orange—Not the Top Hit—Current compound annotation 
matches one of the hits, but not the top one.

( ) Orange—Partial Match—Only the formula for the current 
compound annotation matches the items retrieved from the 
particular source.

( ) Orange—Unused—Retrieved items from the particular 
source, but did not assign any annotations.

( ) Red—Invalid mass—The best available item from the 
particular source has a molecular weight that does not match the 
molecular weight of the compound within the specified mass 
tolerance. 

( ) Red—No match—The particular source does not have an 
item that matches the current annotations for the compound.

FISh Coverage Displays the FISh Coverage score for a custom annotation (see 
“Editing Compound Annotations” on page 259 and “FISh 
Scoring for Targeted Compounds and Proposed Structures” on 
page 36). 

Molecular Weight Displays the molecular weight of the neutral compound.

RT [min] Displays the retention time of the chromatographic peak for the 
compound.

RT Tolerance [min]
(hidden)

Displays the retention time tolerance specified in the Group 
Compounds node.

Table 115. Compounds table  (Sheet 2 of 8)

Column Description
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Area (Max.) Displays the maximum chromatographic peak area from all of the 
input files for compounds with the same retention time and 
molecular weight (within the user-specified RT and mass 
tolerances). 

The Normalize Areas Node and an input file set with QC samples add these columns to the 
result table: #Usable QC, RSD QC Areas [%], RSD QC Areas [%], QC Fill Status, and 
Norm. Areas.

For information about the batch normalization process, see “Quality Control Samples for 
Batch Normalization” on page 34.

To view the area correction for a compound, select the compound and choose View > 
Compound Area Correction (see “Viewing the QC-Based Compound Area Correction 
Curves” on page 367).

# Usable QC Displays the number of usable QC samples (see Quality Control 
Samples for Batch Normalization). 

RSD QC Areas [%] Displays the relative standard deviation of the peak areas for the 
compound across the QC samples before area correction.

RSD Corr. QC Areas 
[%]

Displays the relative standard deviation of the peak areas for the 
compound across the QC samples after area correction.

QC Fill Status
(hidden)

Displays a status rectangle for each QC sample.

Possible states:

 Green—Filled by re-detected peak

 Gray—N/A

 Orange—Filled by matching ion

 Blue—Filled by simulated peak

Norm. Areas (Normalize Areas node) Displays the normalized peak areas for the 
compound in each input file.

#ChemSpider Results (Search ChemSpider Node) Displays the number of matching 
compounds found by the ChemSpider search for the current 
composition or molecular weight. 

Use the related ChemSpider Results Table to investigate the 
matching compounds.

Mass Defect (Calculate Mass Defect node) Displays the compound’s calculated 
mass defect. 

Table 115. Compounds table  (Sheet 3 of 8)

Column Description
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#mzCloud Results (Search mzCloud Node) Displays the number of matching 
compounds found by the mzCloud search for this molecular 
weight.

Use the related mzCloud Results Table to investigate the matching 
compounds.

#Similarity Results 
(hidden)

Displays the number of similarity results from the Apply mzLogic 
node.

#mzVault Results (Search mzVault Node) Displays the number of matching 
compounds found by the mzVault search for this molecular 
weight.

Use the related mzCloud Results Table to investigate the matching 
compounds.

mzCloud Best Match (Search mzCloud Node) Displays the best match score from the 
mzCloud identity search for the compound. 

Use the related mzCloud Results Table to investigate the matching 
compounds.

mzCloud Best Sim 
Match

(Search mzCloud Node) Displays the best similarity score from 
the mzCloud similarity search for the compound.

Available when the Similarity Search parameter for the Search 
mzCloud node is set to Similarity Forward or Similarity Reverse.

With the factory default setting, this column is the rightmost 
column in the table. Applying the Identification layout moves this 
column to the right of the mzCloud Best Match column.

Use the related mzCloud Results Table to investigate the matching 
compounds.

mzCloud Library 
Matches

Displays colorized rectangles that represent the match status for 
the compound in the selected mzCloud databases. 

Possible states for each database:

( ) Green—Single match found

( )Gray—No matches found

( ) Red—Multiple matches found

Table 115. Compounds table  (Sheet 4 of 8)

Column Description
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#Pathways (for any of 
the Map to Pathway 
nodes)

Displays the number of pathways that include the current 
compound.

See Map to Metabolika Pathways Node, Map to BioCyc Pathways 
Node, or Map to KEGG Pathways Node.

Pathways Displays whether the current compound is present in the named 
pathway.

To display the pathway names, click the expand icon to the right 
of the column name.

See Map to Metabolika Pathways Node, Map to BioCyc Pathways 
Node, or Map to KEGG Pathways Node.

Mass List Matches (Search Mass Lists Node) Indicates the match status for each mass 
list.

( ) Green—Single match found

( ) Red—Multiple matches found

( ) Gray—No matches found

Use the related Mass List Search Results Table to investigate the 
matching compounds.

mzVault Library 
Matches

(Search Mass Lists Node) Indicates the match status for each 
library.

( ) Green—Single match found

( ) Red—Multiple matches found

( ) Gray—No matches found

Use the related mzVault Results Table to investigate the matching 
compounds.

Class Coverage Displays the class coverage score for the compound. Expand the 
header to display the names of the compound class libraries.

#Adducts (hidden) Displays the number of adduct ions that the analysis found for the 
compound.

Pattern Matches (Pattern Scoring Node) Displays an orange rectangle when the 
compound matches the specified isotope pattern.

Use the related Matched Patterns Table to investigate the matched 
isotope pattern.

Table 115. Compounds table  (Sheet 5 of 8)

Column Description
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Labeling Status

(per file)

The Analyze Labeled Compounds Node evaluates the measured 
isotope pattern versus the fitted isotope pattern (for the expected 
isotopologues) to determine the presence of contaminating 
masses. It also evaluates the distribution of the measured exchange 
rates for the expected isotopologues. If the distribution is not 
continuous, for example, if the compound has three exchangeable 
atoms and chromatographic peak area for the M+2 isotopologue is 
significantly less than the chromatographic peak area for the M+1 
and M+3 isotopologues, the node assigns an Irregular Exchange 
status to the input file.

These flags indicate the following states:

( ) Red—Contaminating Mass—The average exchange for the 
unlabeled sample is above the 0.1 threshold.

( ) Orange—Low Pattern Fit—The measured pattern 
significantly differs from the fitted pattern. The SFit value is 
below the threshold of 20%, the Fitted Coverage value is below 
the threshold of 60%, or the Measured Coverage value is below 
threshold of 60%. To review these values, see the Labeled Features 
table.

( ) Blue—Irregular Exchange—The isotopologue exchange rates 
are discontinuous; for example, there is a significant valley in the 
exchange rates profile. This might indicate an incorrect analysis or 
a special type of kinetics. However, if this is the typical behavior 
expected for your experiments, consider changing the setting for 
Mark Irregular Exchanges in the Analyze Labeled Compounds 
node to False. 

( ) Green—No Warnings—The measured isotope patterns and 
the exchange rates are within acceptable limits.

( ) Gray—Compound was not detected in this sample.

Avg. Exchange Average number of atoms exchanged for compound detected in 
input file. 

Table 115. Compounds table  (Sheet 6 of 8)

Column Description
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Rel. Exchange [%] Average exchange relative to the maximum exchange rate. 

100 × Average Exchange/Max. Exchange 

MS2 Displays whether the analysis found data-dependent 
fragmentation scans for the compound. 

( ) Red—No MSn—There are no available MSn scans.

( ) Green—ddMS2 for preferred ion—There is at least one 
data-dependent MS2 scan for the preferred adduct ion.

( ) Blue—ddMS2 for other ion—There is at least one 
data-dependent MS2 scan, but the scans are not for the preferred 
adduct ion.

( )Orange—DIA only—Only data independent [all ions 
fragmentation (AIF)] scans are available.

Background (Mark Background Compounds Node–Unknown Compounds) 
Displays a selected or clear check box that indicates whether the 
compound was also found in the Blank sample above the 
user-specified Sample/Blank or Blank/Sample level. 

• Selected—Indicates that the compound is a background 
compound.

• Clear—Indicates that the compound is not a background 
compound.

Area (one column for 
each input file) 
(hidden)

Displays an area column for each input file.

To display the areas for each input file, click the expand icon to 
the right of the column name.

Gap Status (hidden) (Fill Gaps node) 

( ) Purple—Indicates some missing ions (but not a full gap). 

( ) Gray—Indicates a full gap.

( ) Green—Indicates a compound without any gap.

Table 115. Compounds table  (Sheet 7 of 8)

Column Description
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Note  See the following topics for information about the differential analysis columns and 
the hidden descriptive statistics columns.

• See “Descriptive Statistics Columns” on page 435 for information about the following 
columns: Min. Area, Median Area, Mean Area, Q1 Area, Q3 Area, Area CV%, and 
Area SD.

• See “Differential Analysis Columns” on page 432 for information about the following 
columns: Group Areas, Ratio, and Log2 Fold Change.

The following three columns appear in the related Compounds table for the main KEGG 
Pathways table. Each column contains an ordered list for the same KEGG compounds—
that is, the first item in the KEGG Compound IDs column corresponds to the first item in 
the KEGG Compound Names column and the first item in the KEGG Compound 
Formula column, and so on.

KEGG 
Compound IDs 

Displays a list of the KEGG compound IDs in ascending order 
from left to right.

KEGG 
Compound Names 

Displays a list of the KEGG compound names.

KEGG 
Compound 
Formulas 

Displays a list of the KEGG compound formulas.

The following two columns appear in the related Compounds table for the main KEGG 
Pathways table and the search results tables.

Max. Mass [Da] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in daltons. 

Max. Mass [ppm] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in parts per million.

This column appears in the Compounds table that is related to the mzCloud Search Result 
table.

Scan Number Displays the scan number of the scan that matches the reference 
scan in the mzCloud database.

Table 115. Compounds table  (Sheet 8 of 8)

Column Description
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Compounds per File Table

Use the Compounds per File table to review the compounds detected in each input file. 

Table 116 describes the columns in the Compounds per File table.

Features Table

Use the Features table to review the features detected across the input file set.

The Detect Compounds Node adds the Features table to the result file.

Table 117 describes the columns in the Features table.

Table 116.Compounds per File table

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Clear: False  Selected: True

Molecular Weight Displays the molecular weight of the neutral compound.

RT [min] Displays the retention time at the chromatographic peak apex for 
the adduct ion that contributes the most area to the 
chromatographic peak.

FWHM [min] Displays the width of the chromatographic peak at its half-height. 
Use this value to determine the best RT tolerance for peak 
grouping.

Max #MI Displays the number of matching isotope peaks.

#Adducts Displays the number of adduct ions.

Area Displays the chromatographic peak area in counts * minutes.

Table 117. Features table (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Ion Displays the ion definition of the molecular ion adduct.

Charge Displays the charge on the ion.

Molecular Weight Displays the molecular weight of the unknown compound.

m/z Displays the mass-to-charge ratio of the ion.

RT [min] Displays the retention time in minutes of the chromatographic 
peak that contains the unknown compound ion.
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Filled Gaps Table

Use the Filled Gaps table to review the chromatographic peaks (Full Gap or Missing Ion) that 
the Fill Gaps node finds. The Filled Gaps table is related to the Compounds table. 

By default, the Filled Gaps table is hidden. To display the table, click the Select Table 
Visibility icon, , select the Filled Gaps check box, and click OK.

The Gap Status column, hidden by default in the Compounds table, identifies the 
chromatographic peaks that the Fill Gaps node finds as Full Gap or Missing Ion peaks and 
those that the standard peak detection process finds as No Gap peaks. 

Table 118 describes the columns in the Filled Gaps table.

#MI Displays the number of matching isotopes for the unknown 
compound ion.

Intensity (hidden) Displays the intensity of the ion.

Area Displays the area of the chromatographic peak that contains the 
unknown compound ion.

Parent Area [%] Displays the chromatographic peak area of the current peak as a 
percentage of the total chromatographic peak area for the parent 
compound (which is the compound selected in the Compounds 
per File table) per input file.

File ID Displays the integer that the application assigned to the input file.

Study File ID Displays the study file ID of the input file.

Table 117. Features table (Sheet 2 of 2)

Column Description

Table 118. Filled Gaps table (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Ion Description Displays a description of the adduct where M is the neutral 
compound.

Charge Displays the ion’s charge.

Exp. m/z Displays the m/z value for the adduct ion found in the other input 
files. This value is based on the adduct type and the compound’s 
molecular weight.

Exp. RT [min] Displays the average retention time of the adduct ion found in the 
other input files. 
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Labeled Features Table

Table 119 describes the columns in the Labeled Features table. The labeled features are the 
labeled adduct ions.

Exp. Left RT [min] Displays the average peak start time of the detected 
chromatographic peaks for the adduct ion in all the input files 
included in the analysis.

Exp. Right RT [min] Displays the average peak end time of the detected 
chromatographic peaks for the adduct ion in all the input files 
included in the analysis. 

Exp. FWHM [min] Displays the average peak width at the peak’s half height (full 
width at half maximum) for the adduct ion in all the input files 
included in the analysis.

Area Displays the area of the chromatographic peak found by the Fill 
Gaps node.

Fill Status The possible states for the chromatographic peak detected or 
redrawn by the Fill Gaps node are as follows:

• ( ) Green (Filled by Simulated Peak or Filled by Re-detected 
Peak)—The chromatographic peak was detected with the 
PPD algorithm (set to a lower threshold than in the Detect 
Compounds node) or the peak was simulated with a Gaussian 
fit algorithm.

• ( ) Blue (Filled by Spectrum Noise)—The gap was replaced 
with a chromatographic peak based on the spectrum noise 
level. 

• ( ) Orange (Filled by Matching Ion)—The gap was replaced 
with a chromatographic peak for a matching ion. 

File ID Displays the integer that the application assigned to the input file.

Study File ID Displays the study file ID of the input file

Table 118. Filled Gaps table (Sheet 2 of 2)

Column Description

Table 119. Labeled Features table (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Ion Displays the ion definition of the molecular ion adduct.

Charge Displays the charge on the ion.
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Molecular Weight Displays the molecular weight of the unknown compound.

m/z Displays the mass-to-charge ratio of the ion.

RT [min] Displays the retention time in minutes of the chromatographic 
peak that contains the unknown compound ion.

FWHM [min] Displays the width of the chromatographic peak for the adduct 
ion at its half-height in minutes. 

Intensity (hidden) Displays the intensity of the ion.

Area Displays the area of the chromatographic peak that contains the 
unknown compound ion.

Parent Area [%] Displays the chromatographic peak area of the current peak as a 
percentage of the total chromatographic peak area for the parent 
compound (compound selected in the Compounds per File table) 
per input file.

Max. Exchange Displays the maximum number of atoms considered for 
isotopologue evaluation.

Avg. Exchange Displays the average number of atoms exchanged for the ion.

Rel. Exchange [%] Displays the relative number of atoms exchanged versus the 
maximum number of exchangeable atoms for the feature’s 
elemental composition.

Exchange Rate [%] Displays the exchange rate for individual isotopologues.

#MI Displays the number of matching isotopes for the unknown 
compound ion.

SFit [%] Displays the spectral similarity score between the measured and 
theoretical isotope pattern.

Fitted Cov. [%] Displays the how well the intensities of the fitted isotope pattern 
match those of the theoretical isotope pattern.

Measured Cov. [%] Displays the how well the intensities of the measured isotope 
pattern match those of the theoretical isotope pattern.

File ID Displays the integer that the application assigned to the input file.

Study File ID Displays the study file ID of the input file (see “Removing Input 
Files or Updating Their Location” on page 105).

Table 119. Labeled Features table (Sheet 2 of 2)

Column Description
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Labeled Compounds per File Table

Table 120 describes the columns in the Labeled Compounds per File table. The related table 
displays details about the selected compound in the higher level table. To view the compound 
name for a component in the main Labeled Compound per File table, open its related 
Compounds table.

Table 120. Labeled Compounds per File table

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Molecular Weight Displays the molecular weight of the unknown compound.

RT [min] Displays the retention time in minutes of the chromatographic 
peak that contains the unknown compound ion.

FWHM Displays the width of the chromatographic peak for the adduct 
ion at its half-height in minutes.

Max. #MI Displays the maximum number of matching isotope peaks.

#Adducts Displays the number of adducts (features).

Area Displays the area of the chromatographic peak that contains the 
unknown compound ion.

Max. Exchange Shows the maximum number of exchangeable atoms that the 
analysis considered.

Avg. Exchange Displays the average number of atoms exchanged for the ion.

Rel. Exchange [%] Displays the relative number of atoms exchanged versus the 
maximum number of exchangeable atoms.

Status The Analyze Labeled Compounds Node evaluates the measured 
isotope pattern versus the fitted isotope pattern (for the expected 
isotopologues) to determine the presence of contaminating 
masses. It also evaluates the distribution of the measured exchange 
rates for the expected isotopologues. 

For information about the status flags, see “Labeling Status” on 
page 407.

Exchange Rate [%] Displays the contribution of individual isotopologues to the final 
measured pattern.

File ID Displays the integer that the application assigned to the input file.

Study File ID Displays the study file ID of the input file.
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Similar Compounds (Beta) Related Table

Use the Similar Compounds (Beta) table to review the compounds that the application 
connected to the detected compound in the Compounds table.

The Similar Compounds (Beta) table is generated by the Generate Molecular Networks node.

Table 121 describes the columns in the Similar Compounds table.

Table 121. Similar Compounds table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

Direction Displays the direction in which the transformation was 
applied, and defines which compound is a substrate and 
which is a product.

Forward—The selected compound acts as a substrate to 
which the transformation was applied. The connected similar 
compound is a product of the transformation.

Reverse—The selected compound is a product of the 
transformation. The connected similar compound acts as a 
substrate to which the transformation was applied.

Mass Shift [Da] Displays the difference between the measured molecular 
weights of the two compounds.

Composition Change Displays the difference between the elemental compositions 
of the two compounds.

Transformations Displays the name of assigned transformation pathway—that 
is, this column lists the names of the individual steps. 
Displays “Isomer” when the elemental composition of the 
substrate and product compounds are identical.

Transformation Mass [Da] Displays the total theoretical mass of the assigned 
transformation steps in Daltons.

# Fragments Displays the number of fragments available for the selected 
compound.

MSn Score Displays the final spectral similarity score between the two 
compounds as the average of the forward and reverse 
coverages.

Forward Cov. [%] Displays the relative number of matched centroids in the 
product compound’s MSn spectra.

Forward Matches Displays the number of matched centroids in the product 
compound’s MSn spectra.



10 Reviewing the Tabular Result Data
Compound Identification Result Tables

416 Compound Discoverer User Guide Thermo Scientific

Compound Identification Result Tables
For information about the result tables for the Compound Identification workflow nodes, see 
these topics:

• ChemSpider Results Table

• Mass List Search Results Table

• mzCloud Results Table

• mzVault Results Table

• Predicted Compositions Table

ChemSpider Results Table

Use the ChemSpider Results table to review the compounds found in the ChemSpider 
databases. The Search ChemSpider Node creates the ChemSpider Results table.

 To open the ChemSpider information for a specific ChemSpider hit

Click the link in the CSID column.

The ChemSpider web page for the selected hit opens in your default web browser.

Table 122 describes the columns in the ChemSpider Results table.

Reverse Cov. [%] Displays the relative number of matched centroids in the 
substrate compound’s MSn spectra. 

Reverse Matches Number of matched centroids in the substrate compound’s 
MSn spectra.

Table 121. Similar Compounds table  (Sheet 2 of 2)

Column Description

Table 122.  ChemSpider Results table (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Name Displays the name of the compound hit in the ChemSpider 
database.

Structure Displays the molecular structure of the compound.

Formula Displays the chemical formula of the compound.
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Molecular Weight Displays the molecular weight of the compound to five decimal 
places.

CSID Displays the ChemSpider identification number.

#References Displays the number of references for the compound in the 
ChemSpider database.

Additional hidden columns

SMILES (hidden) Displays the compound’s molecular structure by using short 
ASCII strings. SMILES stands for simplified molecular input line 
entry System.

InChi (hidden) Displays the international chemical identifier for the compound.

#Data Sources 
(hidden)

Displays the number of ChemSpider data sources that include the 
compound.

#PubMed References 
(hidden)

Displays the number of PubMed references for the compound. 
You can use a PubMed reference to access the scientific literature.

AlogP (hidden) Displays the AlogP value for the compound. The AlogP value is a 
measure of the compound’s hydrophobicity, where P is the 
partition coefficient.

#RSC (hidden) Displays the number of Royal Society of Chemistry references for 
the compound.

XlogP (hidden) Displays the XlogP value for the compound. The XlogP value is a 
measure of the compounds hydrophobicity, where P is the 
partition coefficient.

Additional columns in the related ChemSpider Results table

Compound Match Indicates the match status between the current item and the 
assigned compound annotation. For color-coding information, see 
“Annotation Source” on page 403.

Mass [Da] Displays the mass difference in daltons between the search mass 
and the mass of the matching compound in the ChemSpider 
database.

Mass [ppm] Displays the mass difference in ppm between the search mass and 
the mass of the matching compound in the ChemSpider database.

SFit[%] Displays the spectral similarity score from the Apply Spectral 
Distance node.

Table 122.  ChemSpider Results table (Sheet 2 of 2)

Column Description



10 Reviewing the Tabular Result Data
Compound Identification Result Tables

418 Compound Discoverer User Guide Thermo Scientific

Mass List Search Results Table

Use the Mass List Search Results table to review the compounds in the selected mass lists that 
match the compounds detected by the Detect Compounds node.

The Search Mass Lists Node creates the Mass List Search Results table.

The main Mass List Search Results table displays all of the compounds in the selected mass 
lists that match the compounds detected by the untargeted analysis. The related Mass List 
Search Results table lists information about the compound selected in the main Compounds 
Table.

Table 123 describes the columns in the Mass List Search Results table.

Table 123. Mass List Search Results table (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Formula Displays the elemental composition of the compound in the mass 
list. 

Molecular Weight Displays the molecular weight of the compound in the mass list.

RT [min] Displays the chromatographic retention time (if available) of the 
compound in the mass list. 

Structure Displays the structure (if available) of the compound in the mass 
list.

Name Displays the name of the compound in the mass list.

Annotation Displays additional information about the compound in the mass 
list.

Reference List Name Displays the name of the mass list that contains the matching 
compound. 

Additional columns in the related Mass List Search Results table 

Compound Match Indicates the match status between the current item and the 
assigned compound annotation. For color-coding information, see 
“Annotation Source” on page 403.

Max. Mass [Da] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in daltons. 
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mzCloud Results Table

Use the mzCloud Results table to view the results of an mzCloud search.

The Search mzCloud Node creates the mzCloud Results table.

Selecting a row in the mzCloud Results table displays a mirror plot with the selected 
fragmentation scan on the top and the matched reference scan from the mzCloud database on 
the bottom. Figure 121 shows a mirror plot with structure annotations. The centroids for the 
matching fragments are displayed as green sticks with a green circle at the end. Red circles on 
the x-axis indicate the m/z values of the missing fragments. 

Figure 121. Mass Spectrum view with an annotated mirror plot

Max. Mass [ppm] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in parts per million.

SFit[%] Displays the spectral similarity score from the Apply Spectral 
Distance node.

Table 123. Mass List Search Results table (Sheet 2 of 2)

Column Description

Note  By default, the Search mzCloud node does not annotate the matching fragments. To 
annotate the matching fragments, you must enable this feature—that is, you must set the 
node’s Annotate Matching Fragments parameter to True.

Scan information
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Table 124 describes the columns in the mzCloud Results table.

Table 124. mzCloud Results table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Structure Displays the structure of the matching compound.

Name Displays the compound name in the mzCloud database.

Formula Displays the elemental composition formula of the matching 
compound.

Molecular Weight Displays the molecular weight of the matching compound.

Best Match Displays the match value (0–100%) between the best 
fragmentation scan for a compound (across the input files) and 
the matching mzCloud spectrum (mzCloud ID). The related 
Compounds tables lists the scan number of the best fragmentation 
scan.

Best Sim. Match Displays the best match score for a library spectrum to a 
fragmentation scan across the input files. The related Compounds 
tables lists the scan number of the similar fragmentation scan.

mzCloud ID Displays the mzCloud ID (Database-Number) for the matching 
compound. Clicking this link opens the mzCloud database to the 
matching compound’s reference spectrum.

KEGG ID Displays the KEGG ID for the compound in the KEGG database.

Compound Class Displays the mzCloud compound classes that include the 
compound.

mzCloud Library Displays the name of the database where the search found the 
matching spectrum.

Additional columns in the related mzCloud Results table

Compound Match Indicates the match status between the current item and the 
assigned compound annotation. For color-coding information, see 
“Annotation Source” on page 403.

Searched with Mass 
[Da]

Displays the maximal difference between the theoretical and 
measured mass in Da.

mzCloud Library Displays the name of the mzCloud database where the search 
found the matching scan.

Intensity Threshold Displays the relative intensity threshold for the search spectrum.

Mass [Da] Displays the difference between the theoretical mass of the 
matching compound and the observed mass of the unknown 
compound in daltons.
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Related Topics

• Search mzCloud Node 

mzVault Results Table

Use the mzVault Results table to review the results of an mzVault search.

The Search mzVault Node creates the mzVault table.

Table 125 describes the columns in the mzVault Results table.

Mass [ppm] Displays the difference between the theoretical mass of the 
matching compound and the observed mass of the unknown 
compound in parts per million.

Type Displays the search type: Identify or Similarity.

Scan Number Displays the scan number from the input files that contains the 
best matching fragmentation spectrum.

Match Displays the match value (0–100%) between the specified scan 
number from the input files and the matching spectrum in the 
mzCloud database.

Table 124. mzCloud Results table  (Sheet 2 of 2)

Column Description

Table 125. mzVault Results table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Structure Displays the structure of the matching compound.

# Related Compounds Displays the number of unknown compounds with the same 
putative elemental composition but different retention times.

mzVault ID Displays the ID number of the matching compound in the 
mzVault library.

Name Displays the name of the matching compound.

Formula Displays the elemental composition formula of the matching 
compound.

Molecular Weight Displays the molecular weight of the matching compound.

Best Match Displays the match value (0–100%) between the best 
fragmentation scan for a compound (across the input files) and 
the matching mzVault spectrum. The related Compounds table 
lists the scan number of the best fragmentation scan.
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Predicted Compositions Table

Each compound in the Compounds table has a related Predicted Compositions table.

Use the Predicted Compositions table to review the possible chemical formulas for the 
selected compound in the Compounds table. The Predicted Compositions tables lists the 
possible chemical formulas based on the compound’s molecular weight.

The Predict Compositions Node creates the Predicted Compositions table.

mzVault Library Displays the name of the mzVault library where the analysis found 
a matching compound.

ChemSpider ID Displays the ChemSpider ID number for the matching 
compound. Clicking this link opens the ChemSpider database to 
the compound’s record.

Compound Class Displays the mzVault compound class that includes the 
compound. 

mzCloud ID Displays the mzCloud ID for the matching compound in the 
mzCloud database. Clicking this link opens the mzCloud database 
to the compound’s record.

KEGG ID Displays the KEGG ID for the matching compound in the 
KEGG database. Clicking this link opens the KEGG database to 
the compound’s record.

Additional columns in the related mzVault Results table

Compound Match Indicates the match status between the current item and the 
assigned compound annotation. For color-coding information, see 
“Annotation Source” on page 403.

Mass [Da] Displays the difference between the theoretical mass of the 
matching compound and the observed mass of the unknown 
compound in daltons.

Mass [ppm] Displays the difference between the theoretical mass of the 
matching compound and the observed mass of the unknown 
compound in parts per million.

Scan Number Displays the scan number from the input files that contains the 
best matching spectrum.

Match Displays the match value (0–100%) between the specified scan 
number from the input files and the matching spectrum in the 
mzVault database.

Table 125. mzVault Results table  (Sheet 2 of 2)

Column Description
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Table 126 describes the columns in the Predicted Compositions result table. 

Table 126. Predicted Compositions table  (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Compound Match Displays whether the predicted composition matches the currently 
assigned compound annotation.

( ) Red rectangle—No Match

( ) Green rectangle—Full Match

Formula Displays the predicted elemental composition.

Molecular Weight Displays the molecular weight.

Mass [Da] Displays the difference between the theoretical mass and the 
measured mass in daltons.

Mass [ppm] Displays the difference between the theoretical mass and the 
measured mass in ppm.

RDBE Displays the rings and double bonds equivalent value for the 
predicted composition.

H/C Displays the ratio of hydrogen to carbon atoms in the predicted 
composition.

Rank Displays the rank order of each composition.

#Matched Iso. Displays the number of matching isotopes.

#Missed Iso. Displays the number of isotopes that were missing in the 
measured isotope pattern as compared to the theoretical pattern 
for the predicted composition.

#Matched Fragments When the Use Fragments Matching algorithm is turned on in the 
Predict Compositions node, this column displays the number of 
centroids (m/z values) in the best MS2 scan that match possible 
fragments (mass values from a subset of the elemental 
compositions in the predicted composition).

SFit [%] Displays the spectral similarity score between the theoretical and 
the measured isotope pattern as a percentage.

The SFit [%] score = (1–SD) ×  100

SD (hidden) Displays the spectral distance score. A lower SD score corresponds 
to a higher SFit [%] score.

Range: 0 to 1
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Pathway Mapping Result Tables
For information about the result tables for the Pathway Mapping nodes, see these topics:

• BioCyc Pathways Table

• BioCyc Results Table

• KEGG Pathways Table

• Metabolika Pathways Table

• Metabolika Results Table

Pattern Cov. (%) Displays the summed intensity of the matching isotope peaks in 
the measured MS1 spectrum relative to the summed intensity of 
the theoretical isotope pattern.

Provides a quantitative measure of how well the measured isotope 
pattern matches the theoretical isotope pattern.

Note  Because the base peak (leftmost peak) is typically 
responsible for most of the pattern intensity, even a small 
decrease in the percent coverage might be important. For 
example, a missing peak for an isotope with two 13C atoms 
might cause only a small decrease in the summed intensity of the 
measured isotope pattern.

MS Cov. (%) Displays the summed intensity of matching isotope peaks in the 
measured pattern relative to the summed intensity of all the peaks 
in the measured pattern.

IMPORTANT  Low values for all of the candidates might indicate 
an overlapping pattern rather than a lack of good matches.

MSMS Cov. (%) Displays the summed intensity of the matched fragment peaks 
relative to the summed intensity of all the fragment peaks in the 
selected fragmentation scan.

Note  Low values for all of the candidates might indicate a 
contaminating compound within the isolation window for the 
fragmentation scan.

Table 126. Predicted Compositions table  (Sheet 2 of 2)

Column Description

Summed intensity of the matching isotope peaks 100
Summed intensity of the theoretical isotope pattern----------------------------------------------------------------------------------------------------------------------

Summed intensity of the matching isotope peaks 100
Summed intensity of all the peaks in the measured pattern--------------------------------------------------------------------------------------------------------------------------------
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BioCyc Pathways Table

Use the BioCyc Pathways table to review all the mapped pathways in the result file.

For more information, see “Viewing BioCyc Pathways” on page 362.

Table 129 describes the columns in the BioCyc Pathways main table. The BioCyc Pathways 
table lists all the BioCyc pathways that include at least one of the compounds detected by the 
untargeted search.

BioCyc Results Table

Use the BioCyc Results table to review the compounds found in the mapped BioCyc database.

The Map to BioCyc Pathways Node creates the BioCyc Results table.

Table 128 describes the columns in the BioCyc Results table.

Table 127.BioCyc Pathways table

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

Pathway ID Displays the identification number of the mapped BioCyc 
pathway. 

Pathway Name Displays the name of the mapped BioCyc pathway that 
includes at least one compound in the Compounds table.

#Referenced Compounds Displays the number of detected compounds that are 
referenced in the identified BioCyc pathway.

#Identified Compounds Displays the number of compounds in the referenced 
pathway that the analysis detected in the input file set.

To view the list of detected compounds, select a pathway and 
open the related BioCyc Results table.

Related BioCyc Pathways table only

BioCyc Compound IDs Displays a list of the BioCyc compound IDs in ascending 
order from left to right.

BioCyc Compound Names 
(related table)

Displays a list of the BioCyc compound names.

BioCyc Compound 
Formulas (related table)

Displays a list of the BioCyc compound formulas.
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KEGG Pathways Table

Use the main KEGG Pathways table to review all of the mapped pathways that include 
compounds detected across the input file set.

The Map to KEGG Pathways Node creates the KEGG Pathways table. 

Table 128. BioCyc Results table

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Structure Displays the molecular structure of the compound.

Name Displays the compound name in the BioCyc database.

Formula Displays the chemical formula of the compound.

Molecular Weight Displays the molecular weight of the compound to five decimal 
places.

Additional columns in the related BioCyc Results table for a compound

Compound Match Indicates the match status between the current item and the 
assigned compound annotation. For color-coding information, see 
“Annotation Source” on page 403.

Max. Mass [Da] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in daltons. 

Max. Mass [ppm] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in parts per million.

BioCyc ID Displays the BioCyc identification number for the compound.

BioCyc DB Displays the name of the BioCyc database that mapped the 
compound.

mzLogic Score Displays the mzLogic score provided by the Apply mzLogic node.

SFit[%] Displays the spectral similarity score from the Apply Spectral 
Distance node.
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Table 129 describes the columns in the KEGG Pathways table. The KEGG Pathways table 
lists all the KEGG pathways that include at least one of the compounds detected by the 
untargeted search.

Metabolika Pathways Table

Use the main Metabolika Pathways table to review all of the mapped pathways that include 
compounds detected across the input file set. Use the related Metabolika Pathways tables to 
review the results for specific compounds.

The Map to Metabolika Pathways Node creates the Metabolika Pathways table.

Table 129. KEGG Pathways table

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Pathway ID Displays the identification number of the mapped KEGG 
pathway. 

Pathway Name Displays the name of the mapped KEGG pathway that includes at 
least one compound in the Compounds table.

#Referenced 
Compounds

Displays the number of detected compounds that are referenced in 
the identified KEGG pathway.

#Identified 
Compounds

Displays the number of different KEGG compound IDs.

#mzCloud Results Displays the number of compounds in the identified KEGG 
pathway that the mzCloud search identified.

KEGG Compound 
IDs (related table)

Displays a list of the KEGG compound IDs in ascending order 
from left to right.

KEGG Compound 
Names (related table)

Displays a list of the KEGG compound names.

KEGG Compound 
Formulas 
(related table)

Displays a list of the KEGG compound formulas.

Max. Mass [Da] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in daltons. 

Max. Mass [ppm] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in parts per million.
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Table 130 describes the columns in the Metabolika Pathways table. The main Metabolika 
Pathways table lists all the Metabolika pathways that include at least one of the compounds 
detected by the untargeted search. The related table displays the search results for the selected 
compound in the Compounds table.

Metabolika Results Table

Use the main Metabolika Results table to review the compounds found in the mapped 
Metabolika pathways. Use the related Metabolika results table to review the results for a 
specific compound.

The Map to Metabolika Pathways Node creates the Metabolika Results table.

Table 128 describes the columns in the Metabolika Results table.

Table 130. Metabolika Pathways table

Column Description

Checked Use this column to select the rows that you want to display in 
the result table and in reports after you apply result filters. 

Pathway Name Displays the names of the mapped Metabolika pathways that 
include matching structures (by formula, mass, or both) for 
at least one compound in the Compounds table.

#Referenced Compounds Displays the number of detected compounds that are 
referenced in the identified Metabolika pathway.

#Compounds in Pathway Displays the total number of compounds in the pathway.

#Identified Compounds Displays the number of different Metabolika compound IDs.

Metabolika Compound IDs 
(related table)

Displays a list of the Metabolika compound IDs in ascending 
order from left to right.

Metabolika Compound 
Names (related table)

Displays a list of the Metabolika compound names.

Metabolika Compound 
Formula (related table)

Displays the Metabolika compound formula.

Table 131. Metabolika Results table (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Structure Displays the molecular structure of the compound.

Name Displays the compound name in the Metabolika database.

Formula Displays the chemical formula of the compound.
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Compound Scoring Tables
For information about the result tables for the unknown compound scoring nodes, see these 
topics:

• Compound Class Matches Table

• Matched Patterns Table

Compound Class Matches Table

The Compound Class Matches table is related to the Compounds table. Use the Compound 
Class Matches table to review the compounds classes that match the compound selected in the 
Compounds table.

The Compound Class Scoring Node adds the Class Coverage column to the Compounds 
table and creates the Compound Class Matches table, which is related to the Compounds 
table.

Molecular Weight Displays the molecular weight of the compound to five decimal 
places.

Additional columns in the Metabolika Results related table

Compound Match Displays whether the Metabolika pathway structure is a full or 
partial match for the selected compound.

( )—Full Match

( )—Partial Match

mzLogic Score Displays the normalized score from the Apply mzLogic node for 
the structure based on the mzCloud similarity matches (Apply 
mzLogic node).

Original mzLogic 
Score

Displays the score from the Apply mzLogic node for the structure 
based on the mzCloud similarity matches 

Max. Mass [Da] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in daltons. 

Max. Mass [ppm] Displays the maximum mass difference between the measured 
mass for the compound in the Compounds table and the 
theoretical mass of the compound, in parts per million.

SFit[%] Displays the spectral similarity score from the Apply Spectral 
Distance node.

Table 131. Metabolika Results table (Sheet 2 of 2)

Column Description
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Table 132 describes the columns in the Compound Class Matches table.

Figure 122 shows an annotated fragmentation scan of a detected compound. By comparing 
the m/z values of the centroids in the fragmentation scan against a compound class library 
with 11 structures, the application annotated 6 centroids in the fragmentation scan with 
matching structures from the library. The legend in the Mass Spectrum view lists the search 
library, the Class Coverage score, and the FISh Coverage score.

Table 132. Compound Class Matches table

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Name Displays the name of the library that contains the matching 
structure.

Description Displays the user-specified description of the library. 

FISh Coverage Displays the FISh coverage score (see “FISh Scoring for Targeted 
Compounds and Proposed Structures” on page 36).

Class Coverage Displays the number of matching centroids in the best 
fragmentation scan divided by the total number of fragments in 
the selected compound class libraries.

# Matched Fr. Displays the number of library fragments that match the centroids 
in the best fragmentation scan for a compound.

# Missed Fr. Displays the number of library fragments that do not match the 
centroids in the best fragmentation scan for a compound.
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Figure 122. Fragmentation scan and compound class match result for a detected compound

Matched Patterns Table

The Matched Patterns table is related to the Compounds table. Use the Matched Patterns 
table to review how well the isotopic pattern matches the compound selected in the 
Compounds table.

The Pattern Scoring node adds the Matched Patterns table to the result file. 

Table 133 describes the columns in the Matched Patterns table.

#Matched fragments

Table 133. Matched Patterns table (Sheet 1 of 2)

Column Description

Checked Use this column to select the rows that you want to display in the 
result table and in reports after you apply result filters. 

Name Displays the name or chemical formula of the compound.

SFit [%] Displays the spectral fit for the isotope pattern to the chemical 
formula.
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Differential Analysis Columns
When the analysis includes sample groups and group ratios and the processing workflow 
includes the Differential Analysis node, the following columns appear in the Compounds 
Table and the Expected Compounds Table: Group Areas, Group CV(%), Ratio, Log2 Fold 
Change, P-value, and Adj. P-value. In addition, the following columns appear in the Merged 
Features Table, Group Areas, Ratio, and Log2 Fold Change. The background colors of the 
table cells provide visual information about the numeric values in these columns.

SD Displays the spectral distance score.

Pattern Coverage [%] Displays the summed intensity of the matching isotope peaks in 
the measured MS1 spectrum relative to the summed intensity of 
the theoretical isotope pattern.

Provides a quantitative measure of how well the measured isotope 
pattern matches the theoretical isotope pattern.

Note  Because the base peak (leftmost peak) is typically 
responsible for most of the pattern intensity, even a small 
decrease in the percent coverage might be important. For 
example, a missing peak for an isotope with two 13C atoms 
might cause only a small decrease in the summed intensity of the 
measured isotope pattern.

#Matched Iso. Displays the number of matching isotopes for the unknown 
compound. 

File ID Displays the integer that the application assigned to the input file.

Study File ID Displays the study file ID of the input file (see “Removing Input 
Files or Updating Their Location” on page 105).

Table 133. Matched Patterns table (Sheet 2 of 2)

Column Description

Summed intensity of the matching isotope peaks 100
Summed intensity of the theoretical isotope pattern--------------------------------------------------------------------------------------------------------------------------
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Table 134 describes the columns from a differential analysis.

Table 134. Differential analysis columns (Sheet 1 of 3)

Column Description

Group Areas Displays the median chromatographic peak area for the compound in 
the sample group. To display the group names, click the expand icon 
to the right of the column heading.

When the compound is not found, the cells have a gray background. 
The Differential Analysis node bins the group areas in the current 
result file on the Log10 scale, with one bin for each order of 
magnitude (1e4, 1e5, 1e6, and so on), and uses a different background 
color for each bin. The values in the lowest bin have a pale yellow 
background. The values in the highest bin have a green background. 

Color-coding:

• Lowest values: 

• Highest values: 

Group CV(%) Displays the coefficient of variation for the groups. Groups with a high 
degree of variation (20% or greater) have a red background.

Color-coding: 

( ) Values equal to or greater than 20 have a red background.

( ) Values from 0 to 19 have a white background.

Ratio Displays the area ratio or ratios for the generated ratios.

A ratio of 0 (0/X) has a dark purple background ( ). An 
undefined ratio (X/0) (labeled as Infinity) has an orange background 
( ). 

The cells for compounds with defined ratios greater than 0 have the 
following background colors:

• Compounds with ratios between 0 and 0.5 are divided into five 
equal bins. The background color for the table cells is a 
progressively darker blue hue as the ratio approaches zero. 

• Compounds with ratios greater than 2 are divided into five equal 
bins. The background color for the tables cells is a progressively 
darker red hue as the ratio increases.

0.000

Infinity

Ratio  2  0 < Ratio < 0.5
20.5
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Log2 Fold Change Displays the fold change (ratio) in the log base 2 scale.

A log2 fold change of Infinity has an orange background ( ). If 
the ratio is 0 (0/X) or –Infinity in the Log2 format, the background 
color is a dark purple ( ).

The cells for compounds with log2 fold change values between
–infinity and infinity have the following background colors:

• Compounds with log2 fold change values more negative than –
1.00 are divided into five equal bins. The background color for 
the table cells is a progressively darker blue hue as the value 
becomes more negative. 

• Compounds with log2 fold change values greater than 1.00 are 
divided into five equal bins. The background color for the table 
cells is a progressively darker red hue as the value increases.

P-value Displays the p-value for the sample group calculated by running the 
Tukey HSD test (posthoc) after an analysis of variance (ANOVA) test.

The p-value is a number between 0 and 1. 

Given the following hypotheses:

• Null hypothesis—There is no difference between the sample 
groups for the variable tested.

• Alternate hypothesis—There is a difference between the sample 
groups for the variable tested.

You can interpret the p-value as follows:

• A low p-value means that you can reject the null hypothesis with a 
low probability of error that the alternate hypothesis is true.

• A high p-value means that you can accept the null hypothesis with 
a low probability of error that the alternate hypothesis is true.

Table 134. Differential analysis columns (Sheet 2 of 3)

Column Description

Infinity

–Infinity

Log2 Fold Change 
positive

Log2 Fold Change 
negative 1–1
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Descriptive Statistics Columns
The Descriptive Statistics post-processing node adds the columns described in Table 135 to 
the Compounds Table and Expected Compounds Table. The descriptive statistics columns 
are hidden by default.

Adj. P-Value (Differential Analysis node) Displays the adjusted p-value.

The application adjusts p-values in cases of multiple testing. Multiple 
testing of a null hypothesis leads to higher probabilities of rejecting 
this null hypothesis by chance, and therefore the application corrects 
the whole set of hypotheses (for example, all detected compounds) as a 
function of the set size (for example, a set of 10 000 compounds has a 
stronger correction than one of only 1000). The application performs 
this correction by using the Benjamini-Hochberg algorithm for the 
false discovery rate. 

P-value and Adj. 
P-value

Color-binning for p-values and adjusted p-values:

• 1–0.05 [ ] Red

• 0.05–0.01 [ ] Orange

• 0.01–0.005 [ ] Yellow 

• 0.005–0.001 [ ] Yellow green

• <0.001 [ ] Green

Table 134. Differential analysis columns (Sheet 3 of 3)

Column Description

Table 135. Descriptive statistics columns (Sheet 1 of 2)

Column Description

Min. Area Displays the minimum peak area for the compound in the sample 
set.

Q1 Area Displays the lower boundary of the first quartile (25%) area for 
the compound in the sample set.

Median Area Displays the median area for the compound (MW×RT) in the 
sample set.

Q3 Area Displays the upper boundary of the third quartile (75%) area for 
this compound in the sample set.

Mean Area Displays the calculated average area for the compound (MW×RT) 
in the sample set.
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Area SD Displays the standard deviation of the peak areas for the 
compound (MW×RT) in the sample set.

Area CV [%] Displays the coefficient of variation of the area for the compound 
(MW×RT) in the sample set.

Table 135. Descriptive statistics columns (Sheet 2 of 2)

Column Description
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11

Creating and Printing Reports

These topics describe how to create, preview, and print reports. You can use the standard 
report templates provided with the application or you can create your own custom report 
templates. 

When you open a report template for editing, it opens as a tabbed page with a workspace area 
on the left 

Reporting Workflow
The following flowchart shows the reporting workflow (Figure 123 and Figure 124).

Contents

• Reporting Workflow

• Generating a Report with an Existing Report Template

• Creating a New Report Template 

• Editing an Existing Report Template

• Editing Tools for the Report Template Page

• Section Report Items for a Report Template

• Property Settings for the Sections and Items in a Report Template

• Selecting the Paper Type, Print Width, Page Orientation, and Watermark for a Report 
Template

• Previewing and Printing a Report
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Figure 123. Reporting workflow (page 1)

Open a result file.

Can you use an existing 
report template as is?

Yes

From the Reporting menu, 
choose Create Report 

and select a report template. 

The report resolution page opens.

Review the resolved report.

Does the template display 
the data correctly?

Yes

Print the report.

Can you use an existing 
report template with minor 

modifications?

Yes

From the Reporting menu, 
choose Edit Report Template 
and select a report template.

The report template page opens.

Make the appropriate selections 
and click OK.

The report template page opens.

Close the page.

No

No No

From the Reporting menu, 
choose Create Report Template. 

The Customize Report dialog box 
opens.

Next page

Sort the table rows in the order of 
interest and save the result file.

Filter the data to display only the 
table rows of interest.
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Figure 124. Reporting workflow (page 2)

Generating a Report with an Existing Report Template
You can use one of the report templates provided with the application or one of your own 
custom report templates to produce reports that display items of interest in a result file. 

The application comes with the following eight defined report templates: 

• Compounds No Graphs A4.cdReportTemplate 

• Compounds with Graphs A4.cdReportTemplate

Does the template display 
the data correctly?

Yes

Edit the report template.

To resolve the data and preview the report, click 
the Preview Report icon, , to open the 

Report Preview dialog box. 
Or, click the Print Report icon, , to open the 

Report Print dialog box. 

No

To save the report template with a new name, 
close the dialog box to return to the report 

template page and click the Save As icon, . 

To print the report, click the Print button, .

To return to the report template 
page, close the dialog box. 

Previous 
page
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• Expected Compounds No Graphs.cdReportTemplate

• Expected Compounds per File No Graphs A4.cdReportTemplate

• Expected Compounds per File with Graphs A4.cdReportTemplate

• Expected Compounds with Structures No Graphs.cdReportTemplate

• Expected Compounds with Structures with Graphs A4.cdReportTemplate

• Expected Compounds with GraphsA4.cdReportTemplate

You can find these report templates in the following folder:

C:\Users\Public\Public Documents\Thermo\Compound Discoverer 3.1\Common 
Templates\ReportTemplates

 To preview and print a report by opening an existing report template

1. Open a result file.

In the application window, the reporting menu commands and the reporting toolbar 
icons ( ) become available.

2. Determine which main table you want to include in the report and filter the data in this 
table. 

3. To select an existing report template, choose Reporting > Create Report from the menu 
bar or click the Create Report icon, .

The Open Report Design Template dialog box opens to the Report Templates folder. 

To select an appropriate report template, you must know what data the report template is 
designed to resolve. Typically, a report template resolves the filtered data from one of the 
main tables and one or more of the graphs associated with the table. A report template 
can also resolve data from one or more related tables.

4. Select the appropriate report template and click Open.

The report resolution page opens with the thumbnail pane on the right and a report 
preview on the left. 

The tab format for the report resolution page is as follows:

 Report Template Name

As the application resolves the data with the report template, the following icon displays 
the progress. 
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When the data is resolved, the progress icon disappears, and the application begins 
rendering the report pages. The current page/estimated pages box lists the progress. 

If the selected template does not contain ReportInfo items, the application displays the 
pages as it renders them. If the selected template contains a ReportInfo item, the 
application does not display the rendered pages until it has rendered all of the report 
pages. ReportInfo items include the time stamp in the upper left and the page number at 
the center bottom of the defined report templates.

If the report contains too many pages, the application cancels the report generation, and 
the following message box appears. 

5. If the application cancels the report generation, repeat step 2 to step 4. But this time, 
reduce the number of reported items by modifying the filters.

6. Review the contents of the report. 

7. On the report resolution page, click the Print icon, , in the toolbar to print the 
report.

The Print dialog box opens.

8. Select the appropriate printer and the page range that you want to print. 

The report templates that come with the application default to printing on A4 paper. 

9. If you are not printing on A4 paper, change the printer setting.

10. Click OK to print the report.

Related Topics

• Opening, Closing, and Updating Result Files

• Using Result Filters for Data Reduction and Creating Filter Sets
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Creating a New Report Template
This topic describes how to create a new report template by using the Customize Report 
dialog box where you do the following:

• Select the data to be included in the report:

– Columns of interest in the main table

– Graphs associated with the main table

– Columns of interest in any of the related tables

– Graphs associated with any of the selected related tables

• Change the appearance of the tables:

– Change the column orientation from left to right to from top to bottom

– Add Separator lines below the column headings

– Indent the related tables below the main table

– Select background colors for the table headers and table rows

• Select the paper type (PaperKind parameter), page orientation, and logo image

See these topics:

• Creating a New Report Template by Using the Customize Report Dialog Box

• Adding, Removing, or Modifying Color Schemes for a Report Template’s Tables

• Customize Report Dialog Box Parameters

Creating a New Report Template by Using the Customize Report Dialog Box

 To create a report template by using the Customize Report dialog box

1. Open a result file.

2. Do one of the following:

• From the menu bar, choose Reporting > Create Report Template. 

• In the toolbar, click the Create a New Report Template icon, .

The Customize Report dialog box opens in front of the New Report Template page.
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Figure 125. Customize Report dialog box

3. In the Reported Table list at the top of the dialog box, select the main table for the report 
template.

A list of data items for the selected table appears. By default, the Columns list is 
expanded, and the Graphs and Related Tables lists are collapsed.

4. To select the columns for the main table, any of the associated graphs, and any of the 
main table’s related tables, do the following:

a. Under the selected table name, click each expand icon, , to open these sections as 
needed:

• Columns

• Graphs

• Related Tables

b. In the expanded sections, select the check box for each column, graph, or related 
table (and associated columns) that you want to include in the generated reports.

5. To add a separator line above the column heading row for each result table, select the 
Draw Lines check box.

(Default layout for the main result table)

Column 1 label Column 2 label Column 3 label Column 4 label Column 5 label

Data text box Data text box Data text box Data text box Data text box

(Related table)

Column 1 label Column 2 label Column 3 label Column 4 label Column 5 label

Data text box Data text box Data text box Data text box Data text box
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6. To transpose the tabular data from columns to rows, do the following:

a. Select the main result table and the related tables for the report.

b. In the data item list, select the table that you want to transpose as follows: 

• To transpose the columns in the main table, select the main table name (the first 
data item) in the Customize Report dialog box. 

• To transpose the columns in a related table, select the check box to the left of the 
related table name and click the table name to make sure that it is highlighted in 
blue. 

c. Select the Transpose Data check box.

Each selected data column appears as a two-column row in the report template. The first 
column displays the column heading and the second column displays the data from a 
table row.

7. To indent a related table, do the following:

a. Select the related table in the expanded list of data items. 

b. In the Indenting box, type the indentation value from 0.00 to 1.00 inch. 

Tip  For result tables with a large number of data columns, transpose the columns by 
selecting the Transpose Data check box. Otherwise, you might need to resize the data 
columns to fit the page. 

Note  Selecting another table clears the Transpose Data check box.

(Default layout for the main table)

Column 1 label Column 2 label Column 3 label

Data text box Data text box Data text box

(Transposed layout for the main table)

Column 1 label Data text box

Column 2 label Data text box

Column 3 label Data text box

(Default layout for the main result table)

Column 1 label Column 2 label Column 3 label Column 4 label Column 5 label

Data text box Data text box Data text box Data text box Data text box

______________________________________________________________
(Related table indented by 1 inch)

Column 1 label Column 2 label Column 3 label Column 4 label

Data text box Data text box Data text box Data text box
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8. To select a color scheme for a report table, do the following:

a. In the report item list, select the table of interest, for example, the main table or one 
of the related tables.

b. In the Color Scheme list, select one of the available color schemes. 

Each scheme consists of two colors: the first color for the background of the table 
headers and the second color for the background of the table rows. The default color 
scheme is Transparent/Transparent.

9. Under General Settings, do the following:

• In the PaperKind list, select the default paper size for the report.

• In the Orientation list, select the page orientation.

• Next to the Logo Image box, click the browse icon, . Then, in the Open Image 
File dialog box, select the graphic file for the logo image and click Open.

10. To apply the settings and close the Customize Report dialog box, click OK.

Your selections appear on the report template page. The tab format for the report 
template page is as follows:

 Main Result Table

11. To save the template with a different name, click the Save As icon,  , in the upper left 
corner of the report template page. 

For information about editing the report template, see “Editing an Existing Report 
Template” on page 450.
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When you create a report by using the Customize Report dialog box, the application adds the 
following additional TextBox design items to the report template: DateTimeInfo in the Page 
Header section and PageNumberInfo in the Page Footer section. 

Figure 126 shows a report template for selected columns in the Compounds per File table and 
two associated graphs. The default report template uses the Compound Discoverer 
application icon. You can select a different image and resize its picture container as needed.

Figure 126. Report template with data from the Compounds per File table 

Adds a page number to 
the report.

Default logo 
image

Selected main table name

Selected 
columns 

Selected 
graphs

Adds a date-and-time stamp to the report. Logo image’s 
picture 
container
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Adding, Removing, or Modifying Color Schemes for a Report Template’s Tables

In the Customize Report dialog box, follow this procedure to modify, add, or remove color 
schemes.

 To modify the current color scheme or to add or remove color schemes from the list

1. In Customize Report dialog box, select the main result table and the related tables for the 
report.

2. Click Modify.

Two color selection lists appear below the Color Scheme list. The list on the left changes 
the background color for the column headings. The list on the right changes the 
background color for the data columns.

3. From the color lists, select one or two background colors, and then click Add. 

The application displays the effect of the color scheme in the data item list, adds the new 
color scheme to the Color Scheme list, and activates the Remove button.
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4. To change the color selection, do one or both of the following:

• If you do not want to apply the new color scheme to the currently selected table, click 
Reset.

The application undoes the color selections, applies the default color scheme 
(Transparent/Transparent), and closes the color lists. When you click OK to accept 
the settings and close the Customize Reports dialog box, the application adds the new 
color scheme to the ColorScheme.xml file.

• If you do not want to keep the new color scheme, click Remove.

The application undoes the color selections, leaves the color lists open, and removes 
the color scheme from the Color Scheme list.

Customize Report Dialog Box Parameters

Table 136 describes the parameters in the Customize Report dialog box.

Note  Accepting the settings in the Customize Report dialog box adds the new color 
scheme to the ColorScheme.xml file that is located in the following folder:

C:\Users\Public\Public Documents\Thermo\Compound Discoverer 
3.1\Common Templates\ReportTemplates

If you remove the new color scheme before you click OK at the bottom of the 
Customize Report dialog box to accept the settings, the application does not add the 
new color scheme to the ColorScheme.xml file.

Table 136. Customize Report dialog box parameters (Sheet 1 of 3)

Parameter Description

Reported Table Lists the main tables in the result file.

Columns Lists the columns for the selected main table.

Graphs Lists the graphs for the selected main table.

Related Tables Lists the tables related to the selected main table.

Columns Lists the columns for the selected related table.

Graphs Lists the graphs for the selected related table.

Related Tables Lists the second-level related tables for the selected related table.

Appearance

Draw Lines Specifies whether the application draws a line above the table 
column headers.

Default: Selected
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Transpose Data Specifies the layout of the data in the result table columns.

The default layout (check box cleared) matches the result table 
layout, with columns displayed from left to right and rows 
displayed from top to bottom. Select this check box to transpose 
the columns to rows.

Default: Cleared 

Tip  When you select a table item in the data item list, the 
application automatically clears the Transpose Data check box. 
For each table that you want to transpose, select the table name 
and make sure that it is highlighted in blue. Then select the 
Transpose Data check box.

Indenting Specifies the indentation of the selected related table data from the 
left edge of the page, from 0.00 to 1.00 inch.

Default: 0.00 in.

Color Scheme

Color Scheme Specifies the color scheme for the selected table. 

Each color scheme consists of two colors. The first color is the 
background of the column headings. The second color is the 
background of the table rows.

You can modify the Color Scheme list by adding or removing 
color schemes.

Default: Transparent/Transparent

Note  Accepting the settings in the Customize Report dialog box 
adds the new color schemes to the ColorScheme.xml file that is 
stored in the same folder as the common report templates.

General Settings

PaperKind Specifies the size of the paper for printing the report. Select the 
appropriate paper size before sending the report to the printer.

Default: A4 

Orientation Specifies the orientation of the report, either Portrait or 
Landscape.

Default: Portrait

Table 136. Customize Report dialog box parameters (Sheet 2 of 3)

Parameter Description
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Editing an Existing Report Template
Use the report template page to modify a report template. The report template page shows the 
design items that you selected using the Customize Report dialog box or the items in the 
existing report template that you selected. Some of the design items appear as containers (a 
rectangular box) where you can add text, images, or data graphs.

To modify a report template, see these topics as needed:

• Opening a Report Template

• Changing a Report Template’s Logo Image

• Changing a Report Template’s Time Stamp

• Adding Design Items to a Report Template

• Adding Main Table Columns to a Report Template

• Adding Data Graphs to a Report Template

Logo Image Specifies the logo image to appear by default in the upper right 
corner of each report page.

The default size of the picture container for the logo is 
1.823 × 0.492 in. (width × height). When the selected image is 
larger than the picture container, the container clips the image. 
You can edit the properties of the picture container in the report 
template.

Buttons

Reset Resets the color scheme to the default scheme.

Modify Opens two color selection lists. 

Add Selecting colors in one or both of the color selection lists below the 
Color Scheme list activates this button.

Applies the new color scheme to the selected table and adds the 
new color scheme to the Color Scheme list.

Remove Removes the selected color scheme from the Color Scheme list.

OK Applies the selected settings to the new report template.

Cancel Cancels your selections and closes the dialog box.

Table 136. Customize Report dialog box parameters (Sheet 3 of 3)

Parameter Description

Note  You can open more than one report template page in the application window.
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• Adding Related Table Columns to a Report Template

• Editing the Properties of Subreport Columns in a Report Template

• Moving a Subreport Column to a Report Template’s Main Table

• Adding Page Breaks to a Report Template

• Deleting a Pair of Workspace Sections on the Report Template Page

• Resizing a Report Template’s Sections

• Adding Design Items to a Report Template

• Adding Main Table Columns to a Report Template

• Adding Data Graphs to a Report Template

• Adding Related Table Columns to a Report Template

• Editing the Properties of Subreport Columns in a Report Template

• Moving a Subreport Column to a Report Template’s Main Table

• Modifying the Properties of a Report Template Design Item

• Adding Page Breaks to a Report Template
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Figure 127 shows the report template page. 

Figure 127. Report template page

Related Topics

• Editing Tools for the Report Template Page

• Selecting the Paper Type, Print Width, Page Orientation, and Watermark for a Report 
Template

Click this square to display the report 
template properties (page orientation and 
paper type) in the Properties pane.

Sizing bar

Upper 
toolbar

Properties pane for the 
paper size, page orientation, 
and watermarks

Lower toolbar

Design item list
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Opening a Report Template

 To open a report template

1. Open a result file.

2. From the application window, do one of the following:

a. Choose Reporting > Create Report Template from the menu bar, or click the 
Create Report icon, , in the toolbar. 

The Customize Report dialog box opens.

b. Make the appropriate selections and click OK.

The report template page opens as a tabbed document. The tab format is as follows:

 Main Result Table Name

–or–

a. Choose Reporting > Edit Report Template from the menu bar, or click the Edit 
Report Template icon, , in the toolbar.

The Open Report Design Template dialog box opens.

b. Select a report template and click Open.

The report template page opens as a tabbed document. The tab format is as follows:

 Existing Report Template Name

Changing a Report Template’s Logo Image 

 To change the logo image in a report template

1. Open the report template.

The report template opens as a tabbed page in the application window.

2. Select the logo image container.

The picture properties appear in the Properties pane.

3. In the Data area, click the browse icon, , to the right of the Image property. You might 
have to click the row to make the browse icon appear.

The Open dialog box opens with a setting of All image files for the file type.

Note  The Compound Discoverer icon is the default logo for the common templates 
and the templates that you create with the Customize Reports dialog box. 
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4. Browse to the folder where you stored the logo of interest, select the logo, and click 
Open.

The selected image appears in the container. 

5. Modify the Layout properties as appropriate.

Changing a Report Template’s Time Stamp

 To change the format of the date-and-time stamp

1. Open the report template.

The report template opens as a tabbed page in the application window.

2. Select the DateTimeInfo item.

The properties for this design item appear in the Properties pane.

3. Under Appearance, click the OutputFormat box to make the browse icon appear. Then 
click the browse icon.

The OutputFormat dialog box opens (Figure 128).

Figure 128. OutputFormat dialog box

4. Select the format of interest.

5. Click OK to accept the setting.

Adding Design Items to a Report Template

You can add any of the design items in the Section Reports pane to a report template. 

 To add a design item to the template

1. Open the report template.

The report template opens as a tabbed page in the application window.
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2. From the Section Reports pane to the right of the workspace area, drag a design item to 
the appropriate location on a workspace section of the page.

Related Topics

• Section Report Items for a Report Template

Adding Main Table Columns to a Report Template

Use the Add Field shortcut menu command or the Add Items icon in the upper toolbar to add 
data fields from a result table to the report template.

 To add a main table column to the report template

1. Open the report template. 

The report template opens as a tabbed page in the application window.

2. Depending on the orientation of the table columns, do the following:

• If the table columns are arranged horizontally from left to right, go to step 3.

• If the table columns are arranged vertically from top to bottom, go to step 5.

3. To add a main table column to a column set that is arranged horizontally, do either of the 
following:

• To place the new column to the right of the current column set, select the 
PageHeader bar. 

• To place the new column to the right of a specific column, select the column heading.

4. Do one of the following:

• Right-click the PageHeader bar or a specific column heading, and then choose Add 
Field > Data Column from the shortcut menu.

–or–

a. Click the PageHeader bar or a specific column heading.

b. In the toolbar, click the Add Items icon, , to open a list of data column 
selections. 

The available items in the list include the unused data columns in the current main 
table. The data columns that are already in the template are unavailable and grayed 
out.
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c. Select an available data column from the list.

The new data column appears to the right of the selected column or the current 
column set. If there is a gap to the right of the selected column or to the right of the 
column set, the new column fills the gap. If there is no space to the right of the 
selected column or to the right of the column set, the new column shares the space 
with the selected column or the last column in the column set.

5. To add a main table column to a column set that is arranged vertically, do the following:

a. Use the sizing bar to display all of the data column rows.

b. Right-click the Label column (heading) of the two-column row that is above where 
you want to add the new two-column data row, and choose Add Field > Data 
Column.

The new two-column data row appears below the selected two-column row.

Adding Data Graphs to a Report Template

 To add a data graph that is associated with the main table to the template

1. Open the report template.

The report template opens as a tabbed page in the application window.

2. Do one of the following:

• Right-click the DetailSection_Main_Table_Name bar and choose the Add Field > 
Data Graph of interest from the shortcut menu.

–or–

a. Click the DetailSection_Main_Table_Name bar.

b. In the toolbar, click the Add Items icon, , to open a list of data graphs and 
related table selections.

The available items in the list include the data graphs associated with the current 
main table and the related tables for the current main table.

c. Select an available data graph from the list.

When the table columns are positioned from left to right, the data graph appears below 
the table columns and to the right of any existing data graphs.

Adding Related Table Columns to a Report Template

 To add a column from a related table to a report template

1. Open the report template.

The report template opens as a tabbed page in the application window.
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2. Do one of the following:

• Right-click the DetailSection_Main_Table_Name bar and choose Add Field > 
Related Table Name > Column of Interest.

–or–

a. Select the DetailSection_Main_Table_Name bar.

b. In the toolbar, click the Add Items icon, , to open a list of data graphs and 
related table selections.

The available items in the list include the data graphs associated with the current 
main table and the related tables for the current main table.

c. Select an available related table from the list, and then select a table column.

3. If the DetailSection is collapsed, click the expand icon to open the section.

The added table column appears at the bottom of the DetailSection (data area). The 
application automatically adds a line above the column heading (Figure 129). 

Expand icon
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Figure 129. Expected Compounds per File table with the Mass [ppm] column from the related 
Expected Features table

Editing the Properties of Subreport Columns in a Report Template

 To edit the properties of subreport columns 

1. Open the report template.

The report template opens as a tabbed page in the application window.

2. To open the subreport editor area, do one of the following:

• Double-click the Subreport_Related_Table_Name box.

–or–

a. Select the Subreport_Related_Table_Name box.

The Edit Sub-Report icon, , becomes available.

b. Click the Edit Sub-Report icon.

The TextBox design item for the related table column appears in a separate section. The 
item’s container is sized to the full page width (Figure 130).

Line above the 
related table 
column

Column from the related table
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Figure 130. Report template page with the subreport section open

3. To change the properties of the TextBox design item in the subreport section, select it.

The properties for the selected design item appear in the properties pane to the right of 
the workspace.

4. Make changes as necessary in the properties pane, or click the property dialog link below 
the properties pane to open the TextBox dialog box and make similar changes.

5. To close the subreport section, click the Close Sub-Report icon in the report designer 
toolbar.

Moving a Subreport Column to a Report Template’s Main Table

 To move a subreport column up to the set of main table columns

1. Open the report template.

The report template opens as a tabbed page in the application window.

2. Resize the column heading container for the subreport column. Then, move it to an 
appropriate location in the set of main table columns.

Subreport section with the container for 
the Mass [ppm] data item sized to the 
full page width

Column heading for the
Mass [ppm] column
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3. Resize the Subreport_Related_Table_Name container. Then, move it to the appropriate 
location in the Detail Section.

4. In the related table’s Detail Section, resize the data item’s container. 

Figure 131 shows a report template for the Expected Compounds per File table with an 
additional column from the related Expected Features table.

Figure 131. Related table column moved up to the main table

Subreport container moved to the 
main table’s Detail Section 

Column heading for the
related table column

Detail Section for the related table with a 
resized container for a data item
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Modifying the Properties of a Report Template Design Item

On the report template page, you can edit the position and size of a design item by using the 
mouse or the properties pane on the right. You can also edit other properties for a design item 
from the properties pane or the specific dialog box for the design item.

 To edit a design item

1. Open the report template.

The report template opens as a tabbed page in the application window.

2. Select the design item.

The properties for the selected design item appear in the properties pane, at the bottom 
right of the report template page. For information about the properties of each design 
item, see “Property Settings for the Sections and Items in a Report Template” on 
page 474.

3. Do any of the following:

• To move the design item to another position, do either of the following:

– Move the item by dragging it (or you can use the arrow keys on the keyboard).

– In the Properties pane, under Layout, expand Location, and then change the X 
and Y values.

• To resize the container for the design item, do either of the following:

– Resize the item by dragging the handle points of the container.

– In the Properties pane, under Layout, expand Size, and then change the Width 
and Height values.

• To change other properties for the design item, do either of the following:

– Modify the properties in the Properties pane.

– Click the Property Dialog link at the bottom right of the report template page, 
and then modify the property in the item-specific dialog box.

Note  For the RichTextBox design item, in addition to the Property Dialog link, 
you can click the Load File link to load text from a file (see “Populating a Rich 
Text Box by Loading a File” on page 487).
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Adding Page Breaks to a Report Template

 To add a page break between reported result table rows

1. Open the report template.

The report template opens as a tabbed page in the application window.

2. On the report template page, drag the PageBreak design item from the Section Reports 
pane to the bottom of the Detail Section of the report template.

Deleting a Pair of Workspace Sections on the Report Template Page

 To delete a pair of workspace sections

1. Open the report template.

The report template opens as a tabbed page in the application window.

2. Select one of the workspace sections by clicking the section header or by clicking within 
the section area.

3. From the shortcut menu, choose Delete.

Resizing a Report Template’s Sections

Use the sizing bar to the left of the workspace to resize each workspace section vertically, 
except for the Appendix section.

 To vertically resize a workspace section

1. Open the report template.

The report template page opens as a tabbed page in the application window.

Note  The report template page pairs these sections together: 

• Cover Page and Appendix 

• Page Header and Page Footer

When you select one of the paired sections to delete, the application removes both 
sections. You cannot delete one section without deleting the other, and you cannot delete 
the Detail Section section.

Tip  Make sure to enlarge the workspace section enough to hold all of the items that you 
want to add to that section of the template. 

The size of a section on the report template page is not necessarily the same as its size in 
the generated report.
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2. Do any of the following:

• For the CoverPage, PageHeader, DetailSection, and PageFooter sections, do the 
following

– In the sizing bar, drag the sizing handle. 

– To vertically enlarge a workspace section, drag down the handle that is aligned 
with the header of the subsequent section. To reduce a workspace section, drag 
the handle up.

• To enlarge the Appendix section, drag it down by the bottom edge of the report 
template page. To reduce this workspace section, drag the bottom edge up.

Related Topics

• Workspace Sections and Sizing Bar on the Report Template Page

Editing Tools for the Report Template Page
For information about the editing tools for the report template page, see these topics: 

• Workspace Sections and Sizing Bar on the Report Template Page

• Report Template Page Toolbars

• Report Template Page Shortcut Menu

• Section Report Items for a Report Template

• Property Settings for the Sections and Items in a Report Template

• Opening the Property Dialog Boxes for the Report Template’s Design Items

• Populating a Rich Text Box by Loading a File
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Workspace Sections and Sizing Bar on the Report Template Page

Figure 132 shows the five workspace sections, the sizing bar on the left, and the icon that 
opens the page orientation and paper type options in the upper left corner.

Figure 132. Workspace sections, sizing bar, and icon that opens the page size options

By default, the workspace on the report template page has five sections. Table 137 lists these 
sections, from top to bottom.

Sizing 
bar

Resizing the Appendix area

Click this square to display the report template properties 
(page orientation and paper type) in the Properties pane.
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Table 137. Default workspace sections (Sheet 1 of 2)

Workspace section Description

Cover Page Appears as the first page of a report with the following property 
selections:

• True—For the Visible parameter in the Behavior section of 
the properties pane. 

Default: False

• After—For the NewPage parameter in the Data section of the 
properties pane. 

Default: After (See “NewPage” on page 482.)

To display the Cover Page section without a page break between it 
and the next section, select True for the Visible parameter and 
None for the New Page parameter.

Use this section to add nonrepeating information, such as the 
report title, date-and-time stamp, and company logo.

Page Header Adds design items to the top of each report page. The standard 
templates include a Label design item with the main table name, a 
TextBox design item with a time stamp, and a Picture design item 
with a company logo. The column headings (Label design items) 
appear here when you add table columns to the report.

Detail Section

(concatenated with the 
selected Main_Table 
name)

Adds data from the result file, such as the repeating items 
(TextBox design item) of a main table or the data graphs for each 
table row.

Page Footer Adds information to the footer of each report page, for example, 
the page number. 

Report templates created with the Customize Reports dialog box 
automatically include a page number at the bottom of each page. 
The page number is a TextBox design item.
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Report Template Page Toolbars

Table 138 describes the toolbars on the report template page. 

For more information about the report template page, see “Editing an Existing Report 
Template” on page 450.

Appendix Adds information to an appendix section of the report. 

An Appendix section appears after the last page of a report, with 
the following property settings:

• True—For the Visible parameter in the Behavior section of 
the properties pane

Default: False

• Before—For the NewPage parameter in the Data section of 
the properties pane

Default: Before

To display the Appendix section without a page break between it 
and the previous section, select True for the Visible parameter and 
None for the NewPage parameter.

Table 137. Default workspace sections (Sheet 2 of 2)

Workspace section Description

Table 138. Toolbars on the report template page (Sheet 1 of 4)

Icon Description

Top toolbar

Save Active Item—Saves the report template using the same file 
name.

By default, the template file name is the same name as the main 
table that you selected in the Customize Report dialog box (see 
“Creating a New Report Template” on page 442).

Save As—Saves the report template using a different file name.

Preview—Opens the Report Preview dialog box (see “Previewing 
and Printing a Report” on page 489).

Print—Opens the Report Print dialog box.
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Edit Sub-Report—Enlarges a selected subreport so that you can 
edit it.

Selecting a subreport item activates this icon. When you click this 
icon, the report designer opens the subreport in a separate Detail 
Section workspace section. You can zoom in on this temporary 
section or zoom out of it. Increasing the size of this temporary 
section does not affect the report template page.

Note  Related tables that you select in the Customize Report 
dialog box appear as subreports on the report template page.

Close Sub-Report—Closes the separate subreport workspace 
section.

Clicking anywhere in the separate subreport workspace activates 
this icon. 

Align Columns—Aligns the Label (column heading) and Textbox 
(data) containers for the selected column or columns. 

Selecting a report column activates this icon.

Add Items—Opens a list of items that you can add to the 
currently selected section of the report template.

Clicking within a workspace section or the section header activates 
this icon. The list of items varies depending on the selected 
section:

• CoverPage and DetailSection sections: You can add related 
table columns or graphs that are not currently in the template. 

• PageHeader section: You can add main table columns that are 
not currently in the template. The column heading appears in 
the PageHeader section as a Label design item, and the 
container for the column data appears in the DetailSection as 
a TextBox design item.

Cut—Deletes the selected item without confirmation.

Copy—Copies the selected item.

Paste—Pastes the selected item.

Delete—Deletes the selected item after you click OK in the 
confirmation dialog box.

Table 138. Toolbars on the report template page (Sheet 2 of 4)

Icon Description
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Zoom Out—Reduces the magnification of the page.

Zoom In—Increases the magnification of the page.

Magnification box—Displays the magnification percentage.

Actual Size—Displays the page at 100% magnification.

Changing the magnification by using the Zoom In and Zoom 
Out icons or by typing a value in the magnification box activates 
this icon.

Bottom toolbars

Dimension Lines—Displays dimension lines ( ) as you 
resize a design item by using the mouse.

Hide Grid—Clears the grid on the page.

Show Dots—Shows the main grid lines and the small dots within 
the grid.

Show Lines—Shows the main grid and the smaller lines within 
the grid.

Snap Lines—When you move a design item on the page, blue 
alignment lines appear. When the selected design item (Item 1 
below) is horizontally aligned with another design item, two 
vertical lines bracket the aligned items. When the selected design 
item is vertically aligned with another design item, two horizontal 
lines bracket the aligned items. 

Snap to Grid—When you move an item on the page, this mode 
automatically snaps it to the smaller grid lines.

Select Mode—Use this mode to select items on the page.

To select multiple items, press the SHIFT key while you select the 
items.

Table 138. Toolbars on the report template page (Sheet 3 of 4)

Icon Description

Item 2

Item 1 Item 3
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Report Template Page Shortcut Menu

Follow these procedures as needed.

 To open the shortcut menu for the report template page

Right-click the report template page.

 To add a design item to a section of the report

Right-click the section bar within a section area and choose Add Field > Item of Interest.

 To align a column heading to its associated data field

1. In the PageHeader section, right-click the column heading (Label design item) that you 
want to align with its associated data field (TextBox design item).

The Align Columns icon becomes available. 

2. From the shortcut menu, choose Align Fields.

 To transpose the data fields from columns to rows or from rows to columns

1. Right-click a column heading (Label) or a column data field (TextBox) and choose 
Transpose Data Fields.

Pan Mode—When the page is zoomed in, use this mode to move 
to a different part of the page.

Magnification bar—Move the slider to the left to zoom out and to 
the right to zoom in. The magnification percentage appears to the 
left of the slider.

Table 138. Toolbars on the report template page (Sheet 4 of 4)

Icon Description

Tip  You can also select the column heading, and then click the Align Columns icon, 
 , in the report template page toolbar.

Selected column header 
(Label item)

Aligned data field 
(TextBox item)

Align Columns icon
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2. To undo the change, if necessary, right-click a column heading (Label) or a column data 
field (TextBox) and choose Transpose Data Fields.

 To add a border to a design item

1. Right-click the design item in the workspace and choose Format Border.

The Format Border dialog box opens (Figure 133).

Figure 133. Format Border dialog box with the selection of a coral, double line border

2. Click one of the icons in the Presets area or select the line style in the Line Styles area, and 
click the appropriate sides of the square in the Preview area to set up the border.

Table 139 describes the shortcut menu commands for the report template page.

Table 139. Report template page shortcut menu (Sheet 1 of 2)

Command Description

Add Field Adds the item that you choose to the selected workspace section. 

Align Fields Aligns a column header or subreport with the associated data.

This command becomes available when you select a column 
header or a subreport.

Transpose Data Fields Transposes the data from columns to rows or from rows to 
columns.

This command becomes available when you select a column 
header.

Note  The Insert Section command is available if the template does not already include a 
Report Header/Footer section or a Page Header/Footer section.

Insert Section > Report 
Header/Footer

Inserts the ReportHeader and ReportFooter sections.

Insert Section > Page 
Header/Footer

Inserts the PageHeader and PageFooter sections.
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Section Report Items for a Report Template
The Section Reports pane to the right of the workspace on the report template page contains 
all of the different design items that you can add to the report template.

 To add a design item to a report template

1. Drag the item of interest to the appropriate location on the report template page. 

Some of the items appear as containers (boxes) where you can add text or images.

2. Select the design item to open its properties below the Section Reports pane.

3. Edit the item’s properties as necessary.

Table 140 describes the design items in the Section Reports pane.

Copy Copies the selected item.

Paste Pastes the selected item.

Cut Removes the selected item without confirmation.

Delete Deletes the selected item after you click OK in the confirmation 
dialog box.

Bring to Front Moves the selected item to the front, on top of other surrounding 
items.

Send to Back Moves the selected item to the back, beneath all other surrounding 
items.

Format Border Opens the Format Border dialog box where you can change an 
item’s border layout, line style, and color.

Properties Highlights the (Name) property in the properties pane of the 
report template page.

Table 139. Report template page shortcut menu (Sheet 2 of 2)

Command Description

Table 140.Design items in the Section Reports pane (Sheet 1 of 3)

Design item Description

Label A text label that is usually used as a header or title. The column 
headers are Label design items.

TextBox A text box that is usually used to group multiple items together. 
The application uses the TextBox design item to display the 
repeating tabular data in the result file. 

IMPORTANT  Use the Rich Text Box item rather than the 
TextBox item to add text to the report’s cover page. 
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CheckBox A check box that you can select or clear.

RichTextBox A text box that you can populate by typing text in the box or by 
loading text from a file. Use the Load File link below the 
properties pane on the right to select and open a text file. 

Shape A geometric shape such as a rectangular or square box (with either 
square or rounded corners), an ellipse, or a circle.

Tip  When you add this item, by default, it appears as a 
rectangular box with square corners. To change to a different 
shape, modify the Style property under Appearance in the 
properties pane.

Picture A container for a graphic.

Line A straight line.

PageBreak A break to push the subsequent content to the next page. To place 
reported table rows on separate pages, add a page break at the 
bottom of the DetailSection.

Barcode A bar code. For information about setting up the Barcode 
properties, refer to the ActiveReports User Guide on the company 
website for Grape City.

Table 140.Design items in the Section Reports pane (Sheet 2 of 3)

Design item Description
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ReportInfo A variable that the application automatically replaces with 
real-time data in the generated report. Use the ReportInfo design 
item to show the current page number or to add a date-and-time 
stamp. Select the page number or date-and-time stamp from the 
FormatString list under Appearance in the Properties pane. 

CrossSectionLine A line that can span across multiple workspace sections on the 
report template page.

Note  You cannot add this item to the Detail Section workspace 
section. However, you can add it to another section (for 
example, the Page Header section) and have it span across the 
Detail Section section.

CrossSectionBox A box that can span across multiple workspace sections on the 
report template page.

Note  You cannot add this item to the Detail Section workspace 
section. However, you can add it to another section (for 
example, the Page Header section) and have it span across the 
Detail Section section.

Table 140.Design items in the Section Reports pane (Sheet 3 of 3)

Design item Description
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Property Settings for the Sections and Items in a Report Template
On the report template page, the properties pane to the bottom right of the workspace 
includes all of the property settings that you can use to format a workspace section or an 
object (design item) in the report template. The settings vary depending on the selected 
workspace section or design item.

If it is available, click the expand icon, , to open the settings for a particular property or the 
collapse icon, , to close the settings.

The properties pane contains these property groups, from top to bottom:

• Appearance Properties

• Behavior Properties

• Data Properties

• Design Properties

• Layout Properties

• Miscellaneous Properties

• Opening the Property Dialog Boxes for the Report Template’s Design Items

• Populating a Rich Text Box by Loading a File

Appearance Properties

Table 141 describes the Appearance properties.

IMPORTANT  The Summary properties are not functional.
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Table 141.Appearance properties in the Properties pane (Sheet 1 of 3)

Property Description

AnchorBottom (For the Line design item only) Specifies whether the line is 
anchored to the bottom of the workspace section.

Selections:
• False—Does not anchor the line to the bottom of the 

workspace section. 
• True—Anchors the line to the bottom of the workspace 

section.

Alignment (For the Label, TextBox, ReportInfo, and Barcode design items) 
Specifies the horizontal alignment of the text within the container.

(For the Barcode design item) Specifies the horizontal alignment 
of the caption text that is associated with the bar code. You enable 
the caption text by setting the CaptionGrouping and 
CaptionPosition properties.

BackColor Specifies the background or fill color.

BarHeight (For the Barcode design item only) Specifies the height of the bar 
code.

CaptionGrouping (For the Barcode design item only) 

Selections:
• False—Does not enable a text caption to be associated with 

the bar code.
• True—Enables a text caption.

CaptionPosition (For the Barcode design item only) Sets the position of the caption 
container relative to the bar code symbol.

Selections:
• None—Hides the caption.
• Above—Sets the position above the symbol. 
• Below—Sets the position below the symbol, as in the figure 

above.

CharacterSpacing (For the Label and TextBox design items) Specifies the spacing 
between the characters in the text, in points.

Default: 0
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ClassName Specifies the name of the class for a particular format.

Default: Normal

Font (For the Label, TextBox, and CheckBox design items) Specifies the 
name of the font and other font characteristics such as the style, 
size, effects, and script. Clicking the browse icon, , opens the 
Font dialog box where you can specify the font characteristics. 
Clicking the expand icon, , expands the settings. 

Font >

GdiCharSet

Specifies the GDI character set to use. For a list of valid values, 
refer to the GdiCharSet Property in the Microsoft Developer 
Network (MSDN) Library.

Font >

GdiVerticalFont

Specifies that the font is derived from a GDI vertical font.

ForeColor (For the Label, TextBox, and CheckBox design items) Specifies the 
font color.

FormatString (For the ReportInfo design item only) Specifies the format of the 
generated content as a page number or a date-and-time string.

LineColor Specifies the color of a line or border.

LineSpacing Specifies the spacing between multiple lines of content, in points.

LineStyle Specifies the style of a line or border.

LineWeight Specifies the thickness of a line or border, in pixels.

NarrowBarWidth (For the Barcode design item only) Specifies the width of the 
narrow bars in the bar code (a value of 1.0 equals 0.864 points).

Tip  At a thicker width for the narrow bars, the entire bar code 
might be too large for the container. In this case, enlarge the size 
of the container to see the entire bar code.

NWRatio (For the Barcode design item only) Specifies the ratio of the width 
of the wide bars relative to the width of the narrow bars in the bar 
code. The larger the ratio, the thicker the wide bars appear.

Tip  At a thicker width for the wide bars, the entire bar code 
might be too large for the container. In this case, enlarge the size 
of the container to see the entire bar code.

Table 141.Appearance properties in the Properties pane (Sheet 2 of 3)

Property Description
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OutputFormat (For the TextBox design item only) Specifies the format settings 
for custom content, or for a number, currency, date, time, or 
percentage. Clicking the browse icon, , for this property opens 
the OutputFormatDialog box (see Figure 128 on page 454) where 
you can change the settings. 

Do not change the OutputFormat settings for data fields from a 
result table column.

PictureAlignment (For the Picture design item only) Specifies the alignment of the 
selected image with respect to the container. For proper 
alignment, the container must be larger than the image.

Selections: TopLeft, TopRight, Center, BottomLeft, and 
BottomRight

QuietZone (For the Barcode design item only) Specifies the left, right, top, 
and bottom margins of the quiet zone for the bar code, in inches. 

Rotation (For the Barcode design item only) Specifies the rotation of the 
bar code within the container.

Tip  At a rotation of 90 or 270 degrees, the entire bar code might 
be too large for the container. In this case, enlarge the size of the 
container to see the entire bar code.

Style Specifies the format settings such as color, alignment, font, 
geometric shape, or bar code properties.

SupplementOptions (For the Barcode design item only) Specifies the supplement 
options (2- or 5-digit add-ons for EAN/UPC bar codes). 

TextJustify (For the Label and TextBox design items) Specifies how to 
distribute the text when you set the Alignment property to Justify.

VerticalAlignment (For the Label and TextBox design items) Specifies the vertical 
alignment of the text within the container.

Selections: Top, Middle, and Bottom

VerticalText Specifies the a vertical alignment for the text. 
• False—Does not render the text according to the vertical 

layout settings. 
• True—Renders the text according to the vertical layout 

settings.

WrapMode Specifies that a long line of text wraps to the beginning of the next 
line to fit in the container.

Table 141.Appearance properties in the Properties pane (Sheet 3 of 3)

Property Description
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Behavior Properties

Table 142 describes the Behavior properties.

Table 142.Behavior properties in the Properties pane (Sheet 1 of 3)

Behavior property Description

Angle Specifies the slope of the text within the container, in degrees.

AutoReplaceFields (For the RichTextBox design item only) Specifies whether the data 
in the container is automatically replaced with the data from the 
data source as specified by the Data Field property selection.

• False—Does not automatically replace the fields of the object 
with the fields in the data source that are assigned to the 
current workspace section.

• True—Automatically replaces the fields of the object with the 
fields in the data source that are assigned to the current 
workspace section.

AutoSize (For the Barcode design item only) Specifies whether the barcode 
design item stretches to fill its container.

Selections: True or False

CanGrow Specifies whether the container or section can increase in height to 
fit its contents.

Selections: True or False

CanShrink Specifies whether the container or section can decrease in height 
to fit its contents. 

Selections: True or False

CheckAlignment (For the CheckBox design item only) Specifies the alignment of 
the check box in the container.

Checked (For the CheckBox design item only) Specifies whether the 
CheckBox design item appears with or without a check mark in 
the report.

Selections:
• False—Shows the check box selected. 
• True—Shows the check box cleared. 

CheckSumEnabled (For the Barcode design item only) Specifies whether the 
application computes and includes a checksum in the bar code.

Selections: True or False
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ColumnDirection (For the Detail Section workspace section only) Specifies whether 
to display the data columns in the down-and-across direction or 
the across-and-down direction, for a multi-column 
(newspaper-style) report.

Selections: DownAcross or AcrossDown

Enabled (For the PageBreak design item only) Specifies whether the 
PageBreak design item is enabled.

Selections: True or False

KeepTogether (For the Detail Section and Appendix workspace sections only) 
Specifies whether the contents of the current section prints on a 
single page. This property does not shrink items to fit; rather, it 
acts like a page break between reported table rows.

Selections: True or False

MultiLine (For the Label, TextBox, ReportInfo, and RichTextBox design 
items only) Specifies whether the report template displays only the 
content that fits on one line or displays all the lines that fit in the 
container.

Selections: True or False

PrintAtBottom (For the Appendix workspace section only) Specifies where the 
design items in the Appendix section are printed.

Selections:
• False—Places the Appendix design items immediately after 

the DetailSection and before the page footer information.
• True—Places the Appendix design items at the bottom of the 

current page just above the page footer information.

RepeatToFill (For the Detail Section workspace section only) 

False—Does not repeat content to fill the report page.

True—Repeats content to fill the report page.

RightToLeft ((For the Label, TextBox, and ReportInfo design items) Specifies 
whether the text is aligned with the right side of the container. 
Also supports locales that use right-to-left fonts.

Selections: True or False 

Table 142.Behavior properties in the Properties pane (Sheet 2 of 3)

Behavior property Description
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Data Properties

Table 143 describes the Data properties.

ShrinkToFit Specifies whether the font size of the text within the selected 
container shrinks to fit the container. If the WrapMode property 
under Appearance is set to WordWrap, the application first wraps 
the text to fit the container and then shrinks the text to fit the 
container.

Selections: True or False

Visible Specifies whether the selected item appears in the report. By 
default, the Cover Page and Appendix sections are set to False, and 
therefore, do not appear in the report.

Selections: True or False

Table 142.Behavior properties in the Properties pane (Sheet 3 of 3)

Behavior property Description

Table 143.Data properties in the Properties pane (Sheet 1 of 3)

Data property Description

ColumnCount (For the Detail Section workspace section only) Specifies the 
number of columns in the report, similar to a newspaper layout. 

Default: 1

When the template contains data columns that match the layout 
of the main table (data columns displayed from left to right), use 
the default value of 1 (ColumnCount = 1) for the number of 
columns.

Tip  Increasing the number of columns per page works with 
transposed data columns (transposed from rows to columns).

CountNullValues (For the TextBox design item only) 

False—Does not include null values as zeros in the summary 
fields.

True—Includes null values as zeros in the summary fields.

ColumnSpacing (For the Detail Section workspace section only) Specifies the space 
between columns (newspaper style) in a multi-column report.

Culture (For the TextBox design item only) Formats the report data based 
on the selected culture from a particular country or region.

Default: Inherit
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DataField Specifies the data source (main table column, related table 
column, or data graph) for the content.

IMPORTANT  For best results, do not manually modify the 
content of this box; that is, do not select from the associated 
dropdown list or type text in the box. 

To change the design item to another design item, delete the 
current item. Then, add a new design item as described in “To 
add a main table column to the report template” on page 455 or 
“To add a data graph that is associated with the main table to the 
template” on page 456.

Description (For the Picture design item only) Not implemented.

Hyperlink Sets to a URL address for a specific location. The application 
automatically converts this URL to a hyperlink in the HTML or 
PDF exported reports.

Image (For the Picture design item only) Opens the Open dialog box 
where you can find and select the image file. The default file types 
for the search are image files.

MaxLength (For the RichTextBox design item only) Specifies the maximum 
number of characters to be displayed.

NewColumn (For the Detail Section workspace section only) Specifies where a 
new column is printed. The default number of report columns is 
1. The standard report templates contain only one column and 
the Customize Reports dialog box creates reports with one 
column. In this context, a column is a formatting option, not a 
table column from a result table.

Table 143.Data properties in the Properties pane (Sheet 2 of 3)

Data property Description
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NewPage Specifies whether a page break is inserted before, after, or both 
before and after the section.

Default settings: 
• CoverPage—After
• DetailSection—None
• Appendix—Before

CoverPage section:
• None—No page break between the cover page and the next 

section.
• Before—No effect.
• After—Adds a page break between the cover page and the 

next section.
• BeforeAfter—Adds a page break between the cover page and 

the next section.

DetailSection:
• None—No page break between the table rows.
• Before—Adds a page break between each table row.
• After—Adds a page break between each table row.
• BeforeAfter—Adds a page break between each table row.

Appendix section:

• None—No page break.
• Before—Adds a page break before the Appendix section.
• After—No effect.
• BeforeAfter—Adds a page break before the Appendix section.

Tag Displays information associated with an object on the page.

IMPORTANT  Do not modify or delete the Tag property.

Text For a Label design item, you can type text here. For the column 
headings, this box displays the column heading text. For the 
TextBox design item, this box displays the name of the data source 
(table column in the result file).

Title (For the Picture design item only) Not implemented.

Table 143.Data properties in the Properties pane (Sheet 3 of 3)

Data property Description
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Design Properties

Table 144 describes the Design property.

Layout Properties

Table 145 describes the Layout properties.

Table 144.Design properties in the Properties pane

Design property Description

(Name) Displays the internal name of an object on the report template 
page, used by the application to uniquely identify each individual 
object.

Table 145.Layout properties in the Properties pane (Sheet 1 of 2)

Layout property Description

End (For the CrossSectionLine and CrossSectionBox design items 
only) Specifies the X and Y coordinates of the end of the line or 
the bottom right corner of the box, based on the rulers at the top 
and left side of the report template page.

Height (For a workspace section only) Specifies the height of the section, 
based on the ruler to the left of the template workspace.

Location Specifies the X and Y coordinates of the upper left corner of an 
object, based on the rulers at the top and to the left of the 
template workspace.

Padding Specifies the values in points for the space to the left, top, right, 
and bottom of the textual content within the container.

Radius (For the CrossSectionBox design item only) Specifies the 
percentage value for the roundness of the corners of the box. The 
default value of 0 creates corners with no rounding. A value of 100 
creates top and bottom sides that look like half circles. 

RoundingRadius (For the Shape design item only) Specifies the percentage value for 
the roundness of the corners when you select RoundRect 
(rectangle with rounded corners) for the Style property.

Size Specifies the width and height of an object on the page, in inches.

SizeMode (For the Picture design item only) Specifies how the report 
designer sizes the image to fit in the container.

Selections:
• Clip—Clips images that are larger than the container.
• Stretch—Stretches images to fit the container.
• Zoom—Decreases the image size to fit the container.
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Miscellaneous Properties

Table 146 describes the Miscellaneous properties.

Start (For the CrossSectionLine and CrossSectionBox design items 
only) Specifies the X and Y coordinates of the start of the line or 
the top left corner of the box, based on the rulers at the top and to 
the left of the template workspace.

X1 (For the Line design item only) Specifies the coordinate of the left 
end of a line, based on the horizontal ruler at the top of the report 
template page.

X2 (For the Line design item only) Specifies the coordinate of the 
right end of a line, based on the horizontal ruler at the top of the 
report template page.

Y1 (For the Line design item only) Specifies the coordinate of the left 
end of a line, based on the vertical ruler to the left of the template 
workspace.

Y2 (For the Line design item only) Specifies the coordinate of the 
right end of a line, based on the vertical ruler to the left of the 
template workspace.

Table 145.Layout properties in the Properties pane (Sheet 2 of 2)

Layout property Description

Table 146. Miscellaneous properties in the Properties pane (Sheet 1 of 2)

Miscellaneous property Description

Code128 (For the Barcode design item only) When you select Code_128_x 
for the Style property in the Appearance area, use this property to 
define the code.

Code49 (For the Barcode design item only) When you select Code49 for 
the Style property in the Appearance area, use this property to 
define the code.

DataMatrix (For the Barcode design item only) When you select the 
DataMatrix option for the Style property in the Appearance area, 
use this property to define the code.

PDF417 (For the Barcode design item only) When you select Pdf417 for 
the Style property in the Appearance area, use this property to 
define the code.
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Opening the Property Dialog Boxes for the Report Template’s Design Items

The reporting feature for the application includes a property dialog box for each design item 
in the Section Reports pane. Using this dialog box, you can modify the formatting parameters 
for a selected design item on the report template page. The available properties vary 
depending on the selected workspace section or design item. Most of these parameters are 
similar to the properties listed in the Properties pane, although some might have slightly 
different names.

 To open the property dialog box for a report design item

1. Select the design item of interest in the workspace.

The properties pane for the selected item appears (Figure 134).

QRCode (For the Barcode design item only) When you select QRCode for 
the Style property in the Appearance area, use this property to 
define the code.

A QR code (quick response code) is a matrix (2D) barcode. 
Because smartphones can convert QR codes to URLs, QR codes 
can provide quick access to websites.

RssExpandedStacked (For the Barcode design item only) When you select 
RssExpandedStacked for the Style property in the Appearance 
area, use this property to define the code.

Table 146. Miscellaneous properties in the Properties pane (Sheet 2 of 2)

Miscellaneous property Description
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Figure 134. Properties pane for a label design item

2. At the bottom right corner of the report template page, click the Property Dialog link. 

The property dialog box for the selected object opens (Figure 135).

Figure 135. Property dialog box for the Label design item

Property Dialog link
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The parameters in the property dialog boxes have equivalent parameters in the properties 
pane. 

Populating a Rich Text Box by Loading a File

Use the Load File link at the bottom right corner of the report template page, to populate a 
RichTextBox design item with data from a file.

 To populate a RichTextBox design item

1. Click the Load File link.

2. In the Open dialog box, select the data file and then click Open.

You can load text from one of these file types: RTF, TXT, or HTML or HTM.

Selecting the Paper Type, Print Width, Page Orientation, and 
Watermark for a Report Template

On the report template page, you can add a watermark, change the print width and the 
orientation of the report template (portrait or landscape), and select the type of paper that you 
want the printer to use. 

Follow these procedures as needed:

• To open the property settings for the report template

• To add a watermark to the report template

• To change the print width of the template

• To change the page orientation of the report template

• To change the paper size used by the printer

Note  For the RichTextBox design item, in addition to the Property Dialog link, you can 
click the Load File link to load text from a file into the box (see “Populating a Rich Text 
Box by Loading a File” on page 487). 
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 To open the property settings for the report template

Click the square in the upper left corner (below the toolbar) of the report template page.

The watermark properties appear in the Appearance group, and the orientation and paper 
size properties appear in the Miscellaneous group (Figure 136).

Figure 136. Report template properties (in the Properties pane)

Click this 
square.
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 To add a watermark to the report template

1. Under Appearance, click the browse icon, , to the far right of the Watermark property.

The Open dialog box opens with the file type setting for all image files.

2. Find and select the image file of interest and click Open.

3. In the WatermarkAlignment list, select the appropriate alignment.

4. In the WatermarkPrintOnPages box, type the page number of the page where you want 
the watermark to appear.

5. In the WatermarkSizeMode list, select whether you want to clip the image if it is larger 
than the container, stretch the image to fit the container, or reduce the image size to fit 
the container.

 To change the print width of the template

Under Behavior, type a numeric value in the PrintWidth box.

 To change the page orientation of the report template

Under Misc, in the IsLandscape list, select True for Landscape or False for Portrait.

 To change the paper size used by the printer

Under Misc, in the PaperKind list, select the appropriate paper size. 

To open the list to the paper size of interest, type the first letter of the paper-size name. 
For example, if you want to change the size from A4 to Letter, type an L in the box. If the 
paper size does not appear in the box, continue typing the next letter of its name. The 
application cycles through the paper sizes that begin with this letter or letters.

Previewing and Printing a Report
This topic describes how to work with the Report Preview and Report Print dialog boxes and 
the report resolution page. 

You can print all of the report pages from the report resolution page or the Report Print dialog 
box. You can print up to five pages from the Report Preview dialog box.

Follow these procedures as needed:

• To open the Report Preview dialog box

• To open the Report Print dialog box

• To open the report resolution page

• To find a text item in a resolved report
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• To copy a portion of a report to the Clipboard

• To export the contents of a report to an external document

• To print a report

 To open the Report Preview dialog box

In the toolbar on the report template page, click the Preview Report icon, .

The application opens the Report Preview dialog box and resolves the current result file 
with the current template on the report template page. The Page Thumbnails pane 
displays up to five resolved pages. A red line in the right page margin indicates that the 
print width does not fit on the selected page size, and the printer will print an empty page 
with every report page it prints, unless you resize the template (see To change the print 
width of the template).

Figure 137. Report Preview dialog box with a red line indicating an insufficient right margin
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 To open the Report Print dialog box

In the toolbar on the report template page, click the Print Report icon, .

The application opens the Report Print dialog box and resolves the current result file with 
the current template on the report template page.The Page Thumbnails pane displays all 
of the report pages. 

 To open the report resolution page

1. Open a result file.

2. Select an existing report template as follows:

a. Choose Reporting > Create Report from the menu bar or, click the Create Report 
icon, .

The Open Report Design Template dialog box opens to the Report Templates folder. 

b. Select the appropriate report template and click Open.

The application resolves the current result file with the selected template. The Page 
Thumbnails pane displays all of the report pages.

 To find a text item in a resolved report

1. On the report template page, resolve the report by clicking the Print Report icon, , or 
the Preview Report icon, .

2. In the toolbar of the Report Print dialog box or the Report Preview dialog box, click the 
Find icon, .

The Find dialog box opens.

3. In the Find What box, type the text that you want to find (see Figure 138).

Figure 138. Find dialog box with a text entry

4. Select the appropriate check boxes.

• To match whole words only, select the Match Whole Word Only check box.

• To match the case—uppercase or lowercase, select the Match Case check box.

5. Click Find Next or Find Prev.
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 To copy a portion of a report to the Clipboard

Do one of the following:

a. To copy a specific item to the Clipboard, in the Report Preview toolbar, click the 
Selection Mode icon, .

b. Click the item that you want to copy, and then click the Copy icon, .

–or–

a. To copy a rectangular portion of the report to the Clipboard, click the Snapshot 
Mode icon, . 

b. Drag the cursor across the area of interest.

 To export the contents of a report to an external document

1. Open the report resolution page or the Report Print dialog box.

2. In the toolbar, choose Export > File Type, where the File Type is one of the following:

• Text—text file

• PDF—portable document format file

• RTF—rich text format file

• Excel—Microsoft spreadsheet

• HTML—web page that opens in a browser

 To print a report

1. Do one of the following:

a. From the menu bar, choose Reporting > Create Report. 

The Open Report Design Template dialog box opens. 

b. Select an appropriate template and click Open.

The report resolution page opens.

–or–

• From the report template page, open the Report Print dialog box by clicking the 
Print Report icon, .

2. In the toolbar, click the Print icon, .

The Print dialog box opens.

3. Select the appropriate printer and the page range that you want to print.

4. Click OK to print the report.
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Related Topics

• Report Preview Toolbar

• Page Thumbnails Pane

Report Preview Toolbar

The Report Preview and Report Print dialog boxes and the report resolution page share a 
common toolbar. Table 147 describes the icons in the toolbar, from left to right.

Table 147. Report preview icons (Sheet 1 of 2)

Icon Description

Toggle Sidebar—Opens and closes the Page Thumbnails pane (see “Page 
Thumbnails Pane” on page 495). 

Print—Opens the Print dialog box where you select the appropriate print 
options and send the report to the selected printer.

Copy—Copies the selected item to the Clipboard. Clicking the Selection 
Mode icon activates the Copy icon.

Find—Opens the Find dialog box where you can search for a particular 
word or phrase in the report.

Zoom Out—Reduces the magnification of the report view. The current 
zoom box displays the magnification.

Zoom In—Increases the magnification. The current zoom box displays the 
magnification.

Current zoom—Use to change the on-screen magnification of the report 
by selecting or typing a percentage from 10 to 800 in this box, and then 
pressing ENTER.

Fit Width—Sizes the width of the report to the screen width. The current 
zoom box displays the magnification.

Fit Page—Sizes the current report page to the screen width and height, 
while maintaining the aspect ratio. The current zoom box displays the 
magnification.

Single Page View—Fits the current report page to the full-screen view and 
removes the scroll bar. To view the report pages, you must use the First 
Page, Previous Page, Next Page, and Last Page icons or the Page 
Thumbnails pane.

Continuous View—Changes the magnification to 100% and makes the 
scroll bar available so that you can scroll through the document.

Multipage view—Changes the display to the selected multi-page view. 

First Page—Displays the first page of the report.
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Previous Page—Displays the previous page of the report.

Current Page—Indicates the current page and the estimated number of 
pages in the report.

Next Page—Displays the next page of the report.

Last Page—Displays the last page of the report.

Backward—Displays the previously selected page in the report.

Selecting pages as you browse activates the Backward icon.

Forward—Displays the next selected page in the report. 

Clicking the Backward icon activates the Forward icon.

Pan Mode—Use the hand cursor to drag the page on the screen.

Selection Mode—Use to copy a report item to the Clipboard.

Snapshot Mode—Use to copy a rectangular area to the Clipboard.

Export—Use to export the contents of the report to an external document 
of one of these types: Text, PDF, RTF, Excel, or HTML.

Table 147. Report preview icons (Sheet 2 of 2)

Icon Description
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Page Thumbnails Pane

The Page Thumbnails pane appears to the left of the page preview in the Report Preview and 
Report Print dialog boxes and the report resolution page. Each thumbnail represents a page in 
the report. The Report Preview dialog box resolves up to five pages of data. The Report Print 
dialog box resolves all of the data. In the Report Print dialog box, click a page thumbnail to 
jump to that page.

Table 148 describes the icons in the Page Thumbnails pane, from top left to bottom right.

Table 148. Page Thumbnails pane icons

Icon Description

Enlarge—Enlarges the size of the thumbnails.

Reduce—Reduces the size of the thumbnails.

Thumbnails Pane—Displays the Page Thumbnails pane.

Search Results—Displays the Search Results pane where you can search for 
a particular word or phrase in the report. The found instances appear in 
the list of results.
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12

Using the Lists and Libraries Manager

To modify the lists and libraries that are used to process data in the Compound Discoverer 
application, see the following topics.

Library Manager Page
Clicking the Lists & Libraries Manager icon, , in the application toolbar opens the Lists & 
Libraries Manager as a tabbed page. The buttons in the left pane open the individual views, 
and the buttons across the top of the page perform various tasks. 

Not all the task buttons are available for every view. The Edit button is unavailable for the 
Spectral Libraries view, and the Replace button is visible only for the Mass Lists, Spectral 
Libraries, and Metabolika Pathways views.

Contents

• Library Manager Page

• Modifying the Expected Compounds List

• Modifying the Adducts List

• Modifying the Ion Definitions List

• Modifying the Transformations List

• Modifying the Mass Lists Library

• Modifying the Spectral Libraries List

• Modifying the Metabolika Pathways List

• Modifying the Compound Classes List

• Loading a Structure from a Structure File

• Finding a Structure in the ChemSpider Database

• Using the Structure Drawing Tools or Commands



12 Using the Lists and Libraries Manager
Modifying the Expected Compounds List

498 Compound Discoverer User Guide Thermo Scientific

Each view in the Lists & Libraries Manager page includes a table. For information about 
freezing panes, hiding and showing columns, freezing rows, sorting, and filtering the 
application tables, see “Working with the Application Tables” on page 579.

Modifying the Expected Compounds List
The initial expected compounds list contains omeprazole (Figure 139), the targeted 
compound used in the Compound Discoverer Metabolism Tutorial. 

Figure 139. Expected Compounds view

To modify the expected compounds list, see these topics:

• Importing, Exporting, and Deleting Compounds

• Adding and Editing Compounds with the Compound Editor

Importing, Exporting, and Deleting Compounds

Follow these procedures as needed: 

• To open the Expected Compounds view

• To delete a compound

• To import a list of compounds from an XML file

• To export the contents of the Expected Compounds view to an XML file

Note  To use a targeted processing workflow that includes the Generate Expected 
Compounds node, the Create FISh Trace node, or both of these nodes, you must first add 
the compounds of interest to the Expected Compounds list. 

Filters rowButton bar
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 To open the Expected Compounds view

From the application menu bar, choose Lists & Libraries > Expected Compounds.

The Expected Compounds view contains your list of expected compounds for targeted 
analyses.

 To delete a compound

1. Select the compound and click Delete.

2. At the prompt, click Yes.

 To import a list of compounds from an XML file

1. In the Expected Compounds view, click Import.

2. Select the XML file of interest, click Open, and then click OK at the prompt.

The application only imports new entries; it does not import entries that are already in 
the list. After the application imports the new compound entries, it provides a tally of the 
number of imported compounds versus the number of skipped compounds. 

 To export the contents of the Expected Compounds view to an XML file

1. In the Expected Compounds view, click Export All.

2. Select a folder, name the file, and click Save.

The application exports the list to an XML file.

3. At the prompt, click OK.

Table 149 describes the parameters in the Expected Compounds view.

Table 149. Expected Compounds view parameters (Sheet 1 of 2)

Feature Description

Buttons

New Opens the Compound Editor for adding new compounds to the 
list. 

Edit Opens the Compound Editor for editing the selected compound. 

Selecting a compound activates this button. 

Delete Deletes the selected compound.

Selecting a compound activates this button. 

Import Opens the Open dialog box for selecting an XML file. 

Export All Opens the Save As dialog box for exporting the entire list as an 
XML file.
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Adding and Editing Compounds with the Compound Editor

Use the Compound Editor dialog box to create new compound entries or edit existing entries 
in the Expected Compounds view.

Follow these procedures as needed:

• To open the Compound Editor dialog box

• To add a compound to the Expected Compounds list

• To open a structure file

• To edit an existing entry

 To open the Compound Editor dialog box

1. Open the Expected Compounds view (see “To open the Expected Compounds view” on 
page 499).

2. Do one of the following:

• To add a new compound, click New.

• To edit an existing entry, select the entry and click Edit.

Table columns

Name Displays the user-specified compound name.

Description Displays the user-specified description.

Elemental 
Composition

Displays the elemental composition that the application 
determines from the compound’s structure.

Molecular Weight Displays the molecular weight that the application calculates from 
the compound’s elemental composition.

Structure Displays the structure created by using the drawing tools or by 
importing a structure file.

Table 149. Expected Compounds view parameters (Sheet 2 of 2)

Feature Description

Note  Similar Compound Editor dialog boxes open from the Mass List and Metabolika 
Pathways editors. For information about using the structure drawing tools, see “Using the 
Structure Drawing Tools or Commands” on page 542.
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 To add a compound to the Expected Compounds list

1. In the Expected Compounds view, click New.

The Compound Editor dialog box opens . As indicated by the red borders you must name 
the compound and enter its elemental composition to save it. 

Figure 140. Compound Editor dialog box for a new compound

2. To enter the elemental composition, draw the structure in the drawing area, open a 
structure file, or click ChemSpider to find the structure.

The application automatically populates the Elemental Composition and Molecular 
Weight boxes with read-only values. To change the elemental composition and the 
molecular weight, you must modify the chemical structure in the drawing area.

3. (Optional) In the Description box, type a description of the compound.

4. Click Save. 

The dialog box closes and the compound appears in the list.

 To open a structure file

See “Loading a Structure from a Structure File” on page 541.

 To edit an existing entry

1. In the Expected Compounds view, either double-click the entry or select it and click Edit.

The Compound Editor dialog box opens with information for the selected entry.

Drawing area

Opens the ChemSpider application

Click to locate and 
open a structure file.
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2. Edit the information as applicable.

• To modify the chemical structure, edit the structure in the drawing area (see “Using 
the Structure Drawing Tools or Commands” on page 542) or open a different 
structure file.

The application automatically populates the Elemental Composition and Molecular 
Weight boxes.

• To change the compound name, type alphanumeric text in the Name box.

3. To save the changes, click Save, and then click Yes at the prompt.

Modifying the Adducts List
Use the Adducts view to define the adducts in your sample solutions (Figure 141).

Figure 141. Adducts view

To modify the adducts list, see these topics:

• Working with the Adducts List

• Adding and Editing Adducts with the Adduct Editor
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Working with the Adducts List

Follow these procedures as needed:

• To open the Adducts view

• To delete an adduct from the list

• To import a list of adducts from an XML file

• To export the entire list of adducts to an XML file

 To open the Adducts view

From the application menu bar, choose Lists & Libraries > Adducts. 

 To delete an adduct from the list

1. Select the adduct and click Delete.

2. At the prompt, click Yes.

 To import a list of adducts from an XML file

1. Click Import.

2. In the Open dialog box, locate the file, and click Open.

A message opens with a tally of the number of imported adducts versus the number of 
skipped adducts. The application only imports new entries; it does not import entries 
that are already in the list.

3. At the prompt, click OK.

 To export the entire list of adducts to an XML file

1. Click Export All.

2. Select a folder, name the file, and click Save.

3. At the prompt, click OK.

Adding and Editing Adducts with the Adduct Editor

Use the Adduct Editor dialog box to define additional adducts, which are part of the ion 
definition.

 To add adducts to the Adducts library

1. Open the Adducts view (see “Modifying the Adducts List” on page 502).

2. In the button bar, click New.

The Adduct Editor dialog box opens (Figure 142). 



12 Using the Lists and Libraries Manager
Modifying the Adducts List

504 Compound Discoverer User Guide Thermo Scientific

Figure 142. Adduct Editor dialog box 

3. Define the new adduct as follows:

• In the Name box, select New and type a name for the adduct.

• In the Elemental Composition box, type the elemental composition of the adduct.

The editor validates the composition entry.

• In the Charge box, type the charge that the adduct adds to the ion definition. 

Range: –10 to +10

4. Click Save.

The new adduct appears in the library.

 To edit an adduct entry

1. Select the entry.

2. Click Edit.

The Adduct Editor opens with the selected entry.

3. Modify the adduct definition as follows:

• In the Name box, select the current name and type a new name for the adduct.

• In the Elemental Composition box, select the current elemental composition and 
type a new elemental composition for the adduct.

The editor validates the composition.

• In the Charge box, type the charge that the adduct adds to the ion definition.

Range: –10 to +10

4. Click Save. 
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Modifying the Ion Definitions List
To modify the Ion Definitions list, see these topics:

• Working with the Ion Definitions List

• Adding or Editing Ion Definitions with the Ion Definition Editor

Working with the Ion Definitions List

The application uses the entries in the Ion Definitions list in the following workflow nodes: 
Detect Compounds and Generate Expected Compounds.

The default Ion Definitions list contains the most common adducts and dimers formed when 
using the electrospray-mass spectrometry (ESI-MS) technique in either the positive or 
negative polarity mode. 

Table 150 lists the common adducts and dimers for the positive polarity mode. Table 151 lists 
the common adducts and dimers for the negative polarity mode.

Table 150. Common adducts and dimers in the positive ion mode

Ion definition Adducts 
total mass Charge Ion definition Adducts 

total mass Charge

M+H–H2O –17.00329 1 M+H+Na 23.9965 2

M+H–NH3 –16.01927 1 M+H+MeOH 33.03349 1

M+H 1.00728 1 M+K 38.96316 1

2M+H 1.00728 1 2M+K 38.96316 1

M+2H 2.01455 2 M+H+K 39.97044 2

M+3H 3.02183 3 M+H+ACN 42.03383 1

M+NH4 18.03383 1 2M+H+ACN 42.03383 1

2M+NH4 18.03383 1 M+2H+ACN 43.0411 2

M+H+NH4 19.0411 2 M+Na+ACN 64.01577 1

M+Na 22.98922 1 2M+Na+ACN 64.01577 1

2M+Na 22.98922 1 M+H+DMSO 79.02121 1

Table 151. Common adducts and dimers in the negative ion mode (Sheet 1 of 2)

Ion definition Adducts 
total mass Charge Ion definition Adducts 

total mass Charge

M–H –1.00728 –1 M–H+FA 44.9982 –1

2M–H –1.00728 –1 2M–H+FA 44.9982 –1

M–2H –2.01455 –2 2M–H+HAc 59.01385 –1
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Figure 143 shows the default ion definitions. 

Figure 143. Ion Definitions view

M–H–H2O –19.01784 –1 M–H+HAc 59.01385 –1

M+Cl 34.9694 –1 M–H+TFA 112.98559 –1

M–2H+K 36.94861 –1

Table 151. Common adducts and dimers in the negative ion mode (Sheet 2 of 2)

Ion definition Adducts 
total mass Charge Ion definition Adducts 

total mass Charge
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Follow these procedures as needed:

• To open the Ion Definitions view

• To delete an ion definition

• To import a list of ion definitions from an XML file

• To export the contents of the Expected Compounds view to an XML file

 To open the Ion Definitions view

In the application menu bar, choose Lists & Libraries > Ion Definitions. 

 To delete an ion definition

1. In the Ion Definitions view, select the ion definition and click Delete.

2. At the prompt, click Yes.

 To import a list of ion definitions from an XML file

1. In the Ion Definitions view, click Import.

2. Locate the file and click Open.

A message opens with a tally of the number of imported ion definitions versus the 
number of skipped ion definitions. The application only imports new entries; it skips 
entries that are already in the list.

3. At the prompt, click OK.

 To export the entire list of ion definitions to an XML file

1. In the Ion Definitions view, click Export All.

2. Select a folder, name the file, and click Save.

The application automatically adds the file name extension (.xml). 

3. At the prompt, click OK.

Table 152 describes the columns in the Ion Definitions view.

Table 152. Ion Definitions table columns (Sheet 1 of 2)

Column Description

Ion Definitions Displays the user-specified ion definition.

Adducts Total Mass Displays the difference between the exact mass of the neutral 
molecule and the molecular ion adduct or the exact mass of the 
neutral dimer and the ionized dimer.
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Adding or Editing Ion Definitions with the Ion Definition Editor

Use the Ion Definition Editor dialog box to create new ion definitions.

 To add ion definitions to the Ion Definitions list

1. Open the Ion Definitions view (see “Working with the Ion Definitions List” on 
page 505).

2. In the button bar, click New.

The Ion Definition Editor dialog box opens (Figure 144). The Ion Definition box 
contains only an M for the uncharged molecule. Because the ion definition must include 
at least one additional component, a charge, or both, the box has a red border, and the 
Save button is unavailable. 

Figure 144. Ion Definition Editor dialog box

3. In the Weight Factor box, type the weighting factor for the ion definition.

Range: 0 to 99

4. To enter an ion definition, do any of the following:

• Type the ion definition in the Ion Definition box.

• Under Available Adducts, use the arrows to add or subtract components.

Charge Displays the charge of the ion.

Weight Specifies the weighting factor for the ion definition when the ion 
definition is added to the list of possible ions in the Ions list for 
the Detect Compounds node. 

Table 152. Ion Definitions table columns (Sheet 2 of 2)

Column Description
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–or–

• Select the current value to the left of the component and type a new integer value.

5. To save the changes, click Save.

The application calculates the ion’s charge and difference in mass between the uncharged 
molecule and the new ion definition. The new ion definition appears in the list.

 To edit an ion definition

1. In the Ion Definitions view, select the ion definition.

2. Click Edit.

The Ion Definition Editor opens with the selected definition in the Ion Definition box.

3. To modify an ion definition, do any of the following:

• Type the ion definition in the Ion Definition box.

• Under Available Adducts, use the arrows to add or subtract components.

–or–

• Select the current value to the left of the component and type a new integer value.

4. In the Weight Factor box, type a weighting factor from 0 to 99 for the ion. 

The Detect Compounds node uses the weight factor value for the ion definitions. With 
the exception of the protonated molecule [M+H]+ in the positive polarity mode and the 
deprotonated molecule [M–H]– in the negative polarity mode, if you set the weight factor 
to 0, the Detect Compounds node does not look for the specified adduct in the mass 
spectrum. 

5. To save the changes, click Save, and then click Yes at the prompt.

Table 153 describes the parameters in the Ion Definition Editor dialog box.

Table 153. Ion Definition Editor parameters

Parameter Description

Ion Definition Displays the current ion definition. Valid ion definitions include the 
neutral molecule, which is represented by M, and components from the 
component list. A red border indicates an invalid ion definition.

As you edit the ion definition by using the component list, the application 
automatically updates the ion definition.

Weight Factor Specifies the weighting factor for the ion definition.

Available 
Adducts list

Use this list to create custom ion definitions. For information about using 
this list to create ion definitions, see “To add ion definitions to the Ion 
Definitions list” on page 508.
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Modifying the Transformations List
Follow these topics to modify the Transformations list:

• Deleting, Importing, or Exporting Transformations

• Adding or Editing Transformations with the Transformation Editor

Deleting, Importing, or Exporting Transformations

The Transformations view contains a table of possible transformations (Figure 145). The 
Generate Expected Compounds node uses a selection of entries from this table and the 
information in the expected compounds list to generate a table of expected transformations 
for a known compound.

Figure 145. Transformations view with the default transformations list
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Follow these procedures:

• To open the Transformations view

• To delete an entry from the transformations list

• To import a list of transformations from an XML file

• To export the entire transformations list to an XML file

 To open the Transformations view

From the application menu bar, choose Lists & Libraries > Transformations.

 To delete an entry from the transformations list

1. In the Transformations view, select the entry and click Delete.

2. At the prompt, click Yes.

 To import a list of transformations from an XML file

1. In the Transformations view, click Import.

2. Locate the file and click Open.

A message opens with a tally of the number of imported transformations versus the 
number of skipped transformations. The application only imports new entries; it does not 
import entries that are already in the library.

3. At the prompt, click OK.

 To export the entire transformations list to an XML file

1. In the Transformations view, click Export All.

2. Select a folder, name the file, and click Save. 

3. At the prompt, click OK.

Table 154 describes the parameters in the Transformations view. 

Table 154. Transformations view features (Sheet 1 of 2)

Feature Description

Buttons

New Opens the Transformation Editor dialog box for creating new 
transformations.

Edit Selecting an entry activates this button. 

Opens the Transformation Editor dialog box for editing the 
selected transformation.
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Adding or Editing Transformations with the Transformation Editor

Use the Transformation Editor to add entries to or to edit entries in the transformations list.

 To add a transformation to the transformations list

1. In the Transformations view, click New.

The Transformation Editor dialog box opens (Figure 146). The empty Name, Arriving 
Group, and Leaving Group boxes have a red outline. You must enter information in the 
Name box and in at least one of the group boxes.

Delete Selecting an entry activates this button. 

Deletes the selected transformation from the library.

Import Opens a dialog box for selecting an XML file to import.

Export All Opens the Save As dialog box for saving the list as an XML 
file.

Table columns

Name Displays the user-specified name for the entry.

Leaving Group Displays the user-specified elemental composition of the 
leaving group for the transformation, if specified.

Arriving Group Displays the user-specified elemental composition of the 
arriving group for the transformation, if specified.

Leaving Modification Displays the elemental composition difference between the 
arriving group and the leaving group, if the transformed 
compound contains fewer atoms than the original compound.

Arriving Modification Displays the elemental composition difference between the 
arriving group and the leaving group, if the transformed 
compound contains more atoms than the original compound.

M [Da] Displays the difference in mass between the original 
compound and the transformed compound in daltons.

Phase Displays the user-specified category for the transformation.

Max Occurrence Displays the user-specified value for the maximum number of 
times that this transformation can occur in a sequence of 
combinatorial transformations.

Table 154. Transformations view features (Sheet 2 of 2)

Feature Description
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Figure 146. Transformation Editor dialog box

2. In the Name box, type alphanumeric text to identify the transformation.

The red outline disappears.

3. Define the transformation as follows:

a. In the Arriving Group box, type alphanumeric text for the arriving group of the 
transformation, if applicable.

Valid alphabetic characters include all of the naturally occurring elements in the 
periodic table. The valid range of integers is from 1 to 100 000.

After you define the arriving group, the red outline remains until you place the cursor 
in the Leaving Group box. If you leave the Arriving Group box empty, the red outline 
remains until you define the leaving group.

b. In the Leaving Group box, type alphanumeric text for the transformation’s leaving 
group.

The red outline disappears when you select a phase from the Phase list or place the 
cursor in the Maximum Occurrence box.

c. In the Phase list, select Phase 1 or Phase 2 for a biotransformation, or select Other 
for other transformation types.

d. In the Maximum Occurrence box, type an integer from 1 to 10. 

The Transformation Editor validates the entries from top to bottom. 

After you make valid entries, the Save button becomes available. 

4. Click Save.

The Transformation Editor dialog box closes and the new entry appears in the 
transformations library.
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 To edit an entry in the transformations list

1. In the Transformations view, select the entry and click Edit.

The Transformation Editor dialog box opens. The entry boxes are populated with the 
information for the transformation that you selected in the transformations list 
(Figure 147).

Figure 147. Transformation Editor with information for an acetylation chemical reaction

2. Make the appropriate changes.

If the changes are invalid, the Save button becomes unavailable, the application outlines 
the invalid entries in red, and the invalid entries temporarily appear in the 
transformations library.

3. Click Save and, at the prompt, click Yes.

Table 155 describes the parameters in the Transformation Editor dialog box.

Table 155. Transformation Editor parameters

Parameter Description

Name Type alphanumeric text in this box.

Arriving Group Type the elemental composition of the arriving group in this box.

Leaving Group Type the elemental composition of the leaving group in this box.

Phase Select a phase from this list.

Selections: Phase I, Phase II, and Other

Maximum Occurrence Type the maximum number of times that this reaction can occur 
in a set of combinatorial reactions.

Default: 1
Range: 1 to 10 
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Modifying the Mass Lists Library
Use the Mass Lists view to create a library of available mass lists to use with the Search Mass 
Lists node—a processing workflow node that searches selected mass lists for matching 
compounds. Figure 148 shows the mass lists that come with the application. 

To edit the mass lists library or a mass list, follow these topics:

• Adding, Deleting, Importing, Exporting, and Replacing Mass Lists

• Editing a Mass List

• Adding and Editing Mass List Compounds with the Compound Editor

Figure 148. Mass Lists view

The application comes with four mass lists: 

• Anita Lab Flavenoid Structure Database.massList (with structures)

• Endogenous Metabolites database 4400 compounds.massList 

• EFS HRAM Compound Database.massList

• Extractables and Leachables HRAM Compound Database.massList (with structures)
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The application can read the following file types:

• CSV files with a molecular weight column, an elemental composition column, or both of 
these columns (For best results, verify that the molecular weight is calculated to five 
decimal places.)

• CSV files created by exporting a ChemSpider Results table or a Compounds table as plain 
text.

• CSV files created by exporting data from the Thermo Scientific ToxID application

• CSV files (MaConDa_version#_.csv) downloaded from the Mass Spectrometry 
Contaminant Database

• Mass lists files (.massList) created by the Compound Discoverer application

• XML files created by exporting all the compounds (Export All command) in the Expected 
Compounds library.

Figure 149 shows a flowchart for adding compounds to or editing the compounds in a mass 
list.

Note  The Export > As Plain Text shortcut menu command saves the data in the result 
table to a CSV file (ChemSpider Results.csv or Compounds.csv).
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Figure 149. Flowchart for creating and editing mass lists within the application

To open the Mass Lists view, from 
the application menu bar, choose 
Lists & Libraries > Mass Lists.

In the Mass Lists view, click New.

In the Create New Mass List dialog box, 
name the mass list and click Create.

In the Edit ‘File Name.massList’ (No 
Compounds ) dialog box, click New.

In the Compound Editor dialog box, define 
the new compound and click Save.

In the Edit ‘File Name.massList’ 
(No Compounds) dialog box, click Save to 

save the new mass list.

In the Edit ‘File Name.massList’ 
(# Compounds ) dialog box, click New or 

select a compound and click Edit..

In the Compound Editor dialog box, define the 
new compound or edit the selected compound 

and click Save.

Create a new 
mass list?

Edit an 
existing 

mass list?

In the Mass Lists view, select a mass 
list and click Edit.

In the Edit ‘File Name.massList’ 
(# Compounds) dialog box, click Save to 

save the edited mass list. 

No

Yes

Yes

Repeat for each 
new compound.

Repeat to add 
or edit more 
compounds.
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Adding, Deleting, Importing, Exporting, and Replacing Mass Lists

From the Mass Lists view, you can add, delete, export, and replace mass lists.

Follow these procedures as needed:

• To open the Mass Lists view

• To create a new mass list

• To delete mass list files

• To import a mass list from a CSV file

• To replace a mass list file

• To export a mass list file to a specified file directory

 To open the Mass Lists view

From the application menu bar, choose Lists & Libraries > Mass Lists.

 To create a new mass list

1. In the Mass Lists view, click New.

The Create New Mass List dialog box opens.

2. Name the file and click Create.

The Edit File Name (No Compounds) dialog box opens.

3. Go to the next topic, “Editing a Mass List” on page 521.

 To delete mass list files

1. In the Mass Lists view, select the entries to delete and click Delete.

2. At the prompt, click Yes.

 To import a mass list from a CSV file

1. In the Mass Lists view, click Import.

2. Locate the CSV file and click Open.
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The Define CSV File Format dialog box opens.

3. In the Essential Columns area, do the following as needed:

• To define the column in the CSV file that contains the compound names, select the 
column name from the Name list.

• To define the column in the CSV file that provides the compound masses, select the 
column name from the Formula, Molecular Weight, or Structure lists. 

• To define the column in the CSV file that provides the chromatographic retention 
times of the compounds, select the column name from the Retention Time list.

4. Click OK.

The Edit ‘File Name.massList (# Compounds)’ dialog box opens.

5. To edit the mass list, see “Editing a Mass List” on page 521.

 To replace a mass list file

1. In the Mass Lists view, select the entry and click Replace.

2. Browse to the appropriate folder, select a file, and click Open.

• When you select a result file to replace the existing file, the application automatically 
reads the mass list.

• When you select a CSV file, the Define CSV File Format for file name.csv dialog box 
opens if the application does not recognize the file format. Otherwise, the application 
automatically reads the mass list.

 To export a mass list file to a specified file directory

1. In the Mass Lists view, select the file.

2. Click Export. 

3. Select a folder for the file, rename the file if applicable, and click Save.

Table 156 describes the parameters in the Mass Lists view.

Note  Typically, when the column header in the CSV file matches the name of an 
essential column, the application recognizes it in the Essential Columns area. A red 
border around a column name indicates that you must define the column. 

The OK button remains unavailable until you define the Name column and at least 
one column that provides the compound’s mass.

Note  Double is the value type for the Molecular Weight column. 
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Table 156. Mass Lists view parameters (Sheet 1 of 2)

Parameter Description

Button

New Opens the Create Mass List dialog box for creating and naming a 
new and empty mass list file. After you name the file and click 
Create, the Edit ‘File Name.massList (# Compounds)’ dialog box 
opens for adding compounds to the list.

Edit Opens the Edit ‘File Name.massList (# Compounds)’ dialog box 
for editing the selected mass list.

Selecting a table row activates this command.

Delete Deletes the selected file from the library.

Selecting a table row activates this command.

Import Opens a dialog box for locating and opening a CSV, a massList, or 
an XML file that contains, at a minimum, a list of masses. 

When you select a CSV file, the Define CSV File Format ‘File 
Name.csv’ dialog box opens.

Export Opens the Save As dialog box for renaming and saving the selected 
mass list file to another folder. 

Replace Replaces the selected file with the replacement file. Use this 
command when the replacement file has the same name as the 
current file. 

Selecting a table row activates this command. 

Table columns

Filename Displays the file name of the imported file.

Description User-editable field for adding descriptive information about the 
mass list.

File Size Displays the file size of the imported file.

Uploaded Displays the date (month/day/year) and time (hour/minute) when 
you added the file to the library in the following format: 

MM/DD/yyyy HH:mm

Updated Displays the data and time when the file was updated.
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Editing a Mass List

Use the Edit ‘File Name.massList (# Compounds)’ dialog box to modify the compounds list in 
a mass list. You can add entries to or edit the existing entries in the list.

To edit a mass list, follow these procedures as needed:

• To open a mass list for editing

• To add a compound to or edit a compound in a mass list

• To delete a compound from a mass list

• To import compounds from an XML file into a mass list

• To import compounds from a CSV file into a mass list

• To add a new column to a mass list

 To open a mass list for editing

1. From the application menu bar, choose Lists & Libraries > Mass Lists.

2. Do one of the following:

• Create a new mass list (see “To create a new mass list” on page 518).

• Select a mass list file and click Edit.

–or–

• Double-click a mass list file.

The Edit ‘File Name (# Compounds)’ dialog box opens with editable entries for the 
selected mass list.

 To add a compound to or edit a compound in a mass list

See “Adding and Editing Mass List Compounds with the Compound Editor” on 
page 524.

Context Displays the source of the mass list—for example, Import from 
CSV or Import from XML.

State Specifies whether the mass list is available, corrupted, or missing.

If you remove a mass list from the ServerFiles folder or edit a mass 
list in the ServerFiles Folder, and then restart the application, the 
mass list’s state changes to Missing or Corrupted, respectively.

Table 156. Mass Lists view parameters (Sheet 2 of 2)

Parameter Description
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 To delete a compound from a mass list

1. Open the mass list for editing.

2. In the Edit ‘File Name (# Compounds)’ dialog box, select the compound, and then click 
Delete.

3. Click Save.

 To import compounds from an XML file into a mass list

1. Open the mass list (see “To open a mass list for editing” on page 521).

2. In the Edit ‘File Name (# Compounds)’ dialog box, click Import.

3. Locate the XML file and click Open.

4. Click Save.

 To import compounds from a CSV file into a mass list

1. Open the mass list (see “To open a mass list for editing” on page 521).

2. In the Edit ‘File Name (# Compounds)’ dialog box, click Import.

3. Locate the CSV file of interest and click Open.

The Import Compounds for list ‘File Name’ dialog box opens. When the application 
maps a CSV column to an essential mass list column, it automatically displays the 
column name in the appropriate list. In addition, it makes the check box for a recognized 
essential column unavailable in the Additional Columns area and selects the data type for 
the column entries.

4. Check the following:

• In the Essential Columns area, check which CSV columns the application was able to 
map to the essential columns for a mass list. 

• In the Additional Columns area, check which CSV columns the application was 
unable to map.

Figure 150 shows the mapped columns from an imported CSV file. 

Note  The XML file must have the same format as an XML file created by exporting 
all the compounds in the Expected Compounds library to an XML file.
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Figure 150. Import Compounds for list ‘File Name’ dialog box

5. Define any of the remaining columns as appropriate. 

For example, to map the RT [min] column in the CSV file as retention time information 
that the application can search against, in the Essential Columns area, select RT [min] in 
the Retention Time list.

6. (Optional) To avoid importing a non-essential CSV column, clear its check box in the 
Additional Columns area under Use Columns.

7. Click OK.

8. In the Edit ‘File Name (# Compounds)’ dialog box, click Save.

 To add a new column to a mass list

1. Open the mass list (see “To open a mass list for editing” on page 521).

2. In the Edit ‘File Name (# Compounds)’ dialog box, click Add Column.

3. In the Add Column dialog box, do the following:

a. Name the column.

Mapped columns
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b. (Optional) Select the data type: 

• String: Alphanumeric and special characters

• Double: Decimal numbers

• Integer: Integers 

c. Click Add.

4. Click Save.

Table 157 describes the buttons at the top of the Edit ‘File Name.massList’ (#Compounds) 
dialog box.

Adding and Editing Mass List Compounds with the Compound Editor

Use the Compound Editor dialog box to add entries to and edit entries in a mass list.

Table 157. Edit ‘File Name.massList’ (# Compounds) dialog box parameters

Feature Description

Buttons

New Opens the Compound Editor dialog box for defining a new 
compound.

Edit Opens the Compound Editor dialog box for editing the selected 
compound in the mass list.

Selecting a compound activates this command.

Delete Deletes the selected compound from the mass list.

Selecting a compound activates this command.

Import Opens a dialog box for locating and opening a CSV, massList, or 
XML file that contains, at a minimum, a list of masses. 

When you select a CSV file, the Define CSV File Format ‘File 
Name.csv’ dialog box opens.

Add Column Opens the Add Column dialog box for naming and defining an 
additional table column. 

Note  The application includes three similar Compound Editor dialog boxes. All three 
dialog boxes include the same structure drawing tools, but their data entry fields differ. 
The Compound Editor dialog box that opens for editing mass list compounds includes 
the following data entry fields: Molecular Weight, Name, Formula, and RT [min].
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 To add a compound to or edit a compound in a mass list

1. From the Mass Lists view, open the mass list for editing (see “Editing a Mass List” on 
page 521).

2. In the Edit ‘File Name (# Compounds)’ dialog box, do one of the following:

• To add a compound, click New.

• To edit a compound, double-click it (or select it and click Edit).

The Compound Editor dialog box opens (Figure 151). The dialog box is unpopulated for 
a new compound. The minimum required information is the compound’s molecular 
weight.

Figure 151. Compound Editor dialog box for editing mass list compounds

3. To change the structure in or add a structure to the drawing area, use the structure tools, 
load a structure file, or click ChemSpider to find a structure file. 

For details, see these topics: “Using the Structure Drawing Tools or Commands” on 
page 542, “Loading a Structure from a Structure File” on page 541, and “Finding a 
Structure in the ChemSpider Database” on page 541.

The chemical structure appears in the drawing pane and its molecular weight and formula 
appear in their respective fields.

4. (Optional) In the Name box, type or edit the compound’s name.

Note  If you are editing the structure for an existing entry in the mass list, the 
Molecular Weight field is unavailable, and any formula or structure that you enter 
must match the displayed molecular weight.
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5. (Optional) In the RT [min] box, enter a chromatographic retention time.

The application rounds the retention time to three decimal places.

6. Click Save.

The Edit ‘File Name (# Compounds)’ dialog box appears.

7. Review the new or edited compound. If necessary, use the filter row to display only the 
new entry (see “Filtering the Tables on a Study Page or a List or Library View” on 
page 588). 

8. To save the changes to the mass list you are editing, click Save.

Modifying the Spectral Libraries List
The following mzVault libraries are snapshots of the mzCloud database taken in May 2019:

• mzVault Reference May 2019

• mzVault Autoprocessed May 2019

You can create your own custom mzVault libraries by using the mzVault 2.2 application or by 
exporting the spectral information from a Compound Discoverer result file (see “Exporting 
Spectral Data to a New or Existing mzVault Library” on page 286).

Note  If you attempt to close the dialog box without saving the changes, an Unsaved 
Changes prompt appears.

Tip  The Search mzVault node does not require the mzVault application, so installing the 
mzVault 2.2 software is optional. However, Thermo Fisher Scientific recommends 
installing the software to do any of the following:

• Edit existing spectral libraries.

• Create new spectral libraries with curated spectra.

• Convert existing legacy mzVault spectral libraries 

You can create new mzVault libraries with the Compound Discoverer 3.1 application, but 
you are limited to exporting spectra from these result tables: Compounds and Expected 
Compounds. 

Note  You cannot edit spectral libraries in the Compound Discoverer application. The 
Edit button in the command bar is unavailable.
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Follow these procedures as needed.

 To open the Spectral Libraries list

From the application menu bar, choose Lists & Libraries > Spectral Libraries.

 To add an mzVault library to the list

Click Import, locate the library, and click Open.

 To replace an mzVault library

1. In the Spectral Libraries view, select the library.

2. Click Replace, locate the library, and click Open.

 To export an mzVault library

1. In the Spectral Libraries view, select the library.

2. Click Export, select a folder, and click Save.

 To delete an mzVault library

In the Spectral Libraries view, select the library and click Delete.

 To create a new empty mzVault library

1. In the Spectral Libraries view, click New.

The Create New Spectral Library dialog box opens. 

2. Name the file and click Create.
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Modifying the Metabolika Pathways List
Initially, the Metabolika Pathways view contains a list of the Metabolika Pathways files 
(.metabolika) that install with the Compound Discoverer application. 

Use the Metabolika Pathways view to create new pathways, edit existing pathways, import and 
export pathways, and replace pathways.

Follow these topics as needed:

• Deleting, Importing, Exporting, and Replacing Metabolika Pathways

• Editing Metabolika Pathways

• Adding and Editing Pathway Structures with the Compound Editor

Deleting, Importing, Exporting, and Replacing Metabolika Pathways

Follow these procedures as needed.

 To delete pathways

1. In the Metabolika Pathways view, select the pathways and click Delete.

2. At the prompt, click Yes.

 To import pathway files

1. In the Metabolika Pathways view, click Import.

2. Locate the files (.metabolika) and click Open.

 To export pathway files to another folder

1. In the Metabolika Pathways view, select the pathways, and then click Export.

2. In the Browse For Folder dialog box, select a folder and click OK.

The application copies the files to the selected folder.

 To replace a pathway

1. In the Metabolika Pathways view, select the pathway, and then click Replace.

2. Locate the replacement file and click Open.
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Editing Metabolika Pathways

Use the Edit ‘File Name.metabolika’ dialog box to create a new or edit an existing Metabolika 
pathway.

To create or edit a pathway, follow these topics:

• Creating a New Pathway

• Editing an Existing Pathway

• Modifying Pathway Arrows

• Shortcut Menu for the Metabolika Pathway Editor

Creating a New Pathway

 To edit a new (empty) pathway

1. From the application menu bar, choose Lists & Libraries > Metabolika Pathways.

1. In the Metabolika Pathways view, click New.

The Create New Metabolika Pathway dialog box opens.

2. Name the file and click Create.

The Edit Metabolika Pathway ‘File Name.metabolika’ dialog box opens.

3. In the pathway editor, right-click and choose Add Structure.

Figure 152. Metabolika pathway editor with shortcut menu

The Compound Editor opens.
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4. Use the Compound Editor to add new structures (see “Adding and Editing Pathway 
Structures with the Compound Editor” on page 533).

5. To add an arrow to indicate the direction between reactants and products, right-click a 
structure and choose Add Arrow. To add more arrows, repeat this step. 

By default, arrows are straight unidirectional lines with one arrow head and four anchor 
points (Figure 153). To change the arrow’s properties, see “Modifying Pathway Arrows” 
on page 531.

Figure 153. Selected arrow with four anchor points

6. To clean up the drawing, do any of the following:

• To delete a structure or an arrow, select it and press the Delete key. 

• To delete all the drawing items, right-click and choose Select All. Then, press the 
Delete key.

• To move a structure or an arrow, select it and hold down the left mouse button to 
display the move pointer. Then, drag the items to another location.

Editing an Existing Pathway

 To edit an existing pathway

1. In the Metabolika Pathways view, select the pathway and click Edit.

The Metabolika pathway editor opens and displays the selected pathway or the beginning 
section of the pathway in the left pane and the entire pathway at a lower zoom level in the 
right pane. Use the tools in the upper right of the left pane to change the zoom level, and 
the selection window in the right pane to display a different section of the pathway in the 
left pane.

2. To modify the pathway, do any of the following:

• To edit a structure, right-click it and choose Edit Structure.

The Compound Editor opens.

• To add a structure, right-click it anywhere in the left pane and choose Add Structure.

The Compound Editor opens.

• To edit the arrows, see “Modifying Pathway Arrows.” 

3. To undo a change, use the CTRL+Z keys. 

You can undo up to six changes.
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Modifying Pathway Arrows

To modify the arrows in a Metabolika pathway, follow these procedures as needed:

• To move an arrow

• To change an arrow’s angle

• To change an arrow’s curvature

• To make an arrow bidirectional to represent a reversible reaction

• To merge arrows

• To add an arrow caption

 To move an arrow

1. Select the arrow and hold down the left mouse button to display the move pointer ( ).

2. Drag the arrow to another location.

 To change an arrow’s angle

1. Select the arrow to display its anchor points, and then point to an end anchor point.

2. When this pointer ( ) appears, drag the end of the arrow up or down as needed.

 To change an arrow’s curvature

1. Select the arrow to display its anchor points, and then point to one of its two internal 
anchor points.

2. When this pointer ( ) appears, drag the pointer arrow up or down as needed.

 To straighten a curved arrow

Right-click it and choose Reshape.

 To make an arrow bidirectional to represent a reversible reaction

Right-click it and choose Is Reversible.

 To merge arrows

1. Reshape the arrows into curves.
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2. Overlay the curved arrows, and then select one of the curves.

3. Point to any of the blue squares. 

4. When this pointer ( ) appears, drag the selected curve until the red square anchor points 
appear on the second curve. Then, release the mouse button.

5. To straighten one of the merged arrows, right-click it and choose Reshape.

 To add an arrow caption

1. Right-click the arrow and choose Edit Arrow Caption.

2. In the Plain HTML dialog box, type text or text with standard HTML tags and click OK.

3. To lock the caption to the arrow, right-click the arrow and choose Is Locked.

Character style Tag

Bold <b> </b>

Superscript <sup> </sup>

Subscript <sub> </sub>
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Shortcut Menu for the Metabolika Pathway Editor

Table 158 describes the shortcut menu for the Metabolika pathway editor.

Adding and Editing Pathway Structures with the Compound Editor

Use the Compound Editor to add structures to and edit the structures in a Metabolika 
pathway.

 To edit or add a pathway structure

1. Open the Compound Editor for editing and adding Metabolika pathway structures (see 
“Adding and Editing Mass List Compounds with the Compound Editor” on page 524).

Figure 154 shows the Compound Editor dialog box for a new structure. 

Table 158. Shortcut menu for the Metabolika pathway editor

Command Function

Add Arrow Adds a straight, unidirectional arrow.

Add Structure Opens the Compound Editor dialog box for adding a structure.

Add Standard Text Opens the Plain HTML dialog box for adding formatted text.

Merge Text and Arrow Merges a selected standard text string to a selected arrow.

Is Reversible Makes the selected arrow bidirectional.

Edit Structure Opens the Compound Editor dialog box for editing the selected 
structure.

Available for a selected structure.

Edit Standard Text Use to edit standard text, which is text that is not associated with 
a structure or an arrow.

Edit Arrow Caption Opens the Plain HTML dialog box for entering formatted text 
as an arrow caption.

Reshape Straightens a curved arrow.

Is Locked Locks the arrow caption to the arrow.

Copy > Selection Copies the selected items. Press CTRL+V to paste the copied 
items elsewhere in the dialog box.

Copy > Structure Copies the selected structure. 

Copy > Pathway Copies the pathway.

Select All Selects all the drawing items in the dialog box. 
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Figure 154. Compound Editor dialog box for editing Metabolika pathway structures

2. Do one of the following:

• When adding a new structure, use the drawing tools, load a structure file, or use the 
ChemSpider application (see “Using the Structure Drawing Tools or Commands” on 
page 542, “Loading a Structure from a Structure File” on page 541, or “Finding a 
Structure in the ChemSpider Database” on page 541).

The application automatically populates the Molecular Weight and Formula boxes.

• When editing an existing structure, you are limited to structures that match the 
current molecular weight and formula.

Drawing area

Opens the ChemSpider application

Click to locate and 
open a structure file.
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Modifying the Compound Classes List
When the processing workflow includes the Compound Class Scoring Node, the application 
can determine the probability that an unknown compound belongs to the user-defined 
compound classes by comparing the ions detected in the fragmentation scans to user-defined 
compound classes.

Use the Compound Classes view, the Edit ‘Named Compound Class’ dialog box, and the 
Fragmentation Editor to create a list of compound class libraries. Figure 155 shows the 
Compound Classes view.

Figure 155. Compound Classes view

Follow these procedures as needed:

• To open the Compound Classes library

• To add new compound classes to the Compound Classes library

• To edit a compound class

• To delete a compound class

• To import a compound class library file (.clib)

• To export a compound class

 To open the Compound Classes library

From the menu bar, choose Lists & Libraries > Compound Classes.

 To add new compound classes to the Compound Classes library

1. In the Compound Classes view, click New.

The Create Compound Class dialog box opens (Figure 156).
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Figure 156. Create Compound Class dialog box

2. Name the class, provide a brief description, and click OK.

The named compound class appears as a new row in the Compound Classes view and the 
Edit ‘Named Compound Class’ dialog box opens (Figure 157). For information about this 
dialog box, see “Compound Class Editor” on page 538.

Figure 157. Edit ‘Named Compound Class’ dialog box

3. In the Edit ‘Named Compound Class’ dialog box, click New. 

4. In the Fragment Editor, define the fragments for the compound class as described in 
“Using the Fragment Editor” on page 539. 

5. Click OK to close the Edit ‘Named Compound Class’ dialog box.

 To edit a compound class

1. In the Compound Classes view, select the compound class of interest and click Edit.

The Edit ‘Named Compound Class’ dialog box opens with a list of fragments.

2. Do the following as needed:

• To add a new fragment by using the Fragment Editor, click New. Then, use the 
Fragment Editor to define the fragment (see “Using the Fragment Editor” on 
page 539).

• To add new fragments by importing their structures from a CSV or SDF file, click 
Import.

• To edit a fragment, select it and click Edit.

• To delete a fragment, select it and click Delete.

3. Close the dialog box to return to the library.
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 To delete a compound class

1. In the Compound Classes view, select the compound class of interest and click Delete.

2. At the prompt, click Yes.

 To import a compound class library file (.clib)

1. In the Compounds Class view, click Import.

2. Browse to and select a compound class library file (.clib).

3. Click Open.

The application uploads the file to your local hard drive in the ProgramData > Thermo > 
Compound Discoverer X.X > Server Files folder. A new entry appears in the library. The 
entry displays the following information about the compound class: name, description, 
# fragments, date uploaded, date updated, and file size.

 To export a compound class

1. In the Compounds Class view, select the compound class of interest and click Export.

2. In the Save As dialog box, browse to a storage location for the file, change the file name as 
needed, and click Save.

Table 159 describes the features of the Compound Classes view.

Table 159. Compound Classes view parameters (Sheet 1 of 2)

Feature Description

Commands

New Opens the Create Compound Class dialog box for naming 
and describing the new compound class.

Edit Opens the Edit ‘Named Compound Class’ dialog box for 
editing the selected compound class file.

Delete Deletes the selected compound class file.

Import Opens the Open dialog box for selecting a .clib file.

Export Opens the Save As dialog box for selecting a file name and 
location for the exported .clib file.

Table columns

Name Displays the name of the .clib file.

Description Displays a description of the file.

# Fragments Displays the number of fragments in the file.
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Compound Class Editor

Table 160 describes the buttons and columns in the compound class editor. For information 
about using the compound class editor, see “Modifying the Compound Classes List” on 
page 535.

Uploaded Displays the date (month/day/year) and time (hour/minute) 
when you added the class to the library in the following 
format: 

MM/DD/yyyy HH:mm

Updated Displays the data and time when the file was updated.

File Size Displays the size of the file.

State Displays Available when an uncorrupted file with the 
specified name exists in the following folder:

Drive X > ProgramData > Thermo > Compound 
Discoverer X.X > ServerFiles 

Table 159. Compound Classes view parameters (Sheet 2 of 2)

Feature Description

Table 160. Edit ‘Named Compound Class dialog box parameters

Parameters Description

Buttons

New Opens the Fragment Editor for defining a fragment (see 
“Using the Fragment Editor” on page 539).

Edit Opens the Fragment Editor with the definition of the selected 
fragment.

Delete Deletes the selected fragment.

Import Opens the Open dialog box for selecting a CSV or an SDF 
file.

Table columns

m/z Displays the m/z value of the fragment.

Structure Displays the structure of the fragment.

Formula Displays the formula of the fragment.

Charge Displays the charge of the fragment.

Comment Displays the description that you typed in the Create 
Compound Class dialog box.
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Using the Fragment Editor

Use the Fragment Editor to define fragments for a compound class.

 To open the Fragment Editor dialog box

1. Open the Compound Classes view from the application menu by choosing Lists & 
Libraries > Compound Classes.

2. In the Compound Classes view, do one of the following:

a. Select a library and click Edit.

b. In the Edit ‘Named Compound Class’ dialog box, select a fragment and click Edit.

–or–

a. Click New.

b. In the Create Compound Class dialog box, name the library, type a description, and 
click OK.

c. In the Edit ‘Named Compound Class’ (No Fragments) dialog box, click New. 

Note  For information about using the Fragment Editor’s drawing tools, see “Using the 
Structure Drawing Tools or Commands” on page 542. 
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Figure 158 shows the Fragment Editor dialog box.

Figure 158. Fragment Editor dialog box

 To use the drawing tools to add a structure to the drawing area

See “Using the Structure Drawing Tools or Commands” on page 542.

 To open a structure file

See “Loading a Structure from a Structure File” on page 541.

 To add a charge to a structure

1. In the drawing area of the Fragment Editor, select the atom where you want to add a 
charge.

2. Click the Atom Properties icon, .

3. In the Atom Properties dialog box, select the Charge check box (Figure 159). 

Opens a structure. 

The application 
populates these 
boxes as you draw 
the structure.

Drawing 
area

Opens the Atom 
Properties dialog 
box for adding a 
charge to the 
structure.
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Figure 159. Atom Properties dialog box with an available Charge check box

4. Select the positive or negative option.

5. Click OK.

Loading a Structure from a Structure File
From the Compound Editor or the Fragment Editor, you can load a structure from a structure 
file.

 To load a structure from a structure file

1. In the editor’s toolbar, click the Load Structure from Disk button, . 

The Open Structure dialog box opens.

2. In the Known Structure Formats list, select the format of the structure file: MOL Format 
(.mol), Compressed Structure (.mcs), or Template (.tml).

3. Locate the structure file and click Open.

The chemical structure appears in the drawing pane, and the application automatically 
populates the Elemental Composition and Molecular Weight boxes. 

If the structure is not visible or it is only partially visible in the pane, right-click the pane and 
choose Select All. Then, while pressing the SHIFT key, drag the structure into the pane.

Finding a Structure in the ChemSpider Database
You can access the ChemSpider database from the Compound Editor dialog box, the 
Compound Annotation Editor dialog box, or the mzLogic Analysis view and search for a 
compound entry with a structure file. 

 To load a structure into the drawing area

1. Click ChemSpider.

The ChemSpider Search dialog box opens.
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2. In the Input box, enter a name, formula, molecular weight, or CSID.

3. Click Search.

4. Select a compound from the search results.

5. Click Select.

The chemical structure appears in the drawing pane and the compound’s molecular 
weight, name, and formula appear in their respective fields. 

Using the Structure Drawing Tools or Commands
The Compound Editors and the Fragment Editor include a set of drawing tools.

Use the editor toolbar and the shortcut menu for the drawing area to draw, manipulate, and 
save structures as described in the following topics:

• Compound Editor Toolbar and Fragment Editor Toolbar

• Shortcut Menu Commands for the Drawing Area

• Using the Structure Icons

• Using the Template Tool

• Checking the Validity of a Structure

• Manipulating Structures

• Modifying Atoms and Bonds

• Saving a Structure

• Editing Atom Properties
 

Note  The application has three different Compound Editor dialog boxes and one 
Fragment Editor dialog box that all have the same structure drawing tools. You can open 
these dialog boxes from the following Lists & Libraries views: Expected Compounds, 
Mass Lists, Metabolika Pathways, and Compound Classes.
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Compound Editor Toolbar and Fragment Editor Toolbar

The Compound Editor and Fragment Editor dialog boxes have the same set of toolbar icons 
(Figure 160).

Figure 160. Editor toolbar

Shortcut Menu Commands for the Drawing Area

The Compound Editor dialog boxes and the Fragment Editor dialog box include a drawing 
area for adding a two-dimensional structure.

Table 161 describes the drawing area’s shortcut menu commands.

Selection Tool

Save Structure to Disk

Redo
Clean

Double Bond

Chain

Benzene Ring

Single Bond

Load Structure from Disk

Undo
Check

Triple Bond

6-Membered Ring

5-Membered Ring

n-Membered 
Ring

Templates

Atom Property

Table 161. Shortcut menu commands for the drawing area (Sheet 1 of 2)

Menu command Description

Selection Tool Selects a portion of the structure.

Lasso Selection Selects an non-rectangular portion of the structure.

Rectangle Selection Selects a rectangular portion of the structure.

Cut Removes the selected portion of a structure.

Copy Copies the selected portion of a structure to the Clipboard.

Paste Copies a structure from the Clipboard to the drawing area.

Delete Deletes the selected portion of a structure.

Select All Selects everything in the drawing area.

Resize Resizes the selected portion of a structure (see “To resize a 
structure” on page 547).
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Using the Structure Icons

 To begin drawing a chemical structure

1. Click any of these structure icons, . 

–or–

Select a template structure as described in “Using the Template Tool.” 

The cursor changes shape to represent the current drawing mode.

2. Click the drawing area where you want to place the selected structural feature.

Until you click another structure icon, you can continue to add the same structural 
feature each time you click the drawing area.

3. Edit the atoms and bond properties as described in “Modifying Atoms and Bonds” on 
page 548.

Using the Template Tool

Use the template tool to draw closely related chemical structures as described in these 
procedures:

• To open a template structure

• To create a template structure

 To open a template structure

1. Click the Templates icon, .

The Templates dialog box opens.

Rotate Rotates the structure around the selected axis of rotation (see “To 
rotate a structure” on page 547).

Mirror Reflects the structure along its vertical or horizontal axis (see “To 
mirror a structure” on page 547).

Table 161. Shortcut menu commands for the drawing area (Sheet 2 of 2)

Menu command Description

Tip  Point to a drawing icon to display its description. 
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2. In the Explorer view of the Templates dialog box, browse to and select the folder where 
you store your structure files.

The title bar of the Templates dialog box changes from Templates to Templates – Folder 
name, and the 2D structures appear above the Explorer view (Figure 161). The 
application displays all of the structures in the folder. It does not differentiate between 
MOL files and Template files.

Figure 161. Templates dialog box with a view of the stored structures

3. On the structure that you want to open, click any atom or bond.

The templates cursor, , appears in the drawing area of the Compound Editor dialog 
box.

4. To place the selected structure in the drawing area, click the drawing area.

 To create a template structure

1. Open a structure file or draw a structure in the drawing area.

2. In the Compound Editor toolbar, click the Save Structure to Disk button, .

3. In the Save Structure dialog box, do the following:

a. Browse to the folder where you want to store the file.

b. Name the file.

c. In the Save As Type list, select Template (*.tml).

d. Click Save.
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Checking the Validity of a Structure

The application does not prevent you from creating and saving invalid structures. To check 
the validity of a structure as you create it or before you save it, use the check structure tool.

 To check a structure

1. Click the Check icon, .

The check structure tool searches for formal errors and unusual structural features. If a 
structure is formally incorrect or if the check structure tool finds its validity questionable, 
the Check Structure message lists the errors and warnings (Figure 162). 

Figure 162. Check Structure message

2. Click OK.

The application automatically selects the atoms and bonds that it considers incorrect. The 
application considers structures that are not connected as mixtures and reports them as 
errors, but it does not select the mixtures.

Manipulating Structures

To manipulate a structure, follow these procedures:

• To resize a structure

• To rotate a structure

• To mirror a structure

• To clean a structure

Note  The check structure tool does not perform quantum mechanical or 
thermodynamical calculations that address possible structural stability.
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 To resize a structure

1. Select the structure or part of the structure you want to resize.

2. Right-click and choose Resize.

3. Drag one of the small rectangles on the structure’s edge and release the mouse button.

Dragging one of the diagonal rectangles keeps the aspect ratio constant during structure 
resizing.

 To rotate a structure

1. Select the structure or part of the structure you want to rotate.

2. Right-click and choose Rotate.

A small circle with a cross in the middle, , appears. The circle indicates the center of 
rotation.

3. Move the center of rotation by dragging the circle.

4. Rotate the selected structure around the center of rotation by dragging any of the small 
rectangles on the structure’s edge.

 To mirror a structure

1. Select the structure or part of the structure you want to mirror.

2. Right-click and choose Mirror.

3. Click one of the small rectangles on the structure’s edge.

• The top and bottom rectangles flip the selected structure along a horizontal axis.

• The left and right rectangles flip the selected structure along a vertical axis.
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 To clean a structure 

1. Do one of the following:

• Select an entire structure.

–or–

• Select only the atoms you want to clean.

The selected atoms must be connected.

2. Click the Clean icon, .

The cleaning tool helps you create a professional look for your structures. 

After finishing a structure drawing, always check for errors before proceeding.

Modifying Atoms and Bonds

To modify or add elements to a structure or to modify or add bonds to a structure, follow 
these procedures:

• Selecting Atoms and Bonds

• Editing Bond Properties

For information about editing the atom properties, see “Editing Atom Properties” on 
page 550.

Selecting Atoms and Bonds

You can select individual atoms and bonds, a contiguous portion of a structure, an entire 
structure, or groups of atoms and bonds that are not adjacent to each other.

Note  In some complicated cases, the Clean function can lead to structures that you might 
not find satisfactory. If this occurs, click the Undo icon, .
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Follow these procedures:

• To select an individual atom or bond

• To choose a selection mode

• To select a group of atoms that are adjacent to each other

• To select all of the atoms and bonds in the structure

• To move a structure

 To select an individual atom or bond

Click the Selection Tool icon, and then click the individual atom or bond.

 To choose a selection mode

Right-click anywhere in the drawing area of the Compound Editor dialog box and choose 
Lasso Selection or Rectangle Selection.

 To select a group of atoms that are adjacent to each other

Do one of the following:

• Right-click and choose Rectangle Selection. Then drag the cursor to form a 
rectangle around the atoms.

–or–

• Right-click and choose Lasso Selection. Then draw a free-form shape around the 
atoms.

 To select all of the atoms and bonds in the structure

Do one of the following:

• Right-click the drawing area and choose Select All.

–or–

• Click the Selection Tool icon, and then double-click anywhere in the drawing area, 
except on atoms or bonds. 

Lasso Selection Rectangle Selection
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 To move a structure 

1. Select the atoms or bonds that you want to move.

2. Drag the selected structures to a new location.

 To move all of the structures in the drawing area

1. Right-click the drawing area and choose Select All. 

2. Click any atom or bond in the drawing area, and then drag the structures to a new 
location.

Editing Bond Properties

Use the bond icons to change the bond multiplicity. 

 To change the multiplicity of a bond

Click , , or , and then click the bond that you want to change.

Saving a Structure

After you draw or modify a structure, you can save the structure as a structure file (in MOL 
format or as a compressed structure) or as a template file.

 To save a structure as a structure file

1. Click the Save Structure to Disk button in the toolbar, .

2. In the Save Structure dialog box, do the following: 

a. Browse to the directory where you want to store the file.

b. Name the structure file.

You can save structures under their actual names, regardless of length (for example, 
1-Amino-2-hydroxyindane.mol).

c. In the Save As Type list, select a file type.

d. Click Save.

Editing Atom Properties

Use the Atom Properties dialog box to change the isotope of an atom or the entire element. 
For more information about modifying compound structures, see “Using the Structure 
Drawing Tools or Commands” on page 542.

IMPORTANT  The application does not support compounds with a charge or radical nor 
does it support the R-Substituent feature.
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 To edit the element or nucleon number of a single atom

1. Open the Compound Editor dialog box as described in “To open the Compound Editor 
dialog box” on page 500.

2. Click the Selection Tool icon, .

3. Do one of the following:

• Double-click the atom that you want to change.

–or–

• Select the atom that you want to change and click the Atom Properties icon, . 

The Atom Properties dialog box opens with the properties of the selected atom displayed. 
The Charge and Radical check boxes are not available for compounds.

Figure 163. Atom Properties dialog box, showing the properties for carbon

4. To change the element, do the following:

• To change the atom to an element that is in the Element area, click the appropriate 
Element button.

• To change the atom to an element not listed in the Element area, click Periodic 
Table. Then, in the Periodic Table dialog box, select an element and click OK.

5. To specify a less abundant isotope of the element, select the Isotope check box, and then 
select the appropriate value in the Nucleon Number list.

Tip  To add charges to fragment structures for a Compound Class library, see “Using 
the Fragment Editor” on page 539.

The Charge and Radical check boxes 
are not available for compounds.
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6. When you finish editing the selected atom, click OK.

Changes you make in the Atom Properties dialog box affect only the selected atom.

Tip  For example, to create a compound that is labeled with one carbon-14 atom, 
double-click the labeling site—the atom that you want to change. In the Atom 
Properties dialog box, select the Isotope check box, and then select 14 in the Nucleon 
Number list. 

The application displays carbon-14 as [14]C; that is, the elemental composition of 
carbon-14 labeled caffeine is displayed as C7 [14]C H10 N4 O2.
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13

Using the License Manager

Use the License Manager to activate or deactivate the software license and to install new 
processing workflow nodes as they become available. 

Opening the License Manager
Access the License Manager page from the Help menu.

 To open the License Manager page

From the menu bar, choose Help > License Manager.

The License Manager opens as a tabbed document in the application window 
(Figure 164). 

Contents

• Opening the License Manager

• License Manager Command Bar

• Activating the Software License

• Deactivating the Software License for Transfer to Another Computer

• Installing or Updating a Processing Workflow Node

Note  After you install the Compound Discoverer application on your computer, you can 
use the application without activating the license for up to 60 days.

After you activate the software license on one computer, you can deactivate the license and 
transfer it to another computer.
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Figure 164. License Manager page

License Manager Command Bar
Table 162 describes the License Manager command bar.

Table 162. License Manager command bar

Command or feature Description

Activate Opens the License Activation dialog box where you can apply a 
new activation code and activate the license on the current 
computer.

Deactivate Opens the License Deactivation dialog box for deactivating the 
software license. 

Scan for Missing 
Features

Activates a scan for newly installed processing workflow nodes.

Show Expired Licenses Selecting this check box displays any expired licenses.



 13 Using the License Manager
Activating the Software License

Thermo Scientific Compound Discoverer User Guide 555

Activating the Software License
To activate your Compound Discoverer 3.1 software license, see these topics as necessary:

1. Entering the Product ID and the Activation Code

2. Follow one of these topics:

• Activating the License on an Online Computer

• Activating the License on an Offline Computer

Entering the Product ID and the Activation Code

To activate your Compound Discoverer 3.1 license, you must know the product ID 
(XCALI-XXXXX) and the activation code. Within one week of ordering the software, you 
should receive an email from Thermo MS Licensing with the subject line “Your Order Is 
Ready.” This email contains the product ID and activation code information.

 To enter the licensing information

1. On the License Manager page, click Activate.

The License Activation dialog box opens to the Activation Code view.

Figure 165. License Activation dialog box opened to the Activation Code view
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2. If you have not already received your activation code, do the following:

a. Check your Junk Email folder.

b. If the email is not in your Junk Email folder, log in to your account at the following 
URL. In the left navigation pane, under Software & Services, click Order History. 
Then, in the list of ordered products, click the order number.

https://thermo.flexnetoperations.com 

c. If you cannot find your account, send an email message to Licensing at 
ThermoMSLicensing@thermofisher.com. 

Provide the following information in the body of the message:

• Software application: Compound Discoverer

• Sales order number or purchase order number:____________________

• End user name:______________________

• End user email:______________________

3. In the License Activation dialog box (Figure 165), enter the following:

• Your company name

• Your full name

• Your contact email address

• The product ID for the Compound Discoverer 3.1 application. 

There are five possible product IDs. Four of the product IDs are for software 
upgrades (see Table 163).

• The activation code. You can type or paste the activation code.

Table 163. Product IDs for the Compound Discoverer 3.1 software (Sheet 1 of 2)

Material Order No. Product ID Description

OPTON-30925 XCALI-65037 SW, Compound Discoverer 3.1 
(single license)

OPTON-30926 XCALI-65037 SW, Compound Discoverer 3.1 
(2–5 licenses)

OPTON-30927 XCALI-65037 SW, Compound Discoverer 3.1 
(6–10) licenses

OPTON-30928 XCALI-65040 SW, Compound Discoverer 3.1 
upgrade from MetWorks (MW) 
or Mass Frontier (MF)

OPTON-30929 XCALI-65041 SW, Compound Discoverer 3.1 
upgrade from Sieve

https://thermo.flexnetoperations.com
https://thermo.flexnetoperations.com
mailto:ThermoMSLicensing@thermofisher.com
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4. Depending on whether your processing computer is connected to the Internet, continue 
with one of these topics:

• Activating the License on an Online Computer

• Activating the License on an Offline Computer

Activating the License on an Online Computer

Follow these instructions if your processing computer has an Internet connection.

 To activate the software license on an online computer

1. If you have not already entered the licensing information, enter it in the Activation Code 
view of the License Activation dialog box.

2. Click Online Activation to process the activation code. 

3. At the confirmation prompt, click OK. 

4. At the “new features” prompt, click OK.

This completes the online license activation process. 

Activating the License on an Offline Computer

Follow these instructions if your processing computer is not connected to the Internet.

OPTON-30930 XCALI-65042 SW, Compound Discoverer (CD) 
3.1 upgrade from CD 1.0, CD 
2.0, CD 2.1 

OPTON-30931 XCALI-65043 SW, Compound Discoverer 3.1 
upgrade from Compound 
Discoverer 3.0

Table 163. Product IDs for the Compound Discoverer 3.1 software (Sheet 2 of 2)

Material Order No. Product ID Description

Note  Activating the license on an offline computer is a three-step process that requires 
access to an online computer. 

1. Create an activation request file (Activation-Activation Code.req) on the offline 
computer. 

2. Transfer the activation request file to an online computer where you upload it to the 
licensing portal to obtain a response file (activation.xml). 

3. Transfer the response file (activation.xml) to the offline computer, and then process it 
by clicking Process Response File in the License Activation dialog box. 
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 To activate the software license on an offline computer

1. If you have not already entered the licensing information in the Activation Code view of 
the License Activation dialog box, enter it now.

2. In the License Activation dialog box, click Offline Activation. 

The Save Activation Request File dialog box opens.

3. Save the activation request file (Activation-Activation Code.req). 

The Offline Activation instructions appear. 

Figure 166. Offline activation instructions

4. Click OK.

The Activation Code view of the License Activation dialog box reappears.

Tip  When you close the Offline Activation dialog box, the application automatically 
saves the URL to the Clipboard, so that you can save the URL to a file for use on an 
online computer.
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5. (Optional) Save the URL to a file.

6. Keep the License Activation dialog box open on this offline computer.

7. To download the response file (activation.xml) from the licensing server, do the following 
on an online computer:

a. Transfer the activation request file ((Activation-Activation Code.req) to the online 
computer.

b. Go to the following URL (case sensitive): 

https://thermo.flexnetoperations.com/control/thmo/offlineActivation 

The Life Sciences Mass Spectrometry Software Download and Licensing Portal 
opens. 

c. Click Choose File or Browse, browse to and select the request file (Activation 
Activation Code.req), click Open, and then click Process.

The server downloads the activation file.

Figure 167. Software licensing portal with a view of a downloaded response file 

d. Save the response file (activation.xml).

IMPORTANT  If you accidentally close the License Activation dialog box, start over at 
step 1.

Note  Whether the page includes a Choose File button or a Browse button 
depends on the web browser.

Transfer this file to your offline computer.

https://thermo.flexnetoperations.com/control/thmo/offlineActivation
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8. To activate the license on the offline computer, do the following:

a. Transfer the response file (activation.xml) to this computer.

b. In the License Activation dialog box that you left open, click Process Response File. 

The Open Response File dialog box opens. 

c. Browse to and select the response file (activation.xml), and then click Open.

d. At the “license response processed” prompt, click OK. 

e. At the “new features” prompt, click OK.

This completes the offline license activation process. The License Manager indicates that the 
license for the specified product (XCALI-XXXXX) is permanent. 

Deactivating the Software License for Transfer to Another Computer
To transfer the software license to another computer, you must first deactivate the license on 
the current computer.

Follow the appropriate topic:

• Deactivating the Software License on an Online Computer

• Deactivating the Software License on an Offline Computer

Deactivating the Software License on an Online Computer 

Follow this procedure if your computer has Internet access.

 To deactivate the software license on an online computer

1. On the License Manager page, select the software product that you want to deactivate, 
and then click Deactivate.

The License Deactivation dialog box opens. The Product ID box is populated with the 
selected product’s ID, and Activation Code box is populated with the activation code for 
your license.
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Figure 168. License Deactivation dialog box populated with the product ID and activation code

2. If the computer is connected to the Internet, click Online Deactivation. 

3. At the confirmation prompt, click Yes.

The license deactivation process is complete, and the product ID disappears from the 
License Manager page.

Deactivating the Software License on an Offline Computer

If your processing computer is not connected to the Internet, follow these instructions to 
deactivate the software license.

Note  Deactivating the license on an offline computer is a three-step process that requires 
access to an online computer. 

1. Create a deactivation request file (Deactivation-Activation Code.req) on the offline 
computer. This step only starts the license deactivation process. 

2. Transfer the deactivation request file (Deactivation-Activation Code.req) to an online 
computer where you upload it to the licensing portal to obtain a response file 
(activation.xml).

3. Transfer the response file to the offline computer, and then process it to complete the 
deactivation process.
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 To deactivate the software license on an offline computer

1. On the offline computer, create the deactivation request file as follows:

a. On the License Manager page, select the software license that you want to deactivate, 
and then click Deactivate.

The License Deactivation dialog box opens. The Product ID box is populated with 
the selected product’s ID, and Activation Code box is populated with the activation 
code for your license.

b. Click Offline Deactivation.

c. At the confirm deactivation prompt, click Yes.

The Save Request File dialog box opens. The File Name box displays the following 
text: Deactivation Activation Code.req. 

d. Save the deactivation request file. 

e. At the prompt, which displays the location of the saved request file, click OK.

The license state changes to Deactivation in Progress, and the URL is copied to the 
Clipboard.

f. (Optional) Copy the URL to a file. 

2. From the online computer, retrieve the response file (activation.xml) as follows: 

a. Transfer the deactivation request file and the file with the URL to this computer.

b. Go to the following URL (case sensitive): 

https://thermo.flexnetoperations.com/control/thmo/offlineActivation 

The Life Sciences Mass Spectrometry Software Download and Licensing Portal 
opens.

c. Click Choose File, browse to and select the Deactivation Activation Code.req file, 
click Open, and then click Process.

The server downloads the response file. 

d. Save the response file (activation.xml). 

3. Complete the deactivation process on the offline computer as follows:

a. Transfer the response file (activation.xml) to this computer.

b. On the License Manager page, select the license that you are in the process of 
deactivating, and click Deactivate. 

The License Deactivation dialog box opens. 

c. Click Process Response File.

The Open Response File dialog box opens. 

https://thermo.flexnetoperations.com/control/thmo/offlineActivation
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d. Select the response file (activation.xml) and click Open.

The license disappears from the License Manager page. 

Installing or Updating a Processing Workflow Node
The application uses a node-based workflow to process raw data files. Following set 
guidelines, you can create your own custom workflow nodes. In addition, Thermo Fisher 
Scientific might occasionally provide custom workflow nodes on its customer website.

 To install a new processing workflow node

1. Download the executable files and store them in the appropriate folder on the computer 
where you are running the application.

2. Open the License Manager page.

3. Click Scan for Missing Features.

4. Close and reopen the application.

5. Choose Help > About.

The About Compound Discoverer dialog box opens with the Patent and Legal Notices 
page displayed.

6. Expand the Nodes list and verify that it lists the new node.
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14

Setting Up the Configuration Options

To set up the application’s configuration options, follow these topics. 

Opening the Configuration Page
Use the Configuration page to set up the application’s global configuration options. 

 To open the Configuration page

From the menu bar, choose Help > Configuration.

Selecting the Maximum Number of Parallel Processing Jobs
Use the Parallel Options view of the Configuration page to specify the maximum number of 
analyses (jobs) that the application can process in parallel.

 To change the maximum number of parallel jobs

1. In the left pane of the Configuration page, under Server Settings, select Parallel Options. 

Contents

• Opening the Configuration Page

• Selecting the Maximum Number of Parallel Processing Jobs

• Selecting Where to Store Temporary Data

• Selecting the Global Color Palettes

• Turning Off the Auto-Save Feature for Studies

• Hiding the Workflow Node Numbers

• Specifying the Default mzCloud Mass Tolerance Settings

• Setting Up a BioCyc Account or Subscription

• Specifying the Fragmentation Libraries
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2. In the Parallel Options view, in the Maximum Number of Processing Workflows in 
Parallel Execution box, type or select an integer from 1 to 4.

The default value is equal to half the number of CPU cores in the processing computer. 

3. Click Save Current Settings.

Selecting Where to Store Temporary Data
Use the Scratch Directory Options view of the Configuration page to change the folder where 
the application stores temporary data during data processing.

 To change the scratch directory

1. In the left pane of the Configuration page, under Server Settings, select Scratch 
Directory Options.

The Current Scratch Directory box lists the current location of the scratch folder.

Figure 169. Scratch Directory Options view

2. Click the browse button next to New Scratch Directory and locate the new directory.

3. Click Save Current Settings.

4. Restart the application.

5. Reopen the Scratch Directory Options view and make sure that the Current Scratch 
Directory box lists the new scratch directory.
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Turning Off the Auto-Save Feature for Studies
If you want the application to automatically save changes that you make to studies, including 
the list of result files on the Analysis Results page, do not turn off the auto-save feature.

 To turn off the auto-save feature

1. In the left pane of the Configuration page, under Client Settings, select Study 
Management Settings (Figure 170).

Figure 170. Study Management Settings view with the default setting

2. Clear the Save Study Automatically On Close and After Analysis Submit check box.

3. Click Save Current Settings.

4. Restart the application.

Hiding the Workflow Node Numbers
When you create a processing workflow by dragging the workflow nodes into the Workflow 
Tree pane, the application automatically adds an integer to each workflow node. Use the 
Workflow Editor Settings view to hide these numbers.

 To hide the workflow node numbers

1. In the left pane of the Configuration page, under Client Settings, select Workflow Editor 
Settings.

2. Under Workflow Settings, select the Hide Node Numbers check box (Figure 171).
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Figure 171. Workflow Editor Settings view

3. Click Save Current Settings.

Selecting the Global Color Palettes
Use the Color Schema view of the Configuration page to select one of the standard global 
color palettes or create a custom color palette. The colormap selection affects the sample 
group colors in the following views: Chromatograms, Trend Charts, Principal Component 
Analysis, and Descriptive Statistics. The selection does not affect the color-coding in the result 
tables.

Figure 172. Color Schema view

To set up the global color palette, follow these topics as needed:

• Opening the Color Schema View

• Selecting a Standard Color Palette

• Creating Custom Color Palettes

• Deleting Custom Color Palettes

• Importing Custom Color Palettes
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• Exporting Custom Color Palettes

• Editing a Custom Color Palette

• Selecting a Color in the Gradient Color Chart

Opening the Color Schema View

 To open the Color Schema view

1. From the menu bar, choose Help > Configuration.

2. In the left pane of the Configuration page, under Client Settings, select Color Schema. 

Selecting a Standard Color Palette

For visualizing chart data, you can select from four standard color palettes. 

 To select a standard color palette

1. Open the Color Schema view. 

2. In the Selected Palette list, select from four palettes.

• Compound Discoverer

• Proteome Discoverer

• 60 Distinct Colors

• Deuternopia, Protanopia, and Tritanopia

3. Click Save Current Settings.

Creating Custom Color Palettes

 To create a custom color palette

1. Open the Color Schema view.

2. Click New.

The Color Palette Configuration dialog box opens.
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Figure 173. Color Palette Configuration dialog box

3. Name the custom color palette.

4. Add selected colors to the custom color palette (see “Editing a Custom Color Palette” on 
page 571).

5. Click Save.

The custom color palette appears as the selected palette in the Selected Palette list of the 
Color Schema view. 

6. To apply the new color palette, click Save Current Settings.

Deleting Custom Color Palettes

 To delete a custom color palette

1. In the Color Schema view, select the custom color palette in the Selected Palette list.

2. Click Delete.

Importing Custom Color Palettes

 To import a custom color palette

1. In the Color Schema view, click Import.

2. Locate the color palette file (XML) and click Open.

The import color palette appears in the Selected Palette list.
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Exporting Custom Color Palettes

 To export a custom color palette

1. In the Color Schema view, select the custom color palette in the Selected Palette list.

2. Click Export.

3. Name the palette and click Save.

Editing a Custom Color Palette

 To edit a custom color palette

1. Open the custom color palette for editing as follows:

a. In the Selected Palette list, select the custom color palette.

b. Click Edit.

The Color Palette Configuration dialog box opens.

2. Do any of the following:

a. To add a color to a custom color palette, select the color in the gradient color chart.

b. Click Add.

In the Palette Colors area, the new color appears to the right of the current colors.

–or–

a. To insert a color in a custom color palette, select its insertion point—the color to the 
right of the intended position—in the Palette Colors area. 

b. Select the new color in the gradient color chart. 
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Figure 174. Color Palette Configuration dialog box with the basic options view

c. Click Insert.

In the Palette Colors area, the new color appears to the left of the currently selected 
color. 

–or–

a. To replace a color with another color, select the color to replace in the Palette Colors 
area.

b. Select a color in the gradient color chart.

Selected position for insertion

Selected color
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c. Click Replace.

–or–

a. To remove a color from a custom color palette, select the color in the Palette Colors 
area.

b. Click Remove.

3. Click Save.

Selecting a Color in the Gradient Color Chart

The Color Palette Configuration dialog box that opens when you click either New or Edit in 
the Color Schema view includes a gradient color chart.

 To select a color in the gradient color chart

Do any of the following:

• Click a color in the hexadecimal color gradient chart.

• Enter an RGB formula or an HSB formula by typing numeric values or using the 
slider.

• Select the Advanced Options check box and use the separate sliders for red, green, 
blue, hue, saturation, and brightness.

Figure 175. Advanced Options view

–or–

• Enter the hexadecimal code.
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Specifying the Default mzCloud Mass Tolerance Settings
Use the Submit Single Spectrum to mzCloud Options view to set up the mass tolerance 
settings for a manual mzCloud search. 

 To set up the mass tolerance settings for a manual mzCloud search

1. In the left pane of the Configuration page, under Miscellaneous settings, select Submit 
Single Spectrum to mzCloud Options.

2. Do the following:

• For the mass tolerance of scans acquired in the Orbitrap mass analyzer, select the 
units, and then type an appropriate value in the FT Mass Tolerance box.

• For the mass tolerance of scans acquired in the ion trap mass analyzer, select the units, 
and then type an appropriate value in the IT Mass Tolerance box.

• If your processing workflows include the Search mzCloud node, select the Use 
mzCloud Node Settings check box to use the node’s settings (see “Search mzCloud 
Node” on page 209).

3. Click Save the Current Settings.

Table 164 describes the options for submitting single scans to the mzCloud database.

Table 164.  Submit Single Spectrum to mzCloud Options view

Parameter Description

FT Mass Tolerance Specifies the mass tolerance for scans acquired with an FT mass 
analyzer. 

Default: 12 ppm

IT Mass Tolerance Specifies the mass tolerance for scans acquired with an ion trap 
mass analyzer. 

Default 0.4 Da

Use mzCloud Node 
Settings

When this check box is selected, the application uses the settings 
in the Search mzCloud processing workflow node if the analysis 
included this node.

Default: Selected
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Setting Up a BioCyc Account or Subscription
Follow the instructions in the BioCyc User Login view on the Configuration page to set up 
your BioCyc subscription or user account. You must have either an organization subscription 
and a user account or an individual subscription to access all BioCyc databases. A user account 
alone allows you to access only the EcoCyc database. 

To set up a BioCyc account or individual subscription and enter your credentials in the 
BioCyc User Login view, follow these topics as needed:

• Opening the BioCyc User Login View

• Setting Up a BioCyc Account or Individual Subscription

• Entering, Testing, and Saving Your Account Information

Opening the BioCyc User Login View

 To open the BioCyc User Login view

1. From the application window, choose Help > Configuration.

The Configuration page opens.

2. In the left pane, under Miscellaneous settings, select BioCyc User Login.

• If you have an organization subscription, the Organization Subscription area displays 
the organization name in green. Otherwise, the area displays the following text in red: 
No Valid Subscription Found.

• If you already have a BioCyc user account, entered and tested your credentials, and 
saved the settings, the Username box displays your email address. Otherwise, the 
following text appears in red under User Subscription: No Valid Subscription Found.

Figure 176 shows a BioCyc User Login page for a user without a subscription.

Note  To set up a user account or an individual user subscription, you must have Internet 
access.
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Figure 176. BioCyc User Login page for a user without a subscription

Setting Up a BioCyc Account or Individual Subscription

 To set up a BioCyc account or individual subscription

Open the BioCyc User Login view on the Configuration page, and follow the instructions 
in the view.

Entering, Testing, and Saving Your Account Information

 To enter, test, and save your account information

1. In the User Subscription area of the BioCyc User Login view on the Configuration page, 
enter your user name (email address) and password.

2. Click Test Credentials.

3. Click Save Current Settings.
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Figure 177 shows the subscription information for a user who has a user account but does 
not have an organization subscription or an individual subscription. When running 
analyses that map compounds to the BioCyc pathways, the user can access only the 
EcoCyc database.

Figure 177. Settings for a user with a only a user account

Specifying the Fragmentation Libraries
Use the HighChem Fragmentation Options view to select the fragmentation databases.

Currently, there is only one available fragmentation database. This view is reserved for future 
use.

 To open the HighChem Fragmentation Options view

In the left pane of the Configuration page, under Miscellaneous Settings, select 
HighChem Fragmentation Options.
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15

Working with the Application Tables 

These topics describe the common operations that you can perform on the tables in the Lists 
and Libraries view, on the pages of a study, and in result files.

Moving Up and Down Table Rows
Use the following procedure to move through the rows in a data table.

 To move up or down through the rows of a result or library table

To move down, press TAB. 

To move up, hold down the SHIFT key and press TAB.

Contents

• Moving Up and Down Table Rows

• Sorting Data Tables

• Freezing Table Rows

• Grouping Table Rows

• Changing the Position of Table Columns

• Freezing Table Columns

• Showing or Hiding Table Columns

• Copying Table Entries to the Clipboard

• Filtering the Tables on a Study Page or a List or Library View
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Sorting Data Tables
To sort the data tables, see these topics:

• Sorting Table Entries By One or More Columns

• Sorting Table Entries By a Column with a Distribution Map

Sorting Table Entries By One or More Columns

 To sort the rows based on the contents of one or more columns

1. Click a column header to sort the rows between ascending order (A, B, C …) and 
descending order (Z, Y, X …), based on the contents of the column.

2. To sort the data by a second column, hold down the CTRL key and click the second 
column heading.

Sorting Table Entries By a Column with a Distribution Map

 To sort a table by a column that contains a distribution map

1. Click the expand icon to display the vertical headings of the subordinate columns.

2. Select the heading of the subordinate column that you want to sort by.

The selected subordinate column heading appears in bold text.

3. Click the column heading to sort the table rows.

Note  The application treats formulas the same as text strings and sorts them by the 
order of the characters in the formula string, not by the actual number of elements in 
the formula.

Expand 
icon

Subordinate 
column headings

Column 
heading
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Freezing Table Rows
Use the following procedure to freeze table rows.

 To affix rows at the top of the table

1. Click the pin icon, , next to the row number of the row that you want to freeze. 

The row moves to the top of the table, its pin icon changes to the pinned position, , and 
a blue bar that defines the bottom of the freeze pane appears below the fixed row.

2. As you fix additional rows, they move up to the freeze pane in the order selected and their 
icons change to pinned, . The row just above the blue bar is the last fixed row.

When you scroll the table, the freeze pane remains at the top. Figure 178 shows a 
compound library with caffeine in the freeze pane.

Figure 178. Compound library with a freeze pane

Pin icon to the right of the row number
Blue bar that defines the 
bottom of the freeze pane
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Grouping Table Rows
For a table on a study page, use the Enable Row Grouping shortcut menu command to group 
items by a column heading. 

 To group and ungroup the table rows on a study page

1. Right-click the page and choose Enable Row Grouping.

The Group by Area bar appears above the table heading row.

2. Drag the column heading that you want to group by into the Group by Area bar.

Figure 179 shows the column heading for a study factor being dragged to the Group by 
Area bar.

Figure 179. Group by Area bar above the table heading row

3. To ungroup the table rows, drag the column heading out of the Group by Area bar.

Figure 180 shows the study factor (Phenotype) column heading inside the Group by Area 
bar, and the table rows grouped by the study factor value (Lean, Fatty, or n/a).

Column heading
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Figure 180. Samples table grouped by phenotype

4. To turn off the group by row feature, right-click the page and choose Disable Row 
Grouping.

Changing the Position of Table Columns
To change the position of table columns, see the following topics. Changes to tables in any of 
the Lists & Libraries views are temporary. You can save the layout changes to a result table by 
applying the File > Save Result View Layout command.

• Changing the Column Order

• Stacking Two Table Columns into One Column

Column heading in the Group by Area bar
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Changing the Column Order

 To change the order of the columns in a library or list table or a result table

To move a column to the left of its current position, drag the column header to the left. 
Release the mouse button when the cursor ( ) appears over the column delineator 
(Figure 181).

Figure 181. Moving a column to the left

Stacking Two Table Columns into One Column

 To stack two table columns into one column

Drag the column header of the column that you want to stack below the column header 
of the column that you want on top. Release the mouse button when the cursor ( ) 
appears over the column heading (Figure 182). 

Figure 182. Stacking two columns into one column

Column 1 Heading Column 2 Heading Column 3 Heading 

Column 3 Heading 

Column 1 Heading Column 3 Heading Column 2 Heading 

Column 1 Heading Column 2 Heading Column 3 Heading 

Original
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New
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column 3
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Freezing Table Columns
In a result table, to more easily compare values in columns that are not next to each other, you 
can lock columns in place so that they are always visible as you scroll through the unlocked 
columns.

 To lock table columns to the left of the first column

1. Right-click the table and choose Enable Column Fixing.

A pin icon, , appears to the right of each column heading.

2. Click the pin icons for the columns that you want to move to the left of the first column.

The columns move to the left of the Checked column and their pins face down, .

Showing or Hiding Table Columns
Use the Field Chooser dialog box to show or hide columns in any of the result tables or tables 
in the Lists & Libraries views. The changes to tables in any of the Lists & Libraries views are 
temporary. You can save the layout changes to a result table by choosing Window > Save 
Layout.

 To show or hide columns in a library or result table

1. Click the Field Chooser icon, , in the upper left corner of the table (Figure 183). 

Figure 183. Field chooser icon in the upper left corner of the main mzCloud Results table

The Field Chooser dialog box opens with a list of all of the column headers for the 
current table in alphabetical order (Figure 184). 

Note  Except for the Input Files table, the Checked column is, by default, the first column 
in every result table—that is, Checked is the text in first column’s heading row. 

Field Chooser icon
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Figure 184. Field Chooser dialog box for the mzCloud Results table

2. In the Field Chooser dialog box, clear the check box for each column that you want to 
hide. To show those columns again, select their corresponding check boxes.

The table updates and shows or hides your chosen columns immediately.

Copying Table Entries to the Clipboard
You can copy a single table cell, a single table row, or multiple table rows to the Clipboard, 
and then paste the Clipboard contents into other documents, such as a Notepad text 
document or Microsoft Office documents.

See these topics:

• Copying the Contents of a Single Table Cell to the Clipboard

• Copying the Contents of a Single Row to the Clipboard

• Copying the Contents of Multiple Rows to the Clipboard

Copying the Contents of a Single Table Cell to the Clipboard

 To copy table cells to the Clipboard

1. Right-click anywhere in the table and choose Cell Selection Mode.

Note  The application does not copy the compound structure in the Structure column of 
the Expected Compounds library to the Clipboard.
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2. To select multiple table cells, use the CTRL key or the SHIFT key.

The selected cells turn a lighter blue than the other cells in the row, as shown in the 
following figure.

3. Right-click and choose Copy from the shortcut menu.

Copying the Contents of a Single Row to the Clipboard

 To copy a single row to the Clipboard

Do one of the following:

• To copy a single row to the Clipboard, right-click the row and choose Copy.

• To copy a single row and the table header, right-click the row and choose Copy with 
Headers.

Copying the Contents of Multiple Rows to the Clipboard

 To copy multiple rows to the Clipboard

Do one of the following:

• To copy a range of contiguous rows to the Clipboard, while holding down the 
SHIFT key, click the first and last row in the range. Then, right-click the last row to 
open the shortcut menu and choose Copy to copy the row contents or choose Copy 
with Headers to copy the row contents and the table header.

• To copy noncontiguous rows to the Clipboard, while holding down the CTRL key, 
click each row that you want to copy. Then, right-click the last row to open the 
shortcut menu and choose Copy to copy the row contents or choose Copy with 
Headers to copy the row contents and the table header.

Selected table cell
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Filtering the Tables on a Study Page or a List or Library View
For the tables on the study pages or in the Lists & Libraries views, use the filters in the filter 
row below the column headers to reduce the number of entries in the current display. The 
filtering effect is not permanent; closing a filtered list or study removes the filters.

To set up single-condition filters for the table columns, see these topics:

• Setting Up Single-Condition Filters for the Table Columns

• Setting Up a Single-Condition Wild Card Filter

• Setting Up a Single-Condition Filter for Numeric Data

Related Topics

• Setting Up a Custom Filter with Multiple Conditions

Setting Up Single-Condition Filters for the Table Columns

 To set up filters for one or more table columns

1. In the table’s filter row, do the following for each column that you want to filter by:

a. Click the operator symbol (Aa or =) and select an operator from the list. 

b. Set up the operand by selecting or typing a value in the operand box. 

After you set up a filter, the applied filter icon, , appears to the right of the operand 
box, and the table displays only those rows with entries that fulfill the filter condition.

2. To remove a single filter, click the filter icon, , to the right of the operand box.

Setting Up a Single-Condition Wild Card Filter

 To set up a wild card filter for a table column

1. In the operator list in the filter row, select Like (Wildcards) or Not Like (Wildcards).

2. In the operand box, select or type text and use an asterisk “*” to replace more than one 
character or use a question mark “?” to replace only one character.

Note  For information about filtering the tables in the result files, see “Using Result Filters 
for Data Reduction and Creating Filter Sets” on page 266.

Tip  For example, to filter the entries in the transformations library by the presence of 
nitrogen in the arriving group, do the following in the Arriving Group column: 

• Select * Like (Wildcards) in the operator list.
• Type *N* in the operand box.
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Setting Up a Single-Condition Filter for Numeric Data

 To set up a filter for a table column with numeric data

Do any of the following:

• To set up a filter that uses a specific table entry in the operand list, select any of these 
operators: Equals, Not Equals, Less Than, Less Than or Equal To, Greater Than, or 
Greater Than or Equal To.

• To set up a filter that uses any of these operands: (Blanks), (NonBlanks), Above 
Average, Below Average, Top 10, Top 10 percentile, Bottom 10, or Bottom 10 
percentile, select either Equals or Not Equals in the operator list.

• To display the top n number of entries, select Top in the operator list and type an 
integer value in the operand box.

• To display the bottom n number of entries, select Bottom in the operator list and 
type an integer value in the operand box.

• To display the top n percentile of entries, select Top Percentile in the operator list 
and type a numeric value in the operand box. 

• To display the bottom n percentile of entries, select Bottom Percentile in the 
operator list and type a numeric value in the operand box.

Operators and Operands for a Single-Condition Table Filter

The filter for each table column consists of an operator and an operand. In an unfiltered table, 
the filter row displays the default operator, which is represented by its symbol, and an empty 
operand box for each column. To set up a table filter, you select the operator from a fixed list, 
and you select the operand from a list or type a value in the operand box.

The selections in the operator list depend on whether the column contains text or numeric 
entries. After you select an operator, the operator symbol appears in the filter row to the left of 
the operand box. For more information about the operator lists, see Table 166 on page 593 
and Table 167 on page 594. 

For all columns, the operand list includes the following: Custom, Blanks, NonBlanks, and the 
column entries. For numerical-entry columns, the operand list also includes the following: 
Above Average, Below Average, Top 10, Top 10 Percentile, Bottom 10, and Bottom 10 
Percentile. For more information, see Table 165.

After you set up a column filter, the applied filter icon, , appears to the right of the operand 
box. Figure 185 shows a filtered Ion Definitions list that reduces the number of displayed 
entries to 10 by using the total adduct mass. The filter row of the Adducts Total Mass column 
displays the equals symbol ( )for the mathematical operator, the selection of Top 10 for the 
operand, and the applied filter icon, .
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Figure 185. Ion Definitions list that is filtered by the adduct mass

Table 165 describes the available operand selections and the valid typed operand entries for 
both text and numeric columns.

Table 165. Operands for the table columns on a study page or Lists & Libraries view (Sheet 1 of 3)

Operand Description

All table columns

(Custom) Applies the custom filter that you set up by using the Custom 
Filter Selection dialog box. 

A custom filter contains more than one condition. If you set up a 
single-condition filter, the operand box lists the single condition 
rather than the (Custom) setting.

(Blanks) Compatible operators:  Equals and  Not Equals

 (Blanks)—Displays the table rows that have blank entries in the 
filtered column. 

 (Blanks)—Displays the table rows that have entries in the 
filtered column.

Operator

Operand
Applied filter icon

Filter 
row
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(NonBlanks) Compatible operators:  Equals and  Not Equals

 (NonBlanks)—Displays the table rows that have entries in the 
filtered column.

 (NonBlanks)—Displays the table rows that have blank entries 
in the filtered column.

Selected entry Table 166 on page 593 describes the compatible operators for text 
entries. Table 167 on page 594 describes the compatible operators 
for numeric entries.

Filters the table rows by using the selected entry and operator.

Typed alphanumeric 
text or numeric value

Table 166 describes the compatible operators for text entries. 
Table 167 describes the compatible operators for numeric entries.

Filters the table rows by using the typed text entry and the selected 
operator.

Additional selections for numeric value columns

Above Average Compatible operators:  Equals and  Not Equals

 (Above Average)—Displays the table rows with numeric values 
in the filtered column that are greater than the calculated column 
average.

 (Above Average)—Displays the table rows with numeric values 
in the filtered column that are equal to or less than the calculated 
column average.

Below Average Compatible operators:  Equals and  Not Equals

 (Below Average)—Displays the table rows with numeric values 
in the filtered column that are less than the calculated column 
average.

 (Below Average)—Displays the table rows with numeric values 
in the filtered column that are equal to or greater than the 
calculated column average.

Top 10 Compatible operators:  Equals and  Not Equals

 (Top 10)—Displays the top 10 table rows for the filter 
condition.

 (Top 10)—Displays the table rows with numeric values in the 
filtered column that are less than those of the top 10 table rows.

Table 165. Operands for the table columns on a study page or Lists & Libraries view (Sheet 2 of 3)

Operand Description
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Top 10 Percentile Compatible operators:  Equals and  Not Equals

 (Top 10 Percentile)—Displays the top 10th percentile of table 
rows for the filter condition.

 (Top 10 Percentile)—Displays the table rows with numeric 
values in the filtered column that are less than those of the top 
10th percentile.

Bottom 10 Compatible operators:  Equals and  Not Equals

 (Bottom 10)—Displays the bottom 10 table rows for the filter 
condition.

 (Bottom 10)—Displays the table rows with numeric values in 
the filtered column that are greater than those of the bottom 10 
table rows.

Bottom 10 Percentile Compatible operators:  Equals and  Not Equals

 (Bottom 10 Percentile)—Displays the bottom 10th percentile 
of table rows for the filter condition.

 (Bottom 10 Percentile)—Displays the table rows with numeric 
values in the filtered column that are greater than those of the 
bottom 10th percentile.

Table 165. Operands for the table columns on a study page or Lists & Libraries view (Sheet 3 of 3)

Operand Description
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Table 166 describes the operators for columns with text entries. 

Table 166. Operators for text columns

Symbol Text selection Effect

Equals Displays the text entries that exactly match the selected or 
typed operand.

Not equals Displays the text entries that do not exactly match the 
selected or typed operand. 

Less than For alphabetic text entries, displays the text entries that 
begin with a letter in the alphabet that comes before the 
selected or typed operand.

Less than or equal 
to

–

Greater than –

Greater than or 
equal to

–

Contains Displays the text entries that contain the text in the selected 
or typed operand.

Does not contain Displays the text entries that do not contain the text in the 
selected or typed operand.

Like (wildcards) Displays the text entries that contain the selected or typed 
text and any additional text represented by an asterisk.

Not like 
(wildcards)

Hides the text entries that contain the selected or typed text 
and any additional text represented by an asterisk.

Match (regular 
expression)

Displays the text entries that contain the same text as the 
selected or typed operand.

Does not match 
(regular 
expression)

Displays the text entries that do not contain the same text as 
the selected or typed operand. 

Starts with Displays the text entries that start with the selected or typed 
operand.

Does not start 
with

Displays the text entries that do not start with the selected 
or typed operand.

Ends with Displays the text entries that end with the selected or typed 
operand.

Does not end 
with

Displays the text entries that do not end with the selected or 
typed operand.
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Table 167 describes the operators for columns with numeric entries.

Setting Up a Custom Filter with Multiple Conditions
Use the Custom Filter Selection dialog box to set up a custom filter with multiple conditions 
for a library or list table or a table on a study page.

 To set up a custom filter

1. Select (Custom) from the operand list for a table column.

The Custom Filter Selection dialog box opens.

Table 167. Operators for numeric columns

Symbol Text selection Effect

Equals Displays the numerical entries that equal the selected operand.

Not equals Displays the numerical entries that are not equal to the selected 
operand.

Less than Displays the numerical entries that are less than the selected 
operand.

Less than or 
equal to 

Displays the numerical entries that are less than or equal to the 
selected operand.

Greater than Displays the numerical entries that are greater than the selected 
operand.

Greater than 
or equal to

Displays the numerical entries that are greater than or equal to 
the selected operand.

Top Displays the n highest entries in the table, where n equals the 
integer typed in the operand box.

Bottom Displays the n lowest entries in the table, where n equals the 
integer typed in the operand box.

Top 
percentile

Displays the entries in the top nth percentile, where n equals the 
percentage typed in the operand box.

Bottom 
percentile

Displays the entries in the bottom nth percentile, where n equals 
the percentage typed in the operand box.
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Figure 186. Custom Filter Selection dialog box with no conditions

2. Do the following for each condition that you want to add to a group:

a. Click Add Condition.

A new table row appears.

b. Select an operator from the Operator list and an operand from the Operand list.

As you add conditions to the group, the application updates the group filter in the 
gray area below the table.

3. To add the last condition to the group, click its row number. 

Figure 187. Clicking the row number in the last row to add the row to the group

The last condition appears in the group filter area. By default, the application applies the 
AND operator to all of the conditions in the group (Figure 188). A vertical blue bar to 
the left of the condition rows indicates an AND group.

Click the row 
number.
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Figure 188. Group filter with three conditions and the AND group operator

4. To change the group operator from AND to OR or from OR to AND, click Toggle.

An orange bar to the left of the condition rows indicates an OR group. 

Figure 189. Group filter with three conditions and the OR group operator

5. To add an overlapping group to the filter, do the following:

a. Select the rows that you want to group, using the SHIFT key for contiguous rows or 
the CTRL key for noncontiguous rows.

The selected rows are highlighted in blue and the ‘And’ Group and ‘Or’ Group 
buttons become available.

Third condition
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Figure 190. Selection of two noncontiguous rows

b. Specify the group type by clicking ‘And’ Group or ‘Or’ Group.

The application applies the second group definition and the Ungroup button 
becomes available.

Figure 191. A set of filter conditions with two groups

6. To remove conditions from a group, select the conditions and click Ungroup.

7. To apply the filter, click OK. 

The Custom Filter Selection dialog box closes, the text (Custom) appears in the operand 
box, and the application applies the custom filter to the entries in the selected filter 
column.
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Custom Filter Selection Dialog Box

Table 168 describes the features of the Custom Filter Selection dialog box.

Table 168. Custom Filter Selection dialog box features

Feature Description

Buttons or icons

+ Add Condition Adds a blank condition row to the condition table.

– Remove Condition(s) Removes the selected conditions. Selected conditions are 
highlighted in blue.

‘And’ Group When the filter contains more than one group, applies the 
AND group type to a set of selected conditions.

‘Or’ Group When the filter contains more than one group, applies the 
OR group type to a set of selected conditions.

Toggle Changes the selected AND group to an OR group or the 
reverse.

Ungroup As you create groups, group label columns appear to the left 
of the Operator column.

When conditions belong to more than one group, removes 
the second group condition for the selected conditions.

OK Closes the dialog box and applies the filter conditions.

Cancel Closes the dialog box without applying the filter conditions.

Table

Operator column Use to select an operator for the filter condition. 

See Table 166 on page 593 for a list of the operators for the 
text entry columns. See Table 167 on page 594 for a list of the 
operators for the numerical entry columns.

Operand column Use to select or type an operand for the filter condition.

See Table 165 on page 590 for a list of the operands for the 
library columns.

Third column Displays comments about the filter condition. For example, 
this box displays “Condition is empty” until you define the 
operator and the operand for a condition.

Filter description area

This area, which is highlighted in gray, displays the group filter conditions.
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16

Working with Molecular Networking 

Use the new molecular networking (beta) feature to investigate possible relations between 
compounds in the Compounds table. 

Using the Molecular Networking Feature
To use the molecular networking feature, follow this process:

1. Process your raw data files with a processing workflow that includes the Generate 
Molecular Networks node, which is a node under Compound Scoring.

2. To review the processed results, open the result file.

3. (Optional) Using the Result Filters view, apply a filter to display only the compounds of 
interest.

4. Do one or both of the following:

• To view a table of similar compounds, in the Compounds table, select a compound of 
interest. Then, open its related Similar Compounds table.

–or–

• Export the molecular network to the viewer.

Related Topics

• How the Generate Molecular Networks Node Works

• Information Displayed in the Similar Compounds Table

Contents

• Using the Molecular Networking Feature

• How the Generate Molecular Networks Node Works

• Information Displayed in the Similar Compounds Table

• Exporting the Molecular Network to the Viewer

• Working with the Molecular Network Viewer
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• Exporting the Molecular Network to the Viewer

• Using Result Filters for Data Reduction and Creating Filter Sets

How the Generate Molecular Networks Node Works
To express the similarity of a pair of compounds, the Generate Molecular Networks node uses 
the assigned elemental compositions and fragmentation data. The composition information is 
used to reject pairs having unexpected elemental composition differences, while the best MSn 
fragmentation scans for both compounds are compared by using the FISh scoring algorithm 
to indicate their structural similarity.

A minimal processing workflow that includes the Generate Molecular Networks node consists 
of untargeted compound detection, grouping, and annotation assignment. To validate the 
elemental composition differences, the workflow must contain at least one search node or the 
Predict Compositions node.

Figure 192. Example processing workflow with the Generate Molecular Networks node
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The input to the Generate Molecular Networks node is a list of annotated compounds, and 
the output from the node is a table of similar compounds for each detected compound. 

The node processes the data as follows:

1. Generates possible transformation pathways according to the user-specified settings.

• If there are multiple pathways to the same elemental composition, the node selects 
the shorter pathway.

• If there are compounds with the same elemental composition (isomers with different 
retention times), the node adds a pathway of length 0.

2. For each pair of compounds that have assigned elemental compositions, the node finds a 
matching pathway that explains the elemental composition difference between the two 
compounds.

3. For each pair of compounds that have fragmentation data, the node calculates the spectral 
similarity by FISh Scoring as follows:

a. Matches the fragments for both compounds by directly comparing their masses.

b. For the remaining unmatched fragments, the node does the following to match the 
fragments:

• Uses the mass shift of the assigned pathway to match “shifted” fragments (if 
enabled). In addition, it uses all possible permutations of the individual pathway 
steps (if enabled).

• Uses the mass shift between the two compounds to match “shifted” fragments (if 
enabled).

c. Calculates the similarity scores. 

4. Applies specified rules and thresholds to the connections (matched pairs).

5. Stores valid connections to the results file.

6. Applies specified view filters on the results table.

Related Topics

• Similar Compounds (Beta) Related Table

Note  If you do not select any transformations for the Generate Molecular Networks node, 
the node does not consider the elemental compositions of the detected compounds for 
scoring. 
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Information Displayed in the Similar Compounds Table
The Generate Molecular Networks node stores all the valid connections between each pair of 
compounds and creates a related table of Similar Compounds. The table shows all the 
connections between the selected compound and its related compounds, with additional 
information about the similarity between them.

You can consider each stored connection as a reaction, where one compound is a substrate 
that is converted into a product through a specific transformation pathway. The Direction 
column indicates the direction of the reaction between the selected compound in the 
Compounds table and the similar compound in the Similar Compounds table. 

A Forward connection indicates that the selected compound is a substrate, to which the 
transformation has been applied to generate the similar compound. A Reverse connection 
indicates that the selected compound is a product of applying the transformation to the 
similar compound. 

In Figure 193, paraxanthine is listed as a demethylation product of caffeine (substrate).

Figure 193. Caffeine and one of its demethylation products
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Exporting the Molecular Network to the Viewer
After you process a set of input files with a processing workflow that includes the Generate 
Molecular Network node, you can export the molecular network for a specified number of 
compounds to the molecular networking viewer.

 To export the molecular network to the viewer

1. (Optional) To display only the compounds of interest, filter the Compounds table.

2. (Optional) Sort the Compounds table by the columns of interest.

3. Right-click the Compounds table and choose Molecular Networks (Beta).

The Export Molecular Networks (Beta) dialog box opens with the following default 
settings: 

• Destination: Folder where the result file resides

• Name: Name of the result file

• Compounds Limit: 500

• Open Viewer After Export: Clear

4. Do any of the following:

• To change the destination folder, click the browse icon and select another folder.

• To change the name of the final folder where the application stores the web page 
components, type a different name in the Name box.

• To change the maximum number of compounds to export, type a number from 1 to 
1000 in the Compounds Limit box.

• To automatically open the viewer in the default browser after clicking Export, select 
the Open Viewer After Export check box.

5. Click Export.

6. If you did not select the Open Viewer After Export check box, open the named 
destination folder. Then, right-click the index.html file and choose the web browser of 
interest.

The viewer opens in the selected or default web browser.

Note  The application only exports compounds that appear in the table in the order 
that they appear in the table, beginning with row 1. It does not export compounds 
that are hidden by applied result filters or compounds in row numbers greater than 
the Compounds Limit value.

Note  Increasing the number of compounds increases the processing time.
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Working with the Molecular Network Viewer
Use the molecular network viewer to visualize the similarity between the compounds of 
interest in the Compounds table.

When you export compounds to the molecular networking viewer, the application processes 
the data and displays a molecular network simulation with the filter and threshold settings 
that you specified in the Generate Molecular Networks workflow node.

In the left pane of the viewer, you can change the settings for the filters and the thresholds, 
change the basis of the link color and the node size, search for a named compound or 
transformation, and isolate the display to a specific cluster. 

In the right pane of the viewer, you can view information for each node or link that you point 
to in the graph area.

See these topics:

• Color-Coding for the Nodes

• Sizing a Node By the Compound’s Peak Area or MW

• Colorizing a Link By Its Score, Coverage, or Number of Fragments

• Interactive Functions in the Molecular Network Viewer

• Search Pane

Figure 194. Molecular network viewer with a cluster for caffeine
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Color-Coding for the Nodes

In the molecular network viewer, the color of a compound’s node indicates the identification 
confidence.

Sizing a Node By the Compound’s Peak Area or MW

The node size is proportional to the Max. Area or MW of a compound, depending on the 
option you select.

 To select whether the node size is proportional to the compound’s peak area or MW

1. In the left pane of the molecular network viewer, open the Node Size area.

2. Select one of these options: By Area or By Mass.

Colorizing a Link By Its Score, Coverage, or Number of Fragments

The color of a link is displayed in the range of gray > orange > dark-red and is proportional to 
the MSn Score, the Forward or Reverse Coverage (max), or the number of Forward or Reverse 
Matches (max), depending on the option you select. If a connection has no fragmentation 
data, the link appears as a gray-dashed line. 

 To select a different option to colorize a link by

1. In the left pane of the molecular network viewer, open the Link Color area.

2. Select one of these options: By Score, By Coverage, or By Fragments.

Table 169. Node colors

Color Meaning

Light green The workflow identified the compound by its fragmentation spectra during 
an mzCloud or mzVault library search.

Dark green The workflow identified the compound by its formula and a database match.

Blue The workflow only determined the compound’s formula. 

Gray The workflow only determined the compound’s mass. 

Tip  By default, the link color is a function of the MSn score. To investigate the clusters, 
try colorizing the links by the other options.

Note  The length of each link has no meaning.
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Interactive Functions in the Molecular Network Viewer

Table 170 describes the interactive tasks that you can perform in the molecular network 
viewer.

Search Pane

Use the Search pane of the molecular network viewer to highlight nodes or links in the graph 
area by searching for the name of a compound or the name of a transformation, respectively.

Table 170. Interactive functions in the molecular network viewer

Task Action

Show information about a compound. 
(graph node)

Point to the compound.

Information about the compound appears in the 
right pane, and all the compound’s relations are 
highlighted in the graph area.

Show information about a graph link 
(relation).

Point to the link (connecting line).

Information about the connection between the 
two compounds appears.

Zoom in or out of an area of the graph. Point to the area of the graph where you want to 
change the zoom level, and then use the mouse 
wheel.

There are four icons in the upper left of the graph.

Reset the pan and zoom. Click the Reset Pan and Zoom icon, . Or, 
double-click anywhere in the graph. 

Move a cluster. Drag one of its nodes.

Refresh the simulation. Click the Refresh icon, .

Stop the simulation process. Click the Stop Simulation icon, .

Enter or exit the isolation mode. Double-click a node to isolate the node and its 
connections, and then click the Isolation mode 
icon, , to exit the isolation mode.

To do the following ... Do this ...

Highlight nodes, in red, for 
compounds with a specified text 
string in their names.

In the Search pane, type the compound’s name in the 
Compound box. 

The viewer highlights all compounds with the 
specified text string in the graph area.

Highlight links, in red, for the 
same named transformation.

In the Search pane, type the transformation’s name in 
the Transformation box.
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Graph Info Pane

The Graph Info pane of the molecular network viewer provides information about the 
exported data. Each bar shows relative portion of currently visible items in blue (for example, 
the number of visible links with fragmentation data) as well as relative portion of all items of 
particular type in dark gray (for example, the number of all links with fragmentation data). 
Finally, the light-gray background of a bar represents the total number of items (for example, 
the number of all the links). The tooltip provides the exact numbers if needed.

Isolation Pane

If the main graph is in the Isolation mode, the Isolation panel provides dynamic control over 
the maximum allowed depth of the graph (see below for more details).

Filters Pane

Use the filters in the Filters pane of the molecular network viewer to limit the amount of 
visible data.

Table 171. Graph Info pane of the molecular network viewer

Parameter Description

Nodes Indicates the number of nodes in the graph area.

Orphans Indicates the number of nodes without any connection (according to 
the current filters and thresholds).

Identified Indicates the number of compounds with an assigned name.

Unknown Indicates the number of compounds without an assigned name.

Links Indicates the number of all connections.

Transform. Indicates the number of connections with assigned transformations. 

MS2 Indicates the number of connections with fragmentation data.

Both Indicates the number of connections with assigned transformations 
and fragmentation data.

Table 172. Filters pane (Sheet 1 of 2)

Filter Description

Unknown Orphans Select to display compounds without a name or connection. 

Default: Not enabled 

Identified Orphans Select to display named compounds without a connection.

Default: Not enabled
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Thresholds Pane

To show or hide low confidence relationships between compounds, adjust the settings in the 
Thresholds pane. By default, the thresholds are set to those specified in the processing 
workflow.

Compound or Transformation Information

Each time you point to a link or node, available information appears on the right side of the 
viewer. For a link, the information pane first displays the assigned pathway name, elemental 
composition, mass difference and fragmentation scores, followed by the reaction from one 
compound to the other. For each compound, it shows the assigned name, elemental 
composition, retention time, molecular weight, max. area, and number of used fragments.

The information automatically disappears from the right pane when you move the pointer 
away from the node or link. 

Require Transformation Clear to display links without assigned transformations.

Default: Enabled

Require MS2 Clear to display links without fragmentation data.

Default: Enabled

Table 172. Filters pane (Sheet 2 of 2)

Filter Description

Table 173. Threshold pane

Threshold Description

Score Specifies the minimum MSn Score for a connection to be 
visible.

Range: 0 to 100

Coverage Specifies the minimum Forward or Reverse Coverage for a 
connection to be visible. 

Range: 0 to 100

Matched Fragments Specifies the minimum number of matched fragments for a 
Forward or Reverse search for a connection to be visible.

Range: 0 to 20

Tip  To prevent the information about the selected node or link from disappearing or 
changing when you move the mouse pointer, hold the SHIFT key while you move the 
pointer. 
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Using the Isolation mode

Use the isolation mode to display only the cluster of interest. The graph displays the 
connections to the selected node up to the maximum reaction depth that you specify under 
Visible Depth.

 To turn on the isolation mode to isolate a specific cluster

1. Double-click the node of interest.

2. To exit the isolation mode, click the Toggle Isolation icon, , or double-click the 
orange node—that is, double-click the node that you clicked to enter the isolation mode.
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17

Testing Communication to the Online Databases

A typical Compound Discoverer analysis that identifies unknown compounds searches mass 
spectrum databases on the Internet. To run these searches, the application must have 
unblocked access to the mass spectral databases on the Internet. 

Follow these topics to test and troubleshoot the application’s access to the online mass 
spectrum databases.

 To test and troubleshoot the application’s access to the online databases

1. Run the communication tests (see “Running the Communication Tests” on page 612). 

If the communication tests succeed, the application has access to the online databases. 

2. If a communication test fails, do the following as needed:

• If only the mzCloud communication test fails, check the Date and Time settings on 
the processing computer (see “Setting the Correct Time and Time Zone on the 
Processing Computer” on page 615).

• If the Check Subscription test for the BioCyc database fails, check the subscription 
information in the BioCyc User Login view of the Configuration page.

Contents

• Running the Communication Tests

• Checking the URLs for the Online Databases in Your Browser

• Specifying the IP Address of the Proxy Server

• Setting the Correct Time and Time Zone on the Processing Computer 

IMPORTANT  If you do not have an organization subscription for the BioCyc 
database, you must create a BioCyc user account or obtain and individual 
subscription, and then enter, test, and save your account credentials in the BioCyc 
User Login view (see “Setting Up a BioCyc Account or Subscription” on 
page 575).
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• If any of the other communication tests also fail, check the access to the URLs for the 
online databases (see “Checking the URLs for the Online Databases in Your Browser” 
on page 613). 

If you can access the URLs for the online databases through your browser, but the 
communication tests still fail, the firewall or proxy setting for your company network 
is blocking the application’s access to the online databases. 

3. If the communication tests fail, but you can access the URLs for the online databases, do 
the following as needed: 

• If a firewall is blocking the application’s access to the online databases, ask your IT 
department to make sure that the company firewall is not blocking “Compound 
Discoverer” or “Compound Discoverer Server” from accessing the URLs. The 
application uses the following protocol: http port 80 and . 

• If a proxy setting is blocking access, see “Specifying the IP Address of the Proxy 
Server” on page 614.

Running the Communication Tests
Use the Communication Tests dialog box to test your processing computer’s access to the 
online databases.

 To verify that your computer has access to the external databases

1. From the menu bar, choose Help > Communication Tests.

The Communication Tests dialog box opens.

2. To open the page for the database that you want to access, click its tab.

3. Click Run Tests.

Figure 195 shows the communication tests in progress.
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Figure 195. BioCyc communication tests

4. If the tests are successful, your computer has access to the required databases on the 
Internet. If only the mzCloud test fails, check the Date and Time settings for the 
processing computer (“Setting the Correct Time and Time Zone on the Processing 
Computer” on page 615). If any of the other tests also fail, check the access to the URLs 
in your browser (see “Checking the URLs for the Online Databases in Your Browser” on 
page 613).

Checking the URLs for the Online Databases in Your Browser
Table 174 lists the URLs for the online mass spectrum databases. If a communication test 
fails, test the URL for the affected database.

Table 174. URLs of online mass spectrum databases (Sheet 1 of 2)

Database URL

mzCloud Identity https://identity.mzcloud.org/

https://www.mzcloud.org/Services/MzCloudApiV1.svc

https://www.mzcloud.org/Services/MzCloudApiLightService.svc

ChemSpider http://www.chemspider.com

http://chemspider.com/MassSpecAPI.asmx

http://chemspider.com/Search.asmx
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Specifying the IP Address of the Proxy Server
If the communication tests fail but you can access the online databases through your browser, 
follow this procedure to specify the IP address of the proxy server.

 To configure the IP address of the proxy server

1. Go to drive:\Program Files\Thermo\Compound Discoverer 3.0\bin\Config.

2. Open the Proxy.config file in Notepad.

3. Remove the text that is highlighted in yellow in Figure 196—that is, remove the XML 
comment delimiters: <!-- and -->.

Figure 196. Proxy configuration setting with XML comment delimiters

4. Replace the text that is highlighted in yellow in Figure 197 with your company proxy 
address.

Figure 197. Default proxy address highlighted in yellow

KEGG: Kyoto 
Encyclopedia of Genes 
and Genomes 

http://www.kegg.jp/

http://rest.kegg.jp

BioCyc https://biocyc.org/

https://biocyc.org/web-services.shtml

Table 174. URLs of online mass spectrum databases (Sheet 2 of 2)

Database URL
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Setting the Correct Time and Time Zone on the Processing Computer
The mzCloud communication test includes a validation of the date and time settings on the 
processing computer. If the mzCloud communication test fails, but the other communication 
tests succeed, check the date and time settings for the processing computer. 

 To check the time and time zone settings

1. Open the Date and Time dialog box. For the Windows 7 operating system, open the 
Control Panel. In the View By list, select Category, and then choose Clock, Language, 
and Region > Date and Time.

2. Make sure that both the date and time and time zone settings are correct.

3. If the Internet Time tab is available, click it and synchronize the computer’s clock with an 
Internet server.

Tip  If your computer is not part of a network domain that synchronizes the 
computer’s clock to the network server, you can use an Internet server to synchronize 
the computer’s clock.
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A

Experiment Design for Comparison Statistics

To understand how and when to use the biological replicate study factor, see these topics.

Biological Versus Technical Replicates
Biological replicates are samples from biological individuals (or non-biological entities) of the 
same type under the same conditions and provide a measure of the variability associated with 
these conditions.

Technical replicates are replicate samples from the same entity under the same conditions. 
Technical replicates from the same entity under the same conditions provide a measure of the 
sampling error, and replicate injections from the same sample solution provide a measure of 
the instrument error.

You can add only one biological replicate factor to a study. The application treats study factors 
nested under a biological replicate factor as technical replicates.

Non-Nested Versus Nested Experiment Designs
When you add a biological replicate factor to study, you can set up two different experiment 
designs—nested and non-nested. In non-nested experiments, the biological replicates are 
independent of each other—that is, you do not reuse individual entities to study multiple 
condition states (study factor items).

In non-nested experiments, different sets of biological replicates are used for each condition. 
Figure 198 shows a non-nested experiment where replicate samples are taken from two sets of 
rats under two conditions. Tom, Jerry, and Hector are fed a normal diet; and Tai, Fernando, 
and Pierre are fed a low-calorie diet.

Contents

• Biological Versus Technical Replicates

• Non-Nested Versus Nested Experiment Designs
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Figure 198. Non-nested design with independent sets of rats for the two dietary conditions

In nested experiments, the same set of biological replicates are used for each condition. 
Figure 199 shows a nested experiment where replicate samples are taken from the same three 
rats under two conditions—a normal diet and a low-calorie diet. Tom, Jerry, and Pierre are 
the biological replicates.

Figure 199. Nested design with the same three rats under two dietary conditions 

JerryTom Hector FernandoTai Pierre

1 32 1 32 1 32 1 32 1 32 1 32
Three technical replicates for each rat

Normal Diet Low-Calorie Diet

Different set of rats for each condition 

Rat 2Rat1 Rat 3

1 32 1 32 1 32 1 32 1 32 1 32

Rat 2Rat 1 Rat 3Tom Jerry Hector

Normal Diet Low-Calorie Diet

Tom Jerry Hector

Same three biological replicates per condition

Three technical replicates for each rat
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To set up the comparison ratios for a nested design with technical replicates, add the following 
study factors:

• A factor for the variable being studied with an itemized list of the variable states

• A biological replicate factor with an itemized list of the entities being studied

• (Optional) A factor for the technical replicates

Figure 200 shows the study factors for the experiment shown in Figure 199.

Figure 200. Study factors for the nested design experiment 

Figure 201 shows the generated sample groups and ratios for the nested design. The sample 
groups—Low-cal Diet and Normal Diet—are highlighted in green. The two sample groups 
contain the same values for the Rat Biological Replicate factor—Tom, Jerry, and Pierre. The 
technical replicates for each biological replicate are grouped together and the biological 
replicates are highlighted in yellow. As shown in the Generated Ratios area, for each selected 
denominator, the Differential Analysis node calculates one group ratio and individual ratios 
for each biological replicate. In the result file, the Compounds table includes a Ratio column 
for the group ratio and Bio. Rep. Ratio columns for the biological replicate ratios.

Note  The application calculates p-values as follows:

• Uses the t-test when comparing two sample groups.

• Uses ANOVA when comparing more than two sample groups.

Numerical factor

Categorical factor

Biological Replicate factor
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Figure 201. Nested design example



Thermo Scientific Compound Discoverer User Guide  621

I

Index

A
Abort command, Job Queue  128
Activate button, License Manager  554
activation code, licensing  555
activation request (.req) file  558
activation response file (activation.xml)  557
Activation Type parameter  171, 179
Actual Size icon, reporting  468
Add Column command  523
Add Files command, study  101
Add Items icon, reporting  467
Add Plot command  302
Add Structure Proposal command  279
adding

adducts to the library  503
biological replicate factors to a study  68, 81
categorical factors to a study  79
charges to a structure  540
column to a mass list  523
compounds to the library  501
custom explanations to a result file  260
fragments lists to the Compound Classes list  30
input files to a new study  75
input files to the Analysis pane  118
ion definitions to the library  508
manual peaks to a specialized trace  299
mass lists to the library  518
numeric factors to a study  80
page break after the page footer of a report  462
transformations to the library  512

Adduct Editor  503
adducts

deleting  503
editing  504
library  502
table, hidden  257

Align Columns icon, reporting  467

Align Retention Times node
limitations  174
using  166

Alignment Model parameter  166
Alignment property, reporting  475
alignment, chromatographic  18, 25, 174, 365
Allow Aromatic Cleavage parameter  265
ammonium adduct  192
analyses

reprocessing  131
reviewing  130
sample groups and ratios for  92, 120
starting  60
submitting to the job queue  122
troubleshooting  57, 120

Analysis pane  60, 133
Analysis Results page of a study  129
Analysis Sequence Details window  130
analysis summary  275
Analysis Validation Issue prompt  60
Analysis Validation Issues prompt  122
Analyze Labeled Compounds node  189
AnchorBottom property, reporting  475
AND logical conjunction, filtering with  271–272, 274
Angle property, reporting  478
Annotate Full Spectrum Tree check box  265
annotations

copying  310
editing  259
fragmentation scan  307

Appearance properties, reporting  474
Appendix section, reporting  466
application

menu bar  7
toolbar  12

applications, installing
Compound Discoverer  xxii
mzVault  xxiv
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Index: B

Apply Dealkylation parameter  237
Apply Dearylation parameter  237
Apply Filters button, Result Filters view  274
Apply FISh Scoring check box  261
Apply mzLogic node  223
arranging windows, tool for  45
Arriving Group

data entry box  513
parameter  514
result table column  400
Transformations library column  512

arrows
layout guide tool  45
Metabolika pathway  531

As Batch check box, Analysis pane  122, 133
Assign command, Input File Characterization page  84
Assign Compound Annotations node  200
Atom Properties dialog box

using for charged fragments  540
using for neutral compounds  551

Auto Layout command, Workflows page  138
AutoReplaceFields property, reporting  478
auto-save option for studies  567
Autosize property, reporting  478
Average Peak Width parameter  19, 232
Avg. Exchange column  407
axis labels

Hierarchical Cluster Analysis view  375
Histogram Chart  317
Scatter Chart  328, 330

B
BackColor property, reporting  475
Bar Chart page, displaying  319
Barcode design item  472
BarHeight property, reporting  475
base ions  29, 192
batch normalization  155
Behavior properties, reporting  478
best fit MS scan  394
best MS1 scan for a compound  33
best MS2 scan for a compound  33
BioCyc credentials, saving  576
BioCyc Pathways table  425
BioCyc Pathways view  362
BioCyc Results table  425, 428
BioCyc User Login view  575
Biological Replicate Factor  68, 81, 104, 617
blanks

Blank check box for sample type  254

Blank sample type  69, 84, 112
Exclude Blanks parameter  199
Mark Background Compounds node  21, 26, 240
Normalize Areas node  199

blocked IP addresses  611
blue circles, KEGG database  360
bond multiplicity, changing  550
borders, adding to design items  470
bracket, using in elemental composition formula  144
Bulk Ratio Generation area  97

C
Calculate Score button  378
CanGrow property, reporting  478
CaptionPosition property, reporting  475
carbon-14 labeled compounds  552
Categorical Factors  68
Caution symbol, Analysis pane  119–120
Ceiling selection, mass defect  168, 224
Cell Selection Mode command  278
Cell Selection Mode shortcut menu command  586
Character spacing property, reporting  475
Charge parameter  146–147, 150, 508
charge state

parameter  177, 180
structure editor  550

charged structures  540
Chart Type parameter  324
Check All Down-Regulated Points command  358
Check All Up-Regulated Points command  358
Check icon, structure checking tool  546
Check Point command  331
Check Structure message box  546
CheckAlignment property, reporting  478
CheckBox design item, reporting  472
Checked property filter, Result Filters view  267
Checked property, reporting  478
CheckSumEnabled property  478
ChemSpider Results table  416
Chromatogram Peaks table  384
Chromatograms view

shortcut menu commands  302
working with  304

chromatographic peak apex, red line indicating  394
Clear All button, Result Filters view  274
Clear Compound Annotation command  279
Clear Frozen Content command  302
Close Sub-Report icon, reporting  467
Collapse All Column Headers command  278



Thermo Scientific Compound Discoverer User Guide 623

Index: D

collapsible left pane
Chromatograms view  253
Mass Spectrum view  308
Options pane, Result Charts view  311

Collect Small Segments parameter, Pie Chart  325
Color legend, Scatter Chart view  330
color map, selecting  568
color palettes, standard  569
color schemes, selecting for a report template  445
ColumnCount property, reporting  480
ColumnDirection property, reporting  479
columns, application table

changing the order  584
stacking  584

columns, report
aligning  467, 469
transposing  444

ColumnSpacing property, reporting  480
communication tests  611
compatibility, software  xxii
Compound Annotation Editor dialog box  259
Compound Area Corrections view  367
compound class editor  538
Compound Class Matches table  429
Compound Class Scoring node  225
Compound Classes library, modifying  535
Compound Discoverer application window  7
Compound Editor dialog box

for editing mass list compounds  524
shortcut menu  543
using  500

compounds labeled with carbon-14  552
Compounds table  401
compounds, library of expected  498
Configuration page  565
contacting us  xxvi
Continuous View icon, reporting  493
Control sample type  69, 112
Copy command  330
Copy Image command  301
Copy Points command  301
Copy with Headers command  278
copying

Chromatograms view as a table of data points  301
Chromatograms view as an image  301
Copy to Clipboard dialog box  146
elemental composition of a compound  144
result tables  278
study factors  82, 104

cover page, report  465
CoverPage section, reporting  465

Create Analog Trace node
connections  158
parameter descriptions  182

Create FISh Trace node, parameter descriptions  184
Create Mass Trace node, parameter descriptions  186
Create Pattern Trace node, parameter descriptions  187
Create Report icon  440
CrossSectionBox design item  473
CrossSectionLine design item  473
CSV files  5, 146, 278, 516
CTRL key, using  298
Culture property, reporting  480
Current Workflow Issues pane  120
Custom Filter Selection dialog box, features  598
Custom Isotope Ratio Pattern option  147
custom layout  258
Customize Report dialog box  442

D
data points, minimum number for peak detection  232
Data properties, reporting  480
Data Source parameter  326
Data Source, Scatter Chart  330
DataField property, reporting  481
date and time information, reporting  446
deactivating the software license  560
deactivation request file  561–562
dealkylation step, description  235
decimal precision for Is Equal To filter  267
default layout, result file  259
Define from Elemental Composition Formula option  146
Degradants folder  31
deleting

adducts, library  503
compounds, library  499
fragments, compound class  538
ion definitions, library  507
mass lists  518
raw data files, effect of  99
study factors  82
transformations, library  511
workflow nodes in the Workflow Tree pane  141
workspace sections, report template  462

dendograms  369
Description box, working with  29
Descriptive Statistics view  347
Deselect All Visible Points command  331
Deselect Point command  331
design items, report template

adding to a report template  469
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Section Report pane  471
Design properties, reporting  483
DetailSection, reporting  465
Detect Compounds node  191
deuternopia, colormap for  569
diamond pattern tool  45
Differential Analysis view  352
Dimension Lines icon, reporting  468
direct match annotations  307
directional arrows

layout guide tool  45
Metabolika pathways  531

Discriminate By check boxes  254
Distance Function parameter  375
Distribute Selection to All command  303
double bonds  203
Down Arrow, using  298
downloading documents  xviii
dragging input files to the Analysis pane  118
dragging views  45

E
E and L folder  31
Edit button, Analysis pane  133
Edit Compound Annotation command  279
Edit Sub-Report icon  458
editors

Adduct Editor  503
biological replicate factor editor  81
categorical factor editor  79
Compound Annotation Editor  259
compound class editor  538
Compound Editor  500
Fragment Editor  539
Isotope Ratio Editor  142
numeric factor editor  80
Transformation Editor  512

Elemental Composition parameter  147
elements, changing  551
EMF files  291
Enable Column Fixing command  278
Enable Column Fixing shortcut menu command  585
Enable Row Grouping command  582
Enabled property, reporting  479
End property, reporting  483
Environmental folder  31
error bars  337
exclamation symbol  107
exclusion list  282
executing runs in parallel  565

Execution State column
Analysis Results page  129
Job Queue page  128

Expand All Column Headers command  278
Expected Compounds library

exporting to an XML file  499
features  499
importing from an XML file  499
initial  498
opening  499

Expected Compounds per File table  395
Expected Features table  397
Expected Finder node

automatic peak width detection algorithm  174
connections  160
using  16–17, 19

Expected Formulas table  398
experimental variables  68
Export > As Mass List command  289–290
Export > Compounds to a New mzVault Library
 command  279

Export > Single Compound to an Existing mzVault Library 
command  279

Export As Xcalibur Inclusion/Exclusion List command  279
Export Image As command  301
Export Points As command  302
Export Spectra node

connections  158
parameter descriptions  164

Export to Excel dialog box  281
Export to Existing Mass List dialog box  290
Export to New Mass List dialog box  289
Export to Text File command  278
exporting

compounds to a new mzVault library  288
data to a CSV file  282
mass list for the TraceFinder application  286
reports  492
single compound to an existing mzVault library  287
Xcalibur inclusion/exclusion lists  282

Extract Sample Information From Sample Names 
 dialog box  85

F
Factor Unit box, numeric factor  80
factory default result file layout  257
Factory Defaults command  314, 320, 323, 329
Features table  410
Field Chooser icon, using to show or hide columns  585
file path, input files  106
Files for Analysis area  118
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Fill Gaps node
connections  28, 159
parameter descriptions  193

Filter By check boxes  254
Filter By check boxes, Chromatograms view  253
Filter By Mass Defect node  167
Filter By Scan Event node  170
Filter Centroids node  173
filter set file

saving  268
summary  276

Filter Summary page  276
Find dialog box, reporting  491
Find Expected Compounds node  230
Find icon, reporting  491
Find Missing Files command  109
firewalls  612
FISh Scoring node

connections  160
FISh coverage score  36
using  232

FISh Scoring Queue view  368
FISh Trace Fragments table  386
Fit Page icon, reporting  493
Fit Width icon, reporting  493
Floor selection, mass defect  168, 224
flowchart, reporting  437
fold change  352
folder structure  70
Font property, reporting  476
Food Research folder  31
ForeColor property, reporting  476
Forensics folder  31
FormatString property, reporting  476
Forward connection, molecular networking  602
Fractional Mass selection, mass defect  168
Fragment Editor  539
Fragment Mode parameter  185
fragments, number of  537
FreeStyle data-visualization application  146
Freeze Content command, Chromatograms view  302
freeze pane  581

G
GdiCharSet property, reporting  476
GdiVerticalFont property, reporting  476
Generate Expected Compounds node

connections  160
using  234

Generate Molecular Networks node  226

generating reports  439
Get from Clipboard button, Isotope Ratio Editor  145
Get from Composition Formula button, Isotope Ratio
 Editor  145

global settings  565
Go to Same Item in Main Table command  280
gray status rectangle  389–390
green background, table cell with  435
green circles, KEGG database  360
green status rectangle  389–390
Group By check boxes  254
Group By check boxes, Chromatograms view  253
Group By Sample check box  255
Group Compounds node  195
Group Expected Compounds node

connections  160
parameter descriptions  239

grouping table rows  582
groups, sample  94
guide tool  45

H
heat map  371
Height property, reporting  483
Help

menu  11
Wizard  98

hidden
result tables  257
table columns  585

Hide Grid icon, reporting  468
Hierarchical Cluster Analysis view  369
HighChem Fragmentation Options view  577
Highest Charge State parameter  177
high-mass compounds, predicted composition for  204
Histogram Chart

displaying histograms  313
parameters  314

hydrogen-to-carbon ratio  203
Hyperlink property, reporting  481

I
Identification Only sample type  69
image files

adding pictures to a report template  472
changing the logo image in a report template  453
saving data points to  291
selecting the logo image for a report template  445, 450

Image property, reporting  481
images of graphs  291
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importing
adduct libraries  503
compound library  5
ion definition libraries  507
library compounds  499
mzVault libraries  527
transformation libraries  511

Impurities folder  31
In ChemSpider column, Predicted Compositions table  207
inclusion list  282
inclusion/exclusion lists, exporting  282
indenting a related table in report templates  444
indenting columns in report templates  449
indicator icon, Result Filters window  269
Individual Traces parameter  184
Input File Characterization page  77
Input File Selection page  75
input files

adding to a new study  75
dragging to the Analysis pane  118
modifying the location of  107

Input Files page of a study  105
Input Files table  387
installation instructions  xxii
Internet Explorer, set as default browser  308
Ion Definition Editor dialog box  509
Ion Definitions library

adding ion definition  503
adding ion definitions  508
deleting entries  507
description  505
editing  509
exporting  507
features  507
importing ion definitions  503

Ion Definitions view  507
IP addresses, blocked  611
isolation mode, Molecular Networks viewer  606
Isotope check box  552
isotope pattern

brackets, using to identify isotopic atoms  144
custom  147
intensity tolerance  191, 204
Pattern List Editor  149
reevaluating precursors  175

Isotope Ratio Editor, using  142
Isotope Ratios parameter  188
isotopologues  407
Isotopologues Distribution Chart  379

J
Job Queue page  124
jobs, processing in parallel  574

K
KeepTogether property, reporting  479
KEGG Pathways table  426
Kendrick Formula  168, 224
Known Structure Formats list  541

L
Label design item, reporting  471
Label Style parameter  324
labeled compounds  144, 188
Labeled Compounds per File table  414
Labeled Features table  412
Labeling Status column  407
Labels Font parameter  325
landscape paper orientation, report template  449
Last Changed parameter  104
layout files, result  257
Layout properties, reporting  483
Leaving Group

parameter  514
result table column  400

Legend Size command  303
libraries

adducts  502
compound classes  535
expected compounds  498
ion definitions  505
mass lists  515
transformations  510

license activation methods
online  557

License Deactivation dialog box  560
License Manager page  553
license, software

activation  558
deactivation  560

Life Sciences Mass Spectrometry Software Download and 
Licensing Portal  559

light bulb icon, New Study and Analysis Wizard  98
Line design item  472
Line Weight property, reporting  476
LineColor property, reporting  476
lines, adding to report templates  443
LineSpacing property, reporting  476
LineStyle property, reporting  476
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Linkage Method parameter  375
Load button, Scatter Chart view  329
Load Filter Set dialog box  274
Location property, reporting  483
logo image

changing  453
report templates  442
selecting  445

Lowest Charge State parameter  177

M
Manual Peak Integration command  303
Manual Peaks table  387
manual peaks, comparing to an XIC trace  22
Map to BioCyc Pathways node  217
Map to KEGG Pathways node  219
Map to Metabolika Pathways node  220
Mark Background Compounds node

connections  28, 160
parameter descriptions  240

Mass Analyzer parameter  178
Mass Defect Plot view  339
Mass Defect Type parameter  168
Mass List Search Results table  418
mass lists

exporting compounds to a new mass list  289–290
library  515

Mass Lists library  515, 520
Mass Lists view  518
mass spectrometers, HRAM  193
Max. Collision Energy parameter  171, 179
Max. Concurrent Entries, Xcalibur exclusion list  285
Max. Depth parameter  265
Max. Occurrence parameter  514
Max. Precursor Mass parameter  177
Max. Wavelength parameter  183
Maximum Shift parameter  166
MaxLength property, reporting  481
menu bar, application  7
Merge Features node  22, 241
Merged Features table  388
Metabolika Pathways table  427
Metabolika Pathways view  364
Metabolism folder  32
Metabolomics folder  32
Min. Collision Energy parameter  171, 179
Min. Precursor Mass parameter  177
Min. Wavelength parameter  183
Minimum Peak Count parameter  177
minimum peak intensity setting, recommended  193

Miscellaneous properties, reporting  484
missing files, resolving  107
mobile phase, background compounds in  240
MS Order parameter  170, 178, 186, 189
MS2 column  408
MultiLine property, reporting  479
Multipage view icon, reporting  493
multiple chromatograms, overlaying  298
mzCloud Results table  419
mzCloud search node  209
mzCloud Similarity button  378
mzCloud, submitting a single sample to  574
mzLogic Analysis view  377
mzLogic score  377
mzVault libraries

adding compounds  287
creating new  288

mzVault Results table  421

N
n/a assignment, study factor  92
NarrowBarWidth property, reporting  476
nested experiments  68
New Analysis command, study  102
New Study and Analysis Wizard

Extract Sample Information From Sample Names 
dialog box  85

Input File Characterization page  77
Input File Selection page  75
light bulb icon  98
Sample Groups and Ratios page  92
Study Name and Processing Workflow page  72

NewColumn property, reporting  481
NewPage property, reporting  482
nodes, workflow

connections  158
parameters  163

Nominal Mass Rounding parameter  168, 224
normalization, batch  155
Normalize Areas node

connections  28, 159
parameter descriptions  196

normalized areas, viewing  351
Nucleon Number list  552
Numerical Factors  68
NWRatio property, reporting  476

O
Open Analysis Template command, study  102
Open Common command, Workflows page  138
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Open Response File dialog box  560
opening

Atom Properties dialog box  551
existing studies  100
report templates  440
result files  248
structure files  541

Options panel, Scatter Chart view  330
OR logical conjunction, filtering with  271–272, 274
orange background, table cell with  435
orange status rectangle  389
Order, result table column  401
Orientation parameter, Custom Report dialog box  449
orientation, report template page  442
OutputFormat property, reporting  477
Overlay Cell Size box, Metabolika Pathways view  365
overlaying multiple chromatograms in one plot  298

P
Padding property, reporting  483
page break, adding to a report  462
page numbers, adding to report templates  446
page orientation, selecting for a report  445
Page Thumbnails pane, reporting  495
PageBreak design item, reporting  472
PageFooter section, reporting  465
PageHeader bar, reporting  455
PageHeader section, reporting  465
Pan Mode icon, reporting  469, 494
paper size

PaperKind parameter, Custom Report
 dialog box  442, 449

selecting for a report  445
Parallel Options view  565
parallel processing  574
Partial Least Squares - Discriminant Analysis view  358
Pattern List Editor  149
Pattern Scoring node

connections  160
parameter descriptions  229

pausing processing runs  125
PDA detector, chromatograms  182
PDF file type, exporting reports  492
Phase

parameter  514
result table column  400

Picture design item, reporting  472
PictureAlignment property, reporting  477
pie charts, parameter descriptions  323

pinning
Options panel, Scatter Chart view  313
result table columns  278
study or result files on the Start Page  40
table rows  581

plot grid, Scatter Chart view  330
Polarity Mode parameter  172, 180
Polarity parameter  186, 189
polarity switching data  18
polarity, ionization  120, 184, 186, 189
portrait paper orientation, report template  449
Predict Compositions node  202
Predicted Compositions table  422
presentations, images for  291
Principal Component Analysis view  341
PrintAtBottom property, reporting  479
printing reports  492
Process Response File button  560
Processing Message Summary page  276
product ID for software license  555
Progress column, Job Queue  128
protanopia, colormap for  569
proxy server  614
Public Documents folder  65
publications, images for  291
p-values

Differential Analysis node  26
volcano plot  352

Q
QRCode property, reporting  485
Quality Control sample type  69
quickstart, Compound Discoverer  49
QuietZone property, reporting  477

R
Radius property, reporting  483
ratios, generating  97
RDBE calculation  203
red background, table cell with  435
red bar, heat map  370
red circle with exclamation symbol  107
red circles, KEGG database  360
red line, vertical  394
red status rectangle  389–390
Refresh button, Scatter Chart view  330
Refresh command  312
Region and Language settings  xxi
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Regular Expression Builder area, Extract Sample Information 
from Sample Names dialog box  91

regular expression operators  88
Related Structures table  399
related tables

basic targeted workflow  23
indenting in a report template  444
untargeted workflow  27

Relative Intensity command  303
Relative Mass Defect parameter selection  168
Remove All Plots command  302
Remove Analysis Result Files message box  107
Remove Files command, study  101
Remove Input File message box  107
Remove Plot command  302
removing

chromatogram plots  297, 302
color schemes  447, 450
completed runs from the job queue  126
input files from the Input Files page  107
result or study files from the Start Page  40

RepeatToFill property, reporting  479
report designer page

description  450
opening  453
shortcut menu  470

Report Preview dialog box, reporting  489
Report Print dialog box, reporting  489
report resolution page  491
report resolution page, reporting  489
ReportInfo design item, reporting  473
reporting

Customize Report dialog box, using  442
exporting reports  492
previewing reports  489
printing reports  492
properties

Appearance  474
Behavior  478
Data  480
Design  483
Layout  483
Miscellaneous  484

report templates
creating  442
data-and-time stamp, adding to reports  454
editing  450
page numbers  446

Reprocess command, Analysis Results page  129
reprocessing an analysis  131
request file, activation process  558
requirements

minimum number of data points for peak
 detection  232

software and hardware  xix
Reset button, Customize Report dialog box  450
resetting factory default layout, result file  257
Resolution parameter  147
restoring, factory default layout  257
Result Charts view  311
result files

naming  133
opening  61, 248

Result Filters view  266
result tables

BioCyc Pathways  217
BioCyc Results  425, 428
ChemSpider Results  416
Chromatogram Peaks  384
Compound Class Matches  429
Compounds  401
Expected Compounds per File  395
Expected Features  397
Expected Formulas  398
Features  410
FISh Trace Fragments  386
Input Files  387
KEGG Pathways  426
Labeled Compounds per File  414
Labeled Features  412
Manual Peaks  387
Mass List Search Results  418
Merged Features  388
Metabolika Pathways  427
Metabolika Results  428
mzCloud Results  419
mzVault Results  421
Predicted Compositions  422
Related Structures  399
Specialized Traces  390
Structure Proposals  391
Transformations  400

resuming processing runs  125
Retention Time Correction view  365
Reverse connection, molecular networking  602
reviewing

analyses  129
result files  247

RichTextBox design item, reporting  472
RightToLeft property, reporting  479
ring equivalents  203
Rotation property, reporting  477
Round selection, mass defect  168, 224
Row Selection Mode, shortcut menu selection  144
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rows, table
copying  586
pinning  581
sorting  580

RT Offset parameter  182
Run command  122
Run command, Analysis pane  133
runs

parallel processing  565
pausing  125
processing  125

S
S/N Threshold parameter  180
Sample Groups and Ratios page  92
sample groups and ratios, analysis summary  275
sample types  112
Samples page of a study  110
Save As icon, report designer page  466
Save Common command, Workflows page  138
Save Filter dialog box  274
saving

all changes to open pages  8
analysis templates  133
auto-save option for studies  567
BioCyc credentials  576
current page  8
data points to a text file  5
data points to image files  5
filter sets  268
processing workflow templates  138, 161
report templates  466
result file layout  257
study factors  80, 82, 104

scaling factor, chromatographic peak area  199
Scan for Missing Features button, License Manager  563
Scan Polarity parameter  184
Scan Type parameter  172, 179
screen resolution, recommended  xxi
Scripting Node  244
Search ChemSpider node  206
Search Mass Lists node  207
Search mzCloud node  209
Search mzVault node  214
Search Results icon, reporting  495
sections, report designer page  464
Select All Visible Points command  331
Select Mode icon, reporting  468
Select Spectra node

connections  158
parameter descriptions  174

using  174
Select Template Study File dialog box  74
Select/Deselect Item in All Groups icon  97
Selection Mode icon, reporting  492, 494
selection mode, choosing  549
Selection Tool, using  549
Set As Input File To shortcut menu command  112
Set Sample Type To command  85, 111
Shape design item, reporting  472
SHIFT key, using  298, 579
shifted match annotations  307
shortcut menu commands

Chromatogram View  300
Compound Editor dialog box  543
Mass Spectrum View  310
report designer page  470
result tables  278
tabbed documents  44

Show All Tables check box, Result Filters view  267, 274
Show Details icon, Input Files page  106, 108
Show Detected Peaks command  303
Show Dots icon, reporting  468
Show Gridlines command  303
Show Legend command  303
Show Lines icon, reporting  468
Show Standard Errors command  337
Show Tooltips command  303
ShrinkToFit property, reporting  480
Single Page View icon, reporting  493
Size property, reporting  483
SizeMode, reporting  483
sizing bar, report designer page  462, 464
Sleeping status, Job Queue  127
Small Slice Collection parameter, Pie Chart  325
Small Slice Threshold (%) parameter  325
Snap Lines icon, reporting  468
Snap to Grid icon, reporting  468
Snapshot Mode icon, reporting  492, 494
software requirements  xix
sorting

analyses on the Job Queue page  127
distribution maps, result table  580
result table rows  580

Sorting icon, study variable  97
Specialized Traces table  390
Specify FISh Scoring Settings dialog box  263
Spectrum Maximum parameter  183
spreadsheet

exporting data to  278, 281
exporting the contents of a report  492
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stable isotope labeling experiments  189, 379, 407
Stable Isotope Labeling folder  32
Standard Mass Defect parameter selection  168
Standard sample type  69, 112
Start Page

hiding  41
icon  13
pin icon  40
recent file lists  40
shortcut menu  44

Start property, reporting  484
state, compound class file  538
status columns

Expected Finder, Consolidated Peaks table  390
Unknown Detector, Consolidated Peaks table  389

status conditions, result filter  270
structure

cleaning  548
creating a mirror image  547
moving  550
resizing  547
rotating  547
saving  550

structure drawing tools, using  542
Structure Editor module

Atom Properties dialog box  550
bond multiplicity  550
bond properties  550
check structure  546
clean structure  548
mirror structure  547
move structure  550
resize structure  547

structure files, opening  541
Structure Proposals table  391
structures, charged  540
structures, checking the validity  546
studies

Analysis Results page  129
Samples page  110

Studies Folder parameter  70
Study Name and Processing Workflow page  72
Study Summary page  276
study variables

assigning  77
hierarchy  95

Style property, reporting  477
SubReport design item, editing  467
summaries, processing  275
Summed Trace parameter  184
SupplementOptions property, reporting  477
synchronizing the computer’s clock  615

T
table rows

copying  586
grouping  582
pinning  581
sorting  580

tables
filtering  588
freezing columns  585
sorting  580

Tag property, reporting  482
template tool, using  544
text file  5
Text property, reporting  482
Text with crossout line button, using  91
TextJustify property, reporting  477
Thermo MS Licensing, email from  555
Thermo Scientific website, user documents  xviii
Thumbnails Pane icon, reporting  495
time zone settings  615
Toggle Sidebar icon, reporting  493
tool, guide or position  45
toolbar, application  12
tooltips  336
Total Intensity Threshold parameter  177
Total Scan parameter  182
Trace Type parameter  182, 186
TraceFinder application, mass list for  286
Transformation Editor  512
transformations

adding  512
editing  514
exporting  511
importing  511

Transformations library
description  510
features  511

Transformations table  400
Transformations view  511
Transpose Data Fields shortcut menu command  470
transposing columns in a report template  469
transposing the columns in a report template  444
Trend Chart view  332
tritanopia, colormap for  569
troubleshooting

access to the Online databases  611
analyses  57
Analysis pane Caution symbol  120
Current Workflow Issues pane  120
Region and Language settings  xxi
screen resolution  xxi
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U
Undo All Zoom/Pan command  300, 330
Undo Last Zoom/Pan command  300
units, chromatographic peak area  3
unrecognized scan event filters  180
Use Fragmentation Libraries check box  265
Use Isotope Pattern in Precursor Reevaluation parameter  175
Use Libraries parameter  185
Use Normalized Areas check box  351
UV-Vis detectors, chromatograms  182

V
validation issues

missing Assign Compound Annotations node  123
missing Differential Analysis node  123

vector images  291
verbose messages, displaying in Job Queue  126
VerticalAlignment property, reporting  477
VerticalText property, reporting  477
View menu  9
viewer, molecular networking  604
views

Bar Chart page, Result Charts view  319
BioCyc Pathways  362
Chromatograms  294
Compound Area Corrections  367
copying data to the Clipboard  291
Descriptive Statistics  347
FISh Scoring Queue  368
Hierarchical Cluster Analysis view  369
Histogram Chart page, Result Charts view  313
Isotopologues Distribution Chart  379
Job Queue page  124
KEGG Pathways  360
Mass Defect Plot view  339
Metabolika Pathways view  364
mzLogic Analysis view  377
Partial Least Squares - Discriminant Analysis  358
Pie Chart page, Result Charts view  323
Principal Component Analysis  341
Result Charts  311
Result Filters  266
Retention Time Correction  365
Scatter Chart page, Result Charts view  326
Trend Chart  332

Visible property, reporting  480

W
Wavelength Range parameter  183
whisker  333

width
logo image container  450
object, report template  483
Overlay Cell Size box, Metabolika Pathways view  365
page width, report template  489

window position tool  45
workflow nodes

installing  563
list of  163
numbers, hiding  567
parameters for

Align Retention Times node  166
Analyze Labeled Compounds  189
Apply mzLogic node  223
Assign Compound Annotations node  200
Compound Class Scoring node  225
Create Analog Trace node  182
Create FISh Trace node  184
Create Mass Trace node  186
Create Pattern Trace node  187
Detect Compounds node  191
Export Spectra node  164
Export Xcalibur Inclusion/Exclusion List node  243
Fill Gaps node  193
Filter By Mass Defect node  167
Filter By Scan Event node  170
Filter Centroids node  173
Find Expected Compounds node  230
FISh Scoring node  232
Generate Expected Compounds node  234
Generate Molecular Networks node  226
Group Compounds node  195
Group Expected Compounds node  239
Map to BioCyc Pathways node  217
Map to KEGG Pathways node  219
Map to Metabolika Pathways node  220
Merge Features node  241
Normalize Areas node  196
Pattern Scoring node  229
Predict Compositions node  202
Scripting Node  244
Search ChemSpider node  206
Search Mass Lists node  207
Search mzCloud node  209
Search mzVault node  214
Select Spectra node  174

workspace sections, report designer page  464
Wrapmode property, reporting  477

X
X Axis Type parameter, Scatter Chart  329
X marks  302
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Xcalibur Inclusion/Exclusion list, exporting  282

Y
Y Axis Type parameter, Scatter Chart  329
yellow background, table cell with  435
yellow-green background, table cell with  435

Z
Z Axis Type parameter, Scatter Chart  329
Zoom In icon, reporting  468
Zoom Out command  330
Zoom Out icon, reporting  468, 493
z-score transformation  374
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